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3 ‘ 1. Overzicht

Systeemconfiguratie
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1. Overzicht

Plaats en functie van onderdelen

Linkerkant en voorkant

O O~NOUID W IN —

1. Meetlinthaak

De meetlinthaak zit op dezelfde hoogte

als de beeldsensor. Gebruik deze haak als
referentiepunt om de afstand tussen de
camcorder en het onderwerp nauwkeurig te
meten. U kunt het uiteinde van een meetlint
aan de haak bevestigen om de afstand vanaf
het onderwerp te meten.

2. Zoekeraansluiting (pagina 19)
3. Ventilatie-opening

[Opmerking]
Bedek de ventilatie-opening niet.

4. Keuzeschakelaar TC IN/OUT (pagina 35,
116)

5. Aansluiting afstandsbedieningsgreep
(pagina 21)

Ve et

e
g
¢ s

% 16

6. N (N-teken) (pagina 60)

e Raak met een smartphone die is uitgerust
met de NFC-functie het apparaat aan, om
een draadloze verbinding tot stand te
brengen.

Sommige smartphones die draadloze
betalingssystemen ondersteunen
ondersteunden mogelijk geen

NFC. Raadpleeg voor details de
gebruiksaanwijzing van de smartphone.

e NFC (Near Field Communication) is een
internationaal communicatieprotocol voor
draadloze communicatie tussen objecten
die zich dicht bij elkaar bevinden.

7. Bevestiging afstandsbedieningsgreep
(pagina 21)

8. Vrijgaveknop voor de
afstandsbedieningsgreep (pagina 21)

9. Wifi-antenne

10. Opname/tally-lampje (voorkant)
(pagina 34)

Knippert als de resterende capaciteit van de

opnamemedia of accu laag is.

11. FOCUS-schakelaar (pagina 37)
12. Beeldsensor
13. Knop PUSH AUTO FOCUS (pagina 41)

14. Signaalcontacten objectief

[Opmerking]
Niet direct met uw handen aanraken.

15. Knop WB SET (witbalansinstelling)
(pagina 46)

16. Vrijgaveknop objectief (pagina 22)



5 1. Overzicht: Plaats en functie van onderdelen

8. Knop ND VARIABLE AUTO (pagina 44)
Druk op de knop ND VARIABLE AUTO om
automatische dichtheidsaanpassing van het
ND filter te starten. De LED brandt groen als dit
is ingeschakeld.

Rechterkant (voorkant/bovenkant/onderkant)

9. Multifunctionele regelaar (pagina 49)
Indrukken tijdens het bekijken van het beeld in
de zoeker om het directmenu weer te geven
en te bedienen.
Draai de multifunctionele regelaar als er een
menu in de zoeker wordt weergegeven om
de cursor omhoog/omlaag te verplaatsen
om menu-onderdelen of instellingen te
Rechterkant (achter) selecteren. Indrukken om het geselecteerde
(pagina 6) onderdeel toe te passen.
Op momenten dat het menu niet wordt
weergegeven kan de regelaar ook
functioneren als een toewijsbare regelaar.

3 ﬁ§l\ —
5 —ﬁ/f:]b -
6 7 ‘ %: ﬁ ND@.@ e

8 ‘M\@
Po—_ o

| éi‘c)g - W =
111 ‘W_J®\®®

10. Functieknop IRIS (pagina 43)
11. Knop CANCEL/BACK (pagina 69)
12. Knop THUMBNAIL (pagina 68)

13. Knop MENU (pagina 10, 73)

Druk op de knop MENU om het statusscherm
weer te geven. Houd de knop MENU ingedrukt
om het hoofdmenuscherm weer te geven.
Druk op de knop tijdens weergave van het
statusscherm of hoofdmenuscherm om naar
de vorige schermweergave te gaan.

MENG

1 3 =\ Wi

[
Yoy

14 15)17 14. Functieknop ISO/GAIN (pagina 43)
16 18 15. Schakelaar ISO/GAIN
(versterkingsselectie) (pagina 43)
1. Knop Clipvlaggen (pagina 53, 70) 5. Schakelaar ND PRESET/VARIABLE 16. Functieknop WHT BAL (witbalans)

. (pagina 46)
2. HOLD-schakelaar (pagina 100) (pagina 44)

3. Knop Record START/STOP (pagina 34)
Druk op de knop START/STOP om te starten
met opnemen. De LED brandt tijdens opname. 7. Indicator ND CLEAR (pagina 44)

4. Regelaar ND VARIABLE (pagina 44) 19. Hoofdtelefoonaansluiting (pagina 34)
20.POWER-schakelaar (pagina 34)

6. Omhoog/omlaag-knoppen ND FILTER 17. Sc.hakelaar WH1: BAL (geheugenselectie
POSITION (pagina 44) witbalans) (pagina 46)
18. Functieknop SHUTTER (pagina 44)
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Rechterkant en kaartsleuf

]
|
0

>H
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1. Wwifi-antenne 6. Knop DISPLAY (pagina 11)
2. Regelaar AUDIO LEVEL (CH?1) 7. Interne luidspreker (pagina 34)
(pagina 47) 8. POWER-indicator (pagina 34)
3. Schakelaar CH1 (AUTO/MAN) 9. Knop SLOT SELECT (selectie
(pagina 47)

4. ASSIGN (toewijsbaar) knoppen 1t/m 3
(pagina 49)

5. Interne microfoon (pagina 47)
Spraakmicrofoon voor opname van
omgevingsgeluid.

[Tip]

Deze microfoon wordt uitgeschakeld als de draaggreep

wordt bevestigd en de interne microfoon van de
draaggreep actief wordt (pagina 7).

geheugenkaartsleuf (A)/(B))
(pagina 34)

10. Schakelaar CH2 (AUTO/MAN)
(pagina 47)

11. Regelaar AUDIO LEVEL (CH2)
(pagina 47)

12. Toegangsindicator A (pagina 26)

12
13

14
15

13. CFexpress Type A/SD kaartsleuf (A)

(pagina 26)

14. CFexpress Type A/SD kaartsleuf (B)
(pagina 26)

15. Toegangsindicator B (pagina 26)
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Draaggreep, achterkant en aansluitblok

0000

T 2
A A

O@° = 26

1. HOLD-schakelaar draaggreep

(pagina 100)
Gebruiken om de bediening van
bedieningselementen op de draaggreep uit te
schakelen.
[Tip]
U kunt dit ook instellen voor alleen de knop Record
START/STOP op de draaggreep.

2. Knop draaggreep opname START/STOP

3. Interne microfoon draaggreep

4. Multi-interfaceschoen

® Multi
7 interface Shoe

Neem voor details over de accessoires
die worden ondersteund door de multi-
interfaceschoen contact op met uw
verkoopvertegenwoordiger.

5. Toewijsbare regelaar draaggreep
(pagina 49)

6. Zoomregelaar draaggreep (pagina 101)

ASSIGN (toewijsbare) knoppen 7t/m 8
(pagina 49)

8. Keuzeschakelaar (8-voudig D-pad en
toepassingsknop)

9. Accessoireschoen (pagina 7)

10. Schroefgaten bevestiging accessoires (1/4
inch)

Compatibel met 1/4-20 UNC-schroeven (lengte

van 6 mm of minder).

[Opmerking]
Gebruik van schroeven die langer zijn dan 6 mm kan
schade aan externe onderdelen veroorzaken.

11. Opname/tally-lampje (achterkant)
(pagina 34)

12. Knop BATT RELEASE (pagina 17)

13. Luchtinlaat

[Opmerking]

Bedek de luchtinlaat niet.

14. Accuset aansluitopening (pagina 17)
15. USB-C-aansluiting (pagina 63)

16. Aansluiting INPUT2 (audio-ingang 2)
(pagina 47)

17. Aansluiting INPUT1 (audio-ingang 1)
(pagina 47)

18. Schakelaar INPUT2 (LINE/MIC/MIC+48V)
(pagina 47)

19. Schakelaar INPUT1 (LINE/MIC/MIC+48V)
(pagina 47)

20.Schroefgaten voor externe apparaten

Compatibel met M3-schroeven (lengte van
4 mm of minder).
[Opmerking]

Gebruik van schroeven die langer zijn dan 4 mm kan
schade aan het externe oppervlak veroorzaken.

21. HDMI OUT-aansluiting (pagina 115)
22.SDI OUT-aansluiting (pagina 115)

23. Aansluiting TC IN/TC OUT (tijdcode in/uit)
(pagina 116)

24.REMOTE-aansluiting

Aansluiten op algemene LANC jack-accessoire.

25.USB/multi-aansluiting (pagina 117)

26.DC-IN-aansluiting (standaard DC-stekker)
(pagina 18)

De accessoireschoen bevestigen

1 Til de voorste rand van de schoenveer
omhoog en trek de veer in
tegenovergestelde richting van de pijl die
op de veer is gegraveerd.

Schoenveer
‘/\E
<
\ >
\ ‘1@
1
Accessoireschoen

2 Plaats de accessoireschoen op de
accessoireschoenbevestiging, lijn de
uitsteeksels op de schoen uit met de
corresponderende punten op de
bevestiging en draai de vier schroeven
vast.
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3 Zet de schoenveer er in de richting van de
pijl in, zodat het U-vormige gedeelte op
het eind van de accessoireschoen past.

Accessoireschoen

Schoenveer

De accessoireschoen verwijderen

Verwijder de schoenveer zoals beschreven in
stap 1in "De accessoireschoen bevestigen”,
schroef de vier schroeven los en verwijder de
accessoireschoen.

De draaggreep bevestigen

Plaats de draaggreep zo dat de
draaggreepaansluiting en schroefgaten op
elkaar zijn uitgelijnd. Druk in en draai de
bevestigingsschroeven van de draaggreep
naar rechts om de draaggreep aan het
apparaat te bevestigen.

U kunt ook de bevestigingsschroeven van de
twee draaggrepen vastmaken door deze naar
rechts te draaien met een inbussleutel (4 mm).

[Opmerking]

Zorg dat de twee bevestigingsschroeven van de
draaggreep goed zijn vastgemaakt, alvorens de
draaggreep te gebruiken. De hendel kan van de
camcorder afvallen als de schroeven niet stevig zijn
vastgemaakt.

De draaggreep verwijderen

Verwijderen in de omgekeerde volgorde als
van de bevestigingsprocedure.

De beschermkap voor de
draaggreepaansluiting (meegeleverd)
bevestigen

Als de camcorder wordt gebruikt zonder de

draaggreep, bescherm dan de aansluiting met
de meegeleverde beschermkap.

[Tip]
Als de draaggreep wordt bevestigd, berg dan de
beschermkap op aan de onderkant van de draaggreep.

De fysieke aansluitingen beschermen

Bevestig de kap voor niet gebruikte
aansluitingen om de chassisdelen te
beschermen.

Bovenkant

1. Aansluiting draaggreep

2. Schroefgaten bevestiging accessoires (1/4
inch)

Compatibel met 1/4-20 UNC-schroeven (lengte

van 6 mm of minder).

[Opmerking]

Gebruik van schroeven die langer zijn dan 6 mm kan

schade aan externe onderdelen veroorzaken.
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. 8. Knop ASSIGN (toewijsbaar) 5
Onderkant Zoeker Afstandsbedieningsgreep (pagina 49)
Zie voor details over bevestiging van de Zie voor details over bevestiging van de
3 zoeker (meegeleverd) pagina 19. (meegeleverde) afstandsbedieningsgreep
pagina 21.
o = (e
= 1—8
(]
L 2—8
2 @)
o ‘ ol (@) 3—3
(]IIIETIIIID
iy I
4 5
1 2 1. Knop PEAKING
1. Schroefgaten statief (1/4 inch, 3/8 inch) 2. Knop ZEBRA
Compatibel met 1/4-20 UNC-schroeven .
en 3/8-16 UNC-schroeven. Bevestigen op 3. Knop'> ASSIGN (toewijsbaar) 9
een statief (optie, schroeflengte 5,5 mm of (pagina 49)
minder). 4. Aanraakscherm
2. Luchtuitlaat Aanraakbediening kan worden uitgeschakeld
) met een toewijsbare knop of in het menu
[Opmerking]

Bedek de luchtuitlaat niet. (paglna 10)'

5. Schakelaar MIRROR

1. Zoomregelaar

2. Knop ASSIGN (toewijsbaar) 4
(pagina 49)

3. Afstandsbedieningsgreep toewijsbare
regelaar (pagina 49)

4. Knop ASSIGN (toewijsbaar) 6
(pagina 49)

5. Rotatieregelaar afstandsbedieningsgreep
(pagina 21)

6. Knop Record START/STOP

Keuzeschakelaar (8-voudig D-pad en
toepassingsknop)
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Het aanraakscherm gebruiken

Voorzorgsmaatregelen voor Aanraakscherm bewegingen Het aanraakscherm configureren
gebruik van het aanraakscherm Tik
) Bediening van het aanraakscherm kan worden
Raak een onderdeel, zoals een pictogram of ingeschakeld of uitgeschakeld met het

De zoeker van het apparaat is een een menu-onderdeel, licht aan met uw vinger onderdeel Touch Operation (pagina 100) in
aanraakscherm, dat u bedient met directe en verwijder uw vinger direct weer. het menu Technical.
aanraking met uw vinger.
¢ Het aanraakscherm is ontworpen om licht Sleep

met uw vinger te worden aangeraakt. Oefen  Raak het scherm aan en sleep uw vinger

geen kracht uit op het scherm en raak het naar de gewenste positie op het scherm, en

niet aan met voorwerpen met scherpe verwijder vervolgens uw vinger.

randen of punten (nagel, balpen, sleutel

etc.)

e Het aanraakscherm reageert mogelijk niet
bij aanraking in de volgende situaties. Let
op, hierdoor kan ook een defect veroorzaakt
worden.

® Bediening met het uiteinde van
vingernagels

e Bediening terwijl andere objecten
contact maken met het oppervlak

¢ Bediening met een aangebrachte Korte of lange veeg

beschermfolie of sticker Raak het scherm aan en veeg uw vinger snel

* Bediening met wgterdruppels of omhoog, omlaag, naar links of naar rechts.
condens op het display

e Bediening met natte of bezwete vingers

L.

[Tip]

Als de displayinhoud doorloopt buiten de randen van
het scherm, kunt u de displayinhoud met vegen laten
verschuiven.
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Schermdisplay

Tijdens filmen (opnemen/standby) en afspelen worden de status en instellingen van de
camcorder geprojecteerd op het beeld dat in de zoeker wordt weergegeven.

U kunt de informatie weergeven/verbergen met de knop DISPLAY. Zelfs indien verborgen,
verschijnt dit bij het uitvoeren van handelingen in het directmenu (pagina 49).

U kunt ook kiezen om elk onderdeel afzonderlijk weer te geven of te verbergen (pagina 94).

Informatie weergegeven op het scherm tijdens filmen

2

:00)ANB/16)| (DFE.6)

(w B600K+Held)(scnj04) (Low Light ND Clear
5

2 G0

19 20 212223 24 2526 27 28 29

1. Indicator netwerkstatus (pagina 13)
Geeft de netwerkverbindingsstatus weer als
pictogram.

2. Indicator upload/resterende bestanden
(pagina 65)

3. Indicator scherpstellingsgebied
(pagina 38)

Geeft het scherpstellingsgebied voor

automatische scherpstelling weer.

4. Opnamemodus, sleuf A/B, Interval Rec
opname-intervalindicator (pagina 50)

Weergave Betekenis
@®Rec Opnemen
Stby Opnemen stand-by

5. Indicator scherptediepte

6. Indicator scanmodus beeldsensor
(pagina 24)
Er wordt een [-markering weergegeven
als zich een verkeerde combinatie voordoet
tussen de beeldcirkelomvang van het objectief
en de effectieve scanmodusinstelling van de
beeldgrootte van de beeldsensor.
Als Imager Scan Mode is ingesteld op FF,
wordt een "C"-markering weergegeven in
modi met smallere hoek of beeldweergave
(bijgesneden).
Bijsnijden vindt plaats in de volgende modi.
e Als de opname-indeling 3840x2160 is
en S&Q Motion beeldsnelheid 100 fps of
120 fps
e Als Codec is ingesteld op RAW of RAW
& XAVC-I en het RAW uitgangsformaat
3840x2160 is

7. Uitvoerindicator voor RAW
werkingsstatus (pagina 59)

Geeft de uitvoerstatus van het RAW-signaal

weer.

8. Statusindicator UWP-D serie

(pagina 13)
Geeft de signaalsterkte van het RF-signaal
weer als een pictogram als er een apparaat
uit de UWP-D-serie is aangesloten op de
MI-schoen die is geconfigureerd voor digitale
audio-overdracht.

9. Beeldsnelheidindicator voor Slow & Quick
Motion filmen (pagina 50)

10. Indicator resterende accucapaciteit/DC IN
voltage (pagina 17)

11. Indicator scherpstellingsmodus
(pagina 41)

Betekenis Weergave
Modus vasthouden Focus Hold
scherpstelling

MF-modus MF
AF-modus AF

Modus AF volgen in echttijd

Gezichts/ogendetectie AF (AF/&/0nly/ /1)

Pictogram gezichts/ s
ogendetectie
Pictogram gezichts/ Only

ogendetectie AF

Pictogram Opgeslagen Lx3
gezicht voor volgen

AF gepauzeerd tijdens [
gezichts/ogendetectie
AFY

1) Wordt weergegeven als er geen gezicht is opgeslagen
voor volgen en er geen gezicht is gedetecteerd, of als
er een gezicht is opgeslagen voor volgen maar het
gezicht voor volgen niet is gedetecteerd.

12. Indicator scherpstellingsgebied
Geeft het scherpstellingsgebied weer.

13. Indicator zoompositie (pagina 36)

Geeft de zoompositie weer binnen het bereik
van 0 (brede hoek) tot 99 (telefoto) (als er een
objectief is bevestigd dat weergave van de
zoominstelling ondersteunt).

De weergave kan worden gewijzigd naar

een balkweergave of afstandsindicator voor
scherpstelling (pagina 102).

De volgende onderdelen worden aan het
display toegevoegd als Clear Image Zoom is
ingeschakeld.

Weergave Betekenis

c! Clear Image Zoom is
ingeschakeld

Vergrotings- Bij gebruik van Clear Image

waarde Zoom

14. Indicator beeldstabilisatiemodus

15. Indicator SDI output/HDMI output Rec
Control status (pagina 115)

Geeft de uitvoerstatus van het REC

besturingssignaal weer.

16. Indicator scherpstelling (pagina 37)

17. Indicator resterende mediacapaciteit

Weergave Betekenis

@ Montage/montagestatus
(medium A)

EIB Montage/montagestatus
(medium B)

EP Montage/montagestatus
(medium B)"

ErP Montagestatus (kan niet

_ opnemen)
(knippert)  (medium B)?

1) Alleen opname van proxygegevens
2) Mediumfout, medium vol of andere fout opgetreden
bij start van opname of tijdens opname.

Er verschijnt een B-pictogram als de
geheugenkaart schrijfbeveiligd is.
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18. Indicator witbalansmodus

Weergave Betekenis

Automodus

Hold Automodus gepauzeerd
W:P Presetmodus

W:A Modus geheugen A
W:B Modus geheugen B

19. Indicator externe vergrendeling tijdcode/

weergave tijd en datum (pagina 35)
Geeft "EXT-LK" aan bij vergrendeling aan de
tijdcode van een extern apparaat.

20.Indicator ND filter (pagina 44)

Weergave Betekenis

@ Automodus

Modus Bokeh Control
(pagina 53)

21. Indicator scenebestand (pagina 56)

22.Indicator diafragma

Geeft de diafragmapositie (F-waarde) weer
(als er een objectief is bevestigd dat weergave
van de diafragma-instelling ondersteunt).

23.Indicator waarschuwing videoniveau

24.Indicator versterking (pagina 43)
Geeft de El-waarde weer in Cine EI-modus
(pagina 24).

Weergave Betekenis

Automodus

Preset H-modus

Preset M-modus

Preset L-modus

*’_EI@

Tijdelijke
aanpassingsmodus

Modus Bokeh Control
(pagina 53)

G

25.Weergave clipnaam (pagina 93)
Geeft de naam weer van de clip die wordt
opgenomen of gaat worden opgenomen.

26.Sluiterindicator (pagina 44)

27. Indicator AE-modus/AE-niveau
(pagina 43)

28.Waterpasindicator
Geeft het horizontale niveau weer in stappen
van £1° tot en met #15°.

29.Audioniveaumeter
Geeft het audioniveau van CH1 naar CH4 weer.

30.Videosignaalmonitor (pagina 52)

Geeft een golfvorm, vectorscoop en histogram
weer.

De oranje lijn geeft de ingestelde waarde van
het zebrapatroonniveau weer.

In de modus Cine El (pagina 24) geeft dit

het LUT-type weer van het signaal dat wordt
gemonitord.

31. Indicator basisgevoeligheid/Basis-ISO
(pagina 43)

In de modus Custom (pagina 24) geeft

dit de basisgevoeligheid weer bij gebruik

van Base ISO/Sensitivity op het scherm Main

Status of ISO/Gain/El >Base Sensitivity in het

menu Shooting van het hoofdmenu.

In de modus Cine El (pagina 24) geeft dit

de Base ISO-gevoeligheid weer bij gebruik

van Base ISO/Sensitivity van het scherm Main

Status of ISO/Gain/El >Base ISO in het menu

Shooting van het hoofdmenu.

32.Indicator Gammaweergave-assistent/
monitor LUT

Geeft de status weer van de

gammaweergave-assistent. De functie

gammaweergave-assistent kan worden

in- of uitgeschakeld door Gamma Display

Assist toe te wijzen aan een toewijsbare knop

(pagina 49).

In de modus Cine El (pagina 24) geeft
dit LUT-instelling van de monitor weer
(pagina 81).

33.Indicator basisuiterlijk (pagina 56)

Geeft de instelling voor basisuiterlijk weer.

In de modus Cine El (pagina 24) geeft dit

het videosignaal weer dat wordt opgenomen
op de geheugenkaarten (pagina 81).

34 .Indicator proxy-status

Weergave Betekenis

Prosy Proxy-opname aan

Proxy Rec Proxy-opname

Proxy Proxy-opname niet gereed
(knippert)

PxChunk Proxy-segmentopname aan
PxChunk Ree Froxy-segmentopname
PxChunk Ree Froxy- segmentopname niet
(knippert) gereed

35. Indicator opname-indeling (codec)
(pagina 83)

Geeft de naam weer van de opname-indeling

op de geheugenkaarten.

36.Indicator opname-indeling
(beeldsnelheid en scanmethode)

37. Indicator opname-indeling (beeldgrootte)
(pagina 83)

Geeft de beeldgrootte weer voor opname op

de geheugenkaarten.

38.Knop Stop AF volgen in echttijd
(pagina 42)
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Informatie die wordt weergegeven op het scherm tijdens afspelen

Pictogramweergave

De volgende informatie wordt geprojecteerd op het afspeelbeeld.

1 23 T 5 6 7 8
(B=>Pleay)
Csion )
9 10 1 12 13 14

Indicator netwerkstatus

Uploadindicator/indicator resterende
bestanden

3. Clipnummer/totaal aantal clips

4. Indicator afspeelstatus

5. Indicator afspeelindeling (beeldsnelheid

8.

9

en scanmethode)
Indicator afspeelindeling (beeldgrootte)

Indicator resterende accucapaciteit/DC IN
voltage

Indicator afspeelindeling (codec)

Mediaindicator

Er verschijnt een (-pictogram als de
geheugenkaart schrijfbeveiligd is.

10. Weergave tijd/datum

11. Weergave clipnaam

12. Indicator gammaweergave-assistent

13. Audioniveaumeter
Geeft het audio-afspeelniveau weer.

14. Indicator basisuiterlijk

Pictogramweergave netwerkverbinding

Netwerkmodus Verbindingsstatus Pictogram
Toegangspuntmodus Werkend als toegangspunt
Toegangspunt fout AR
Stationmodus Wifiverbinding B A A B
Pictogram wijzigt naargelang de
signaalsterkte (4 stappen)
Wifi ontkoppeld B
Wifi verbindingsfout B
USB-tethering USB-tethering verbonden @?

USB-tethering losgekoppeld

Or

USB-tetheringfout

O

Pictogramweergave UWP-D-serie

Verzendingsstatus

Ontvangststatus

Pictogram

Uitgeschakeld

Geen ontvangst

w

Normale verzendingsstatus

Ontvangend

Vo - Vlll

(ontvangstniveau (4 stappen))

Dempingsstatus

Ontvangen (gedempt)

Waarschuwingsstatus resterende Ontvangend ) .
accucapaciteit (Pictogram knippert)
Dempen en waarschuwingsstatus Ontvangend

resterende accucapaciteit

£ E

(Pictogram knippert)
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Statusscherm

U kunt de status en instellingen van de
camcorder controleren op het statusscherm.
De instellingen van onderdelen die zijn
gemarkeerd met een asterisk (*) kunnen
worden gewijzigd.

Het statusscherm ondersteunt
aanraakbediening.

Het statusscherm weergeven

e Druk op de knop MENU.

[Tip]

U kunt de verschillende statusschermen weergeven of

verbergen met Menu Page On/Off (pagina 101) in het
menu Technical.

Het statusscherm omschakelen

e Draai aan de multifunctionele regelaar.

e Druk de keuzeschakelaar omhoog/omlaag
® \eeg het statusscherm omhoog/omlaag.

Het statusscherm verbergen
e Druk op de knop MENU.

Een instellingen wijzigen

Druk als het statusscherm wordt weergegeven
op de multifunctionele regelaar of
keuzeschakelaar om selectie van een
configuratieonderdeel op een pagina mogelijk
te maken. Selecteer een paginanummer en
druk vervolgens om pagina's om te schakelen.
U kunt ook direct onderdelen selecteren met
aanraakbediening.

[Opmerking]

U kunt wijzigingen vanaf het statusscherm uitschakelen
door Menu Settings >User Menu Only (pagina 101)

in het menu Technical van het hoofdmenu op On in te
stellen.

Scherm Main Status

Geeft de hoofdfuncties van de camera en de
vrije ruimte op de media weer.

Scherm Camera Status

Geeft de status van verschillende presets van
de camera weer.

Displayonderdeel Beschrijving

Displayonderdeel Beschrijving

S&Q Frame Rate* Instellingen voor opnemen
in Slow & Quick Motion en

framesnelheid

Frequency/Scan* Systeemfrequentie en
instellingen scanmethode

Scanmodus van de
beeldsensor

Imager Scan*

Media Remain Resterende vrije ruimte op
(A) media in sleuf A

ND Filter Instelling ND-filter

ISO/Gain/El Instelling ISO/versterking/
belichtingsindex

Base I1SO/ Instelling basis-ISO/

Sensitivity* basisgevoeligheid

Codec* Instelling codec voor

opname

Media Remain (B) Resterende vrije ruimte op
media in sleuf B

Scene File* Scenebestand in gebruik en
de instelling voor bestand-

ID

Base Look/LUT*  Basisuiterlijk/LUT-instelling

Shutter Instelling sluitertijd of
sluiterhoek
Iris Diafragma-instelling

Video Format* Beeldgrootte voor opnamen

op geheugenkaarten

RAW Output
Format*

Beeldgrootte van RAW
uitvoer

White Balance Instelling witbalans

White Switch<B> Instelling witbalans
geheugen B

White Switch<A> Instelling witbalans

geheugen A

White Switch<P> Instelling preset wit

Scherm Audio Status

Geeft de ingangsinstelling, audioniveaumeter
en volumemonitorinstelling voor elk kanaal
weer.

Displayonderdeel Beschrijving

CH1 Level
Control

Aan/uit-status van auto-
aanpassing

Level Meter Audioniveaumeter

Source* Ingangsbron

ND<Preset> Instellingen ND-filter Preset1 Ref./Sens.* Ingangsreferentieniveau
t/m3 Wind Instelling windruisreductie
ISO / Gain<L>* Instelling ISO/Gain"<L> Filter* microfoon
ISO / Gain"<sM>*  Instelling ISO/Gain'<M> CH2 Level Aan/uit-status van auto-
ISO / Gain"<H>* Instelling ISO/Gain<H> Control aanpassing
Base ISO/ Instelling basis-1SO/ Level Meter Audioniveaumeter
Sensitivity* basisgevoeligheid Source* Ingangsbron
Zebral* Instelling en niveau Zebral Ref./Sens.* Ingangsreferentieniveau
aan/uit Wind Instelling windruisreductie
Zebra2* Instelling en niveau Zebra2 Filter* microfoon
aan/uit CH3 Level Aan/uit-status van auto-
VF Gamma/ Gamma categorie en curve Control* aanpassing
Gamma Level Audioniveaumeter
Scene File* Scenebestand in gebruik en Meter*
de instelling voor bestand- Source* Ingangsbron

ID

1) Exposure Index als Shooting Mode is ingesteld Cine
El.

Ref./Sens.* Ingangsreferentieniveau

Wind Instelling windruisreductie
Filter* microfoon

CH4 Level Aan/uit-status van auto-
Control* aanpassing
Level Audioniveaumeter
Meter*
Source* Ingangsbron

Ref./Sens.* Ingangsreferentieniveau

Wind Instelling windruisreductie
Filter* microfoon

Audio Input Instelling audio-

Level* ingangsniveau

(mastervolume)

HDMI Output CH* Instelling HDMI-uitvoer
audiokanaal
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Displayonderdeel

Beschrijving

Scherm Monitoring Status

Scherm Assignable Button Status

Scherm Battery Status

Volume* Volume-instelling . . . . . . . .
hoofdtelefoon/interne Geeft de SDI en HDMI-uitvoerinstellingen Geeft de functies weer die aan de toewijsbare Geeft informatie weer over de accu en de
luidspreker weer. knoppen zijn toegewezen. netstroombron (DC IN).
Monitor CH* Instelling monitorkanaal Displayonderdeel Beschrijving Displayonderdeel Beschrijving Displayonderdeel Beschrijving
SDI Signal*  Beeldgrootte uitvoer 1 Functie toegewezen aan de Detected Battery Type accu
Stat h Proiect Info. Aan/uit-instelling knop ASSIGN 1 Remaining Resterende capaciteit (%)
atusscnerm rrojec Disp.* uitvoerdisplay 2 Functie toegewezen aan de Charge Count Aantal laadcycli
Geeft de basisinstellingen weer met Color Instelling kleurbereik/ knop _ASSIGN 2 Capacity Resterende capaciteit (Ah)
betrekking tot het filmproject. Gamut® _Monitor LUT-status 3 Eundf;;'é?\‘e;"ezen aande Voltage Accuvoltage (V)
HDMI Signal*  Beeldgrootte uitvoer nop M ;
: . - anufacture Fabricagedatum accu
FDlspIayon(j:rdeel SBeSCh”J\:ng Info. Aan/uit-instelling 4 Functie toegewezen aan de Date
requency/Scan* Systeemfrequentie en fen * ; i knop ASSIGN 4
instellingen scanmethode Disp. uitvoerdisplay P : Video Light Geeft de resterende
Codec: " J Color Instelling kleurbereik/ 5 Functie toegewezen aan de Remaining capaciteit van de
odec nstelling codec voor Gamut*  Monitor LUT-status knop ASSIGN 5 videolampaccu weer.
R Fanction® Zz:?:i:nstelling voor Stream  Signal Beeldgrootte uitvoer 6 EU”CtiAest;eG?\‘e‘éveze” aan de Power Source Voedingsbron
) . Info. Uitvoerdisplay (uit (vast)) nop Supplied Voltage Geleverd voedingsvoltage
Ps]peiga.le ?pjlpamefunctle en Disp. 7 Functie toegewezen aan de PP g g J
oofdinstellingen
Simul Rec* S imul Color Instelling kleurbereik/ knop ASSIGN 7
Imul hec ot;r::fnselzl:ctfigg Gamut*  Monitor LUT-status 8 Functie toegewezen aan de
- knop ASSIGN 8
kaartsleuven aan-uit en VF Color Instelling gammaweergave- p‘
instelling Gamut*  assistent/instelling Color 9 Functie toegewezen aan de
Title Prefix Titeldeel van de clipnaam space/status Monitor LUT knop .ASSIGN 2
| Scan® < r g Base Look/LUT*  Basisuiterlijk/LUT-instelling Focus Hold Functie toegewezen aan de
mager >can canmodus van de Button knop Focus Hold van het

beeldsensor

Video Format*

Beeldgrootte voor opnamen
op geheugenkaarten

Gamma Display

Assist*

Gammaweergave-assistent
instelling aan/uit

objectief

Picture Cache
Rec*

Opnamefunctie voor
beelden aan-uit en instelling
voor cachegrootte

Number

Numeriek achtervoegsel van
de clipnaam

Shooting Mode*

Instellingen opnamemodus

RAW Output Beeldgrootte van RAW
Format* uitvoer
Proxy Rec* Instelling Proxy-

opnamefunctie aan-uit

Multi Function
Dial

Functie toegewezen aan de
multifunctionele regelaar

Grip Dial

Functie toegewezen aan de
toewijsbare regelaar van de
handgreep

Handle Dial

Functie toegewezen aan de
toewijsbare regelaar van de
draaggreep
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Scherm Media Status

Geeft de resterende capaciteit en resterende
opnametijd van opnamemedia weer.

Scherm Network Status

Geeft de netwerkverbindingsstatus weer.

Displayonderdeel

Beschrijving

Displayonderdeel Beschrijving
Media A Geeft het mediapictogram
informatie weer als opnamemedia is

geplaatst in sleuf A.

Media A meter

Geeft de resterende

Wireless LAN Draadloze netwerkinstelling
en verbindingsstatus

Wired LAN Bekabelde LAN-
netwerkinstelling en
verbindingsstatus

Modem Draadloze netwerkinstelling

en verbindingsstatus van
USB-tethering

Scherm File Transfer Status

Geeft bestandsoverdrachtinformatie weer.

Displayonderdeel

Beschrijving

resterende capaciteit weer van
capaciteit opnamemedia geplaatst in
sleuf A, uitgedrukt als een
percentage op een
balkgrafiek.
Media A Geeft een schatting weer
resterende van de resterende
opnametijd opnametijd van het
opnamemedium geplaatst
insleufAin
minuteneenheden onder de
huidige opnamecondities.
Media B Geeft het mediapictogram
informatie weer als opnamemedia is

geplaatst in sleuf B.

Auto Upload Aan-uitstatus van de functie
Auto Upload

Auto Upload Aan-uit-segmentstatus van

(Proxy) de functie Auto Upload

(Proxy)

Media B meter

Geeft de resterende

Total Transfer
Progress

Overdrachtsvoorgang van
alle taken

resterende capaciteit weer van

capaciteit opnamemedia geplaatst in Default Upload Naam van Auto Upload
sleuf B, uitgedrukt als een Server (Proxy) bestemmingsserver
percentage op een Job Status Resterend aantal taken en
balkgrafiek. (Remain / Total)  totaal aantal taken

Media B Geeft een schatting weer Current File Overdrachtsvoortgang van

resterende van de resterende Transfer Progress de huidige

opnametijd opnametijd van bestandsoverdracht

opnamemedia geplaatst in
sleuf B in minuteneenheden
onder de huidige
opnamecondities.

Current
Transferring File
Name

Naam van het bestand dat
momenteel wordt
overgedragen

Server Address Adres van transmissie-
bestemmingsserver

Destination Bestemmingsdirectory voor

Directory transmissiebestemmings-

server

Gebruik van aanraakschermen voor instellen

Schermindeling

Onderdeel Naam onderdeel

D Audio

CH4 Input Sel.

Set Set-toets (toepassen)

INPUT1
MIC +48V

INPUT2
MIC +48V ‘

CH1 ““l .

Markering die de huidige
instelling aangeeft

m Selectiecursor voor

instellen
(oranje kader)

CH2 ““l .
CH3
S
CH4
Sl

Audio Input Level ||HDMI Output CH

Int MIC

INPUT2
MIC +48V

Volume

CH1/CH2 (0]

Selectie-opties

Bediening

1 Tik op een configuratie-onderdeel.

2 Sleep naar of tik op een instelling om de

CH4 Input Sel.

a

v

Aantikken

» Audio waarde te selecteren.
I INPUT1 D Audio
Lod0 MIC +48V
e CH1 INPUT1
T NPUT2 o UL v
) N IntMIC | g off I MG gy « INPUTT
oy 5 # 3 CH3 Int MIC
| ' -50dB off m: "
Audio Input Leve DMI Output CH e Monitor CH CH4 ||||| | INPUT2
99 CHI/CH2 CHICL2 AL \\? nput Level HDMI Output CH o ‘\T‘:S\V Internal
) 99 CH1/CH2 0]
Tik
De selectieopties voor de waarde
verschijnen.
3 Tik op de toets Set of de

waardeselectiecursor.

De waarde wordt toegepast en het
display keert terug naar het vorige

scherm.
[Tips]

e Druk op de knop CANCEL/BACK om naar de vorige

waarde te gaan.

o U kunt ook de multifunctionele regelaar of

keuzeschakelaar gebruiken.

e Aanraakbediening kan ook worden uitgeschakeld

(pagina 100).
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2.Voorbereiding

Stroomvoorziening

U kunt een accuset gebruiken of netstroom via
een netadapter.

Gebruik voor uw veiligheid alleen de hieronder
vermelde Sony accusets en netadapters.

Lithium-ion accusets
BP-U35 (meegeleverd)
BP-U60

BP-UG0T

BP-U70

BP-U90

BP-U100

Acculaders

BC-CU1 (meegeleverd)
BC-U1A

BC-U2A

Netadapter (meegeleverd)

[LET OP]

Bewaar accusets niet op plaatsen die
blootstaan aan direct zonlicht, open vuur of
hoge temperaturen.

[Opmerkingen]

e Gebruik bij werken op een locatie met netstroombron
de meegeleverde netadapter.

e Zet de POWER-schakelaar altijd in de stand Off
voordat u een accu of netadapter aansluit. Als de
aansluiting plaatsvindt terwijl de POWER-schakelaar
op On staat, kan de camcorder in sommige gevallen
mogelijk niet starten. Als de camcorder niet kan
worden gestart, zet de POWER-schakelaar dan in
de Off-stand en maak de accuset of de netadapter
tijdelijk los, en wacht vervolgens 30 seconden
alvorens opnieuw aan te sluiten. (Als de netadapter
is aangesloten terwijl de camcorder werkt op
de accuset, kan deze zonder problemen worden
aangesloten met de POWER-schakelaar in de aan-
stand).

Een accuset gebruiken

Om een accuset aan te sluiten steekt u
deze zo ver mogelijk in de aansluitopening
(pagina 7) en schuift u deze daarna
omlaag om de set vast op zijn plaats te
vergrendelen.

Om een accuset te verwijderen houdt u de
knop BATT RELEASE (pagina 7) ingedrukt,
schuift u de accuset omhoog en trekt deze
vervolgens uit de aansluitopening.

Knop BATT
RELEASE

[Opmerkingen]

e Laad voor het bevestigen van een accuset de accu
op met de speciale accu-opladers BC-CU1, BC-U1A, of
BC-U2A.

e Opladen van een accuset als deze nog warm is
(bijvoorbeeld direct na gebruik) kan resulteren in het
niet volledig opladen van de accu.

De resterende capaciteit controleren

Bij het filmen/afspelen bij gebruik van een
accuset wordt de resterende accucapaciteit
weergegeven in de zoeker (pagina 11).

Pictogram Betekenis
(/7] 91% t/m 100%
71% t/m 90%
51% t/m 70%
{ / 31% t/m 50%
{4 1% t/m 30%
) 0% t/m 10%

De camcorder geeft de resterende capaciteit
aan door de beschikbare tijd met de accuset
te berekenen als de werking wordt voortgezet
met het huidige energieverbruik.

Als de acculading minder wordt

Als de resterende acculading tijdens gebruik
onder een bepaald niveau daalt (status Low
Battery), verschijnt er een bericht dat de accu
bijna leeg is en begint het opname/tally-
lampje te knipperen om u te waarschuwen.
Als de resterende acculading onder het niveau
komt waarop verder werken niet mogelijk is
(status Battery Empty) verschijnt een melding
dat de accu leeg is.

Vervangen door een opgeladen accuset.

De waarschuwingsniveaus wijzigen

Vanuit de fabriek is het niveau Low Battery
ingesteld op 10% van de volledige acculading
en het niveau Battery Empty op 3%. U kunt het
waarschuwingsniveau instellen met Camera
Battery Alarm (pagina 102) in het menu
Technical van het hoofmenu.

De accuset opladen met behulp van de
meegeleverde acculader (BC-CUT)

1 Sluit de netadapter (meegeleverd) aan op
de acculader en sluit het netsnoer
(meegeleverd) aan op de netstroombron.

2 Duw de accu erin en schuif deze in de
richting van de pijl.
De CHARGE-lamp gaat oranje branden en
het opladen begint.

&
&

CHARGE-lamp

— Netadapter

*— Netsnoer

CHARGE-lamp (oranje)

Brandt: Laadt op

Knippert: Oplaadfout, of de temperatuur
bevindt zich buiten
bedrijfstemperatuur en het opladen
wordt gepauzeerd.

e De CHARGE-lamp van de acculader.

e Gebruik altijd originele Sony-accu's.
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Laadtijd
Geschatte tijd (in minuten) die vereist is om
een volledig ontlade accuset op te laden.

Accuset Volledige laadtijd
BP-U35 120 minuten
[Opmerking]

Als de netadapter wordt losgekoppeld van de acculader
en de accu blijft aangesloten op de acculader, gaat de
accu zich ontladen.

Netstroom gebruiken

Als de camcorder op de netstroom wordt
aangesloten is gebruik zonder zorgen over het
opladen van de accuset mogelijk.

Netsnoer  Netstroomingang
l [I:I
Netadapter
Sluit de netadapter aan op de DC IN-
aansluiting op de camcorder en sluit

het netsnoer (meegeleverd) aan op de
netstroombron.

Als het uitgangsvoltage van de
netadapter laag wordt

Als het uitgangsvoltage van de netadapter
tijdens bedrijf onder een bepaald niveau komt
(status DC Low Voltagel), verschijnt er een
melding dat het voltage van de netadapter
is gedaald en gaat het opname/tally-lampje
gaat knipperen.

Als het uitgangsvoltage van de netadapter
tijdens bedrijf onder het niveau komt waarop
gebruik niet meer mogelijk is (status DC Low
Voltage2) verschijnt er een melding dat het
voltage van de netadapter te laag is.

Als dit gebeurt kan de netadapter defect zijn.
Controleer de netadapter, zoals vereist.

De waarschuwingsvoltages wijzigen

Het niveau van DC Low Voltagel is vanuit

de fabriek ingesteld op 16,5 V en het niveau
van DC Low Voltage2 op 15,5 V. U kunt de
waarschuwingsniveaus instellen met Camera
DC IN Alarm (pagina 102) in het menu
Technical.

Netadapter

e Sluit een netadapter niet aan of gebruik
deze in een krappe ruimte, zoals tussen een
muur en meubels.

e Steek de netadapter in het dichtstbijzijnde
stopcontact. Als er zich tijdens het
werken een probleem voordoet, trek
dan onmiddellijk het netsnoer uit het
stopcontact.

e Maak geen kortsluiting met de metalen
onderdelen van de stekker van de
netadapter. Dit heeft een defect tot gevolg.

e De accu kan niet worden opgeladen als
deze aan de camcorder is bevestigd, zelfs
als de netadapter is aangesloten.

e Pak bij het loskoppelen van de netadapter
de stekker rechtstreeks vast en trek deze
recht uit het stopcontact. Trekken aan de
kabel kan een defect veroorzaken.
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Apparaten aansluiten

De microfoon aansluiten (apart
aanschaffen)

1 Plaats de microfoon in de
microfoonhouder.

=/

2 Sluit de microfoonkabel aan op de
aansluitingen INPUT1 of INPUT2.

Kabelhouder

~— Microfoon

Microfoonhouder [Tips]
e Als de microfoon niet stabiel kan worden bevestigd,

gebruik dan de afstandhouder die bij de microfoon
wordt geleverd.

e Afhankelijk van het bevestigde objectief kan het
uiteinde van de microfoon zichtbaar zijn in het
camcorderbeeld. Pas de positie van de microfoon aan.

De zoeker bevestigen

[Opmerking]
Bevestig/verwijder de zoeker als de camcorder is
uitgeschakeld.

INPUT1 _ INPUT2

De zoeker aan de voorkant van de

3 Plaats de microfoonkabel in de draaggreep bevestigen

kabelhouder, zoals in de afbeelding wordt

weergegeven. 1 Plaats de montageklemadapter van de

zoeker in de zoekerbevestiging van de
draaggreep (D) en draai de schroef
(meegeleverd) naar rechts om de adapter
op zijn plaats te fixeren (®@).

De montageklemadapter kan vrij worden
bevestigd in stappen van 45°, maar de
positie waarbij het bevestigingspunt zich
direct boven de schroef bevindt, wordt
geadviseerd.

Schroef
Montageklemadapter
van de zoeker

Monteer de zoekerklem op de
montageklemadapter van de zoeker ((9)
en draai de vergrendelknop naar rechts
om de adapter op zijn plaats te fixeren

[Opmerking]

Zorg dat de vergrendelknop bij gebruik van de
zoeker stevig vast zit. De zoeker kan eraf vallen als de
vergrendelknop niet stevig vastgedraaid is.

3 Lijn de A-markering op de camcorder uit

met de ¥-markering op de
zoekeraansluiting, en bevestig de kabel.
Zorg dat de ¥-markering zich aan de
buitenzijde bevindt, alvorens de stekker te
plaatsen.

4 Plaats het snoer in de snoerhouder, zoals

weergegeven in de afbeelding.

Kabelhouder
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De zoeker aan de achterkant van de
draaggreep bevestigen

Er zijn twee bevestigingspunten, aan de
achterkant van de draaggreep (D) en aan de
achterkant van de camcorder (@) voor het
bevestigen van de zoeker. Bevestig de zoeker
op dezelfde manier als beschreven in "De
zoeker aan de voorkant van de draaggreep
bevestigen".

De positie van de zoeker aanpassen

Kantel de zoeker omhoog/omlaag/vooruit/
achteruit om de hoek van de zoeker aan te
passen.

U kunt de MIRROR-schakelaar gebruiken om
het beeld om te draaien als u bijvoorbeeld
vanaf de voorkant van de camcorder kijkt.

[Tip]

Als het apparaat niet wordt gebruikt of wordt
getransporteerd, wordt geadviseerd de zoeker in een
positie te plaatsen zoals in de volgende afbeelding, om
de zoeker te beschermen.

De zoeker verwijderen

Maak de vergrendelknop van de zoeker los en
voer de handelingen voor het bevestigen van
de zoeker in de omgekeerde volgorde uit.

De zoekerkap bevestigen

1 Open de metalen clips op de zoekerkap.

2 Bevestig de metalen beugel aan de
bovenkant van de zoekerkap aan de haak
aan de bovenkant van de zoeker en
bevestig de metalen clip aan de
onderkant van de zoekerkap aan de haak
aan de onderkant van de zoeker.

¥~

Bevestigingshaken m@

3 Duw de vergrendelplaat aan de onderkant
van de zoekerkap in de richting van de pijl
om de zoeker in kappositie te
vergrendelen.

De zoekerkap openen

Trek de middenonderkant van de zoekerkap
uit naar u toe, en duw vervolgens omhoog om
de kap te openen.

[Opmerking]

Houd bij het verplaatsen van de zoeker de body van
de zoeker vast als u verplaatst. Niet vastpakken aan de
zoekerkap.

De zoekerkap verwijderen

Maak de klem van de zoekerkapvergrendeling
los en verwijder de zoekerkap van de zoeker.
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De afstandsbedieningsgreep
bevestigen

[Opmerking]
Bevestig of verwijder de afstandsbedieningsgreep
terwijl de camcorder is uitgeschakeld.

1 Sluit de kabel aan op de aansluiting van
de afstandsbedieningsgreep.

2 Breng de bevestiging van de
afstandsbedieningsgreep van de
camcorder en de montagemarkering op
de greep op één lijn (D), bevestig de
greep aan de camcorder en draai deze
langzaam naar links (®).

U hoort een klikgeluid als de greep in
positie vergrendelt.

Indexmarkering

[Opmerking]

Als correcte bevestiging niet lukt, bevestig

dan opnieuw zonder overmatige kracht op de
afstandsbedieningsgreep of op de camcorder uit te
oefenen.

3 Steek de in stap twee aangesloten kabel
onder de sleuf van de
afstandsbedieningsgreep, zoals in de
afbeelding wordt weergegeven.

[Opmerking]

Als de kabel niet onder de sleuf wordt geplaatst kan het
wijzigen van de hoekbevestiging overmatig veel kracht
uitoefenen op de kabel, of de kabel kan klem komen te

zitten in het draaimechanisme.

De hoek van de 1
afstandsbedieningsgreep aanpassen

Beweeg de rotatieregelaar op de
draaggreep naar de in de afbeelding
weergegeven stand, en draai de greep
U kunt de hoek van de terwijl u de regelaar ingedrukt houdt.
afstandsbedieningsgreep aanpassen over —)
een bereik zoals weergegeven in de volgende
afbeelding, om deze aan te passen aan uw

stijl van filmen.

\' 2 Haal uw vinger van de rotatieregelaar op
de draaggreep bij de gewenste stand.

Standaardpositie

3 Verplaats de greep enigszins tot u een
klikgeluid hoort, wat aangeeft dat de
greep op zijn plaats is vergrendeld.

Als de draaggreep is gezekerd, keert de
rotatieregelaar terug naar de
oorspronkelijke stand.

[Opmerkingen]

e Controleer na het wijzigen van de stand altijd of de
greep stabiel is geplaatst.

e De hoek kan niet verder worden aangepast dan
binnen het aanpassingsbereik. Gebruik geen
overmatige kracht bij het draaien van de greep.

Naar de achterkant gedraaid (83° max.)
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De greep vasthouden (geadviseerde
methode)

Er zijn geen regels voor het vasthouden van
de greep, maar het volgende voorbeeld toont
een manier voor makkelijke bediening van de

greep.

Bij gebruik van de knop ASSIGN 5 of
keuzeschakelaar

@

CA B

A: Bedien de toewijsbare regelaar van de

handgreep met uw wijsvinger.

B: Bedien de keuzeschakelaar en de knop
ASSIGN 5 met uw duim.

C: Houd de handgreep stevig vast met uw
middelvinger, ringvinger en pink.

Bij bedienen van de Zoom

A: bedien de zoomregelaar met uw wijsvinger
en middelvinger.

B: Houd de greep stevig vast met uw duim.

C: Houd de greep stevig vast met uw
ringvinger en pink.

De greep verwijderen

[Opmerking]

Plaats bij het verwijderen van de greep de camcorder op

een vlak oppervlak, zoals een bureau.

1 Maak de kabel los van de aansluiting van
de afstandsbedieningsgreep.

2 Houd de vrijgaveknop voor de
afstandsbedieningsgreep op de
camcorder ingedrukt en draai de greep
naar rechts tot deze loskomt.

Vrijgaveknop voor de
afstandsbedieningsgreep

[Tip]

Er kan een rozet worden bevestigd aan zowel het

greepbevestigingspunt op het apparaat als het

bijbehorende bevestigingspunt op de greep.

Neem voor details over het aanschaffen van rozetten

contact op met uw Sony-dealer.

- Camcorderzijde: 4-546-932- (optie)

- Greepzijde: 4-547-089- (optie)

- Bevestigingsschroeven*

Camcorderzijde: 7-627-556- (optie)
Greepzijde: 7-627-556- (optie)

* Voor elke rozet zijn vier schroeven vereist
(schroefgaten worden aangegeven door de cirkels
in de volgende afbeelding). Gebruik van andere
schroeven dan vermeld kan schade aan externe
onderdelen veroorzaken.

Camcorderzijde

Greepzijde

Een objectief bevestigen

[LET OP]

Laat het objectief niet met de lens in de

zon liggen. Direct zonlicht kan de lens
binnendringen, een brandpunt vormen in de
camcorder en zo brand veroorzaken.

[Opmerkingen]

e Bevestig/verwijder een objectief als de camcorder is
uitgeschakeld.

e Een objectief is een precisiecomponent. Plaats
het objectief niet op een opperviak met de
objectiefbevestiging omlaag. Bevestig de
meegeleverde objectiefbevestigingsdop.

[Tip]

Neem voor details over objectieven die door de
camcorder worden ondersteund contact op met uw
Sony servicevertegenwoordiging.

Een objectief met E-bevestiging
bevestigen

1 Verwijder de lensdop en kap van de
camcorder en het objectief.

2 Lijn de objectiefmontagemarkering (wit)
uit met de camcorder, plaats het objectief
en draai het daarna naar rechts.

U hoort een klikgeluid als de greep in
positie vergrendelt.

Bevestigingsmarkeringen (wit)

[Opmerking]
Druk niet op de objectiefvrijgaveknop bij het bevestigen
van het objectief.

Een objectief met A-bevestiging
bevestigen

Om een objectief met A-bevestiging te
gebruiken bevestigt u een objectiefadapter
(optie) en bevestigt u vervolgens het objectief
met A-bevestiging.

[Opmerking]

Bij gebruik van een objectief met A-bevestiging

wordt het diafragma handmatig ingesteld en is de
scherpstelling ingesteld op MF.

Een objectief verwijderen

Verwijder een objectief met de volgende
procedure.

1 Houd de objectiefvrijgaveknop ingedrukt
en draai het objectief naar links terwijl u
het ondersteunt.

2 Trek het objectief er in voorwaartse
richting uit.
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[Opmerkingen]

e Lijn bij het verwijderen van een objectief
de bevestigingsmarkering op de
objectiefvergrendelingsring uit met de
bevestigingsmarkering op de camcorder.

e Pak het objectief stevig vast, zodat het niet kan vallen.

e Als er niet direct een ander objectief wordt bevestigd,
bevestig dan altijd de bodydop.

Diafragma-aanpassingen voor
objectieven met Auto Iris-schakelaar

e Als de Auto Iris van het objectief is ingesteld
op AUTO, wordt het diafragma automatisch
aangepast, maar kan ook handmatig vanaf
de camcorder worden ingesteld.

e Als de Auto Iris van het objectief is ingesteld
op MANUAL, kan het diafragma alleen
worden aangepast met de objectiefring.
Bediening van het diafragma vanaf de
camcorder heeft geen effect.

Scherpstellingsaanpassingen voor
objectieven met scherpstellingsschakelaar

e Als de scherpstellingsschakelaar voor het
objectief is ingesteld op AF/MF of AF, wordt
de scherpstelling automatisch aangepast
en kan ook handmatig worden aangepast
vanaf een afstandsbediening.

e Als de scherpstellingsschakelaar van
het objectief is ingesteld op MF, wordt
de scherpstelling aangepast met de
objectiefring en kan ook handmatig worden
aangepast vanaf een afstandsbediening.
[Opmerking]

Bij gebruik van een objectief met A-bevestiging is

handmatige aanpassing vanaf een afstandsbediening
mogelijk niet beschikbaar.

o Als de scherpstellingsschakelaar van een
objectief is ingesteld op Full MF, kan de
scherpstelling alleen worden aangepast met de
objectiefring. Bediening van de scherpstelling
op de camcorder heeft geen effect.

Een statief bevestigen

Gebruik de schroefopening op de camcorder
voor het bevestigen van een statief. Gebruik
van de statiefbevestiging op het objectief kan
schade veroorzaken.
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Basisbediening van de camcorder configureren

De eerste keer dat de camcorder wordt
ingeschakeld of als de back-upaccu volledig
is ontladen verschijnt het beginscherm voor
instellingen in de zoeker.

Stel in dit scherm de datum en tijd van de
interne klok in.

Time Zone

Time Zone stelt het tijdsverschil in met UTC
(Coordinated Universal Time). Wijzig zo nodig
de instelling.

De datum en tijd instellen

Gebruik de keuzeschakelaar (pagina 7) of

de multifunctionele regelaar (pagina 5)

om onderdelen en instellingen te selecteren
en druk vervolgens op de toepassingsknop
van de keuzeschakelaar om de instellingen toe
te passen en het lopen van de klok te starten.
Zodra het instelscherm is gesloten kunt u de
datum, tijd en tijdzone-instelling wijzigen

met Clock Set (pagina 107) in het menu
Maintenance.

[Opmerkingen]

e Als de klokinstelling verloren gaat omdat de back-
up-batterij leeg is vanwege gedurende langere
tijd geen aangesloten voeding (geen accuset en
geen DC IN stroombron), wordt het oorspronkelijke
instellingenscherm weergegeven als u de camcorder
weer inschakelt.

e Terwijl het beginscherm voor instellingen wordt
weergegeven is er geen andere bediening mogelijk,
behalve het apparaat in- of uitschakelen, totdat u de
instellingen in dit scherm heeft afgerond.

e De camcorder heeft een ingebouwde oplaadbare
batterij voor het opslaan van datum, tijd en
andere instellingen, zelfs als de camcorder wordt
uitgeschakeld.

Configureer voor het filmen de voor de

toepassing geschikte basisbediening van de

camcorder op het scherm status Project.
[aStby

DCIN19.5 v
4/10

Video Format
3840x2160P
unctior

Off

Simul Rec Picture Cache Rec

Off Off
Title Prefix Number

000 0001

Opnamemodus

U kunt de opnamemodus schakelen tussen
"modus Custom" om flexibel op locatie
beelden te maken en "Cine El-modus”
(waarbij de camcorder op dezelfde manier
wordt bediend als een filmcamera, met
beeldmateriaal ontwikkeld in postproductie).
Stel de opnamemodus in met Shooting Mode
(pagina 15) op het scherm status Project.

[Tip]

U kunt ook de opnamemodus instellen met Base Setting

>Shooting Mode (pagina 83) in het menu Project van
het hoofdmenu.

Custom modus

In de Custom filmmodus kunt u de

videostandaard selecteren.

U kunt de videostandaard instellen met Base

Setting >Target Display (pagina 83) in het

menu Project van het hoofdmenu.

e SDR(BT.709): Filmen volgens HD broadcast-
norm

e HDR(HLG): Filmen volgens de nieuwe
generatie 4K broadcast-norm

Zie voor details pagina 56.

Cine El-modus

Als de opnamemodus is ingesteld op

de modus Cine El, selecteer dan het

basiskleurbereik voor het opnamesignaal

en uitgangssignaal. Het hier geselecteerde
kleurbereik is het kleurbereik van de video-
uitvoer als MLUT is ingesteld op Off.

U kunt het kleurbereik instellen met Cine El

Setting >Color Gamut (pagina 84) in het

menu Project van het hoofdmenu.

e S-Gamut3.Cine/SLog3: Makkelijk voor het
aanpassen van kleurbereik voor digitale
cinema (DCI-P3).

e S-Gamut3/SLog3: breed Sony kleurbereik
dat het ITU-R BT.2020 kleurbereik omvat.

Zie voor details pagina 58.

[Opmerkingen]

e Cine EI-modus heeft de volgende beperkingen.

e Functies die niet automatisch kunnen worden
aangepast (tracking)
- Witbalans
- Versterking
- Sluiter
e Functies die niet kunnen worden geconfigureerd
- 1SO gevoeligheid/versterking (ingesteld op
basis-ISO-gevoeligheid (vast))
- Menu-instellingen Paint/Look (exclusief Base
Look)
- Scene File (uitgeschakeld)

e De volgende functies zijn alleen beschikbaar in de

modus Cine El (pagina 58).
e Exposure Index
e Monitor LUT

Systeemfrequentie

Stel de systeemfrequentie in met Frequency/
Scan (pagina 15) op het scherm status
Project. De camcorder kan mogelijk
automatisch herstarten na overschakeling,
afhankelijk van de geselecteerde waarde.

[Tip]

U kunt de systeemfrequentie ook instellen met Rec
Format >Frequency (pagina 83) in het menu Project
van het hoofdmenu.

[Opmerking]
U kunt de systeemfrequentie niet overschakelen tijdens
opnemen of afspelen.

Scanmodus beeldsensor

U kunt de effectieve beeldgrootte en resolutie
van de beeldsensor instellen.

Stel de scanmodus in met Imager Scan
(pagina 15) op het scherm status Project.

e FF: volledige kadergrootte.

e S35: Super 35mm size.

[Tip]

U kunt de scan modus ook instellen met Rec Format

>Imager Scan Mode (pagina 83) in het menu Project
van het hoofdmenu.

[Opmerkingen]

e De scanmodus van de beeldsensor kan niet worden
omgeschakeld tijdens opnemen of afspelen.

e Indien ingesteld op S35 is het videoformaat beperkt
tot 1920x1080.

Codec

Stel de codec in met Codec (pagina 15) op
het scherm status Project.

[Tip]

U kunt de codec ook instellen met Rec Format >Codec
(pagina 83) in het menu Project van het hoofdmenu.

[Opmerking]
U kunt de codec niet omschakelen tijdens opnemen of
afspelen.
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Video-indeling

U kunt de video-indeling voor opnemen
instellen. Stel de video-indeling in met Video
Format (pagina 15) op het scherm status
Project.

[Tip]

U kunt de video-indeling ook instellen met Rec Format
>Video Format (pagina 83) in het menu Project van
het hoofdmenu.

[Opmerkingen]

e U kunt de video-indeling niet omschakelen tijdens
opnemen of afspelen.

e Er kunnen beperkingen gelden voor het signaal van
de aansluitingen SDI OUT en HDMI OUT, afhankelijk
van de instelling voor video-indeling.
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Geheugenkaarten gebruiken

De camcorder neemt audio en video op CFexpress Type A geheugenkaarten (apart verkrijgbaar)
op of op SDXC geheugenkaarten (apart verkrijgbaar) die in kaartsleuven zijn geplaatst. De
geheugenkaarten worden ook gebruikt voor proxy-opname, het opslaan/laden van instellingen
en tijdens upgraden (software-update).

Over CFexpress Type A geheugenkaarten

Gebruik in de camcorder de Sony CFexpress Type A geheugenkaarten* vermeld in “Aanbevolen
media” (pagina 27).
Raadpleeg voor details over werken met media van andere fabrikanten de gebruiksaanwijzing

voor de media of de informatie van de producent.
*In dit document aangeduid als "CFexpress geheugenkaarten"”.

Over SDXC-geheugenkaarten

Gebruik in de camcorder de SDXC geheugenkaarten* vermeld in “Aanbevolen media”
(pagina 27).

* In dit document aangeduid als "SD-kaarten".
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Aanbevolen media

De gegarandeerde functioneringscondities variéren afhankelijk van de instellingen voor Rec Format en Recording.

Ja: Functioneren wordt ondersteund
Nee: Normaal functioneren niet gegarandeerd

Opname-indeling CFexpress SDXC
Type A
VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 V90
RAW Out & 4096x2160 Normale modus 59.94p Ja Nee Nee Nee Nee Nee Nee Ja
XAVC- Class300 50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
24P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
3840x2160 Normale modus 59.94p Ja Nee Nee Nee Nee Nee Nee Ja
Class300 50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Nee Ja
50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Nee Ja
25P Ja Nee Nee Nee Nee Nee Nee Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee
50P Ja Nee Nee Nee Nee Nee Nee Nee
29.97P Ja Nee Nee Nee Nee Nee Nee Nee
25P Ja Nee Nee Nee Nee Nee Nee Nee
23.98P Ja Nee Nee Nee Nee Nee Nee Nee
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Opname-indeling CFexpress SDXC
Type A
VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-| 4096x2160 Normale modus 59.94pP Ja Nee Nee Nee Nee Nee Nee Ja
Class300 50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
24P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Nee Ja
50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Nee Ja
25P Ja Nee Nee Nee Nee Nee Nee Ja
24P Ja Nee Nee Nee Nee Nee Nee Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
3840x2160 Normale modus 59.94pP Ja Nee Nee Nee Nee Nee Nee Ja
Class300 50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Nee la
50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Nee Ja
25P Ja Nee Nee Nee Nee Nee Nee Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee
50P Ja Nee Nee Nee Nee Nee Nee Nee
29.97P Ja Nee Nee Nee Nee Nee Nee Nee
25P Ja Nee Nee Nee Nee Nee Nee Nee
23.98P Ja Nee Nee Nee Nee Nee Nee Nee
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Opname-indeling CFexpress SDXC
Type A
VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-| 1920x1080 Normale modus 59.94pP Ja Nee Nee Nee Nee Nee Ja Ja
Class100 50P Ja Nee Nee Nee Nee Nee Ja Ja
29.97P Ja Nee Nee Ja Nee Ja Ja Ja
25P Ja Nee Nee Ja Nee Ja Ja Ja
23.98P Ja Nee Nee Ja Nee Ja Ja Ja
S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Ja Ja
50P Ja Nee Nee Nee Nee Nee Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Ja
50P Ja Nee Nee Nee Nee Nee Nee Ja
29.97P Ja Nee Nee Nee Nee Nee Nee Ja
25P Ja Nee Nee Nee Nee Nee Nee Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
S&Q (150fps, 180fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee
50P Ja Nee Nee Nee Nee Nee Nee Nee
29.97P Ja Nee Nee Nee Nee Nee Nee Nee
25P Ja Nee Nee Nee Nee Nee Nee Nee
23.98P Ja Nee Nee Nee Nee Nee Nee Nee
S&Q (200fps, 240fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee
50P Ja Nee Nee Nee Nee Nee Nee Nee
29.97P Ja Nee Nee Nee Nee Nee Nee Nee
25P Ja Nee Nee Nee Nee Nee Nee Nee
23.98P Ja Nee Nee Nee Nee Nee Nee Nee
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Opname-indeling CFexpress SDXC
Type A
VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-L 3840x2160 Normale modus 59.94pP Ja Nee Nee Ja Nee Ja Ja Ja
420 50P Ja Nee Nee Ja Nee Ja Ja Ja
29.97P Ja Nee Nee Ja Nee Ja Ja Ja
25P Ja Nee Nee Ja Nee Ja Ja Ja
23.98P Ja Nee Nee Ja Nee Ja Ja Ja
S&Q (60fps of minder) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja
50P Ja Nee Nee Ja Nee Ja Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Ja Ja
50P Ja Nee Nee Nee Nee Nee Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Nee Ja
25P Ja Nee Nee Nee Nee Nee Nee Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Nee
1920x1080 Normale modus 59.94pP Ja Nee Nee Ja Nee Ja Ja Ja
HD50 50P Ja Nee Nee Ja Nee Ja Ja Ja
29.97P Ja Nee Nee Ja Nee Ja Ja Ja
25P Ja Nee Nee Ja Nee Ja Ja Ja
23.98P Ja Nee Nee Ja Nee Ja Ja Ja
S&Q (60fps of minder) 59.94P Ja Ja Ja Ja Ja Ja Ja Ja
50P Ja Ja Ja Ja Ja Ja Ja Ja
29.97P Ja Nee Nee Ja Nee Ja Ja Ja
25P Ja Nee Nee Ja Nee Ja Ja Ja
23.98P Ja Nee Nee Ja Nee Ja Ja Ja
S&Q (100fps, 120fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja
50P Ja Nee Nee Ja Nee Ja Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
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Opname-indeling CFexpress SDXC
Type A
VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-L 1920x1080 S&Q (150fps, 180fps) 59.94P Ja Nee Nee Nee Nee Nee Ja la
HD50 50P Ja Nee Nee Nee Nee Nee Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Nee Ja
25P Ja Nee Nee Nee Nee Nee Nee Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
S&Q (200fps, 240fps) 59.94P Ja Nee Nee Nee Nee Nee Ja Ja
50P Ja Nee Nee Nee Nee Nee Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Nee Ja
25P Ja Nee Nee Nee Nee Nee Nee Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
1920x1080 Normale modus 59.94p Ja Ja Ja Ja Ja Ja Ja Ja
HD35 50P Ja Ja Ja Ja Ja Ja Ja Ja
29.97P Ja Ja Ja Ja Ja Ja Ja Ja
25P Ja Ja Ja Ja Ja Ja Ja Ja
23.98P Ja Ja Ja Ja Ja Ja Ja Ja
S&Q (60fps of minder) 59.94P Ja Ja Ja Ja Ja Ja Ja Ja
50P Ja Ja Ja Ja Ja Ja Ja Ja
29.97P Ja Nee Nee Ja Nee Ja Ja Ja
25P Ja Nee Nee Ja Nee Ja Ja Ja
23.98P Ja Nee Nee Ja Nee Ja Ja Ja
S&Q (100fps, 120fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja
50P Ja Nee Nee Ja Nee Ja Ja Ja
29.97P Ja Nee Nee Ja Nee Ja Ja Ja
25P Ja Nee Nee Ja Nee Ja Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
S&Q (150fps, 180fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja
50P Ja Nee Nee Ja Nee Ja Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Ja Ja
S&Q (200fps, 240fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja
50P Ja Nee Nee Ja Nee Ja Ja Ja
29.97P Ja Nee Nee Nee Nee Nee Ja Ja
25P Ja Nee Nee Nee Nee Nee Ja Ja
23.98P Ja Nee Nee Nee Nee Nee Nee Ja
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Een geheugenkaart plaatsen

1 Open de mediaklep van het
kaartsleufgedeelte.

2 Plaats een geheugenkaart.

e Bij CFexpress-kaarten wijst het etiket

naar links.

e
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Etiket

e \oor SD-kaarten wijst het etiket naar
rechts met de schuin afgeplatte hoek

aan de onderkant.
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Afgeschuinde hoek
De toegangsindicator (pagina 6)

brandt rood, en gaat branden als de kaart

onbruikbaar is.

[Opmerking]

Als de toegangsindicator doorlopend rood knippert
en niet groen wordt, schakel de camcorder dan
tijdelijk uit, verwijder de geheugenkaart en zet deze
er weer opnieuw in.

3 Sluit de mediaklep.

[Opmerkingen]

e De geheugenkaart, de geheugenkaartsleuf en
beeldgegevens op de geheugenkaart kunnen
beschadigd raken als de kaart geforceerd verkeerd
om in de sleuf wordt geplaatst.

e Gebruik bij opnemen op media die zijn geplaatst
in zowel CFexpress Type A/SD-kaartsleuven A als B
media die worden geadviseerd voor gebruik met de
gebruikte opname-indeling in beide sleuven.

Een geheugenkaart uitwerpen

Open de mediaklep van het kaartgedeelte en
druk de geheugenkaart voorzichtig een klein
stukje naar binnen om de kaart uit te werpen.

[Opmerkingen]

e Als de camcorder is uitgeschakeld of als de
geheugenkaart wordt verwijderd terwijl er gegevens
worden uitgewisseld kan de integriteit van de
gegevens op de kaart niet worden gegarandeerd.
Alle gegevens op de kaart kunnen verloren gaan.
Controleer altijd of de toegangsindicator groen is of
niet brandt, alvorens de camcorder uit te schakelen of
de geheugenkaart te verwijderen.

e Als een geheugenkaart direct na beéindiging van een
opname wordt verwijderd kan deze heet zijn, maar dit
duidt niet op een probleem.

Geheugenkaarten formatteren
(initialiseren)
Als een niet geformatteerde geheugenkaart

of een geheugenkaart wordt geplaatst die
is geformatteerd met andere specificaties,

verschijnt in de zoeker de melding "Media
Needs to be Formatted".

Formatteer de kaart met de volgende
procedure.

1 Selecteer Format Media (pagina 93) in
het menu TC/Media van het hoofdmenu.

2 Selecteer Media(A) (sleuf A) of Media(B)
(sleuf B) en kies de formatteerwijze, (Full
Format of Quick Format).

Er verschijnt een bevestigingsmelding.

e Full Format: Initialiseert de media
volledig, inclusief de dataregio en
databeheerinformatie.

e Quick Format: Initialiseert alleen de
databeheerinformatie van de media.

3 Selecteer Execute.

Er verschijnt een melding terwijl het
formatteren bezig is en de
toegangsindicator brandt rood.

Als het formatteren is voltooid, verschijnt
hiervan een melding. Druk op de
multifunctionele regelaar om de melding
te verwijderen.

[Opmerkingen]

e Het formatteren van een geheugenkaart wist alle
gegevens, inclusief opgenomen videogegevens en
configuratiebestanden.

e Er kunnen meldingen verschijnen tijdens de

uitvoering, afhankelijk van de duur van het
formatteringsproces.

Als het formatteren mislukt

Geheugenkaarten die niet worden
ondersteund door de camcorder kunnen niet
worden geformatteerd.

Er verschijnt een waarschuwingsmelding. Volg
de instructies voor het vervangen van de kaart
door een ondersteunde geheugenkaart.

Een op de camcorder geformatteerde
kaart gebruiken in de sleuf van een
ander apparaat

Maak eerst een back-up van de kaart en
formatteer vervolgens de kaart in het apparaat
dat wordt gebruikt.

De resterende opnametijd
controleren

Bij het filmen (opnemen/stand-by) kunt u de
resterende capaciteit van de geheugenkaart
in elke sleuf monitoren met de sleuf A/B
resterende media-indicators in de zoeker
(pagina 11).

De resterende opnametijd wordt berekend
met de resterende capaciteit van de

media in elke sleuf en de huidige video-
indeling (opname-bitrate), en wordt in
minuteneenheden weergegeven.

Geheugenkaart vervangingstiming

e \Wanneer de totale resterende opnametijd
op de twee geheugenkaarten minder dan
5 minuten wordt, verschijnt het bericht
"Media Near Full", begint het opname/tally-
lampje te knipperen en zal een pieptoon
(hoofdtelefoonuitgang) u waarschuwen.
Vervangen door media met vrije ruimte.

e Als u doorgaat met opnemen tot de totale
resterende opnametijd nul bereikt, wordt
de melding gewijzigd naar "Media Full" en
stopt de opname.

[Opmerking]

Op een geheugenkaart kunnen ongeveer 600 clips

worden opgenomen.
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Geheugenkaarten herstellen

Als er zich om bepaalde redenen een fout

zou voordoen in een geheugenkaart, moet de
kaart voor gebruik worden hersteld.

Als u een geheugenkaart laadt die moet
worden hersteld, verschijnt een melding op
het zoekerscherm of u de kaart wilt herstellen.

Een kaart herstellen

Draai aan de multifunctionele regelaar
(pagina 5) om Execute te selecteren

en druk vervolgens op de multifunctionele
regelaar.

Er worden een melding en voortgangsstatus
(%) weergegeven tijdens het formatteren en
de toegangsindicator brandt rood.

Als het herstellen is voltooid, verschijnt
hiervan een melding.

Als herstellen mislukt

e Geheugenkaarten waarop geheugenfouten
hebben plaatsgevonden kunnen niet
worden hersteld. Er verschijnt een
waarschuwingsmelding. Volg de instructies
om de kaart te vervangen.

e Geheugenkaarten waarop geheugenfouten
hebben plaatsgevonden worden mogelijk
onbruikbaar als ze worden geformatteerd.

® In sommige gevallen kunnen clips worden
hersteld en andere niet. De herstelde clips
kunnen normaal worden afgespeeld.

[Opmerkingen]

e Herstel media die zijn opgenomen met deze
camcorder ook met deze camcorder.

e Media die zijn opgenomen met een ander apparaat
dan deze camcorder of met een andere (soft- of
firmware)versie van deze camcorder (ook al is het
hetzelfde model) mogen niet met deze camcorder
worden hersteld.

e (lips die korter zijn dan 2 seconden kunnen niet
worden hersteld.
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Basisbediening

Eenvoudig filmen wordt als volgt uitgevoerd.

1 Bevestig de vereiste apparaten en
controleer of er stroom beschikbaar is.

2 Plaats de geheugenkaart(en).

3 Zet de POWER-schakelaar in de stand on.
De POWER-indicator gaat aan en het
camerabeeld verschijnt in de zoeker.

4 Druk op de knop START/STOP
(pagina 5).
Het opname/tally-lampje brandt en de
opname begint.

5 Om het opnemen te stoppen drukt u weer
op de knop START/STOP.
Het opnemen stopt en de camcorder
schakelt over op STBY (standby-modus).

[Opmerking]

Als de knop START/STOP voor opname binnen enkele
seconden na het inschakelen van de camcorder wordt
ingedrukt, gaat de opname/tally-lamp branden om aan
te geven dat de eenheid zich in opnamemodus bevindt,
maar opnemen op media kan nog enkele seconden op
zich laten wachten, afhankelijk van de geselecteerde
opname-indeling.

Overschakelen tussen
geheugenkaarten

Als er twee geheugenkaarten zijn geplaatst,
druk dan op de knop SLOT SELECT

(pagina 6) om van kaart te wisselen.
Opnemen schakelt automatisch over naar
de tweede geheugenkaart, vlak voordat de
capaciteit van de eerste kaart nul wordt (relay-
opname). U kunt ononderbroken doorgaan
met opnemen bij het overschakelen van
geheugenkaart door de volle geheugenkaart
te verwisselen voor een nieuwe
geheugenkaart.

[Opmerkingen]

e Tijdens afspelen kan niet worden overgeschakeld
tussen geheugenkaarten. Ook het ononderbroken
afspelen van een clip waarvan de media zich op twee
geheugenkaarten bevinden is niet mogelijk.

e \Wanneer een beschrijfbare geheugenkaart is
geplaatst in de tweede geheugenkaartsleuf,
worden de geheugenkaarten niet omgeschakeld als
alleen proxygegevens worden opgenomen op die
geheugenkaart.

Clips (opgenomen gegevens)

Als u stopt met opnemen worden de video, de
audio en bijbehorende gegevens van start tot
eind van de opname opgeslagen als één "clip"
op een geheugenkaart.

Clipnamen

De naam van elke door de camcorder
opgenomen clip wordt automatisch
toegewezen volgens de indeling die is
ingesteld in Clip Name Format (pagina 93)
van het menu TC/Media van het hoofdfmenu.

Maximale cliplengte

Maximaal 6 uur per clip.

De maximale duur van continue opname

is hetzelfde als de maximale duur van een
clip. Als de opnametijd de maximale duur
van een clip overschrijdt, wordt automatisch
een nieuwe clip aangemaakt en gaat het

opnemen door. De nieuwe clip verschijnt als

afzonderlijke clip op het pictogrammenscherm.

Meerder clips worden achter elkaar
opgenomen tijdens relay-opname, maar het
opnemen stopt automatisch na ongeveer 24
uur.

[Opmerkingen]

e Verwijder geen geheugenkaart tijdens het opnemen
als erop wordt opgenomen. Vervang tijdens het
opnemen alleen geheugenkaarten in sleuven
waarvan de sleuftoegangsindicator niet brandt.

e Als de resterende capaciteit op de geheugenkaart
waarop wordt opgenomen minder dan een minuut
wordt en een beschrijfbare geheugenkaart in de
andere sleuf wordt geplaatst, verschijnt het bericht
"Will Switch Slots Soon". De melding verdwijnt nadat
er is gewisseld van geheugenkaartsleuf.

e Relay-opname werkt mogelijk niet als het opnemen
is gestart als de resterende capaciteit van de
geheugenkaart minder dan een minuut is. Controleer
voor correcte relay-opname of de capaciteit van de
geheugenkaart meer dan een minuut is, voordat het
opnemen wordt gestart.

e Video die is gemaakt met de relay-functie van de
camcorder kan niet naadloos worden afgespeeld op
de camcorder.

e Gebruik om video te combineren die is gemaakt
met de relay-functie van de camcorder de software
"Catalyst Browse".

Audio monitoren

U kunt de audio die wordt opgenomen
monitoren met een hoofdtelefoon.

Als u een hoofdtelefoon op

de hoofdtelefoonaansluiting

(pagina 5) aansluit, kunt u de audio die
wordt opgenomen monitoren. U kunt ook de
afgespeelde audio monitoren (pagina 69)
met de ingebouwde luidspreker (pagina 6)
of hoofdtelefoon.

U kunt het geluidsvolume van de te monitoren
audio aanpassen met Volume (pagina 14)

op het scherm Audio Status of Audio Output
>Volume (pagina 98) in het menu Audio

van het hoofdmenu.

U kunt het te monitoren kanaal selecteren
met Monitor CH (pagina 14) op het scherm
Audio Status of Audio Output >Monitor CH
(pagina 98) in het menu Audio van het
hoofdmenu.
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Tijdgegevens instellen

De tijdcode instellen

Stel de tijdcode in die moet worden
opgenomen met Timecode (pagina 92) in
het menu TC/Media van het hoofdmenu.

Userbits instellen

U kunt een 8-bits hexadecimaal getal aan het
opgenomen beeld als userbits toevoegen.

U kunt de userbits ook op de huidige tijd
instellen. Instellen met Users Bit (pagina 92)
in het menu TC/Media.

Tijdgegevens weergeven

Stel de tijdcode die moet worden
weergegeven in met TC Display (pagina 92)
>Display Select in het menu TC/Media.
Indrukken van een toewijsbare knop

(pagina 49) waaraan DURATION/TC/U-BIT

is toegewezen, schakelt de weergave cyclisch
om tussen tijdcode, userbits en tijdsduur.

De tijdcode invoer/uitvoer omschakelen

U kunt omschakelen tussen tijdcode invoer/
uitvoer met de keuzeschakelaar TC IN/OUT
(pagina 4).

Zie voor details pagina 116.

Een opname controleren (Rec
Review)

U kunt de laatst opgenomen clip op het
scherm controleren (opname controleren).
[Opmerking]

Rec Review wordt niet ondersteund als de video-
indeling is gewijzigd na het opnemen van de clip.

Methode voor opname controleren

Wijs eerst Rec Review toe aan een van de
toewijsbare knoppen.

Druk na het stoppen van de opname op de
toewijsbare knop (pagina 49) waaraan Rec
Review is toegekend. Het afspelen van de
laatste opgenomen clip begint.

De clip wordt tot het eind afgespeeld, Rec
Review wordt beéindigd en de camcorder
gaat terug naar de modus STBY (standby).

Rec Review stoppen

Druk op de toewijsbare knop waaraan Rec
Review is toegewezen of druk op de knop
CANCEL/BACK.

Instellingen voor opname controleren

U kunt de startpositie voor afspelen aan een
van de volgende posities toewijzen met de
instelling Rec Review (pagina 100) in het
menu Technical.

e |aatste 3 seconden van de clip

e |Laatste 10 seconden van de clip

e Begin van de clip

[Tip]

Als u een specifieke clip wilt controleren na het
opnemen van meerdere clips, druk dan op de knop
THUMBNAIL om het pictogrammenscherm weer te

geven en selecteer de gewenste clip om deze af te
spelen.
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De Zoom aanpassen

U kunt de zoom aanpassen volgens de
condities waarin wordt gefilmd.

Als er een power-zoomobjectief is bevestigd,
kunt u de zoom aanpassen met de
zoomregelaar op de afstandsbedieningsgreep
of de draaggreep. De zoomsnelheid varieert
met de druk die op de regelaar wordt
uitgeoefend.

De camcorder is uitgerust met een
zoomfunctie die gebruik maakt van het
beeldsignaalverwerking met de naam

Clear Image Zoom. Als Clear Image Zoom is
ingeschakeld wordt zoom ondersteund, zelfs
voor objectieven met vaste brandpuntsafstand
(prime). Het kan ook worden gebruikt om het
bereik te vergroten buiten het optische bereik
op een powerzoom-objectief.

De maximale zoomverhouding bij gebruik van
Clear Image Zoom varieert, afhankelijk van de
opnameresolutie.

e Voor QFHD/4K-opnameresolutie: 1,5x

e Voor HD-opnameresolutie: 2x

Het type zoom selecteren

Stel het zoomtype in met Zoom >Zoom Type
(pagina 100) in het menu Technical van het
hoofdmenu.

Het type zoom varieert afthankelijk van het
type objectief dat is bevestigd.

Bevestigd Instelling Zoom Type

objectief Optical Zoom On(Clear Image

Only Zoom)

Power- Alleen optische  Optische zoom

zoomobjectief  zoom en Clear Image
Zoom worden
ondersteund.

Bevestigd Instelling Zoom Type

objectief  Optical Zoom  On(Clear Image
Only Zoom)

Prime Zoombediening Clear Image

objectief/ met de regelaar Zoom wordt

handmatig wordt niet ondersteund.

zoomobjectief ondersteund.

[Opmerkingen]

e (Clear Image Zoom is niet beschikbaar in de volgende
gevallen.

- Als S&Q Motion >Frame Rate (pagina 81) in het
menu Shooting van het hoofmenu hoger is dan
60fps

- Als Rec Format >Codec (pagina 83) in het menu
Project van het hoofdmenu is ingesteld op RAW of
een optie die RAW bevat.

e Het bedienen van de selectieschakelaar SERVO/
MANUAL op een objectief reset de vergroting van
Clear Image Zoom naar 1x.

e \Wanneer automatisch scherpstellen door indrukken
(AF-S) wordt uitgevoerd tijdens Clear Image Zoom,
geeft de AF voorrang aan het gebied midden in het
scherm.

Zoom van de draaggreep instellen

Stel de zoominstelling van de draaggreep in
met Handle Zoom (pagina 101) in het menu
Technical van het hoofdmenu.

De richting van de zoomring
instellen

Op sommige objectieven met E-bevestiging
kan de draairichting van de zoomring worden
omgedraaid.

Stel de draairichting in met Lens >Zoom Ring
Direction (pagina 101) in het menu Technical
van het hoofdmenu.
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De scherpstelling aanpassen

U kunt de scherpstelling automatisch of
handmatig aanpassen, afhankelijk van de
condities waarin wordt gefilmd.

De scherpstelling handmatig
aanpassen (Handmatig
scherpstellen)

Om de scherpstelling handmatig aan te

passen zet u de knop FOCUS (pagina 4) op

de stand "MAN".

Hiermee kunt u de scherpte handmatig

aanpassen volgens de condities waarin wordt

gefilmd.

Handmatig scherpstellen is nuttig voor de

volgende onderwerpen.

e Onderwerpen aan de zijkant van een
venster die zijn bedekt met waterdruppels

e Onderwerpen met weinig contrast tegen
een achtergrond

e Onderwerpen die zich verder weg bevinden
dan de onderwerpen op de voorgrond

[Tip]

U kunt in de volgende gevallen automatische

scherpstelling ook gebruiken, als handmatige

aanpassing de hoofdmethode voor bediening is.

e Als de AF-gevoeligheid voor objectverplaatsing is
ingesteld op 1(Locked)

e Als de schakelaar FOCUS is ingesteld op de stand "AF"

e Bij het bedienen van de scherpstellingsring (AF Assist
pagina 40)

Scherpstellen door aanraken (Spot
Focus)

In handmatige scherpstelmodus kunt u de
plek aangeven waarop u wilt scherpstellen
door deze aan te raken.

Wilt u Spot Focus gebruiken, stel dan Focus >
Touch Function in MF (pagina 81) in het
menu Shooting in op Spot Focus.

Een markering voor Spot Focus wordt
weergegeven wanneer u op de plek tikt
waarop u wilt scherpstellen.

AF

[Tips]

e In de modus Spot Focus kunt u drukken op een
toewijsbare knop (pagina 49) die is toegewezen
aan Push AF/Push MF om tijdelijk Spot Focus te
stoppen en automatisch scherpstellen inschakelen
voor zolang als u de knop ingedrukt houdt.

De scherpstelling gaat terug naar handmatige
scherpstelling als u de knop loslaat.

e De functie Spot Focus werkt niet als het objectief is
ingesteld op handmatige scherpstelling.

e U kunt de plaats voor Spot Focus niet opgeven als de
scherpstelling is vergroot of wanneer Touch Operation
(pagina 100) in het menu Technical is ingesteld op
Off.

Automatische scherpstelling tijdelijk
gebruiken (Push Auto Focus (AF))

Als Focus >Push AF Mode (pagina 81) in

het menu Shooting van het hoofdmenu is
ingesteld op AF, druk dan op de knop PUSH
AUTO FOCUS (pagina 4) in de modus
handmatig scherpstellen om automatisch
scherp te stellen als de knop wordt ingedrukt.
Scherpstellen vindt plaats binnen het
scherpstellingsgebied dat is ingesteld met
Focus >Focus Area (pagina 81) in het menu
Shooting van het hoofdmenu.

De scherpstelling gaat terug naar handmatige
scherpstelling als u de knop loslaat.

Dit is nuttig als u de scherpstelling langzaam
van het ene naar het andere onderwerp wilt
verplaatsen tijdens handmatige scherpstelling.

[Tip]

Dezelfde werking wordt ondersteund bij gebruik van
een toewijsbare knop (pagina 49) toegewezen aan
Push AF/Push MF.

[Opmerking]
De functie Push Auto Focus werkt niet als het objectief is
ingesteld op handmatige scherpstelling.

Eenmalig automatische scherpstelling
gebruiken (Push Auto Focus (AF-S))

Stel Focus >Push AF Mode (pagina 81) in

het menu Shooting van het hoofdmenu in

op Single-shot AF(AF-S) en stel vervolgens

het scherpstellingsgebied in met Focus
>Focus Area(AF-S) (pagina 81) in het menu

Shooting van het hoofdmenu.

Druk in de modus handmatige scherpstelling

op de knop PUSH AUTO FOCUS om

automatisch met hoge snelheid scherp te
stellen. Het scherpstellen stopt zodra u de
toets loslaat.

De scherpstellingsstatus wordt aangegeven

door de scherpstellingsindicator.

e Aan: de scherpstelling is gefixeerd op de
scherpstellingspositie.

e Knipperend: onscherp. Omdat scherpstellen
niet automatisch plaatsvindt, wijzigt u de
compositie en scherpstellingsinstellingen
om scherpstelling te bereiken.

De scherpstelling gaat terug naar handmatige

scherpstelling als u de knop loslaat.

Dit is nuttig als u snel op een onderwerp wilt

scherpstellen voordat u begint met filmen.

[Tips]

e Dezelfde werking wordt ondersteund bij gebruik van
een toewijsbare knop (pagina 49) toegewezen aan
Push AF/Push MF.

e U kunt ook de functie Push AF Mode toewijzen aan
een toewijsbare knop (pagina 49).

e U kunt ook de Focus Area(AF-S) toewijzen aan een
toewijsbare knop (pagina 49).

e U kunt het scherpstellingskader weergeven of
verbergen met Display On/Off > Focus Area Ind.

(AF-S) (pagina 94) in het menu Monitoring van het
hoofdmenu.

e Tijdens scherpstellingsvergroting wordt de
scherpstelling aangepast om in de vergrote
weergavepositie te passen.

[Opmerkingen]

e De functie Push Auto Focus werkt niet als het
objectief is ingesteld op handmatige scherpstelling.

e Het scherpstellingskader is niet verborgen als de
knop DISPLAY wordt gebruikt.

e Tijdens Clear Image Zoom kunt u de kaderpositie
voor Focus Area(AF-S) niet instellen. Tijdens Push
AF-S geeft AF voorrang aan het gebied midden in het
scherm.

Scherpstellen met behulp van vergrote
weergave (Focus Magnifier)

Volgens de standaard fabrieksinstellingen

is de functie Focus Magnifier x3/x6
toegewezen aan de knop ASSIGN 4 op

de afstandsbedieningsgreep en de knop
ASSIGN 7 op de draaggreep (pagina 49).
Druk op de knop ASSIGN 4 of ASSIGN 7 om
de zoeker over te schakelen naar het scherm
scherpstellingsvergroting, waar het midden
ongeveer drie keer wordt vergroot. Druk
nogmaals op de knop om de vergroting
ongeveer zes keer te maken. Deze functie is
nuttig om de scherpstelling te controleren.
Druk nogmaals op de knop om terug te gaan
naar het normale scherm.

U kunt de positie die moet worden vergroot
tijdens scherpstellingsvergroting verplaatsen
met de keuzeschakelaar (pagina 7).
Indrukken van de keuzeschakelaar gaat terug
naar het midden van het beeld.

Als scherpstellen (AF) plaatsvindt binnen het
scherpstellingsgebied dat is ingesteld met
Focus >Focus Area (pagina 81) in het menu
Shooting van het hoofdmenu.

Als scherpstelling door knop indrukken
(AF-S) wordt gebruikt tijdens
scherpstellingsvergroting, wordt de
scherpstelling aangepast aan de vergrote
weergavepositie.
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[Opmerkingen]

e Het opgenomen beeld of het SDI/HDMI-uitvoerbeeld
wordt niet vergroot als de scherpstelling wordt
vergroot.

e Tijdens scherpstellingsvergroting zijn de knop MENU
en andere bedieningssubroutines uitgeschakeld.

e De vergrote positie gaat terug naar het midden van
het scherm als de camcorder wordt uitgeschakeld.

De scherpstelling automatisch
aanpassen (Autofocus)

De camcorder gebruikt fasedetectie AF

voor scherpstelling op hoge snelheid en
contrast AF voor scherpstelling met hoge
nauwkeurigheid.

De combinatie van deze twee AF-methodes
zorgt voor automatische scherpstelling met
hoge snelheid en hoge nauwkeurigheid.

Om de scherpstelling automatisch aan

te passen zet u de schakelaar FOCUS

(pagina 4) van de camcorder op de stand
"AUTO". Als het objectief is uitgerust met een
focus-keuzeschakelaar, zet de schakelaar dan
op de stand "AF/MF" of "AF". Als de schakelaar
is ingesteld op de stand "Full MF" of "MF",
kan het scherpstellen van het objectief

niet worden bediend vanaf de camcorder
(pagina 23).

[Tip]

Als Focus >AF Assist (pagina 81) in het menu Shooting
van het hoofdmenu is ingesteld op On, kunt u de
scherpstellingsring tijdens automatische scherpstelling

nog steeds gebruiken om de scherpstelling aan te
passen.

[Opmerkingen]

e Een objectief dat automatische scherpstelling
ondersteunt is vereist.

e Nauwkeurigheid kan mogelijk niet worden bereikt,
afhankelijk van de condities waarin wordt gefilmd.

e De scherpstelling kan niet automatisch worden
aangepast op een objectief met A-bevestiging.

Het gebied of de positie van
automatische scherpstelling instellen
(Focus Area)

U kunt het doelgebied voor automatische
scherpstelling instellen met Focus >Focus Area
(pagina 81) in het menu Shooting van het
hoofdmenu.

Flexible Spot:

Richt zich op een specifieke positie op het
beeld.

Als dit is geselecteerd, geef dan de positie aan
met de keuzeschakelaar (pagina 7).

U kunt terugkeren naar de middenpositie door
de keuzeschakelaar vast te houden.

AF

Zone:

Zoekt automatisch een scherpstellingspositie
binnen de opgegeven zone.

Als dit is geselecteerd, geef dan de positie aan
met de keuzeschakelaar (pagina 7).

U kunt terugkeren naar de middenpositie door
de keuzeschakelaar vast te houden.

AF
r A
L a

Wide:

Zoekt bij scherpstellen naar een onderwerp
in een brede hoek in het beeld. Er wordt geen
kader weergegeven.

AF

[Tip]

Dezelfde bediening wordt ondersteund bij het gebruik
van een toewijsbare knop (pagina 49) die is

toegewezen aan Focus Area.

U kunt het scherpstellingskader weergeven of verbergen
met Display On/Off >Focus Area Indicator (pagina 94)

in het menu Monitoring van het hoofdmenu.

[Opmerking]
Het scherpstellingskader is niet verborgen als de knop
DISPLAY wordt gebruikt.

Het scherpstellingsgebied snel wijzigen
(Focus Setting)

U kunt de positie en de grootte van het
automatische scherpstellingsgebied snel
wijzigen tijdens het filmen door Focus Setting
aan een toewijsbare knop toe te wijzen
(pagina 49).

De werking varieert afhankelijk van de
instelling voor het scherpstellingsgebied.

Als Focus >Focus Area (pagina 81) in het
menu Shooting van het hoofdmenu is

ingesteld op Flexible Spot of Zone

U kunt de positie van het
scherpstellingsgebied wijzigen door op

een toewijsbare knop te drukken die is
toegewezen aan Focus Setting en aanpassen
met de keuzeschakelaar (pagina 7).

U kunt de positie van het
scherpstellingsgebied naar het midden
terugbrengen tijdens het aanpassen van

de positie door op de keuzeschakelaar te
drukken.

U kunt de grootte van het
scherpstellingsgebied wijzigen door een
toewijsbare knop vast te houden die is
toegewezen aan de Focus Setting.

Na het wijzigen van de grootte bevestigt u de
positie van het scherpstellingsgebied door op
de keuzeschakelaar te drukken.

Druk na voltooiing op de toewijsbare knop die
is toegewezen aan de Focus Setting om naar
het oorspronkelijke scherm terug te keren.

Als Focus >Focus Area (pagina 81) in het
menu Shooting van het hoofdmenu is
ingesteld op Wide

U kunt de grootte van het
scherpstellingsgebied alleen wijzigen door
een toewijsbare knop vast te houden die is
toegewezen aan de Focus Setting. De positie
kan ook worden gewijzigd door eerst het type
te veranderen naar Flexible Spot of Zone.

[Tips]

e Als zowel Focus >Push AF Mode (pagina 81) in
het menu Shooting van het hoofdmenu is ingesteld
op Single-shot AF(AF-S) en de schakelaar FOCUS
(pagina 4) in de stand MF staat, kunt u de stand
van de Focus Area(AF-S) (pagina 81) wijzigen.

e Het scherpstellingskader wordt oranje weergegeven
als de positie van het scherpstellingsgebied kan
worden gewijzigd.
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Het scherpstellingskader verplaatsen
met aanraakbediening (aanraakgebied
scherpstelling)

U kunt de positie van het
scherpstellingsgebied wijzigen door op een
toewijsbare knop (pagina 49) te drukken

die is toegewezen aan Focus Setting om de
weergave van het scherpstellingsgebied

te wijzigen in oranje en vervolgens te
verplaatsen met aanraakbediening.

Tip op het scherm om het
scherpstellingsgebied te verplaatsen met de
scherpstelling gecentreerd op de aangetikte
positie. Sleep over het scherm om het
scherpstellingsgebied te verplaatsen naar de
positie die uw vinger volgt (pagina 10).

[Tip]

U kunt aanraakbediening voor scherpstellingsbediening

in- of uitschakelen op het schooting-scherm met een
toewijsbare knop toegewezen aan Focus Setting.

Tik op een willekeurige plaats

U

Het scherpstellingsgebied verplaatst zich met
het scherpstellingsgebied gecentreerd op de
aangetikte positie.

U

Sleep om het scherpstellingsgebied te
verplaatsen, waarbij het uw vingerpositie
volgt.

e

[Opmerkingen]

e Als u op een plaats tikt of het scherpstellingsgebied
naar een positie sleept die buiten het instelbereik
ligt, wordt het scherpstellingsgebied ingesteld op
de boven-/onder-/linker of rechterkant van het
instelbereik.

e Deze functie is niet beschikbaar in de volgende
gevallen.

- Als Touch Operation (pagina 100) in het menu
Technical van het hoofdmenu is ingesteld op Off.

- Als het scherpstellingsgebied grijs wordt
weergegeven of helemaal niet wordt
weergegeven.

De automatische scherpstellingsactie
aanpassen (AF-overgangssnelheid,
AF-gevoeligheid
onderwerpverplaatsing)

AF-overgangssnelheid

U kunt de snelheid van de
scherpstellingsaandrijving voor als het
onderwerp verandert instellen met Focus >AF
Transition Speed (pagina 80) in het menu
Shooting van het hoofdmenu.

Als dit is ingesteld op lage snelheid, verandert
de scherpstelling langzaam als het scherp

te stellen onderwerp wijzigt, waardoor
indrukwekkende beelden kunnen worden
gemaakt.

Als dit is ingesteld op hoge snelheid wisselt
de scherpstelling tussen onderwerpen snel.
Er wordt onmiddellijk scherpgesteld op

het onderwerp dat het frame binnenkomt,
waardoor dit ideaal is voor het filmen van
documentaires, waarbij snel scherpstellen
vereist is.

Scherpgesteld op een onderwerp verder weg

o

Tijdens de wijziging:
1(Slow): Scherpstelling werkt
langzaam

7(Fast): Scherpstelling werkt
snel

V

Scherpgesteld op een onderwerp dichterbij

por |
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AF-gevoeligheid voor objectverplaatsing

U kunt de gevoeligheid voor het
overschakelen tussen onderwerpen instellen
met Focus >AF Subj. Shift Sens. (pagina 80)

in het menu Shooting van het hoofdmenu.
Ingesteld op een lage gevoeligheid verandert
de scherpte niet direct, zelfs als er een

ander onderwerp véoér het scherpgestelde
onderwerp komt. Ingesteld op een hoge
gevoeligheid reageert de scherpstelling direct

op het onderwerp dat naar de voorgrond gaat.

[Tip]

Als AF Speed/Sens. is toegewezen aan een toewijsbare
knop, worden de niveausegmenten voor instellen

van waarden in de volgende volgorde weergegeven,
elke keer als de knop wordt ingedrukt. Hiermee kunt

u de instellingen voor AF overgangssnelheid en AF
gevoeligheid voor objectverplaatsing wijzigen.
AF-overgangssnelheid — AF-gevoeligheid voor
objectverplaatsing — Geen weergave ...

AF Subj. Shift Sens.: 1(Locked On)

[mmm

Langzaam scherpstellen op een ander
onderwerp

AF Subj. Shift Sens.: 5(Responsive)

[

Snel scherpstellen op een ander onderwerp

Het onderwerp voor scherpstelling
handmatig wijzigen (AF assist)

Als Focus >AF Assist (pagina 81) in het

menu Shooting van het hoofdmenu is

ingesteld op On, kunt u de scherpstellingsring

op het objectief tijdens automatische
scherpstelling nog steeds gebruiken om
scherp te stellen op het onderwerp.

Als u stopt met gebruik van de

scherpstellingsring, gaat automatische

scherpstelling door met scherpstellen op het
onderwerp waarop werd scherpgesteld met
de scherpstellingsring (AF assistentiestaat).

Na het bedienen van de scherpstellingsring

is het verplaatsen van de scherpstelling naar

een ander onderwerp iets moeilijker, ongeacht

Focus >AF Subj. Shift Sens. (pagina 80)

instelling in het menu Shooting van het

hoofmenu.

De AF assistentiestaat wordt geannuleerd

door het volgende.

e Als het onderwerp waarop met de
scherpstellingsring is scherpgesteld niet
langer zichtbaar is

e Bij het overschakelen naar handmatige
scherpstelling

e \Wanneer AF volgen in echttijd is gestart

[Tips]

e De AF assistentiestaat kan snel worden geannuleerd
door een toewijsbare knop (pagina 49) te
gebruiken die is toegewezen aan Push AF/Push MF.

e AF volgen in echttijd stopt wanneer u de
scherpstelring gebruikt.

e In de modus Face/Eye Only AF, stelt automatische
scherpstelling scherp op het gezicht dat zich
het dichts bij de scherpstellingspositie van de
scherpstellingsring bevindt.
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Handmatige scherpstelling tijdelijk
gebruiken (Push Manual Focus)

Druk op de knop PUSH AUTO FOCUS
(pagina 4) in de modus automatische
scherpstelling als u handmatig wilt
scherpstellen terwijl de knop is ingedrukt.
De scherpstelling gaat terug naar
automatische scherpstelling als u de knop
loslaat.

Hiermee kunt u tijdelijk automatische
scherpstelling stoppen en handmatig
scherpstellen als eriets anders dan het
onderwerp van het filmen voor het onderwerp
passeert.

[Tip]

Dezelfde werking wordt ondersteund bij gebruik van

een toewijsbare knop (pagina 49) toegewezen aan
Push AF/Push MF.

Volgen met behulp van gezichts-
en ogendetectie (Face/Eye
Detection AF)

De camcorder kan gezichten en ogen

van mensen detecteren als volgobject en

vervolgens de scherpstelling aanpassen

op de gezichten en ogen binnen het

scherpstellingsgebied.

Deze functie is alleen beschikbaar als de

AF-modus als scherpstellingsmodus wordt

gebruikt of tijdens scherpstelling door knop

indrukken.

Als er gezichten worden gedetecteerd,

worden grijze gezicht/ogen-detectiekaders

weergegeven. Als automatisch scherpstellen
mogelijk is, worden de kaders wit en start het
volgen. Als er ogen worden gedetecteerd en
de scherpstelling wordt aangepast, wordt het
gezicht/ogen-detectiekader weergegeven op
de ogen. Als er meerdere personen worden
gedetecteerd, wordt het hoofdonderwerp
automatisch bepaald.

[Tips]

e Als het scherpstellingsgebied is ingesteld op Zone of
Flexible Spot en gezichten of ogen overlappen in het
specifieke scherpstellingsgebied, worden de gezicht/
ogen-detectiekaders wit en stelt de camcorder scherp
op deze gezichten/ogen.

o Als scherpstelling door knop indrukken (AF-S) wordt
gebruikt, worden de gezicht/ogen-detectiekaders

groen voor de gezichten en ogen waarop is
scherpgesteld.

Stel de AF-actie voor gezichts/ogendetectie
in met Focus >Face/Eye Detection AF
(pagina 81) in het menu Shooting.

Face/Eye Only AF:

De camera detecteert de gezichten/ogen
van onderwerpen (mensen) en volgt en stelt
scherp op alleen hun gezichten/ogen. Als

er geen gezicht of oog wordt gedetecteerd,
wordt AF tijdelijk gestopt en wordt het
pictogram 11 (modus Face/Eye Only AF-
modus voor automatische scherpstelling
gepauzeerd) (pagina 11) weergegeven.

Deze modus is effectief als u alleen wilt volgen
en scherpstellen op gezichten/ogen.

Face/Eye Priority AF:

De camera detecteert de gezichten/ogen van
onderwerpen (mensen) en geeft voorrang aan
het volgen/scherpstellen op de gezichten/
ogen. Als er geen gezicht of oog wordt
gedetecteerd, vindt scherpstellen plaats in AF-
modus (standaardinstelling).

Off:
De functie gezichts/ogendetectie AF is
uitgeschakeld.

[Opmerkingen]

e Tijdens werking van scherpstelling door knop
indrukken wordt Face/Eye Priority AF geactiveerd,
zelfs als Face/Eye Only AF momenteel is geselecteerd.

e Als de schakelaar FOCUS is ingesteld op MAN, is face/
eye detection AF uitgeschakeld (behalve tijdens
scherpstelling door knop indrukken).

e Als u de camcorder uitschakelt terwijl Face/Eye Only
AF is geselecteerd, schakelt de modus automatisch
over naar Face/Eye Priority AF als de camcorder de
volgende keer weer wordt ingeschakeld.

Gezicht/ogen-detectiekaders verbergen

U kunt de gezicht/ogen-detectiekaders
weergeven of verbergen met Display On/Off
>Face/Eye Detection Frame (pagina 94) in
het menu Monitoring van het hoofdmenu.

[Opmerking]

Groene gezicht/ogen-detectiekaders worden
weergegeven voor gezichten en ogen die zijn
scherpgesteld met scherpstelling door knop indrukken
(AF-S) en niet zijn verborgen met de knop DISPLAY of als
Face/Eye Detection Frame is ingesteld op Off.

De werking van gezichts/ogen-detectie AF
in- of uitschakelen met een toewijsbare knop

Wijs Face/Eye Detection AF toe aan een
toewijsbare knop (pagina 49). U kunt dan met
elke druk op de knop de werking van gezichts/
oogdetectie AF omschakelen in de volgorde
Face/Eye Priority AF, Face/Eye Only AF en Off.

Instellen in het hoofdmenu

U kunt ook de werking van gezichts/ogen-
detectie AF instellen in het hoofdmenu
(pagina 49).
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Een bepaald onderwerp volgen
(AF volgen in echttijd)

U kunt blijven scherpstellen op een
onderwerp door het onderwerp op te geven
door aanraken of door een kader voor
gezichtsherkenning te selecteren.

Wanneer een onderwerp is geselecteerd,

wordt een wit kader weergegeven en start het

volgen.

[Tips]

e Het volgen gebeurt over het hele beeldgebied,
ongeacht de instelling voor automatisch
scherpstellen.

e Wanneer Focus >Touch Function in MF (pagina 81)
in het menu Shooting is ingesteld op Tracking AF,
wordt AF volgen in echttijd ondersteund, zelfs als MF-
modus de scherpstelmodus is.

De volgende handelingen worden uitgevoerd
op het volgobject, athankelijk van de modus
voor AF met gezichts-/ogendetectie.

Face/Eye Only AF, Face/Eye Priority AF:
Gebruik dit om op een bepaald onderwerp
scherp te stellen en dit te volgen.

Als het volgobject een persoon is en een
gezicht of ogen worden gedetecteerd, stelt de
camera scherp op dat gezicht / die ogen.
Wanneer een gezicht/ogen voor volgen wordt
gedetecteerd, wordt het gezicht voor volgen
opgeslagen. Eenmaal opgeslagen, wordt
(pictogram Opgeslagen gezicht voor volgen)
(pagina 11) weergegeven.

[Opmerking]

Als u AF volgen start tijdens handmatig scherpstellen,
wordt het gezicht voor volgen niet opgeslagen.

Off:

Het opgegeven onderwerp wordt gevolgd en
er wordt op scherpgesteld.

Gezicht/ogen worden niet gedetecteerd, zelfs
niet als het volgobject een persoon is.
[Opmerking]

De functie AF volgen in echttijd werkt niet als het
objectief is ingesteld op handmatige scherpstelling.

AF volgen in echttijd starten

Wanneer u een bepaald onderwerp hebt
aangegeven als volgobject, start het volgen
van dat onderwerp.

Opgeven door aanraken

Tik op het volgobject om het te volgen in een

van de volgende situaties:

e Wanneer de scherpstelmodus MF is of
tijdens handmatig scherpstellen door
indrukken en Focus >Touch Function in
MF (pagina 81) in het menu Shooting is
ingesteld op Tracking AF

e Wanneer de AF-modus als
scherpstellingsmodus wordt gebruikt of
tijdens scherpstelling door knop indrukken
(AF)

[Opmerking]

U kunt geen doel opgeven door aanraken wanneer

Touch Operation (pagina 100) in het menu Technical is
ingesteld op Off.

Opgeven door selectie van een kader voor

gezichtsherkenning

Verplaats de gezichtsselectiecursor (oranje
onderstreept) met de keuzeschakelaar
(pagina 7) naar het volgobject en druk op
de keuzeschakelaar.

Andere gezichtsdetectiekaders
(grijs) Volgkader

Gezichtsselectiekader (oranje)

[Tips]

e U kunt het volgobject ook wijzigen om dit te volgen
tijdens AF volgen in echttijd.

e Als u op een toewijsbare knop (pagina 49)
drukt die is toegewezen aan de functie Focus
Magnifier tijdens AF volgen in echttijd, wordt de
volgstatus behouden en wordt het scherpstelgebied
vergroot. U kunt echter geen doel opgeven tijdens
scherpstellingsvergroting.

[Opmerking]

Tijdens handmatig scherpstellen kunt u het volgen
niet starten door een kader voor gezichtsherkenning te
selecteren.

AF volgen in echttijd stoppen

Stoppen door aanraken

Tik op de knop IO (AF volgen in echttijd
stoppen) die linksboven op het aanraakscherm
wordt weergegeven.

[Tips]
e AF volgen in echttijd stopt in de volgende gevallen:
- Wanneer u de schakelaar FOCUS of de knop AUTO/
MAN op het objectief gebruikt
- Wanneer u de scherpstelmodus wijzigt
- Wanneer u assistentie voor automatisch
scherpstellen gebruikt

- Wanneer u de instelling voor het
scherpstellingsgebied of de handeling voor
gezichts-/ogendetectie met AF wijzigt

- Wanneer u een toewijsbare knop indrukt die is
toegewezen aan Push AF/Push MF

- Wanneer het volgobject zich niet binnen het
opnamevenster bevindt of wanneer het onderwerp
meerdere seconden lang onscherp is

e \Wanneer u een gezicht voor volgen opslaat (wanneer
het pictogram “$3" (opgeslagen gezicht voor volgen)
wordt weergegeven), gaat AF volgen in echttijd weer
verder wanneer het opgeslagen gezicht voor volgen
weer in het beeldgebied komt. U wist het gezicht voor
volgen door AF volgen in echttijd te stoppen, zoals
hierboven is beschreven.
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De helderheid aanpassen
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U kunt de helderheid aanpassen door het
diafragma, versterking en sluitertijd in te
stellen en het lichtniveau met ND-filters

te beinvioeden. U kunt ook automatisch
aanpassingen maken.

Het doelniveau voor automatische
helderheidsaanpassing wordt ingesteld met
Auto Exposure (pagina 78) >Level in het
menu Shooting van het hoofdmenu. U kunt
ook Auto Exposure Level toewijzen aan een
toewijsbare knop of toewijsbare regelaar
(pagina 49).

[Opmerking]

De versterking kan niet worden aangepast in de modus
Cine El. De basisgevoeligheid is vast. De helderheid
kan dus niet automatisch met de sluitertijd worden

aangepast. Automatische helderheidsaanpassing met
het diafragma en ND-Filter wordt ondersteund.

De basisgevoeligheid selecteren

U kunt op de camcorder twee typen
basisgevoeligheid selecteren.

In Custom-modus kunt u de basisgevoeligheid
instellen op High of Low met Base ISO/
Sensitivity op het scherm Main Status
(pagina 14), het scherm Camera Status
(pagina 14), of ISO/Gain/El >Base

Sensitivity (pagina 77) in het menu

Shooting van het hoofdmenu.

In modus Cine El kunt u de basis-ISO
instellen op 1SO 12800 of ISO 800 met Base
ISO/Sensitivity op het scherm Main Status
(pagina 14), het scherm Camera Status
(pagina 14) of ISO/Gain/El >Base I1SO

(pagina 77) in het menu Shooting van het
hoofdmenu.

Geadviseerd wordt om Low of ISO 800 onder
normale lichtcondities en High of ISO 12800
onder zwakke lichtcondities te selecteren.

* Kan ook worden geconfigureerd op het statusscherm.

[Tip]
U kunt Base ISO/Sensitivity ook aan een toewijsbare
knop toewijzen (pagina 49).

Het diafragma aanpassen

U kunt het diafragma zo instellen dat het
automatisch de helderheid aanpast.

Het diafragma automatisch aanpassen

Deze functie past de helderheid aan, aan de
hand van het onderwerp. Een objectief dat
autodiafragma ondersteunt is vereist.

1 Als er een objectief is bevestigd met een
Auto Iris-schakelaar, zet de schakelaar dan
op AUTO.

2 Houd de functieknop IRIS (E) ingedrukt
om het directmenu weer te geven
(pagina 49) en selecteer Auto.

[Tip]

U kunt Auto Iris ook toewijzen aan een toewijsbare
knop (pagina 49).

[Opmerking]

Het diafragma kan niet automatisch worden
aangepast op een objectief met A-bevestiging.

Het diafragma handmatig aanpassen

1 Houd de functieknop IRIS (E) ingedrukt
om het directmenu weer te geven
(pagina 49) en selecteer Manual.

2 Druk op de functieknop IRIS (E), zodat de
diafragmawaarde wordt weergegeven op
een witte achtergrond.

3 Draai aan de multifunctionele regelaar om

de waarde aan te passen.

[Tips]

e U kunt ook de multifunctionele regelaar
bedienen als een IRIS-regelaar (pagina 49)
door de functie IRIS aan de multifunctionele
regelaar toe te wijzen.

e U kunt ook de functie IRIS toewijzen aan een
toewijsbare regelaar (pagina 49).

Tijdelijk automatisch aanpassen

Druk op de toewijsbare knop (pagina 49)
die is toegewezen aan de functie Push Auto
Iris om automatisch het diafragma tijdelijk aan
te passen zolang de knop wordt ingedrukt.
Het diafragma gaat terug naar de vorige
instelling als u de knop loslaat.
[Opmerkingen]
e Als de schakelaar Auto Iris van het objectief is
ingesteld op MANUAL, hebben de functies Auto
Iris en Push Auto Iris van de camcorder geen effect.
Handmatige aanpassingen van het diafragma op de
camcorder hebben ook geen effect.

e Push Auto Iris is niet mogelijk wanneer Iris > Bokeh
Control (pagina 78) in het menu Shooting is
ingesteld op On.

De versterking aanpassen

In Custom-modus kunt u de versterking
aanpassen om de helderheid aan te passen.

De versterking automatisch aanpassen

Houd de functieknop ISO/GAIN (H)

ingedrukt om het directmenu weer te geven

(pagina 49) en selecteer Auto.

[Tips]

e U kunt dezelfde actie ook uitvoeren door Auto
Exposure (pagina 78) >AGC in het menu Shooting
op On in te stellen.

e U kunt ook AGC aan een toewijsbare knop toewijzen
(pagina 49).

Versterking handmatig aanpassen

U kunt de versterking regelen als u de
belichting wilt aanpassen bij gebruik van
een vaste diafragma-instelling of als u extra
versterking wilt voorkomen als gevolg van
AGC.

1 Houd de functieknop ISO/GAIN (H)
ingedrukt om het directmenu weer te
geven (pagina 49) en selecteer Manual.

2 Stel de schakelaar ISO/GAIN switch (1) in
op H, M of L.
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[Tips]

e U kunt de presetwaarde van de verschillende
schakelaarstanden wijzigen met ISO/Gain<L>/<M>/
<H> (pagina 14) op het scherm Camera Status of
ISO/Gain/El > ISO/Gain<H>/<M>/<L> (pagina 77) in
het menu Shooting van het hoofdmenu.

e U kunt ook Push AGC aan een toewijsbare knop
toewijzen en AGC tijdelijk inschakelen door de knop
vast te houden.

[Opmerking]

Push AGC is niet mogelijk wanneer Iris > Bokeh Control
(pagina 78) in het menu Shooting in het hoofdmenu

is ingesteld op On.

De versterking regelen (fijnafstelling)

1 Druk op de functieknop ISO/GAIN (H),
zodat de versterkingswaarde wordt
weergegeven op een witte achtergrond.

2 Draai aan de multifunctionele regelaar om
de waarde aan te passen.

[Tip]

Wijzig de versterkingspresetwaarde volgens de

instelling van de ISO/GAIN-schakelaar (1).

De versterking tijdelijk regelen
(fijnafstelling)

Draai aan de toewijsbare regelaar

(pagina 49) die is toegewezen

aan de functie ISO/Gain/El, om de
versterkingswaarde aan te passen die is
ingesteld met de schakelaar ISO/GAIN (I).
Dit is nuttig als u de belichting met een stap
wilt aanpassen zonder de scherptediepte te
wijzigen.

De aangepaste versterkingswaarde wordt
geannuleerd door het omschakelen van

de schakelaar ISO/Gain (1), wijzigen van de
basisgevoeligheid, AGC op On instellen of de
stroom uitschakelen.

[Tips]

e U kunt deze functie ook toewijzen aan de
multifunctionele regelaar (pagina 49).

e U kunt ook Push AGC aan een toewijsbare knop
toewijzen en AGC tijdelijk inschakelen door de knop
vast te houden.

[Opmerking]

Push AGC is niet mogelijk wanneer Iris > Bokeh Control
(pagina 78) in het menu Shooting in het hoofdmenu

is ingesteld op On.

De belichtingsindex aanpassen

In de modus Cine El wordt ervan uitgegaan
dat videouitvoer met MLUT ingesteld op

Off wordt opgenomen als het hoofdsignaal.
Door de helderheid van het beeld met MLUT
On te wijzigen om overeen te komen met
de El-waarde, kunt u tijdens het filmen het
resultaat van post-productieaanpassing van
belichtingsgevoeligheid controleren.

U kunt de El-waarde wijzigen door de ISO/
GAIN-schakelaar (1) in te stellen op H, M of L.
[Tip]

U kunt de El-waarde van elke stand wijzigen met
I1SO/Gain/El (pagina 14) op het scherm Camera

Status of ISO/Gain/El >Exposure Index<H>/<M>/<L>

(pagina 77) in het menu Shooting van het
hoofdmenu.

Fijnafstelling van de belichtingsindex

1 Druk op de functieknop ISO/GAIN (H),
zodat de El-waarde wordt weergegeven
op een witte achtergrond.

2 Draai aan de multifunctionele regelaar om
de waarde aan te passen.

[Tip]

Wijzig de El-presetwaarde volgens de instelling van de

ISO/GAIN-schakelaar (1).

De sluiter aanpassen

U kunt de sluiter aanpassen, zodat deze de
helderheid aanpast.

De sluiter automatisch aanpassen

Houd de functieknop SHUTTER (F) ingedrukt
om het directmenu (pagina 49) weer te

geven en selecteer Auto om automatisch de
sluitertijd of sluiterhoek aan te passen als
reactie op de beeldhelderheid.

[Tip]

U kunt dezelfde actie ook uitvoeren door Auto Exposure

>Auto Shutter (pagina 79) in het menu Shooting van
het hoofdmenu op On in te stellen.

De sluiter handmatig aanpassen

1 Houd de functieknop SHUTTER (F)
ingedrukt om het directmenu
(pagina 49) weer te geven en selecteer
Speed of Angle.

2 Druk op de functieknop SHUTTER (F),
zodat de sluiterwaarde wordt
weergegeven op een witte achtergrond.

3 Draai aan de multifunctionele regelaar om
de sluitertijd aan te passen.

[Tips]

e Selecteer Off in stap 1 om de belichtingstijd aan te
passen aan het frame-interval.

e U kunt ook de hoek instellen en de frequentie
aanpassen (pagina 77).

Het lichtniveau aanpassen (ND-
Filter)

Onder condities waarin het licht te helder

is, kunt u de juiste helderheid instellen door
wijziging van het ND-filter.

De camcorder heeft twee ND-filter-modi. U
kunt tussen de twee modi overschakelen met
de schakelaar ND PRESET/VARIABLE.

De presetmodus aanpassen

Zet de schakelaar ND PRESET/VARIABLE (A) in
de stand PRESET en zet de omhoog/omlaag-
knoppen ND FILTER POSITION (B) op een van
de volgende instellingen.

Clear: geen ND-filter

1: Lichtdoorlatendheid ingesteld met ND Filter
>Preset1 (pagina 77) in het menu Shooting
van het hoofdmenu.

2: Lichtdoorlatendheid ingesteld met ND Filter
>Preset2 (pagina 77) in het menu Shooting
van het hoofdmenu.

3: Lichtdoorlatendheid ingesteld met ND Filter
>Preset3 (pagina 77) in het menu Shooting
van het hoofdmenu.

Aanpassen in variabele modus

Zet de schakelaar ND PRESET/VARIABLE (A)
in de stand VARIABLE. Schakel de omhoog/
omlaag-knoppen ND FILTER POSITION (B) om
tussen CLEAR en On.
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Het lichtniveau automatisch aanpassen

U kunt Auto ND Filter op On instellen om
automatische belichtingsaanpassing met het
ND-filter in te schakelen.

1 Druk op de [+]-knop van de omhoog/

omlaag-knoppen ND FILTER POSITION (B)

om de werking van het ND-filter in te
schakelen.

2 Houd de knop ND VARIABLE AUTO (C)
ingedrukt tot Auto is geselecteerd.

Het lichtniveau handmatig aanpassen
1 Druk op de [+]-knop van de omhoog/

omlaag-knoppen ND FILTER POSITION (B)

om de werking van het ND-filter in te
schakelen.

2 Houd de knop ND VARIABLE AUTO (C)
ingedrukt tot Manual is geselecteerd.

3 Draai aan de regelaar ND VARIABLE (D)
om de lichtdoorlatendheid van het filter
aan te passen.

[Tip]

U kunt ook de functie ND Filter toewijzen aan een

toewijsbare regelaar (pagina 49).

Tijdelijk automatisch aanpassen

U kunt Push Auto ND aan een toewijsbare
knop aanpassen (pagina 49) en tijdelijk

Auto ND Filter inschakelen door de knop vast

te houden. De knop loslaten schakelt Auto ND

Filter weer uit.

Druk op de [+]-knop van de omhoog/omlaag-

knoppen ND FILTER POSITION (B) om de
werking van het ND-filter in te schakelen.

[Opmerkingen]

e Als het ND-filter wordt overgeschakeld van of
naar CLEAR tijdens het filmen, wordt het ND-
filterkader weergegeven op het beeld en wordt het
bedieningsgeluid opgenomen in de audio.

e Push Auto ND is niet mogelijk wanneer Iris > Bokeh
Control (pagina 78) in het menu Shooting is
ingesteld op On.

[Tips]

e U kunt overschakelen naar CLEAR door de regelaar
ND VARIABLE (D) omlaag te draaien van ND1/4. De
regelaar omhoog draaien vanaf CLEAR stelt ND1/4 in.
U kunt deze actie uitschakelen met ND Dial >CLEAR
with Dial (pagina 100) in het menu Technical van het
hoofdmenu.

e U kunt ND Filter Position toewijzen aan een
toewijsbare knop (pagina 49) en deze knop
indrukken in plaats van de knoppen ND FILTER
POSITION omhoog/omlaag te gebruiken om deze
instelling te wijzigen.

Presetmodus: Clear — Preset1 — Preset2 — Preset3
— Clear...
Variabele modus: Clear — On — Clear...

e U kunt ook Auto ND Filter toewijzen aan een
toewijsbare knop (pagina 49) en de knop
indrukken om over te schakelen tussen Auto ND filter
On en Off.

e Bij het filmen van een helder verlicht onderwerp
kan het dichtdraaien van het diafragma
diffractievervaging veroorzaken, wat een beeld
produceert dat onscherp begint te worden (en
typisch verschijnsel in videocamera's). U kunt dit
effect onderdrukken voor betere videoresultaten met
behulp van het ND-filter.
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Aanpassing voor natuurlijke kleuren (witbalans)

IRIS

CANCEL/ THUMBNAIL =FULL MENU DISPLAY
BACK

G =

U kunt de aanpassingsmodus instellen die
geschikt is voor de condities waarin wordt
gefilmd.

ATW (automatische witbalans)

Deze functie past de witbalans automatisch
aan tot een geschikt niveau.

De witbalans wordt automatisch aangepast
als de kleurtemperatuur van de lichtbron zich
wijzigt.

Houd de functieknop WHT BAL (G)

ingedrukt om het directmenu weer te geven
(pagina 49) en selecteer ATW.

U kunt de aanpassingssnelheid (vijf stappen)
selecteren met White Setting >ATW Speed
(pagina 80) in het menu Shooting van het
hoofdmenu.

[Tip]

U kunt de huidige witbalansinstelling bevriezen door
de ATW Hold-functie toe te wijzen aan een toewijsbare

knop (pagina 49) en de toewijsbare knop in te
drukken om de ATW-modus tijdelijk te pauzeren.

[Opmerkingen]
e ATW kan niet worden gebruikt in de modus Cine EI.
e De juiste kleur kan mogelijk niet worden aangepast
met ATW, afhankelijk van de condities van het licht en
het onderwerp.
Voorbeelden:
- Als het onderwerp wordt gedomineerd door één
kleur, zoals lucht, zee, aarde of bloemen.
- Als de kleurtemperatuur extreem hoog of extreem
laag is.
Als het adequate effect niet kan worden bereikt
omdat de ATW autotracking-snelheid laag is of om

andere redenen, voer dan automatische witbalans uit.

De witbalans handmatig
aanpassen

1 Als witbalans is ingesteld op ATW-modus,
houd dan de functieknop WHT BAL (G)
ingedrukt om het directmenu weer te
geven (pagina 49) en selecteer W:P,

W:A, of W:B.

2 Selecteer B, A of PRESET met de WHT
BAL-schakelaar (J).
B: modus geheugen B
A: modus geheugen A
PRESET: Presetmodus
[Tip]
ATW kan worden uitgeschakeld voor geheugen B door
White Setting >White Switch<B> (pagina 80) in het

menu Shooting van het hoofdmenu in te stellen op ATW.

Modus geheugen A/geheugen B

Deze modus als de witbalans aan naar de
instelling die is opgeslagen in geheugen A of
B.

Presetmodus

Deze modus past de kleurtemperatuur
aan tot een presetwaarde (standaard
fabrieksinstellingen is 3200K).

De standaard presetwaarde wijzigen

In presetmodus kunt u een bestaande
presetwaarde rechtstreeks veranderen.
Houd de functieknop WHT BAL (G) ingedrukt
en selecteer een van de volgende opties in het
directmenu.
Modus Custom: — 3200K, — 4300K,

— 5600K, — 6300K
Modus Cine El: — 3200K, — 4300K,

— 5500K

[Tip]

U kunt ook Preset White Select aan een toewijsbare

knop toewijzen (pagina 49) en de knop indrukken om

de instelling te wijzigen.

Modus Custom: 3200K — 4300K — 5600K — 6300K
— 3200K...

Modus Cine EI: 3200K — 4300K — 5500K — 3200K...

De kleurtemperatuur wijzigen

1 Druk op de functieknop WHT BAL (G),
zodat de kleurtemperatuurwaarde wordt
weergegeven op een witte achtergrond.

2 Draai aan de multifunctionele regelaar om
de waarde aan te passen.

[Tips]

e In presetmodus kunt u de waarde instellen in stappen
van 100K.

e In geheugenmodus kunt u de waarde instellen in
stappen van 20K binnen het bereik van 2000K tot
5600K. Waarden boven 5600K kunnen worden
ingesteld in intervallen die overeenkomen met de
hoeveelheid kleurwijziging (Mired) van 5580K tot
5600K. U kunt ook de tintwaarde aanpassen met
White (pagina 79) >Tint in het menu Shooting van
het hoofdmenu.

Automatische witbalans uitvoeren

De witbalans die wordt opgeslagen in de
modus geheugen A/geheugen B wordt
automatisch geconfigureerd.

1 Selecteer de modus geheugen A of
geheugen B.

2 Plaats een wit papier (of object) op een
plaats met dezelfde lichtbron en condities
als het onderwerp en zoom vervolgens in
op het papier om wit op het scherm weer
te geven.

3 Pas de helderheid aan.
Pas het diafragma aan volgens de
procedure in “Het diafragma handmatig
aanpassen” (pagina 43).

4 Druk op de knop WB SET (pagina 4).

e Als automatische witbalans wordt
uitgevoerd in de geheugenmodus
wordt het resultaat van de automatische
aanpassing opgeslagen in het geheugen
(A of B) dat in stap 1is geselecteerd.

e Als automatische witbalans wordt
uitgevoerd in ATW-modus, blijft het
resultaat behouden en gaat ATW verder
wanneer de automatische aanpassing
stopt. Dit is handig als u de witbalans
snel wilt aanpassen, ongeacht de
instelling voor ATW Speed.

[Opmerking]

Als de aanpassing niet is gelukt, verschijnt gedurende
ongeveer 3 seconden een foutmelding op het scherm.
Als de foutmelding aanhoudt na herhaalde pogingen

voor het instellen van de witbalans, neem dan contact
op met uw Sony servicevertegenwoordiger.
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De audio voor opname instellen

U kunt de audio die moet worden opgenomen

instellen met de ingangsaansluitingen,

schakelaars en regelaars op de camcorder.

Externe ingangen audio en
selectieschakelaars

Aansluiting INPUT1 (pagina 7)
Aansluiting INPUT2 (pagina 7)
Multi-interfaceschoen (pagina 7)
Schakelaar INPUT1 (LINE/MIC/MIC+48V)
(pagina 7)

Schakelaar INPUT2 (LINE/MIC/MIC+48V)
(pagina 7)

Schakelaars voor instellen van het
audioniveau

Schakelaar CH1 (AUTO/MAN) (pagina 6)
Schakelaar CH2 (AUTO/MAN) (pagina 6)
Regelaar AUDIO LEVEL (CH1) (pagina 6)
Regelaar AUDIO LEVEL (CH2) (pagina 6)

Scherm Audio Status

D Audio

INPUTA
MIC +48V

INPUT2
MIC +48V

Int MIC

CH1 mn
<

0dB

INPUTA

MIC +48V :50d8 off

CH4
o

Audio Input Level VI O C Volume

99 0

Monitor CH

CH1/CH2

Het audio-invoerapparaat
selecteren

1

Stel de audio-ingang in met CH1/CH2/
CH3/CH4>Source (pagina 14) op het
scherm Audio Status of Audio Input >CH1
Input Select t/m CH4 Input Select
(pagina 97) in het menu Audio van het
hoofdmenu.

Als u een microfoon of XLR-adapter
gebruikt met de multi-interfaceschoen,
geef dan Shoe CH1 of Shoe CH2 op. Zie
voor details over de XLR-adapter “Audio-
ingangen toevoegen” (pagina 48).

[Opmerkingen]

e Audio wordt niet opgenomen in de Interval Rec
mode of Slow & Quick Motion.

e De camcorder heeft een ingebouwde
spraakmicrofoon voor het opnemen van
omgevingsgeluid. Deze kan worden gebruikt
voor het synchroniseren van de timing met
andere apparatuur. Specificeer in dergelijke
gevallen Internal MIC.

e De interne microfoon van de draaggreep
(pagina 7) wordt alleen actief voor het
opnemen van audio als de draaggreep is
bevestigd. Als de draaggreep niet is bevestigd
kan de spraakmicrofoon (pagina 6) voor het

opnemen van omgevingsgeluid worden gebruikt.

e Als CH1 Input Select en CH2 Input Select zijn
ingesteld op Internal MIC, wordt het audio-
opnameniveau van zowel CH1 als CH2 aangepast
met de regelaar AUDIO LEVEL(CH1) (pagina 6).
Als CH3 Input Select en CH4 Input Select zijn
ingesteld op Internal MIC, wordt het audio-
opnameniveau van zowel CH3 als CH4 aangepast
met CH3 Input Level (pagina 97).

2 De audio-ingangsbron selecteren.
Stel de schakelaars INPUT1/INPUT2 (LINE/
MIC/MIC+48V) in op de apparaten die zijn
aangesloten op de ingangen INPUT1/

INPUT2.

Aangesloten apparaat Schakelaar-
stand

Externe audiobron LINE

(bijvoorbeeld een
mengpaneel)

Dynamische microfoon, MIC
microfoon met batterij

+48 V fantoomvoeding MIC+48V

microfoon

e Het selecteren van MIC+48V en
een microfoon aansluiten die niet
compatibel is met +48V kan het
aangesloten apparaat beschadigen.
Controleer de instelling, alvorens het
apparaat aan te sluiten.

e Als ruis een probleem is bij ingangen
waarop geen apparaat is aangesloten,
zet de betreffende schakelaars voor
INPUT1/INPUT2 (LINE/MIC/MIC+48V) dan
op LINE.

Het audio-opnameniveau
automatisch aanpassen

Zet de schakelaars CH1/CH2 (AUTO/MAN)
op AUTO om de kanalen automatisch aan te
passen.

Stel voor CH3/CH4 de audioniveauregeling
in op Auto op het scherm Audio Status
(pagina 14) of bij Audio Input >CH3 Level
Control en CH4 Level Control in het menu
Audio van het hoofdmenu (pagina 97).

Het audio-opnameniveau
handmatig aanpassen

Gebruik de volgende procedure om het audio-
opnameniveau voor CH1/CH2 aan te passen.

1 Zet de schakelaars CH1/CH2 (AUTO/MAN)
voor de kanalen op MAN om handmatig
aan te passen.

2 Draai tijdens het filmen aan de regelaars
AUDIO LEVEL (CH1)/(CH2) van de
betreffende kanalen om het audioniveau
aan te passen.

e Stel voor CH3/CH4 de
audioniveauregeling met behulp van
CH3/CH4 (pagina 14) op het scherm
Audio Status of Audio Input >CH3 Level
Control of CH4 Level Control in het
menu Audio van het hoofdmenu in op
Manual en stel vervolgens het audio-
opnameniveau in met behulp van CH3
Input Level of CH4 Input level.

e U kunt de niveaus voor CH1t/m CH4
als groep aanpassen. U kunt het
opnameniveau aanpassen met een
toewijsbare knop (pagina 49) die is
toegewezen aan het functie Audio Input
Level, het scherm Audio Status, of Audio
Input >Audio Input Level het menu
Audio of het hoofdmenu.

[Tip]

Het scherm Audio Status is handig om het audio-

ingangsniveau te controleren (pagina 14).

[Opmerkingen]

e Deinstellingen voor Audio Input Level zijn mogelijk
uitgeschakeld, afhankelijk van de combinatie van
instellingen in het menu Audio. Zie voor details het
schema op pagina 134.

e De camcorder ondersteunt combinaties van
diverse instellingen. Zie voor details het schema op
pagina 134.
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Audio-ingangen toevoegen

U kunt maximaal vier kanalen met XLR-
audioapparatuur tegelijk aansluiten op de
camcorder met de XLR-K2M XLR-adapter (niet
meegeleverd) of de XLR-K3M XLR adapter
(niet meegeleverd).

Bevestig de XLR-adapter aan de

multifunctionele interfaceschoen en stel

CH3 >Source in op Shoe CH1 en CH4 >Source

op Shoe CH2 op het scherm Audio Status in

(pagina 14). Of stel Audio Input> CH3 Input

Select in op Shoe CH1 en CH4 Input Select

op Shoe CH2 in het menu Audio van het

hoofdmenu.

Camcorderfuncties die overlappen worden

uitgeschakeld voor kanalen waarop de XLR-

adapter als ingang is geselecteerd. Gebruik
de schakelaar en regelaars op de XLR-adapter
vOoor aanpassingen.

[Opmerkingen]

e De camcorder ondersteunt de 2-kanaals digitale
audio-interface van de XLR-K3M.

e Als Audio Input >CH3 Level en CH4 Level in het menu
Audio zijn ingesteld op Audio Input Level, dan wordt
Audio Input Level op de camcorder vermenigvuldigd
met het aangepaste niveau op de XLR-adapter.
Audio Input Level wordt ook ingeschakeld als de
schakelaar op de XLR-adapter is ingesteld op AUTO.
Als "Through" is opgegeven, wordt audio opgenomen
op het niveau dat is ingesteld met de XLR-adapter
(pagina 135).
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Handige functies

Handelingen directmenu

U kunt de status en instellingen van
de camcorder controleren die worden
weergegeven op het zoekerscherm en direct
instellingen selecteren en wijzigen.
De volgende onderdelen kunnen worden
geconfigureerd.

e Face/Eye Detection AF

SteadyShot

White Mode

Color Temp

Scene File

ND Filter Position / Auto ND Filter
ND Filter Value

Auto Iris

Iris Value

AGC

Gain Value

ISO Value

Exposure Index Value

Auto Shutter / ECS

Shutter Value

Auto Exposure Mode

Auto Exposure Level

S&Q Motion Frame Rate

_—) @& @& 0 0 0 0 O o o o o o o ¢ ¢ o o

Druk op de multifunctionele regelaar of
een toewijsbare knop die is toegewezen
met de functie Direct Menu.

Alleen de onderdelen op het scherm die
kunnen worden geconfigureerd met het
directmenu kunnen worden geselecteerd
met de oranje cursor.

2 Draai aan de multifunctionele regelaar om
de cursor te verplaatsen naar het menu-
onderdeel dat moet worden bewerkt en
druk vervolgens op de multifunctionele
regelaar.

Er wordt een menu weergegeven of het
onderdeel wordt weergegeven op een
witte achtergrond.

3 Draai aan de multifunctionele regelaar om
een instelling te selecteren en druk
vervolgens op de multifunctionele
regelaar.

Het menu of de witte achtergrond

verdwijnt en de nieuwe instelling wordt

weergegeven met een oranje cursor.

Druk nogmaals op de toewijsbare knop

die is toegewezen aan Direct Menu of

wacht 3 seconden zonder een handeling
uit te voeren om het directmenu te
verlaten.

[Tips]

e Directe instellingen kunnen ook worden
geconfigureerd door indrukken en vasthouden
van de verschillende functieknoppen
(pagina 5).

e Als onderdelen worden weergegeven op een
witte achtergrond kan de multifunctionele
regelaar worden gebruikt als een toewijsbare
regelaar.

o De keuzeschakelaar (pagina 9) kan ook
worden gebruikt voor het selecteren van
handelingen.

Toewijsbare knoppen/regelaars

Er bevinden zich negen toewijsbare knoppen
(pagina 6, 7, 9) op de camcorder

waar u functies aan kunt toewijzen.

U kunt ook functies toewijzen aan de
multifunctionele regelaar op de camcorder
(pagina 5), de toewijsbare regelaar op de
draaggreep (pagina 7) en de toewijsbare
regelaar op de afstandsbedieningsgreep
(pagina 9).

De functie van een knop wijzigen

Gebruik Assignable Button (pagina 86) in

het menu Project van het hoofdmenu.

U kunt de toegewezen functies op het scherm
Assignable Button Status zien (pagina 15).

De functies die standaard vanuit de fabriek
zijn toegewezen aan de toewijsbare knoppen

Knop 1 S&Q Motion

Knop 2 AF Speed/Sens.

Knop 3 Focus Setting

Knop 4 Focus Magnifier x3/x6
Knop 5 Direct Menu

Knop 6 Off

Knop 7 Focus Magnifier x3/x6
Knop 8 Direct Menu

Knop 9 Video Signal Monitor

Knop Hold button  Focus Hold

Toewijshare functies
Off

Base ISO/Sensitivity
AGC

Push AGC

ND Filter Position
Auto ND Filter

Push Auto ND

Auto lIris

Push Auto Iris
Bokeh Control

Auto Shutter

Auto Exposure Level
Backlight

Spotlight

Preset White Select
ATW

ATW Hold

AF Speed/Sens.
Focus Setting

Focus Area

Focus Area(AF-S)
Face/Eye Detection AF
Push AF Mode

Push AF/Push MF
Focus Hold

Focus Magnifier x3/x6
Focus Magnifier x3
Focus Magnifier x6
S&Q Motion
SteadyShot

® Rec

e Picture Cache Rec

e Rec Review

e Clip Flag OK

e Clip Flag NG

e Clip Flag Keep

e Color Bars

e Tally [Front]

e DURATION/TC/U-BIT
e Display

e Lens Info

e Video Signal Monitor
e Marker

® VF Adjust

* \VVF Mode

e Gamma Display Assist
e Peaking

e Zebra

e \olume

e Thumbnail

e Touch Operation

e Handle Zoom

e NFC

e Auto Upload (Proxy)
e Direct Menu

e User Menu

e Menu

De functie van de regelaar veranderen

U kunt de functie wijzigen van de
multifunctionele regelaar op de camcorder, de
toewijsbare regelaar op de handgreep en de
toewijsbare regelaar op de draaggreep.

Gebruik voor het instellen van de
multifunctionele regelaar Multi Function Dial
(pagina 89) >Default Function in het menu
Project.

Vanuit de fabriek is Off toegewezen.
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Functies toewijsbare aan de multifunctionele

regelaar

o Off

ISO/Gain/El

IRIS

Auto Exposure Level
Audio Input Level

[Opmerking]
De instelling is uitgeschakeld als het menu wordt
weergegeven.

Gebruik voor de toewijsbare regelaar
Assignable Dial (pagina 88) in het menu
Project of het hoofdmenu.

Standaard vanuit de fabriek is IRIS aan alle
knoppen toegekend.

[Tip]

De toewijsbare regelaar van de RM-30BP

(optie) volgt de instelling van de handgreep/
afstandsbedieningsregelaar.

Toewijsbare functies aan de toewijsbare

regelaar op de draaggreep/handgreep
Off

ISO/Gain/El

ND Filter

IRIS

e Auto Exposure Level

e Audio Input Level

e Multi Function Dial

U kunt de toegewezen functies op het scherm
Assignable Button Status zien (pagina 15).

Slow & Quick Motion

Als de opname-indeling (pagina 83) is ingesteld op de volgende waarden, kunt u
verschillende waarden opgeven voor de beeldsnelheid waarmee wordt gefilmd en de

beeldsnelheid waarmee wordt afgespeeld.

Opname-indeling

Beeldsnelheid

Intervalopname (Interval Rec)

Met de functie Interval Rec van de camcorder
kunt u time-lapse-video's vastleggen in het
interne geheugen van de camcorder. Dit is een
effectieve manier om langzaam bewegende
onderwerpen te filmen.
Als de opname wordt gestart, neemt de
camcorder automatisch een vastgesteld aantal
frames binnen een specifiek tijdsinterval op.
Filminterval (Interval Time)

e

Systeemfrequentie Scanmodus Codec Video-indeling
beeldsensor
59.94/50/29.97/ FF RAW 3840x2160P 1-60, 100, 120
25/23.98 RAW & XAVC-| 3840%2160P 1-60, 100, 120
XAVC-I 4096x2160P 1-60
3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120, 150,
180, 200, 240
XAVC-L 3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120, 150,
180, 200, 240
S35 XAVC-| 1920x1080P 1-60, 100, 120
XAVC-L 1920x1080P 1-60, 100, 120
24 FF XAVC-I 4096x2160P 1-60

U kunt de modus Slow & Quick Motion

in- of uitschakelen door het indrukken van
een toewijsbare knop (pagina 49) die is
toegewezen aan de functie S&Q Motion.
U kunt de beeldsnelheid voor opname
instellen door de knop vast te houden.
[Tip]

U kunt de modus ook instellen met S&Q Frame
Rate in het scherm Main Status, Rec Function in het

statusscherm Project, en S&Q Motion in het menu
Shooting van het hoofdmenu.

[Opmerkingen]

e Slow & Quick Motion kan niet worden
ingesteld tijdens opname, afspelen of als het
pictogrammenscherm wordt weergegeven.

e Audio opname wordt niet ondersteund in de modus
Slow & Quick Motion.

e De functies automatisch scherpstellen,
autodiafragma, en automatische sluitertijd worden
in de modus Slow & Quick Motion uitgeschakeld. De
functie automatische scherpstelling kan wel worden
gebruikt als de beeldsnelheid als volgt is ingesteld.

Systeemfrequentie Beeldsnelheid

59.94/29.97/23.98 30, 60,120, 240

50/25 25, 50,100, 200

e Zie voor details over RAW-uitvoer pagina 59.

Aantal frames in één take
(Number of Frames)

Als Interval Rec is ingeschakeld, gaat de
HVL-LBPC (optie) videolamp automatisch
aan voordat de opname begint, waardoor
u foto's kunt maken onder stabiele licht- en
kleurtemperatuuromstandigheden (functie
voorverlichting).

[Opmerkingen]

e Erkan slechts één speciale opnamefunctie, zoals
Interval Rec, tegelijk worden gebruikt.

e Als er een andere speciale opnamemodus actief
wordt terwijl Interval Rec in gebruik is, wordt Interval
Rec automatisch uitgeschakeld.

e De modus Interval Rec wordt automatisch

uitgeschakeld na het wijzigen van

systeeminstellingen, zoals de video-indeling.

De instellingen voor Interval Rec kunnen niet worden

gewijzigd tijdens opnemen of afspelen, of als het

pictogrammenscherm wordt weergegeven.
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Interval Rec instellen

Selecteer Rec Function >Interval Rec in het
statusscherm Project en configureer de
instellingen Number of Frames en Interval
Time.

Stel bij gebruik van de HVL-LBPC videolamp
(optie) het vereiste tijdsinterval in voor het
inschakelen van de videolamp, voordat de
opname start met Interval Rec >Pre-Lighting in
het menu Project.

[Tip]

U kunt de modus ook instellen met Interval Rec
(pagina 85) in het menu Project van het hoofdmenu.

[Opmerkingen]

e Als u de videolamp wilt inschakelen voor het begin
van de opname, zet de videolampschakelaar dan
op AUTO. De videolamp gaat automatisch aan
en uit volgens de instelling van Video Light Set
(pagina 102) in het menu Technical.

e Als u de videolampschakelaar op aan zet, is de
videolamp altijd aan (en gaat de videobelichting niet
automatisch aan en uit).

e Als de videolamp zo wordt geconfigureerd dat deze
5 seconden of korter wordt uitgeschakeld, gaat de
videolamp helemaal niet uit.

De camcorder verlaat de modus Interval

Rec als hij wordt uitgeschakeld, maar de
instellingen voor Number of Frames, Interval
Time en Pre-Lighting blijven behouden. De
volgende keer als u gaat opnemen in de
modus Interval Rec hoeft u deze niet meer in
te stellen.

Filmen met Interval Rec

Druk op de knop START/STOP om te starten
met opnemen. "Int @Rec" en "Int @Stby"
verschijnen afwisselend in de zoeker.

Als u de voorverlichtingfunctie gebruikt, gaat
de videolamp aan voordat de opname begint.

Stoppen met filmen

Stop het filmen.

Als het filmen wordt gestopt worden de in het
geheugen opgeslagen videogegevens tot dat
punt opgeslagen op de media.

De modus Interval Rec verlaten

Voer een van de volgende handelingen uit.

e Zet de POWER-schakelaar op Off.

® |n opname-stand-bymodus stelt u in het
statusscherm Project de optie Rec Function
in op een andere instelling dan Interval Rec.

De modus Interval Rec wordt ook automatisch

uitgeschakeld als de camcorder opnieuw

wordt opgestart.

Beperkingen tijdens opname

e Audio wordt niet opgenomen.
e Een opname controleren (Rec Review) is niet
mogelijk.

Als de camcorder wordt uitgeschakeld
tijdens opname

e Als de POWER-schakelaar op de camcorder
in de Off-stand staat, wordt het medium
gedurende enkele seconden gebruikt om de
beelden op te slaan die tot dat moment in
het geheugen zijn opgeslagen, waarna het
apparaat automatisch wordt uitgeschakeld.

e Als de stroom uitvalt omdat de accu is
verwijderd, het netsnoer is losgekoppeld
of de stroom van de netadapter is
uitgeschakeld, gaan de tot dan toe
opgenomen video- en audiogegevens
mogelijk verloren (maximaal 10 seconden).
Bij het vervangen van de accu moet u
voorzichtig te werk gaan.

Beelden in cache opnemen
(Picture Cache Rec)

Met de functie Picture Cache Rec kunt u video
achteraf vastleggen wanneer u een opname
start door een intern cachegeheugen bij te
houden met een bepaalde duur.

Stel Picture Cache Recin op On in het
statusscherm Project en stel vervolgens de
cachegrootte in.

Instelling Cache Cache-tijd (ongeveer)

Size

Short 5 seconden

Medium 10 seconden

Long 20 seconden

Max Maximale waarde van de
betreffende opname-
indeling

[Tips]

e De cachetijd kan korter zijn, afhankelijk van de
opnamebeeldsnelheid en de opname-indeling. Let op
de weergave rechtsonder van het instellingenscherm
voor de cachegrootte.

e U kunt de modus ook instellen met Picture Cache
Rec (pagina 85) in het menu Project van het
hoofdmenu.

e U kunt ook Picture Cache Rec schakelen tussen On en
Off met een toewijsbare knop (pagina 49).

[Opmerkingen]

e U kunt Picture Cache Rec niet gebruiken in combinatie
met Interval Rec, simultane opnamefunctie met 2
kaartsleuven of proxy-opname. Wanneer Picture
Cache Rec is ingesteld op On, worden deze andere
opnamefuncties geforceerd uitgeschakeld.

e De modus Picture Cache Rec kan niet worden
geselecteerd tijdens het opnemen of wanneer Rec
Review bezig is.

e Wanneer Picture Cache Rec is ingesteld op On, wordt
de tijdcode vastgelegd in de modus Free Run, zelfs als
dit is ingesteld op Regen of Rec Run (pagina 92).

e De instelling Output Format kan misschien niet
worden geconfigureerd tijdens de modus Picture
Cache Rec. Als dat gebeurt, schakel dan Picture Cache
Rec tijdelijk uit en wijzig vervolgens de instelling.

Picture Cache Rec starten

Wanneer Picture Cache Rec is ingesteld op On,
verschijnt “@Cache” (@ is groen) in de zoeker.
Wanneer u op de knop START/STOP drukt,
start de opname en wordt video naar de
geheugenkaarten geschreven, te beginnen
met de video die in het cachegeheugen is
opgeslagen.

Picture Cache Recannuleren

Stel Picture Cache Rec in op Off in het
statusscherm Project of druk op een
toewijsbare knop die u de functie Picture
Cache Rec hebt toegewezen.

[Opmerkingen]

e Door de opname-indeling of het basisuiterlijk te
wijzigen, wist u de video die tot dan toe in het
cachegeheugen is opgeslagen. Vervolgens wordt
nieuwe video naar de cache geschreven. Daardoor is
het opnemen in de beeldcache van beelden van voor
het wijzigen van de indeling niet mogelijk, ook niet
als u onmiddellijk met opnemen begint nadat u de
indeling hebt gewijzigd.

e Als u onmiddellijk nadat u een geheugenkaart hebt
geplaatst Picture Cache Rec instelt op On of Off,
worden cachegegevens misschien niet op de kaart
opgenomen.

e Video wordt in het cachegeheugen opgeslagen als de
functie Picture Cache Rec is ingesteld op On. Video
van voor u de functie instelde op On wordt niet in de
cache opgenomen.

e Video wordt niet in het cachegeheugen opgeslagen
wanneer een geheugenkaart bezet is, zoals
bij afspelen, Rec Review of weergave van het
pictogrammenscherm. Op die momenten is opnemen
naar de beeldcache van video niet mogelijk.
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Opnemen op geheugenkaart A en
B tegelijkertijd (2-slot Simul Rec)

U kunt opnemen op zowel geheugenkaart

A als geheugenkaart B tegelijkertijd door
Simul Rec (pagina 15) op het scherm status
Project of Simul Rec >Setting (pagina 85)

in het menu Project van het hoofdmenu in te
stellen op On.

Afzonderlijk naar geheugenkaart A en
geheugenkaart B opnemen

U kunt het opnemen naar de verschillende
geheugenkaarten onafhankelijk in- en
uitschakelen met de knoppen Record START/
STOP op de camcorder en de draaggreep.
Standaard zijn beide knoppen ingesteld op
gelijktijdig starten en stoppen met opnemen
naar beide geheugenkaarten A en B.
e “Rec Button:[SlotA SlotB] Handle Rec
Button:[SlotA SlotB]”
Wanneer de knoppen zijn ingesteld
voor opnemen naar verschillende
geheugenkaarten, volgt de opnamestart-
stopregeling van de SDI/HDMI Rec Control
(pagina 86) de opnamestatus van sleuf A.

De instelling wijzigen

Selecteer Simul Rec >Rec Button Set
(pagina 85) in het menu Project.

Rec Button Set Knoppen en

geheugenkaarten

"Rec Button:[SlotA
SlotB] Handle Rec
Button:[SlotA SlotB]"

Start en stopt
gelijktijdig opnemen
naar de
geheugenkaarten A en
B door middel van
beide knoppen.

"Rec Button:[SlotA]
Handle Rec Button:
[SlotB]"

De knop Record
START/STOP start-
stopt het opnemen
naar geheugenkaart A,
en de knop Record
START/STOP op de
draaggreep start-stopt
het opnemen naar
geheugenkaart B.

"Rec Button:[SlotB]
Handle Rec
Button:[SlotA]"

De knop Record
START/STOP start-
stopt het opnemen
naar geheugenkaart B,
en de knop Record
START/STOP op de
draaggreep start-stopt
het opnemen naar
geheugenkaart A.

[Tip]

De opnameknop op de afstandsbedieningsgreep of
LANC-afstandsbediening werkt hetzelfde als de knop
Record START/STOP op het apparaat.

Per ongeluk gebruiken van de knop
Record START/STOP op de draaggreep
voorkomen

Zet de HOLD-schakelaar op de draaggreep in
de stand HOLD.

[Opmerking]

De schakelaar HOLD op de draaggreep werkt niet
wanneer HOLD Switch Setting (pagina 100) >with Rec
Button is ingesteld op Off in het menu Technical van het
hoofdmenu. Als dit is ingesteld op On, stel dan Handle
HOLD Switch in op Rec Button Only.

Wilt u de zoomregelaar en de overige
knoppen behalve de knop Record START/STOP
op de draaggreep inschakelen, stel dan HOLD
Switch Setting >Handle HOLD Switch in op Rec
Button Only.

Videosignaalmonitor

U kunt het type videosignaal instellen dat

op het zoekerscherm wordt weergegeven

als golfvorm, vectorscoop of historogram
met Display On/Off >Video Signal Monitor
(pagina 95) in het menu Monitoring.

De oranje lijn geeft de ingestelde waarde van
het zebrapatroonniveau weer.

U kunt ook de functie Video Signal Monitor
toewijzen aan een toewijsbare knop

(pagina 49).

Doelweergave voor monitoring

In de modus Cine El wordt de informatie voor
kleurbereikinstelling (pagina 24) of monitor-
LUT-instelling (pagina 81) rechts boven in

de videosignaalmonitor weergegeven om het
doel van de monitoring aan te geven.

LUT s709)

78001284567890123466
ND Glear AE+0.75

De functie Gamma Display Assist

Wanneer Target Display in de modus Custom
is ingesteld op HDR(HLG) (pagina 24), stel

dan Gamma Display Assist* op het scherm
Monitoring Status in op On voor een weergave
met hulp in de zoeker waarmee het opnemen

in HDR makkelijker wordt.

* U kunt de functie ook instellen met Gamma Display
Assist >Setting (pagina 96) in het menu Monitoring
van het hoofdmenu.

De zoekerweergave selecteren wanneer
de functie Gamma Display Assist is
ingeschakeld

Er zijn twee weergavemethoden beschikbaar
voor het weergeven van HDR-beelden in de
zoeker wanneer de functie Gamma Display
Assist is ingeschakeld.

HDR weergeven met behoud van contrast
tussen gebieden met lage helderheid en

gebieden met hoge helderheid

Deze methode maakt gebruik van de
expressieve mogelijkheden van HDR en geeft
het beeld in de zoeker weer zonder extra
zwarte of overdreven lichte gebieden, zelfs als
u opneemt met heldere of donkere belichting.
Het contrast is echter wat minder.

Wilt u deze weergavemethode gebruiken,

stel dan HDR Setting >VF SDR Preview

(pagina 85) in op Off in het menu Project

van het hoofdmenu.
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SDR weergeven door eenvoudige conversie

van HDR naar SDR

Met deze methode kunt u de camera
bedienen met hetzelfde gevoel als bij
conventionele SDR.

U kunt de helderheid van het HDR-beeld
aanpassen door het verschil in versterking
tussen HDR en SDR in te stellen met SDR Gain.
Om deze weergavemethode te kunnen
gebruiken, configureert u op de volgende
manier.

1 Stel HDR Setting >VF SDR Preview
(pagina 85) in op On in het menu
Project van het hoofdmenu.

2 Pas de SDR-versterking in HDR-modus
aan met HDR Setting >SDR Gain
(pagina 85) in het menu Project van het
hoofdmenu.

[Tip]

Wanneer u na het opnemen HDR-beeld naar SDR

converteert met SR Live Metadata, wordt SDR Gain

toegepast op de conversie zodat het SDR-beeld

dezelfde belichting heeft als te zien was in de zoeker
toen u de opname maakte.

(lipvlaggen

U kunt een OK-clipvlag aan de clip toevoegen
door op de Knop Clipvlaggen (pagina 5) te
drukken en Add OK te selecteren.

U kunt een OK Clip-vlag wissen door twee keer

op de knop te drukken en Delete Clip Flag te

selecteren.

[Tips]

e U kunt ook een toewijsbare knop gebruiken die is
toegewezen aan de clipvlagfunctie om clipvlaggen
toe te voegen (pagina 49).

e U kunt ook een clipvlag toevoegen met Set Clip

Flag (pagina 99) in het menu Thumbnail van het
hoofdmenu (pagina 70).

e Het pictogrammenscherm kan worden weergegeven,
gesorteerd op clipvlagtype (gefilterd clip-
pictogrammenscherm). Zie voor details “Clipfuncties”
(pagina 70).

Ademcompensatie

U kunt kiezen voor ademcompensatie voor het
objectief met Lens >Breathing Compensation
(pagina 101) in het menu Technical van het
hoofdmenu.

Deze functie corrigeert voor het fenomeen
waarbij de kijkhoek verandert wanneer de
scherpstelpositie verandert.

Wanneer ademcompensatie wordt
toegepast, wordt een deel van het beeld
elektronisch afgesneden zodat een constante
kijkhoek wordt aangehouden zodat het
ademfenomeen niet optreedt.

[Opmerkingen]

e \Wanneer ademcompensatie is ingeschakeld, kunnen
de kijkhoek en beeldkwaliteit enigszins afwijken.

e Afhankelijk van het objectief kan het zijn dat u de
verandering in kijkhoek niet kunt corrigeren wanneer
ademcompensatie is ingeschakeld.

e Compensatie is niet mogelijk wanneer u een objectief
hebt gemonteerd dat ademcompensatie niet
ondersteunt.

e Deze functie is in de volgende gevallen ingesteld op
Off (vast).

- Wanneer Lens >Distortion Comp. is ingesteld op
Off in het menu Technical

- Wanneer S&Q Motion >Setting in het menu
Shooting is ingesteld op On

- Wanneer Rec Format >Codec in het menu Project is
ingesteld op RAW of een optie die RAW bevat

Bokeh aanpassen (functie Bokeh
Control)

U kunt het bokeh-niveau gemakkelijk
aanpassen door het ND-filter en de
versterking te koppelen aan de bediening van
het diafragma.

De functie Bokeh Control in-uitschakelen

Deze functie kan alleen worden ingeschakeld
als u de belichting handmatig aanpast. Stel
het ND-filter in op variabele modus, stel dan
het diafragma, de versterking, de sluiter en het
ND-filter in op handmatige bediening.

U kunt de functie Bokeh Control in-
uitschakelen met Iris > Bokeh Control

(pagina 78) in het menu Shooting van het
hoofdmenu.

Wanneer de functie Bokeh Control is
ingeschakeld, verschijnt het pictogram op
het ND-filter en de versterkingsindicatoren.
[Tip]

U kunt de functie Bokeh Control ook toewijzen aan een

toewijsbare knop (pagina 49) en de functie Bokeh
Control in- en uitschakelen met de knop.

Het bokeh-niveau aanpassen
1 Stel de functie Bokeh Control in op On.

2 Pas het ND-filter en de versterking aan om
de belichting in te stellen.

3 Pas het diafragma aan.
Het bokeh-niveau verandert.

[Tips]

e Wanneer de functie Bokeh Control is ingesteld op
On, werken het ND-filter en de versterking samen en
compenseren ze wijzigingen in de belichting door
aanpassing van het diafragma. Zo kunt u het bokeh-
niveau aanpassen.

De Bokeh Control wordt eerst gekoppeld aan het

ND-filter in reactie op het gebruik van het diafragma.

Wanneer het ND-filter niet meer gewijzigd kan

worden, wordt de versterking gekoppeld.

e In MF-modus kunt u het beste eerst het diafragma
openen en vervolgens scherpstellen.

e Wanneer u het automatische ND-filter gebruikt in

plaats van de functie Bokeh Control, volgt het ND-

filter de wijzigingen in helderheid van het onderwerp.

Weergave tijdens koppelen van
versterking

Wanneer de functie Bokeh Control is ingesteld
op On, kan de versterking wijzigen als het
diafragma wordt aangepast.

Wanneer de versterking is gekoppeld en deze
wijzigt, verschijnt er een melding bovenin het
scherm en knippert het pictogram op de
versterkingsindicator.

[Opmerkingen]

e Deze functie is alleen ingeschakeld op objectieven
met E-bevestiging die kunnen communiceren met het
apparaat.

e Het maximale effect van deze functie wordt bereikt
door de diafragmaring op een objectief met
E-bevestiging van Sony te gebruiken.

e Hoe dit eruit ziet, hangt af van de gebruikssnelheid,
lens, opname-instellingen en het onderwerp; ook de
helderheid kan veranderen. U kunt het beste eerst
een cameratest uitvoeren voor u gaat opnemen.

e De helderheid kan veranderen wanneer de richting
van het diafragmagebruik wijzigt, bijvoorbeeld
wanneer u het diafragma opent nadat u het eerder
had gesloten of wanneer u het diafragma sluit na het
te openen. In dat geval past u iets verder aan dan
nodig en neemt u vervolgens iets terug. Controleer de
helderheid en begin dan met opnemen.

Als u bijvoorbeeld het diafragma wilt openen naar
F8 en de achtergrond wilt vervagen, open dan het
diafragma eerst verder dan F8 en neem vervolgens
terug tot F8. Controleer vervolgens de helderheid en
begin met opnemen.

e Voer bedieningsfuncties aan de bokeh langzaam uit.
Als u sneller wilt werken, probeer dan geleidelijk aan
te passen terwijl u de wijzigingen in het beeld in de
gaten houdt.

e De kwaliteit van het beeld met Bokeh Control is niet

gegarandeerd onder alle opnameomstandigheden.

De functie Bokeh Control wordt uitgeschakeld in elk

van de volgende gevallen.
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- Wanneer u de camcorder uitschakelt

- Wanneer diafragma, versterking, sluiter of ND-filter
is ingesteld op automatisch

- Wanneer u de opnamemodus wijzigt

- Wanneer het ND-filter is ingesteld op wissen of een
presetmodus

- Wanneer u het objectief verwijdert

- Wanneer het apparaat opnieuw opstart,

bijvoorbeeld na een wijziging in frequentie
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Proxy-opname

Met deze functie kunt u tegelijkertijd
proxydata op lage resolutie opnemen, samen
met originele videodata op hoge resolutie.
Proxygegevens kunnen automatisch met korte
tussenpozen in segmenten worden verdeeld
en de bestanden kunnen worden verzonden
nog voor de opname is voltooid.

Zie “Geheugenkaarten gebruiken” (pagina 26)

voor details over ondersteunende geheugenkaarten,

formatteren van geheugenkaarten en controleren van de
resterende capaciteit.

Configureren voor filmen

1 Stel Proxy Rec (pagina 15) op het
scherm status Project of Proxy Rec
>Setting (pagina 85) in het menu
Project van het hoofdmenu in op On.

2 Plaats een geheugenkaart in een
CFexpress Type A/SD-kaartsleuf
(pagina 6).

e Bij CFexpress-kaarten wijst het etiket
naar links.

e \oor SD-kaarten wijst het etiket naar
rechts met de schuin afgeplatte hoek
aan de onderkant.

[Opmerking]

Proxy Rec kan niet tegelijk worden ingeschakeld met

S&Q Motion of Interval Rec. Als Proxy Rec is ingesteld

op On, worden deze andere opnamemodi geforceerd
uitgeschakeld.

Een proxy opnemen

Druk op de knop START/STOP om het
opnemen te starten na het maken van de
juiste instelling voor het filmen.

[Opmerkingen]

e Als de camcorder is uitgeschakeld of als de
geheugenkaart wordt verwijderd terwijl er gegevens
worden uitgewisseld kan de integriteit van de
gegevens op de kaart niet worden gegarandeerd.
Alle gegevens op de geheugenkaart kunnen verloren
gaan. Controleer altijd of de toegangsindicator van de
geheugenkaart niet brandt, alvorens de camcorder uit
te schakelen of de geheugenkaart te verwijderen.

e Zorg dat de geheugenkaart er niet uitspringt bij het
plaatsen of verwijderen.

Om te verlaten stopt u de opname.

De audiokanalen voor proxy-
opname instellen

Selecteer Proxy Rec >Audio Channel
(pagina 85) in het menu Project van het
hoofdmenu, en stel het audiokanaal in voor
proxydata-opname.

Een proxybestand in segmenten
opnemen en uploaden

Wanneer de instelling Automatisch uploaden
is ingesteld op Chunk en een proxybestand
wordt opgenomen in segmenten, kan het
proxybestand worden getipload terwijl de
hoofdopname bezig is.

Voor nadere gegevens over het uploaden
van een proxybestand dat is opgenomen

in segmenten raadpleegt u “Bestanden

automatisch uploaden” (pagina 66) en “De
app C3 Portal App gebruiken” (pagina 67).

1 Selecteer Proxy Rec >Chunk (pagina 85)
in het menu Project en selecteer het
opname-interval voor segmenten.
30s: neem een proxybestand op in
segmenten van 30 seconden
(standaardinstelling).

Tmin: neem een proxybestand op in
segmenten van 1 minuut.
2min: neem een proxybestand op in
segmenten van 2 minuut.

2 Stel File Transfer >Auto Upload (Proxy)
(pagina 106) in het menu Network in op
Chunk.

Het originele bestand wordt opgenomen
op het medium in sleuf A en het
proxybestand wordt in segmenten
opgenomen op het medium in sleuf B.

3 Start de proxy-opname.

Het proxybestand wordt in segmenten
opgenomen met het opgegeven interval
en alle segmenten worden in de takenlijst
vastgelegd als overdrachtstaak.

[Opmerkingen]

e Wanneer Auto Upload (Proxy) niet is ingesteld op
Chunk, wordt geen proxy-opname in segmenten
uitgevoerd.

e Het medium in sleuf B is bedoeld voor het opnemen
van proxybestanden in segmenten, daarom worden
relay-opname en gelijktijdig opnemen op 2 sleuven
niet ondersteund.

Over het opgenomen bestand

De bestandsnaamextensie is ".mp4".
De tijdcode wordt tegelijkertijd opgenomen.

Opslagbestemming van het
opgenomen bestand

Het opgenomen bestand wordt opgeslagen in
de volgende map.

Opnamemedia Map naar pad

SDXC /PRIVATE/XDROOT/
GENERAL/PXTMP

CFexpress Type A /XDROOT/GENERAL/
PXTMP

Over de bestandsnaam

De bestandsnaam bestaat uit de clipnaam
die is opgenomen op de geheugenkaart, met
“S03" als achtervoegsel. De bestandsnaam
van een proxybestand dat is opgenomen

in segmenten voor uploaden bestaat

uit de originele bestandsnaam plus het
segmentnummer en “S03" als achtervoegsel.
Zie voor details over clipnamen Clip Name
Format (pagina 93) in het menu TC/Media
van het hoofdmenu.
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Filmen met het gewenste uiterlijk

Als de camcorder zich in Custom-modus
bevindt, kunt u wijzigingen aanbrengen in de
zwart, matrix en andere parameters om een
"look" (uiterlijk) te creéren gebaseerd op het
basisuiterlijk.

Matrix

Zwart

Uiterlijk —

Basisuiterlijk

U kunt ook snel een ander uiterlijk selecteren
door verschillende combinaties van
instellingen in scene-bestanden op te slaan.
De camcorder wordt geleverd met in totaal zes
presets voor uiterlijk.

Een uiterlijk selecteren

1 Druk op de multifunctionele regelaar als
het scherm shooting wordt weergegeven.

2 Selecteer het pictogram
(scénebestand).

3 Druk op de multifunctionele regelaar.

4 Selecteer het gewenste uiterlijk in het
menu en druk op de multifunctionele
regelaar.

[Tips]
e De volgende presets zijn standaard vanuit de fabriek
geconfigureerd.

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Scénebestand 1 S-Cinetone HLG Live

Scénebestand 2 Standard HLG Natural

Scénebestand 3 Still (Niet
geregistreerd)

Scénebestand 4 ITU709 (Niet

geregistreerd)

Scénebestanden
5t/m16

(Niet geregistreerd) (Niet
geregistreerd)

e U kunt ook een uiterlijk selecteren met Scene File
(pagina 14) op het scherm Main Status of Scene
File >Recall (pagina 90) in het menu Paint/Look
van het hoofdmenu. U kunt ook een presetuiterlijk
oproepen met Scene File >Preset Recall.

Een gewenst basisuiterlijk
importeren

U kunt een 3D LUT-bestand dat op een
computer of een ander apparaat is gemaakt,
importeren als basisuiterlijk vanaf een
geheugenkaart of clouddienst. Er kunnen
maximaal 16 bestanden worden geimporteerd.
e Bestandsindeling: CUBE-bestand (*.cube)
voor een 17-punt of 33-punt 3D LUT
gemaakt met Catalyst Browse, RAW Viewer,
of DaVinci Resolve* (van Blackmagic Design

Pty. Ltd.).
* Gecontroleerd met Resolve V9.0, V10.0 en V11.0.

o |Invoerkleurbereik/Gamma: S-Gamut3.
Cine/S-Log3 of S-Gamut3/S-Log3

Importeren vanaf een geheugenkaart

U kunt een 3D LUT-bestand importeren vanaf
een geheugenkaart.

1 Sla het 3D LUT-bestand op de computer of
andere apparaat in de gespecificeerde
map of het opnamemedium op.

Opnamemedia Map naar pad

SDXC /PRIVATE/SONY/PRO/LUT/
CFexpress /SONY/PRO/LUT/

Type A

2 Plaats het opnamemedium waarop 3D
LUT-bestanden zijn opgeslagen in de
kaartsleuf CFexpress Type A/SD Card (B).

3 Selecteer Base Look >Import from
Media(B) (pagina 90) in het menu
Paint/Look van het hoofdmenu.

4 Selecteer een importbestemming.

5 Selecteer een 3D LUT-bestand om te
importeren.
Volg de instructies op het scherm. De
camcorder behandelt een 3D LUT-bestand
als een basisuiterlijk.

6 Selecteer het geimporteerde 3D LUT-
bestand met Base Look >Select
(pagina 90) in het menu Paint/Look van
het hoofdmenu.

7 Configureer Base Look >Input en Output
(pagina 90) in het menu Paint/Look van
het hoofdmenu om de attributen aan te
passen aan het geimporteerde 3D LUT-
bestand.

Importeren vanuit een clouddienst

U kunt een 3D LUT-bestand importeren vanuit
een clouddienst.

Maak verbinding met het apparaat vanuit
de smartphone-app “C3 Portal App”
(pagina 67).

2 Selecteer Base Look >Import from
Cloud(Private) of Import from
Cloud(Share) (pagina 90) in het menu
Paint/Look van het hoofdmenu.

3 Selecteer een importbestemming.

4 Selecteer een 3D LUT-bestand om te
importeren.
Volg de instructies op het scherm. De
camcorder behandelt een 3D LUT-bestand
als een basisuiterlijk.

5 Selecteer het geimporteerde 3D LUT-
bestand met Base Look >Select
(pagina 90) in het menu Paint/Look van
het hoofdmenu.
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6 Configureer Base Look >Input en Output
(pagina 90) in het menu Paint/Look van
het hoofdmenu om de attributen aan te
passen aan het geimporteerde 3D LUT-
bestand.

Aanpassen voor onderbelichting

Als er een tendens voor onderbelichting is als
automatische belichting is geselecteerd bij
gebruik van het geimporteerde basisuiterlijk,
pas dan Base Look >AE Level Offset

(pagina 90) in het menu Paint/Look aan.

[Opmerkingen]

e Het zojuist geimporteerde 3D LUT-bestand verandert
het beeld niet. Laad het geimporteerde 3D LUT-
bestand met Base Look >Select (pagina 90) in het
menu Paint/Look van het hoofdmenu.

e Als Input niet correct is ingesteld, wordt het juiste
uiterlijk niet bereikt.

e De instellingen van de menu-onderdelen Input,
Output en AE Level Offset worden toegepast op
het geselecteerde basisuiterlijk met Select. Als er
meerdere 3D LUT-bestanden zijn geimporteerd,
selecteer dan Select voor elk 3D LUT-bestand en
configureer Input, Output en AE Level Offset voor elk
bestand afzonderlijk.

e De geconfigureerde instellingen voor Input, Output
en AE Level Offset worden voor elk 3D LUT-bestand
opgeslagen.

e De basisuiterlijk/LUT selectie-opties voor
geimporteerde 3D LUT-bestanden zijn gebruikelijk
voor SDR(BT.709)/HDR(HLG)/Cine El-modi, maar
kleurbereik- en gammaconversie worden niet
uitgevoerd volgens deze modi.

e 3D LUT-bestanden worden niet gewist als All Reset >
Reset wordt uitgevoerd in het menu Maintenance van

het hoofdmenu.

Een uiterlijk aanpassen

U kunt het uiterlijk aanpassen gebaseerd op
het basisuiterlijk met de Matrix en andere
configuratie-onderdelen in het menu Paint/
Look van het hoofdmenu. Zie voor details over
elk configuratieonderdeel pagina 90.

Sluit uw camcorder aan op een tv of monitor
en pas de beeldkwaliteit aan terwijl u het
beeld bekijkt op de tv of het monitorscherm.
[Opmerking]

Als u een 3D LUT-bestand importeert en op het beeld
toepast, wordt het gewenste beeld dat in het 3D
LUT-bestand is gedefinieerd niet bereikt als Matrix en
andere instellingen dan die van het basisbeeld in het
menu Paint/Look zijn gewijzigd. U kunt alle aangepaste
instellingen resetten met Reset Paint Settings >Reset
without Base Look (pagina 90) in het menu Paint/

Look van het hoofdmenu.

Een uiterlijk opslaan

U kunt het huidige uiterlijk opslaan als een
scene-bestand in het interne geheugen met
Scene File >Store (pagina 90) in het menu
Paint/Look van het hoofdmenu.

U kunt snel opslaan met handelingen in het
directmenu vanaf het filmscherm.

[Opmerkingen]

e Als u een ander uiterlijk selecteert zonder het huidige
uiterlijk op te slaan, wordt het huidige uiterlijk
verworpen.

e Scénebestanden worden niet gewist als All Reset >
Reset (pagina 107) wordt uitgevoerd in het menu
Maintenance van het hoofdmenu.

[Tip]

U kunt de preset scene-bestanden overschrijven.

Om een preset scene-bestand te herstellen, laadt u
het uiterlijk dat moet worden hersteld met Scene File
>Preset Recall (pagina 90) in het menu Paint/Look
van het hoofdmenu en slaat u de scene vervolgens op
met Scene File >Store.

Een opgeslagen uiterlijk verwijderen

U kunt een scene-bestand verwijderen dat
in het interne geheugen is opgeslagen met
Scene File >Delete (pagina 90) in het menu
Paint/Look van het hoofdmenu.

[Tip]

Na wissen wordt het niet langer weergegeven in het
directmenu.

Een basisuiterlijk verwijderen

U kunt een geimporteerd 3D LUT-bestand
verwijderen met Base Look >Delete

(pagina 90) in het menu Paint/Look van het
hoofdmenu.

U kunt alle geimporteerde 3D LUT-bestanden
verwijderen met Base Look >Delete All
(pagina 90) in het menu Paint/Look van het
hoofdmenu.

[Opmerkingen]

e Controleer voor het verwijderen of het basisuiterlijk
niet wordt gebruikt in een scene-bestand. Als een
basisuiterlijk wordt verwijderd dat in gebruik is, wordt
het uiterlijk van de betreffende scene-bestanden
incorrect.

e Geimporteerde 3D LUT-bestanden worden niet gewist
als All Reset >Reset (pagina 107) wordt geselecteerd
in het menu Maintenance.

e Een verwijderd basisuiterlijk kan niet langer
worden gebruikt als een LUT in de modus Cine El
(pagina 58).
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Filmen met uiterlijkaanpassing in postproductie

Door de camcorder in Cine El-modus te
gebruiken en gradaties gelijkmatig op te
nemen van donkere gebieden naar lichte
gebieden, kunt u fijnaanpassingen maken,
zoals het lokaal herstellen van de gradaties
van donkere gebieden en lichte gebieden, in
postproductie.

Echter, bij het bekijken van de opgenomen
beelden op een conventionele monitor

is het algehele contrast laag, waardoor
scherpstellings- en belichtingsaanpassingen
moeilijk worden.

U kunt een LUT toepassen op een
monitordoel op de camcorder om te helpen
bij verschillende aanpassingen tijdens het
filmen. U kunt ook een LUT toepassen op de
afspeelvideo om het voltooide resultaat te
controleren.

LUTs worden toegepast door de volgende
systemen. Maar er kan slechts één LUT
worden toegepast.

e SDI-uitgang en HDMI-uitgang

e Zoeker en proxy-beelden, streaming

¢ \Video opgenomen op opnamemedia

Een LUT toepassen op het
zoekerbeeld

1 Druk op de knop MENU om het scherm
Monitoring Status weer te geven.

2 Selecteer de kolom Gamut/Gamma in de
rij VF.

=@Monitoring 5/13]
Signal Info.Disp. Gamut/Gamma

SDI 1920x1080P(Lvl A) ||Off [SGSC/SLOQS

HDMI 11920x1080P On SG3C/SLog3

Stream Off [MLUT

3 MLUT

Base Look / LUT Gamma Disp. Assist
Off

s709

3 Selecteer On of Off.

[Opmerkingen]

e Deinstelling LUT On/Off van VF wordt ook toegepast
op proxy file en streaming video.

e Gammaweergave-assistent is beschikbaar tijdens
gebruik van scherpstellingsvergroting.

[Tips]

e U kunt ook instellen met LUT On/Off >VF/Proxy/
Stream (pagina 81) in het menu Shooting van het
hoofdmenu.

e SDI/HDMI kan identiek aan VF worden ingesteld.

e \oor video op opnamemedia kunt u LUT On/Off
>Internal Rec (pagina 81) in het menu Shooting van
het hoofdmenu instellen.

Een LUT wijzigen

1 Druk op de knop MENU om het scherm
Monitoring Status weer te geven.

2 Selecteer het veld Base Look/LUT.

@ Monitoring 5/13

Signal Info.Disp. Gamut/Gamma

SDI 1920x1080P(Lvl A) ||Off [SGBC/SLOgS

HDMI {1920x1080P On SG3C/SLog3

Stream Off [MLUT

VF MLUT

Base Look / LUT Gamma Disp. Assist
Off

3 Selecteer de LUT in de basisuiterlijklijst die
moet worden toegepast.

[Tips]

e Het apparaat biedt s709, 709(800%) en S-Log3 als
vooraf ingestelde LUT's.

e Ukunt ook een 3D LUT-bestand importeren en
toepassen. Zie voor details “Een gewenst basisuiterlijk
importeren” (pagina 56) en “Een basisuiterlijk
verwijderen” (pagina 57).

e Het basisuiterlijk kan ook worden ingesteld met Base
Look >Select (pagina 90) in het menu Paint/Look
van het hoofdmenu.

De verdeling van donkere en lichte
gebieden in opgenomen video
wijzigen

U kunt de verdeling van donkere gebieden en
lichte gebieden wijzigen, bijvoorbeeld als u
prioriteit wilt geven aan de toon van donkere
gebieden boven lichte gebieden, door de
Exposure Index te wijzigen ten opzichte van
de basisgevoeligheid.

1 Pas een LUT toe op het zoekerbeeld
(pagina 58).

2 Druk op de knop MENU om het scherm
Camera Status weer te geven.

3 Stel de velden L/M/H van Eposure index
in.
De afzonderlijke instellingen worden
toegewezen aan de L/M/H-posities van
de schakelaar ISO/GAIN (pagina 5).

4 Selecteer de waarde voor Exposure index
die moet worden toegepast met de
schakelaar ISO/GAIN.

5 Pas de belichting van het zoekerbeeld op
de juiste manier aan.

[Opmerking]

Gammaweergave-assistent is beschikbaar tijdens
gebruik van scherpstellingsvergroting. De instelling
voor Exposure Index wordt niet toegepast op de
gammaweergave-assistent.

[Tips]

e De belichting kan ook worden aangepast met ISO/
Gain/El >Exposure Index (pagina 77) in het menu
Shooting van het hoofdmenu.

e De tweede numerieke waarde van de instelling
geeft aan hoeveel stappen helderheidinformatie zijn
toegewezen voor lichte gebieden (helderheid hoger
dan 18% grijs). Gebieden die lichter zijn dan dat, zijn
overbelicht.

Voorbeeld: In "400EI/5.0E" zijn 5,0 stappen
toegewezen aan de lichte zijde.

e U kunt dit ook als een leidraad gebruiken om de toon
van donkere en lichte gebieden tijdens het filmen
te controleren. Bijvoorbeeld, als de M-positie de
basisgevoeligheid is, L-positie is min 2 stappen en
H-positie is plus 2 stappen, kunt u controleren door
de ISO/GAIN om te schakelen. Vergeet niet terug te
gaan naar de M-positie na het controleren van de
belichting.
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RAW video opnemen

U kunt het RAW-video-uitgangssignaal van
de SDI OUT- of HDMI OUT-aansluiting van
de camcorder opnemen naar een externe
recorder die wordt ondersteund.

Opnemen vanaf de SDI OUT-
aansluiting

1 Sluit een externe RAW recorder aan op de
SDI OUT-aansluiting van de camcorder.

2 Stel de filmmodus in het scherm status
Project (pagina 15) of Base Setting
>Shooting Mode (pagina 83) in het
menu Project van het hoofdmenu in op
Cine EI

3 Stel de scanmodus (alleen FF) in met
Imager Scan op het scherm status Project
of Rec Format >Imager Scan Mode
(pagina 83) in het menu Project van het
hoofdmenu.

4 Stel een codec in die RAW ondersteunt
met het scherm status Project of Rec
Format >Codec (pagina 83) in het menu
Project van het hoofdmenu.

Als u RAW & XAVC-| selecteert, wordt
tegelijkertijd video naar de externe RAW-
recorder opgenomen en naar de
geheugenkaarten in de camcorder.

5 Stel de resolutie in met het scherm status
Project of Rec Format >RAW Output
Format (pagina 83) in het menu Project
van het hoofdmenu.

6 Controleer of de externe recorder is
ingeschakeld, en druk dan op de
opnameknop START/STOP op de
camcorder.

[Opmerking]
Als de opname is gestart op de externe recorder,
zonder gebruik te maken van de opnameknop

START/STOP op de camcorder, worden de clips
mogelijk niet goed opgenomen.

De ondersteunde RAW uitvoerindelingen
worden hieronder weergegeven.

Systeem-  Codec RAW Output
frequentie Format
59.94/ RAW 4096x2160
50/ 3840x2160
29.91/ RAW & XAVC-l  4096%2160
gg_/gg 3840x2160
24 RAW 4096x%2160
RAW & XAVC-I 4096x%2160

Opnemen vanaf de HDMI OUT-
aansluiting

1 Sluit een externe RAW recorder aan op de
HDMI OUT-aansluiting van de camcorder.

2 Stel de filmmodus in het scherm status
Project (pagina 15) of Base Setting
>Shooting Mode (pagina 83) in het
menu Project van het hoofdmenu in op
Cine EI.

3 Stel de scanmodus (alleen FF) in met
Imager Scan op het scherm status Project
of Rec Format >Imager Scan Mode
(pagina 83) in het menu Project van het
hoofdmenu.

4 Stel de codec in op RAW(HDMI) met het
scherm status Project of Rec Format >
Codec (pagina 83) in het menu Project
van het hoofdmenu.

Als u RAW(HDMI) & XAVC-I selecteert,
wordt tegelijkertijd video naar de externe
RAW-recorder opgenomen en naar de
geheugenkaarten in de camcorder.

5 Controleer of de externe recorder is
ingeschakeld, en druk dan op de
opnameknop START/STOP op de
camcorder.

[Opmerking]

Als de opname is gestart op de externe recorder, zonder

gebruik te maken van de opnameknop START/STOP

op de camcorder, worden de clips mogelijk niet goed
opgenomen.

De ondersteunde RAW uitvoerindelingen
worden hieronder weergegeven.

Systeem-  Codec RAW Output
frequentie Format
59.94/ RAW(HDMI) 4240x2392
50/ RAW(HDMI) &  4240x2392
29.97/ XAVC-|

25/

23.98

Indicator opnamestatus

Als Display On/Off (pagina 94) >RAW

Output Control Status in het menu Monitoring
van het hoofdmenu is ingesteld op On, wordt
de RAW-opnamestatus aangegeven door een
pictogram in de zoeker.

[Opmerking]

Het opnameregelsignaal wordt verzonden via de SDI
OUT-aansluiting van de camcorder, maar het is niet
mogelijk om de status van de externe recorder op te
vragen. Als gevolg hiervan kan de camcorder aangeven
dat RAW video-opname loopt als de externe recorder
eigenlijk niet opneemt. Controleer de indicator op de
externe recorder voor de correcte functioneringsstatus.

[Tip]
De instelling voor RAW Output Format wordt ook
weergegeven.

Slow & Quick Motion-opname

Als S&Q Motion >Setting in het menu
Shooting is op On ingesteld, wordt RAW

video opgenomen in de modus Slow & Quick
Motion.

Zie voor details over de ondersteunde
beeldsnelheden pagina 50.

[Opmerking]

Opnemen van Slow & Quick Motion vanaf de HDMI OUT-
aansluiting wordt niet ondersteund.
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Verbinding maken met andere apparaten via LAN

De camcorder kan verbinding maken met
smartphones, tablets en andere apparaten via
een LAN-verbinding.
Na het tot stand brengen van een LAN-
verbinding tussen een apparaat en de
camcorder is met de app “Content Browser
Mobile” het volgende mogelijk.
e Bediening op afstand
U kunt de camcorder bedienen vanaf een
smartphone of tablet die is verbonden met
de camcorder via een LAN.
e Bestandsoverdracht
U kunt een proxy-bestand (lage resolutie) of
een origineel bestand (hoge resolutie) dat
is opgenomen op een geheugenkaart in de
camcorder verzenden naar de server via een
LAN.
e Videocontrole
U kunt het camerabeeld of de afgespeelde
video van de camcorder volgen met de app
“Content Browser Mobile” op een apparaat.
[Opmerking]
Monitoren van de video wordt niet ondersteund bij de
volgende instellingen.
- Slow & Quick Motion-modus

- Systeemfrequentie 24
- Interval Rec-modus

Toepassing "Content Browser Mobile"

U kunt de camcorder op afstand bedienen

op het scherm van het apparaat terwijl u de
video van de camcorder bekijkt en u kunt de
instellingen van de camcorder configureren
met de toepassing "Content Browser Mobile".

Neem voor details over de app "Content Browser Mobile"
contact op met uw Sony verkoopvertegenwoordiging.

Gebruikersnaam en wachtwoord
instellen

Stel de gebruikersnaam en het wachtwoord
van de camcorder in om de netwerkfunctie te
gebruiken.

1 Stel Access Authentication >User Name
(pagina 103) in het menu Network van
het hoofdmenu in.

2 Stel Access Authentication >Input
Password (pagina 103) in het menu
Network van het hoofdmenu in.

[Tips]

e U kunt ook automatisch een wachtwoord laten
genereren. Voer Generate Password uit in plaats
van Input Password.

e De gebruikersnaam, het wachtwoord, de tekst en
de QR-code kunnen zichtbaar worden gemaakt
met Show Settings.

[Opmerking]
Let erop dat andere mensen de QR-code en het
wachtwoord niet kunnen zien.

Verbinding tot stand brengen in
draadloze LAN-toegangspuntmodus
De camcorder werkt als een toegangspunt en

maakt verbinding met een apparaat via een
draadloos LAN.

Smartphone/tablet

Verbinding maken met een NFC-
compatibel apparaat via één druk op de
knop

Met apparaten die NFC (verbinding via één
druk op de knop) ondersteunen kan via
herkenning op korte afstand (NFC) verbinding
worden gemaakt.

1 Open [Settings] op het apparaat, selecteer
[More] en plaats een vinkje in het
selectievakje NFC.

J et

|

NFC

2 Schakel de camcorder in.

3 Activeer de NFC-functie.
Houd (gedurende 3 seconden) een
toewijsbare knop ingedrukt die is
toegewezen aan NFC of selecteer Wireless
LAN >NFC in het menu Network om de
NFC verbindingsmodus te activeren.
De NFC-functie is alleen beschikbaar als
N op het scherm verschijnt.

4 Raak de camcorder aan met het apparaat.
Het apparaat maakt verbinding met de
camcorder en "Content Browser Mobile"
wordt gestart.

[Opmerkingen]

e Schakel ook eerst slaapmodus en
schermvergrendeling uit.

e Houd het apparaat stil en laat het contact maken
tot de app "Content Browser Mobile" start (1 tot
2 seconden).
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Verbinding maken met een WPS-
compatibel apparaat

Verbinding maken door invoeren van
een SSID en wachtwoord op een
apparaat

Verbinding maken met een

Verbinding maken met behulp
toegangspunt met behulp van WPS

van draadloos LAN in

Apparaten die WPS ondersteunen kunnen stationmodus

verbinding maken met behulp van WPS.

Als het toegangspunt compatibel is met de
WPS-functie, kunt u verbinding maken met het
toegangspunt met eenvoudige instellingen.
De camcorder maakt verbinding met een 1
bestaand toegangspunt op het draadloos LAN

U kunt de camcorderverbinding laten maken

1 selecteer Wireless LAN >Setting >Access met een ander apparaat door de SSID en het
Point Mode in het menu Network van het wachtwoord van de camcorder in te voeren.

hoofdmenu. 1

Schakel het toegangspunt in.

Selecteer Wireless LAN >Setting >Access

Selecteer Wireless LAN >WPS >Execute in
het menu Network van het hoofdmenu.

Open de netwerkinstellingen of wifi-
instellingen van het apparaat en schakel
wifi in.

Selecteer de SSID van de camcorder in de
SSID-lijst in Wi-Fi Network op het apparaat
en selecteer vervolgens WPS drukknop in
de opties van het apparaat dat moet
worden verbonden.

[Opmerkingen]

e De werkwijze verschilt, afhankelijk van het
apparaat.

e Controleer voor de SSID en het wachtwoord van
de camcorder AP Mode Settings >Camera SSID
& Password (pagina 103) in het menu Network
van het hoofdmenu.

5 Verbinding maken met de app Content

Browser Mobile.

[Tip]

U kunt de gegevens die nodig zijn om de camcorder
te verbinden bekijken met Access Authentication >
Show Settings (pagina 103) in het menu Network
van het hoofdmenu.

Point Mode in het menu Network van het
hoofdmenu.

Open de netwerkinstellingen of wifi-
instellingen van het apparaat en schakel
wifi in.

Breng de verbinding tussen het apparaat
en de camcorder tot stand door de SSID
van de camcorder te selecteren in de lijst
in Wi-Fi Network en het wachtwoord in te
voeren.

Controleer voor de SSID en het
wachtwoord van de camcorder AP Mode
Settings >Camera SSID & Password
(pagina 103) in het menu Network.
[Opmerking]

De werkwijze verschilt, afhankelijk van het
apparaat.

Verbinding maken met de app Content
Browser Mobile.

[Tip]

U kunt de gegevens die nodig zijn om de camcorder
te verbinden bekijken met Access Authentication >
Show Settings (pagina 103) in het menu Network
van het hoofdmenu.

als een client. De camcorder en het apparaat 2

maken verbinding via het toegangspunt.
De 10 toegangspunten waarmee het laatst

verbinding is gemaakt worden weergegeven

in de geschiedenis.

De verbindingsgeschiedenis wordt
opgeslagen in een ALL-bestand, maar
de toegangswachtwoorden worden niet

opgeslagen. Na het laden van het ALL-bestand

is bij het tot stand brengen van de volgende
verbinding wachtwoordinvoer vereist.

Smartphone/
tablet

Computer

Toegangspunt

[

Schakel de camcorder in.

Selecteer Wireless LAN >Setting > Station
Mode in het menu Network van het
hoofdmenu.

Selecteer ST Mode Settings >Camera
Remote Control (pagina 104) >Enable in
het menu Network van het hoofdmenu.

Selecteer Wireless LAN >WPS >Execute in
het menu Network van het hoofdmenu.

Druk op de WPS-knop op het
toegangspunt.

Raadpleeg voor details over de werking
van de WPS-knop de gebruiksaanwijzing
van het toegangspunt.

Als de verbinding is gelukt, geeft het
pictogram indicator netwerkstatus een
sterkte van 1 of hoger weer op het
zoekerscherm.

[Opmerking]

Als de verbinding mislukt, voer de stappen vanaf
stap 1 dan opnieuw uit.

Maak met het apparaat verbinding met
het toegangspunt.

Raadpleeg voor details over verbinden de
gebruiksaanwijzing van het apparaat.

Start de app “Content Browser Mobile” op
een apparaat en selecteer de camcorder.
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[Tip] Op Off instellen om het IP-adres [Tip] e Subnet Mask
U kunt de gegevens die nodig zijn om de camcorder handmatig aan de camcorder toe te U kunt de gegevens die nodig zijn om de camcorder Voer het subnetmasker in voor het
te verbinden bekijken met Access Authentication > wijzen te verbinden bekijken met Access Authentication > t
Show Settings (pagina 103) in het menu Network ’ Show Settings (pagina 103) in het menu Network appar.aa . . .
van het hoofdmenu. * IP Address van het hoofdmenu. Deze instelling is alleen beschikbaar als
Voer het IP-adres van het apparaat in. DHCP is ingesteld op Off.
T . Deze instelling is all beschikb | . T
Verbinding maken met de automatische Sze INSeing 15 aieen beschikbaarals  Handmatig verbinding maken door de * Gateway
DHCP is ingesteld op Off. Voer het adres in van de gateway.
detectiefunctie voor toegangspunten e Subnet Mask gegevens van het toegangspunt in te o ctelling i b
. Deze instelling is alleen beschikbaar als
Voer het subnetmasker in voor het voeren DHCP is ingesteld op Off.
1 Voer de stappen 1t/m 3 uit in “Verbinding appar_aat. L . e DNS Auto
ken met een toegangspunt met Deze instelling is alleen beschikbaar als ’| o PR Stelt in of DNS automatisch moet
ma gangsp DHCP is ingesteld op Off. Voer de stappen 1t/m 3 uit in “Verbinding

behulp van WPS" (pagina 61). worden verkregen.

e Gateway maken met een toegangspunt met NI

2 . Voer de gateway voor het toegangspunt behulp van WPS" (pagina 61). Als ditis ingesteld op On wordt het
Selecteer ST Mode Settings >Scan in DNS-adres automatisch verkregen. Deze
Networks (pagina 104) >Execute in het Deze instelling is alleen beschikbaar als 2 Selecteer ST Mode Settings >Manual ?n§telling is alleen beschikbaar als DHCP
menu Network van het hoofdmenu. DHCP is ingesteld op Off. Register (pagina 105) >Execute in het is ingesteld op On.
De camcorder start detectie van e DNS Auto menu Network van het hoofdmenu. ® Primary DNS Server
verbindingsbestemmingen. Stelt in of DNS automatisch moet Het netwerkdetailscherm (toegangspunt) Voer het adres in van de primaire DNS-
Mogelijke gevonden bestemmingen worden verkregen. verschijnt kort. server.
worden weergegeven in een lijst. Als dit is ingesteld op On wordt het Deze instelling is alleen beschikbaar als

3 _ . . ) !DNS—a_dre_s automatisch yerkregen. Deze 3 Configureer de volgende DNS Auto is ingesteld op Off.
Kies een bestemming uit de lijst. instelling is alleen beschikbaar als DHCP verbindingsinstellingen e Secondary DNS Server
Het netwerkdetailscherm (toegangspunt) is _ingesteld op On. e SSID ' Voer het adres in van de secondaire
verschijnt. De gesele-cteerde verbinding e Primary DNS Server Voer de SSID in voor het DNS-s.erver.. . .
wordt weergegeven in SSID. Voer de primaire DNS-server voor het Deze instelling is alleen beschikbaar als

verbindingstoegangspunt.

toegangspunt in. DNS Auto is ingesteld op Off.

) L : e Security
4 Selecteer Password en voer het BEZSeAIEi;eily?r? |:;2Fdez bgsﬁcchlkbaar als Geselecteerde versleutelingsmethode.

wachtwoord voor het toegangspunt in op o Secondary DNg Server p ot e Password 4 Selecteer na voltooiing Connect om

het wachtwoordinvoerscherm om Voer de secundaire DNS-server voor het Voer het wachtwoord in voor de verbinding te maken met het
verbinding te maken. . toegangspuntin. verbinding met het toegangspunt. toegangspunt.

Het s.ele-cteren van een .SSlD n de Deze instelling is alleen beschikbaar als e DHCP
verbindingsgeschiedenis configureert DNS Auto is ingesteld op Off. Stel DHCP in. 5 Maak met het apparaat verbinding met
automatisch de instellingen, waaronder Als dit is ingesteld op On wordt het het toegangspunt.

Isqf(:lvr\::'frx,\a,\’c%c;\r/\?c;ord i om naar het O selecteer na voltooiing Connect om IP-adres automatisch aan de camcorder Raadpleeg voor details over verbinden de

. verbinding te maken met het toegewezen. gebruiksaanwijzing van het apparaat.

?etwetrkdetallscherm (toegangspunt) toegangspunt. Op Off instellen om het IP-adres

erug te gaan. handmatig aan de camcorder toe te 6 Start de app “Content Browser Mobile” op

) [ Maak met het apparaat verbinding met wijzen. cen a
pparaat en selecteer de camcorder.
5 Configureer de volgende het toegangspunt. IP Address

-V%rg?gmgsmﬁe”mgen. Raadpleeg voor details over verbinden de Voer het IP-adres van het apparaat in. [UTLFL)J]nt de gegevens die nodig zijn om de camcorder
Stel DHCP in. gebruiksaanwijzing van het apparaat. Bazcepl?ss;[sll:S%;fdageegffeSChlkbaar als te verbinden bekijken met Access Authentication >
Als dit is ingesteld op On wordt het 8 ; o 9 p U Shovr\: Ste;tm?ds (pagina 103) in het menu Network
IP-adres automatisch aan de camcorder Start de app “Content Browser Mobile” op van het hoofdmenu.

toegewezen. een apparaat en selecteer de camcorder.
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Verbinding met

U kunt met de camcorder verbinding maken
met internet met behulp van USB-tethering,
bekabeld LAN of draadloos LAN.

Stel van tevoren de gebruikersnaam

en het wachtwoord van de camcorder

in (pagina 60).

Verbinding maken met USB-tethering

U kunt met het apparaat verbinding maken
met een smartphone via een USB-kabel en
vervolgens met de smartphone verbinding
maken met internet.

Smartphone-communicatie configureren

Schakel tethering-communicatie in op de
smartphone.

Raadpleeg voor details de gebruiksaanwijzing
van de smartphone.

Een smartphone op de camcorder
aansluiten

Sluit een USB-kabel aan op de USB-C-
aansluiting (pagina 7) van de camcorder
en sluit deze kabel vervolgens aan op de
smartphone.

[Opmerkingen]

e Sluit de smartphone alleen aan of koppel deze los als
de camcorder is uitgeschakeld.

e USB-tethering kan niet worden gebruikt als de
smartphone is verbonden via een USB-hub.

e USB-tethering kan niet worden gebruikt als een
computer is verbonden met de USB/multi-aansluiting
(pagina 7).

Verbinding maken met een netwerk

1 Schakel de camcorder in.

Internet

2 Stel Modem >Setting (pagina 105) in het
menu Network van het hoofdmenu in op
On.

Werking van de smartphone activeren

U kunt de camcorder op afstand bedienen
met de app “Content Browser Mobile” op een
smartphone die is aangesloten met een USB-
kabel.

1 Stel Modem >Camera Remote
Control (pagina 105) in op Enable in het
menu Network van het hoofdmenu.

2 Start de app “Content Browser Mobile” op

een smartphone en selecteer de
camcorder.

[Tip]

U kunt de gegevens die nodig zijn om de camcorder

te verbinden met de app Content Browser Mobile
bekijken met Access Authentication >Show
Settings (pagina 103) in het menu Network van
het hoofdmenu.

Verbinding maken behulp van een
LAN-kabel

Smartphone/
tablet

f=————\
-

Computer

U kunt verbinding maken met internet door de
bekabelde LAN-aansluiting van een bekabelde

LAN-adapter (optie) verbonden met de USB-
C-aansluiting (pagina 7) van de camcorder
met een LAN-kabel aan te sluiten op een wifi-
router (optie).

Wifi-router

L]

Smartphone/
tablet

Computer

Internet

| —

Wifi-router

&

Internet

Verbinding maken met behulp
van draadloze LAN-stationmodus
(wifi-stationmodus)

Adapter voor
bekabeld LAN

Smartphone/
tablet

Internet

U kunt met de camcorder verbinding met
het internet maken in wifi-stationmodus
door middel van een optionele wifi-router
of door wifi-tethering te gebruiken op een
smartphone.

Maak verbinding met de wifi-router of het
apparaat zoals beschreven in “Verbinding
maken met behulp van draadloos LAN in
stationmodus” (pagina 61).
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LAN-kabelverbindingen en instellingen
bekabeld LAN

1

Sluit een bekabelde LAN-adapter aan op
de USB-C-aansluiting van de camcorder.

Sluit de bekabelde LAN-aansluiting van de

bekabelde LAN-adapter aan op een
wifi-router met een LAN-kabel.

Schakel de camcorder in.

Stel Wired LAN >Setting (pagina 105) in
het menu Network van het hoofdmenu in
op On.

Configureer verbindingsinstellingen met
Wired LAN >Detail Settings (pagina 105)
in het menu Netwerk.

e DHCP

Stel DHCP in.

Als dit is ingesteld op On wordt het
IP-adres automatisch aan de camcorder
toegewezen.

Op Off instellen om het IP-adres
handmatig aan de camcorder toe te
wijzen.

e |P Address

Voer het IP-adres van het apparaat in.
Deze instelling is alleen beschikbaar als
DHCP is ingesteld op Off.

e Subnet Mask

Voer het subnetmasker in voor het
apparaat.

Deze instelling is alleen beschikbaar als
DHCP is ingesteld op Off.

e Gateway

Voer het adres in van de gateway.
Deze instelling is alleen beschikbaar als
DHCP is ingesteld op Off.

e DNS Auto
Stelt in of DNS automatisch moet
worden verkregen.
Als dit is ingesteld op On wordt het
DNS-adres automatisch verkregen. Deze
instelling is alleen beschikbaar als DHCP
is ingesteld op On.

e Primary DNS Server
Voer het adres in van de primaire DNS-
server.
Deze instelling is alleen beschikbaar als
DNS Auto is ingesteld op Off.

e Secondary DNS Server
Voer het adres in van de secondaire
DNS-server.
Deze instelling is alleen beschikbaar als
DNS Auto is ingesteld op Off.

6 Klik na voltooiing op Set om de
instellingen toe te passen.

[Opmerkingen]

e Selecteer altijd Set naar het wijzigen van
verbindingsinstellingen. De instellingen worden niet
toegepast als Set niet is geselecteerd.

e Gebruik een bekabelde LAN-adapter van het type
USB C. Gebruik van een adapter die compatibel is
met Gigabit Ethernet wordt geadviseerd. Correcte
werking met alle apparaten kan echter niet worden
gegarandeerd.

e Een bekabelde USB-LAN-adapter (optie) kan niet
worden gebruikt als een computer is verbonden met
de USB/multi-aansluiting (pagina 7).

e De ingebouwde wifi-communicatiefunctie kan
worden beinvloed, afhankelijk van het model van de
bekabelde LAN-adapter (optie).

Bediening met een smartphone
inschakelen via een bekabeld LAN

Om de camcorder op afstand te kunnen
gebruiken met de app Content Browser Mobile
op een smartphone via wifi over een wifi-
router die is aangesloten via een bekabeld
LAN, stelt u Wired LAN >Camera Remote
Control (pagina 105) in het menu Network

van het hoofdmenu in op Enable.
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Bestanden uploaden

U kunt een proxy-bestand of een origineel
bestand dat is opgenomen op de camcorder
uploaden naar een server op internet, of
een server op een lokaal netwerk, via een
smartphone of toegangspunt.

Voorbereidingen

Verbinding maken met een netwerk

Breng verbinding van de camcorder met
internet of een lokaal netwerk tot stand zoals
beschreven in “Verbinding met internet”
(pagina 63) of “Verbinding maken met
andere apparaten via LAN" (pagina 60).

Een bestemming van een
bestandsoverdracht registreren

Registreer eerst de server voor het uploaden.

1 Selecteer File Transfer >Server Settings1
(of Server Settings2, Server Settings3) in
het menu Network van het hoofdmenu.
Het configuratiescherm
overdrachtsbestemming verschijnt.

2 Stel alle items in op het
configuratiescherm
overdrachtsbestemming.
Display Name
Voer de naam van de server in die moet
worden weergegeven in de
overdrachtsbestemmingslijst.
Service
Geeft het servertype weer.
"FTP": FTP-server
Host Name
Voer het adres van de server in.

Port

Voer het poortnummer van de server in
waarmee verbinding moet worden
gemaakt.

User Name

Voer de gebruikersnaam in.

Password

Voer het wachtwoord in.

Passive Mode

Schakel passieve modus in of uit.

Destination Directory

Voer de naam van de map op de

bestemmingsserver in.

[Opmerkingen] 3

De originele bestanden worden gelipload naar
de map “Main” binnen de opgegeven map van
de overdrachtsbestemming.

e Tijdens bewerking geeft "[0" tekens aan die niet

kunnen worden gewijzigd. Als deze tekens in een
mapnaam worden gebruikt kan correcte werking
niet worden gegarandeerd.

Als u wilt bewerken, verwijder dan alle tekens en
voer opnieuw een waarde in.

e Als er voor de Destination Directory op de

bestemmingsserver tekens worden ingevoerd die

ongeldig zijn, worden bestanden verzonden naar

de hoofdmap van de gebruiker. Welke tekens

ongeldig zijn verschilt, afhankelijk van de server.
Using Secure Protocol

Stel in of veilig FTP-uploaden moet

worden gebruikt.

Root Certificate
Laad/wis een certificaat.

® |oad

Selecteer Set in stap 3 om een CA-
certificaat te importeren.

Het certificaat dat moet worden geladen moet
de PEM-indeling hebben met de bestandsnaam
"certification.pem”, en moet worden opgeslagen
in de hoofdmap van de geheugenkaart die is
geplaatst in de CFexpress Type A/SD-kaartsleuf
(B).

e Clear

Selecteer Set in step 3 om een CA-
certificaat te wissen.

e None

Geen certificaat laden of wissen.

[Opmerkingen]

e Stel de klok van de camcorder in op de juiste tijd,
alvorens een CA-certificaat te importeren.

e Bij opnemen in XAVC-| 4096x2160P/
3840x2160P 59.94/50P, kan Load niet worden
geselecteerd.

e Bij weinig stroom kan Load/Clear niet worden
geselecteerd voor een CA-certificaat.

Root Certificate Status

Geeft de laadstatus van het certificaat
weer.

Reset

Herstel de instellingen van Server Settings
naar de standaardwaarden.

Klik na voltooiing op Set om de
instellingen toe te passen.

Selecteer altijd Set na het wijzigen van de
instellingen. De instellingen worden niet
toegepast als Set niet is geselecteerd.

Een bestand selecteren en
uploaden

U kunt voor overdracht naar de server proxy-
bestanden of originele bestanden die zijn
opgenomen op geheugenkaarten selecteren.
[Opmerking]

Proxybestanden die zijn opgenomen in segmenten zijn
bestanden die bedoeld zijn voor automatisch uploaden.

Ze kunnen niet handmatig worden geselecteerd en
gelipload.

Een proxy-bestand op een
geheugenkaart uit het
pictogrammenscherm uploaden

1 Maak verbinding tussen de camcorder en
apparaat met een LAN-verbinding
(pagina 60).

2 Selecteer Transfer Clip (Proxy) >Select Clip
in het menu Thumbnail van het
hoofdmenu.

De weergave schakelt over van het
hoofdmenu naar het
pictogrammenscherm.

Clips kunnen worden verzonden vanuit
het pictogrammenscherm of het
pictogrammenscherm met gefilterde clips.

3 Selecteer de clip die u wilt verzenden en
druk op de toets MENU.
Er verschijn een bevestigingsscherm voor
de overdracht.
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4 Selecteer Execute.
Het proxy-bestand dat overeenkomt met
het geselecteerde bestand wordt
geregistreerd als een overdrachtsopdracht
en het uploaden begint.
Als de overdrachtsopdracht succesvol is
geregistreerd verschijnt het
resultaatscherm voor de overdracht.

5 Select OK.

Alle bestanden uploaden

Kies in stap 2 All Clips in plaats van Select Clip
om de proxy-bestanden te verzenden die
corresponderen met alle bestanden.

[Opmerking]
Er kunnen maximaal 200 bestanden worden verzonden.

Een origineel bestand op een
geheugenkaart vanuit het
pictogrammenscherm uploaden

[Opmerking]

De originele bestanden worden getipload naar
de map “Main” binnen de opgegeven map van de
overdrachtsbestemming.

1 Maak verbinding tussen de camcorder en
apparaat met een LAN-verbinding
(pagina 60).

2 Selecteer Transfer Clip >Select Clip in het
menu Thumbnail van het hoofdmenu.
De weergave schakelt over van het
hoofdmenu naar het
pictogrammenscherm.
Clips kunnen worden verzonden vanuit
het pictogrammenscherm of het
pictogrammenscherm met gefilterde clips.

3 Selecteer de clip die u wilt verzenden en
druk op de toets MENU.
Er verschijn een bevestigingsscherm voor
de overdracht.

4 Selecteer Execute.
Het geselecteerde bestand wordt
geregistreerd als een overdrachtsopdracht
en het uploaden begint.
Als de overdrachtsopdracht succesvol is
geregistreerd verschijnt het
resultaatscherm voor de overdracht.

5 Select OK.

Alle bestanden uploaden
Kies All Clips in plaats van Select Clip in stap 2
om alle bestanden te verzenden.

[Opmerking]
Er kunnen maximaal 200 bestanden worden verzonden.

De bestandsoverdracht controleren

U kunt de status van de bestandsoverdracht
controleren door selecteren van File Transfer
>View Job List (pagina 106) in het menu
Network van het hoofdmenu.

U kunt ook de status van bestandsoverdracht
controleren vanuit het scherm van de app
Content Browser Mobile.

[Tip]

Als File Transfer >Auto Upload (pagina 106) of Auto
Upload (Proxy) (pagina 106) in het menu Network

van het hoofdmenu is ingesteld op On en er een
netwerkverbinding bestaat, worden de originele
bestanden en proxy-bestanden automatisch gelipload
naar de server die is opgegeven bij Default Upload
Server (pagina 106) als de opname wordt beéindigd.
Als zowel de originele bestanden als de proxybestanden
zijn geconfigureerd voor automatisch uploaden,

heeft het automatisch uploaden van proxybestanden
voorrang.

[Opmerkingen]

e Er kunnen maximaal 200 overdrachtstaken worden
geregistreerd.

e De joblijst wordt bewaard als de camcorder wordt
uitgeschakeld, maar maximaal 10 minuten van de
laatste voortgangsinformatie kan verloren gaan als de
accuset wordt verwijderd of als de camcorder wordt
uitgeschakeld zonder dat de POWER-schakelaar eerst
op STANDBY wordt gezet.

e Opdrachten die zijn toegevoegd na het weergeven
van een lage-stroommelding.

e Als er een fout optreedt tijdens de
bestandsoverdracht, wordt de overdracht van een
clip met dezelfde naam als een overgedragen clip
mogelijk niet hervat, afhankelijk van de instellingen
en status van de bestemmingsserver voor overdracht.
Controleer in dit geval de instelling en status van de
transmissiebestemmingsserver.

Bestanden automatisch uploaden

Een origineel bestand automatisch
uploaden

Originele bestanden kunnen na afloop van de
opname worden gelUpload naar de opgegeven
server. Wilt u deze functie gebruiken, stel dan
File Transfer >Auto Upload (pagina 106) in op
Onin het menu Network van het hoofdmenu.

Een proxybestand automatisch
uploaden

Proxybestanden kunnen na afloop van de
opname worden gelUpload naar de opgegeven
server. Wilt u deze functie gebruiken, stel

dan File Transfer >Auto Upload (Proxy)

(pagina 106) in op On in het menu Network
van het hoofdmenu.

Als Auto Upload (Proxy) is ingesteld op

Chunk kunt u ook een proxybestand in
segmenten opnemen en in segmenten
uploaden naar een opgegeven server terwijl

het opnemen doorgaat. Het uploaden van
een proxybestand dat is opgenomen in
segmenten heeft voorrang boven andere
bestandsoverdrachten.

Zie voor details over configuratie “Een
proxybestand in segmenten opnemen en
uploaden” (pagina 55).

Uploaden met veilige FTP

U kunt bestanden uploaden met versleuteling
met behulp van FTPS in Explicit mode

(FTPES) voor de verbinding met de
bestemmingsbestandsserver.

Veilige FTP-overdracht instellen

Voor veilige FTP-overdracht zet u Using Secure
Protocol op de bestemmingsbestandsserver
op ON en importeert u een certificaat.

Zie voor details over configuratie “Een
bestemming van een bestandsoverdracht
registreren” (pagina 65).
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De app C3 Portal App gebruiken

U kunt gemakkelijk bestanden overbrengen

naar de C3 Portal-cloud door het apparaat te

koppelen met de smartphone-app “C3 Portal

App".

Maak eerst een C3 Portal-account en installeer

C3 Portal App op een smartphone.

Voor details over het maken van een C3 Portal-

clouddienstaccount neemt u contact op met

de systeembeheerder van uw organisatie.

[Opmerkingen]

e De dienst is misschien niet beschikbaar, afhankelijk
van de regio waar u verblijft.

e Voor details over het gebruik van de app C3 Portal
App raadpleegt u de Help-gids bij C3 Portal App.

Bestanden uploaden naar (3
Portal

1 Selecteer Setup for Mobile App >Setup

(pagina 93) in het menu Network.

Er verschijnt een bevestigingsscherm voor

onderdelen die automatisch worden

bijgewerkt.

De volgende instellingen in het menu

Network worden automatisch

geselecteerd.

e Wired LAN >Setting: Off

e Modem >Setting: On

e Modem >Camera Remote Control:
Enable

e Access Authentication >Input Password:
(automatisch gegenereerd indien niet
opgegeven)

2 Controleer de instellingen en selecteer
OK.
De configuratie begint. De melding “Now
changing” verschijnt terwijl de
configuratie bezig is.

Wanneer de configuratie klaar is,
verschijnt het volgende scherm in de
zoeker.

Setup for Mobile App

User Name
admin

Password
ac2ac2C5h

Model Name
ILME-FX6V

Serial Number

0000000000

Fingerprint
De volgende informatie voor
toegangsverificatie wordt weergegeven.
Gebruikersnaam, wachtwoord,
vingerafdruk, naam van camcordermodel,
serienummer

[Tip]

Dit scherm wordt niet uitgevoerd naar de video-

uitgang.

[Opmerking]
Let erop dat andere mensen het wachtwoord niet
kunnen zien en de QR-code niet kunnen kopiéren.

Start de app C3 Portal App op de
smartphone en meld u aan bij de
clouddienst.

Verbind de smartphone via een USB-kabel
met de USB-C-aansluiting van het
apparaat.

Schakel USB-tethering in op het scherm
van de smartphone.

Zie voor details over configuratie
“Verbinding maken met USB-tethering”
(pagina 63).

De bediening verschilt, afhankelijk van uw
smartphone. Raadpleeg de handleiding
van de smartphone.

Scan de QR-code die in de zoeker wordt
weergegeven volgens de aanwijzingen op
het scherm van C3 Portal App.

Installatie-informatie over
bestandsoverdracht wordt vanaf de
smartphone naar het apparaat verzonden
en de volgende melding verschijnt.

Network File received.
Load File?

|_Cancel JERNCIN

7 Select OK.
De installatie-informatie wordt geladen.
Wanneer de installatie-informatie is
geladen, verschijnt de melding “Network
File loaded.".
[Opmerkingen]
e De app C3 Portal App overschrijft de instelling File
Transfer (pagina 106) in het menu Network van het
apparaat.

e Root Certificate kan niet automatisch worden
ingesteld. Configureer dit handmatig.

Een origineel bestand uploaden

Stel File Transfer >Auto Upload (pagina 106)

in het menu Network in op On om uploaden
van originele bestanden naar het C3 Portal in
te schakelen.

Wanneer een opname wordt beéindigd, wordt
een bestand gelipload naar de locatie die is
gekoppeld aan uw C3 Portal-account.

Een proxybestand uploaden

Stel File Transfer >Auto Upload (Proxy)

(pagina 106) in het menu Network in op On
om uploaden van proxybestanden naar het C3
Portal in te schakelen.

Wanneer een opname wordt beéindigd, wordt
een bestand gelpload naar de locatie die is
gekoppeld aan uw C3 Portal-account.
Wanneer Auto Upload (Proxy) is ingesteld op
Chunk, wordt het proxybestand onderverdeeld
in segmenten en worden deze vanaf het
begin van de opname met vaste tussenpozen
gelipload. Zie voor details over configuratie

“Een proxybestand in segmenten opnemen en
uploaden” (pagina 55).

Willekeurig bestanden uploaden

Zie "Een bestand selecteren en uploaden”

(pagina 65).

[Tips]

e Bestanden die worden verzonden door het
apparaat worden gecached in C3 Portal App en
overgebracht naar het C3 Portal. De statusweergave
voor bestandsoverdracht op het apparaat geeft de
overdrachtsstatus naar C3 Portal App aan.

e Wanneer de bestandsoverdracht van het apparaat
naar C3 Portal App op de smartphone is voltooid,
kunt u het apparaat uitschakelen, maar let op dat
de bestandsoverdracht vanaf de smartphone nog
bezig kan zijn. Houd rekening met de resterende
batterijlading van de smartphone.

Overige functies die (3 Portal
gebruiken

3D LUT-bestanden beheren

U kunt 3D LUT-bestanden die zijn opgeslagen
in C3 Portal naar het apparaat importeren.
Zie "Importeren vanuit een clouddienst”
(pagina 56).

ALL-bestanden beheren

U kunt een ALL-bestand dat is gemaakt op
het apparaat opslaan in C3 Portal en een
ALL-bestand vanuit C3 Portal laden. Zie “Een
ALL-bestand opslaan naar een clouddienst”
(pagina 113) en “Een ALL-bestand laden van
een clouddienst” (pagina 114).
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Pictogrammenscherm

Als u op de knop THUMBNAIL (pagina 5) drukt, worden de clips die zijn opgenomen op de geheugenkaart weergegeven als pictogrammen op het scherm.

U kunt een clip op het pictogrammenscherm selecteren en het afspelen van die clip starten. Het afspeelbeeld kan worden weergegeven in de zoeker of op een externe monitor.
Nogmaals op de knop THUMBNAIL drukken sluit het pictogrammenscherm weer en gaat terug naar het camerabeeld.

[Opmerking]

Alleen de clips die zijn opgenomen in de momenteel geselecteerde opname-indeling worden weergegeven op het pictogrammenscherm. Als een verwachte opgenomen clip niet wordt weergegeven, controleer dan de opname-indeling. Let
hier speciaal op véér het formatteren (initialiseren) van media.

Schermindeling

Informatie over de clip op de cursorpositie wordt weergegeven aan de onderkant van het scherm.

Indicator momenteel geselecteerde geheugenkaart
(Er verschijnt een hangslot-pictogram als de card is
beveiligd.)
Clipnummer/totaal aantal clips

I
EO) ) I

Cursor (geel) ;

TCR00:00:00:15  TCR00:00:00:34
-

TCR 00:00:02:35

( | ) ( | ) ( | )
3 4 5
1. Pictogram (indexafbeelding) (pagina 99) >Thumbnail Caption in het 4. Speciale opname-informatie 6. Aanmaakdatum
Geeft de indexafbeelding van de clip weer. menu Thumbnail van het hoofdmenu. Geeft de opname-indeling alleen weer

Als een clip wordt opgenomen, wordt het als de clip is opgenomen in een speciale

S 2. Clipnaam
eerste frame automatisch ingesteld als Geeft de naam van de geselecteerde clip opnamemodus.
indexafbeelding. weer Voor Slow & Quick Motion-clips wordt
Clip/frame-informatie wordt weergegeven ) de beeldsnelheid aan de rechterkant
onder het pictogram. U kunt de weergegeven 3. Video-opname-indeling weergegeven.
informatie wijzigen met Customize View Geeft de bestandindeling van de 5. Clipduur

geselecteerde clip weer.
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Clips afspelen

Opgenomen clips afspelen

U kunt opgenomen clips afspelen als de
camcorder in opnamestand-by (Stby) staat.

Plaats de geheugenkaart om af te spelen.

2 Druk op de knop THUMBNAIL.

3 Gebruik de keuzeschakelaar
(pagina 7) of multifunctionele
regelaar (pagina 5) om de cursor te
verplaatsen naar het pictogram voor de
gewenste clip.

4 Druk op de toepassingsknop van de
keuzeschakelaar of multifunctionele
regelaar.

Afspelen begint vanaf het begin van de
geselecteerde clip.

Afspelen kan worden bediend met de

volgende knoppen.

Druk op de toepassingsknop van de
keuzeschakelaar of de multifunctionele
regelaar:
afspelen pauzeren.

Nogmaals indrukken om terug te gaan
naar normaal afspelen.

Druk op de linker/rechter knop van de
keuzeschakelaar:

Springt naar het begin van de clip of de
vorige/volgende clip.

De linker/rechter knop indrukken en
vasthouden:
vooruit/achteruit spoelen.

Na het loslaten van de knop wordt
normaal afspelen hervat.

Knop CANCEL/BACK:

Stopt afspelen en gaat terug naar de
modus opname-stand-by.

[Opmerkingen]

e Erkan zich een tijdelijke onderbreking van het beeld
of stilstaand beeld voordoen bij de overgang tussen
clips. U kunt de camcorder niet tegelijk gebruiken.

e Als u een clip selecteert in het pictogrammenscherm
en afspelen start, kan er zich een tijdelijke
onderbreking van het beeld bij de start van de
clip voordoen. Om het begin van de clip zonder
onderbreking te bekijken zet u de camcorder in de
modus afspelen, pauze, en gebruikt u de linker knop
van de keuzeschakelaar om naar het begin van de clip
terug te gaan. Start daarna het afspelen opnieuw.
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Clipfuncties

In het pictogrammenscherm kunt u de clips
bedienen of clipeigenschappen controleren in
het menu Thumbnail van het hoofdmenu.

Het menu Thumbnail (pagina 99) verschijnt
als u de knop MENU ingedrukt houdt en
Thumbnail selecteert.

Functies in het menu Thumbnail

Gebruik de keuzeschakelaar (pagina 7) of
de multifunctionele regelaar (pagina 5)
om een functie te selecteren, en druk
vervolgens op de toepassingsknop van de
keuzeschakelaar of de multifunctionele
regelaar.

Druk op de knop CANCEL/BACK (pagina 5)
om naar het vorige scherm te gaan.

[Opmerking]

Sommige onderdelen kunnen niet worden geselecteerd,

afhankelijk van de staat waarin het menu werd
weergegeven.

Menu-onderdelen voor
clipfuncties

Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip

Transfer Clip

Transfer Clip (Proxy)
Filter Clips

Customize View

Zie voor details over menu-onderdelen
voor clipfuncties het menu Thumbnail
(pagina 99).

(lipeigenschappen weergeven

Selecteer Display Clip Properties

(pagina 99) in het menu Thumbnail om het
scherm clipeigenschappen weer te geven.
Druk op de keuzeschakelaar links-rechts om
naar de vorige/volgende clip te springen.

Clipvlaggen toevoegen

U kunt clipvlaggen (OK-, NG- of KP-
markeringen) aan clips toevoegen om

de weergave te filteren op clips die zijn
gebaseerd op de clipvlaggen.

Selecteer het pictogram voor de clip waar
u een vlag aan wilt toevoegen en selecteer
vervolgens de clipvlag met Set Clip Flag
(pagina 99) in het menu Thumbnail van het
hoofdmenu.

Instelling Toegevoegde clipvlag
Add OK OK
Add NG NG
Add KEEP KP

[Tips]

e U kunt ook een toewijsbare knop gebruiken die is
toegewezen aan de clipvlagfunctie om clipvlaggen
toe te voegen (pagina 49).

e U kunt een OK-clipvlag (pagina 53) aan het
pictogram van de geselecteerde clip toevoegen door
op de knop Clip Flag (pagina 5) te drukken.

Weergeven van het gefilterde clip-
pictogrammenscherm

Selecteer Filter Clips (pagina 99) in het

menu Thumbnail van het hoofdmenu en
selecteer een type clipvlag om alleen de clips
met die specifieke vlag weer te geven.
Selecteer All om alle clips weer te geven.

[Tip]

Met de knop DISPLAY kunt u de filters ook
opeenvolgend doorlopen.

Clips verwijderen

U kunt clips van een geheugenkaart
verwijderen.
Selecteer Delete Clip >Select Clip of All Clips in
het menu Thumbnail van het hoofdmenu.
Select Clip:
verwijdert de geselecteerde clip. Er
kunnen meerdere clips tegelijk worden
geselecteerd.
All Clips:
verwijdert alle weergegeven clips.

Wijzigen van de op het
pictogrammenscherm weergegeven
informatie

U kunt de weergegeven clip/frame-informatie
onder het pictogram wijzigen.

Selecteer Customize View >Thumbnail Caption
in het menu Thumbnail van het hoofdmenu
en selecteer de informatie die moet worden
weergegeven.

Date Time:
geeft de datum en de tijd weer waarop de
clip is gemaakt en het laatst is gewijzigd.
Time Code:
geeft de tijdcode weer.
Duration:
geeft de duur van de clip weer.
Sequential Number:
geeft een opeenvolgend getal weer voor
elk pictogram.
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Configuratie en hiérarc

hie hoofdmenu

Houd de knop MENU ingedrukt om het i Project Base Settin Monitorin Output On/Off
hoofdmenu in de zoeker weer te geven en Hiérarchie hoofdmenu ! g 9 P
. o Rec Format Output Format
om diverse onderdelen te specificeren voor Cine El Setti o Dipl
] ine ettin utput Displa
filmen, opnemen en afspelen (het menu kan User Base Setting : 9 : p play
ook worden weergegeven op een externe (Fabrieks- = HDR Setting Display On/Off
monitor). Het hoofdmenu bestaat uit de instellingen) ocus - Simul Rec Marker
volgende menu’s. iﬁ‘?cl)\ﬂ(;g(;? Proxy Rec VF Setting
o I; Interval Rec Gamma Display Assist
Menuconfiquratie leu Rec Picture Cache Rec Peaking
9 | r;)xy |eF: SDI/HDMI Rec Control Zebra
n e.rva s Assignable Button Audio Audio Input
Menu User Assignable Button . . -
Bevat menu-onderdelen die zijn Assignable Dial Assignable Dial Audio Output
geconfigureerd door de gebruiker met g - - Multi Function Dial Thumbnail Display Clip Properties
Edit User Menu. Multi Function Dial User File Set Clip Flag
Menu Edit User All File Al Fil Lock/Unlock Cli
vanhet User-mentr oo ern Clip Name Format Fanlook  Scene Fie eleteclp
Menu Shooting Format Media Base Look Transfer Clip
Bevat instelli t betrekking tot i . - -
ﬁlemvznl-ns eliingen Mmet betrexking to \Z/FbSettlng Reset Paint Settings Transfer Clip (Proxy)
Menu Project ebra Black Filter Clips
Bevat basisinstellingen voor projecten. Zoom : Knee Customize View
Menu Paint/Look Menu Settings Detail Technical Color Bars
Bevat instellingen met betrekking tot Edit User Menu Add Item
beeldkwaliteit. - Matrix ND Dial
Menu TC/Media Customize Reset Multi Matrix Tally
Bevat instelli t betrekking tot i i
tidcodes en opnamemedia, >hooting oo/bain/E TC/Media Timecode HOLD Switch Setting
l\/Ienqu\/Ionitoring P . ND Filter TC Display Touch Operation
Bevat instellingen met betrekking tot Shutter Users Bit Rec Review
video-uitvoer en het zoekerscherm. Iris
Menu Audio AUto Exbosure HDMI TC Out Zoom
Bevat instellingen met betrekking tot - P Clip Name Format Handle Zoom
audio. White Update Media Menu Settings
Menu Thumbnail White Setting .
Bevat instellingen met betrekking tot Offset White Format Media Menu Page On/Off
weergave van pictogrammen. Fan Control
Menu Technical Focus Lens
Bevat instellingen voor technische i
onderdelen. ’ iﬁ?gﬂ(;t(;?? Video Light Set
Menu Network n APR

Bevat instellingen met betrekking tot
netwerken.
Menu Maintenance

Noise Suppression

Flicker Reduce

SteadyShot

Bevat apparaatinstellingen, zoals de klok
en taal.

Camera Battery Alarm

Camera DCIN Alarm
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Network

Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset

Maintenance

Language

Clock Set

All Reset

Hours Meter

Version
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Handelingen hoofdmenu

Houd de knop MENU ingedrukt om het
hoofdmenu in de zoeker weer te geven om
specifieke instellingen te maken (het menu

kan ook worden weergegeven op een externe

Menu-onderdelen instellen

Een reeks tekens invoeren

monitor).

Druk op de knoppen van het 8-richtings-D-

Als u een onderdeel selecteert waarvoor

Het menu vergrendelen en
ontgrendelen

Functies in het hoofdmenu

Knop MENU (pagina 5)

Indrukken en vasthouden om het
hoofdmenu weer te geven. Nogmaals
indrukken als het hoofdmenu wordt

weergegeven om het menu te verbergen.

Keuzeschakelaar (8-voudig D-pad en
toepassingsknop) (pagina 7)

Druk op de knoppen van het 8-richtings-
D-pad om de cursor omhoog/omlaag/
naar links/naar rechts te verplaatsen om
menu-onderdelen of instellingen te
selecteren.

Druk op de toepassingsknop van de
keuzeschakelaar om het geselecteerde
onderdeel toe te passen.

Multifunctionele regelaar (pagina 5)

Draai de multifunctionele regelaar om de
cursor omhoog/omlaag te verplaatsen
om menu-onderdelen of instellingen te
selecteren.

Druk op de multifunctionele regelaar om
het geselecteerde onderdeel toe te
passen.

Knop CANCEL/BACK (pagina 5)

Indrukken om naar het vorige menu terug
te gaan. Een wijziging die niet compleet is

wordt geannuleerd.

[Opmerkingen]

Het hoofdmenu kan niet worden bediend in de
modus scherpstellingsvergroting (pagina 37).
Sommige onderdelen kunnen niet worden
geselecteerd, afhankelijk van de staat waarin het
menu werd weergegeven.

pad of draai aan de multifunctionele regelaar
om de cursor naar het menu-onderdeel te
verplaatsen dat moet worden ingesteld.

Druk daarna op de toepassingsknop of de

multifunctionele regelaar om het onderdeel te

selecteren.

Het selectiegebied voor menu-onderdelen
geeft maximaal acht regels weer. Als alle
beschikbare opties voor een onderdeel niet
tegelijkertijd kunnen worden weergegeven,
verschuif dan het display door de cursor
omhoog en omlaag te verplaatsen.

Voor de subonderdelen met een groot
instelbereik (bijvoorbeeld -99 tot +99)
wordt het instelgebied niet weergegeven.
De huidige instelling wordt gemarkeerd om
aan te geven dat de waarde kan worden
gewijzigd.

Door [Execute] te selecteren voor een
functie wordt de betreffende functie
uitgevoerd.

Een onderdeel selecteren dat moet

worden bevestigd véor uitvoering,
verbergt het menu tijdelijk en geeft een
bevestigingsmelding weer. Controleer de
melding en kies of de functie moet worden
uitgevoerd of niet.

tekens moeten worden ingevoerd,
zoals een bestandsnaam, verschijnt het
tekeninvoerscherm.

All File:File ID

Kurokawa_Scene_001 a

Bbcdefgh.i

nopagqgr st

2 3

i k I m

uv wixy z

1 Druk op de knoppen van het 8-richtings-
D-pad of draai aan de multifunctionele
regelaar om een teken te selecteren en
pas vervolgens de instelling toe.

ABC: hoofdletters
abc: kleine letters
123: numerieke tekens
1#$: speciale tekens

2 Selecteer een teken van het gekozen
tekentype en pas vervolgens de instelling
toe.

De cursor gaat naar het volgende veld.

Space: voert een spatie in op de
cursorpositie.

«—/—: verplaatst de positie van de cursor.

BS: verwijdert het teken links van de cursor
(backspace).

3 Als u klaar bent selecteert u [Done] en
past u de instelling toe.
De tekenreeks is bevestigd en het
tekeninvoerscherm verdwijnt.

U kunt het hoofdmenu vergrendelen, zodat
alleen het menu User wordt weergegeven.
In deze situatie kunnen geen instellingen

worden gewijzigd met de statusschermen.

Het menu vergrendelen

1 Houd de multifunctionele regelaar
ingedrukt en houd ook de knop MENU
ingedrukt.

2 Selecteer Menu Settings >User Menu with
Lock in het menu Technical.

[Opmerking]
Als u alleen de knop MENU ingedrukt houdt om
het normale hoofdmenu weer te geven, wordt User
Menu Only weergegeven bij Menu Settings in het
menu Technical. Houd de multifunctionele regelaar
ingedrukt en houd ook de knop MENU ingedrukt om
User Menu with Lock op te roepen.

3 Stelin op On, en druk op de
toepassingsknop of multifunctionele
regelaar.

Het zoekerscherm schakelt over naar het
scherm voor invoer van de cijfercode.

4 Voer een willekeurig getal in.
Voer een viercijferig nummer in het bereik
van 0000 t/m 9999 in. De
standaardwaarde is 0000.
Voer een cijfer in en druk op de
toepassingsknop of de multifunctionele
regelaar om de cursor naar het volgende
cijfer te verplaatsen.
Als alle cijfers zijn ingevoerd, verplaats de
cursor dan naar SET.
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Druk op de toepassingsknop of de
multifunctionele regelaar.

Het onderdeel is toegepast.

Er verschijnt een bevestigingsmelding en
het scherm schakelt over naar weergave
van het menu User.

Het menu ontgrendelen

1

Houd de multifunctionele regelaar
ingedrukt en houd ook de knop MENU
ingedrukt.

Selecteer Menu Settings >User Menu with
Lock in het menu User.

[Opmerking]

Als u alleen de knop MENU ingedrukt houdt om
het normale hoofdmenu weer te geven, wordt User
Menu Only weergegeven bij Menu Settings in het
menu Technical. Houd de multifunctionele regelaar
ingedrukt en houd ook de knop MENU ingedrukt
om User Menu with Lock op te roepen.

Stel in op Off, en druk op de
toepassingsknop of multifunctionele
regelaar.

Het zoekerscherm schakelt over naar het
scherm voor invoer van de cijfercode.

Voer de cijfercode in die is gebruikt om
het menu te vergrendelen.

Voer een cijfer in en druk op de
toepassingsknop of de multifunctionele
regelaar om de cursor naar het volgende
cijfer te verplaatsen.

Als alle cijfers zijn ingevoerd, verplaats de
cursor dan naar SET.

Druk op de toepassingsknop of de
multifunctionele regelaar.

Het onderdeel is toegepast.

Als de ingevoerde cijfercode overeenkomt
met de cijfercode die werd gebruikt om

het menu te vergrendelen, wordt het

menu ontgrendeld en weer weergegeven.

[Opmerkingen]
e Als de ingevoerde cijfercode niet overeenkomt met

de cijfercode die werd gebruikt om het menu te
vergrendelen, wordt het menu niet ontgrendeld.
Het wordt geadviseerd om een notitie van de
cijfercode bij de hand te houden, voor het geval u
deze vergeet. Als u de cijfercode vergeet, neem dan
contact op met uw Sony servicevertegenwoordiger.
Als het menu wordt vergrendeld zonder dat
onderdelen uit het hoofdmenu in de volgende tabel
in het menu User worden geregistreerd, kunnen deze
functies niet worden toegewezen aan toewijsbare
knoppen.

Als deze functies zijn toegewezen aan toewijsbare
knoppen wordt de toewijsbare functie geforceerd
uitgeschakeld als het menu wordt vergrendeld.

Onderdeel
hoofdmenu

Selectie
toewijsbare knop

Onderdeel
hoofdmenu

Selectie
toewijsbare knop

Shooting >Focus >
Focus Area(AF-S)

Focus Area(AF-S)

Technical >Touch
Operation >Setting

Touch Operation

Shooting >Focus >
Face/Eye Detection AF

Face/Eye Detection
AF

Technical >Handle
Zoom >Setting

Handle Zoom

Shooting >Focus >
Push AF Mode

Push AF Mode

Network >Wireless LAN
>NFC

NFC

Shooting >S&Q Motion  S&Q Motion Network >File Transfer ~ Auto Upload (Proxy)
>Setting >Auto Upload (Proxy)
Shooting >SteadyShot  SteadyShot User User Menu

>Setting

Project >Picture Cache
Rec >Setting

Picture Cache Rec

Technical >Rec Review  Rec Review
Onderdeel Selectie >Setting
hoofdmenu toewijsbare knop Thumbnail >Set Clip Clip Flag OK
Shooting >ISO/Gain/El  Base I1SO/Sensitivity Flag >Add OK
>Base Sensitivity, Thumbnail >Set Clip Clip Flag NG
Shooting >ISO/Gain/El Flag >Add NG
>Base ISO Thumbnail >Set Clip Clip Flag Keep
Shooting >Auto AGC Flag >Add KEEP
Exposure >AGC Technical >Color Bars ~ Color Bars
- Auto ND Filter >Setting
Shooting >Iris >Bokeh Bokeh Control Monitoring >Display Lens Info
Control On/Off >Lens Info
Shooting >Auto Auto Shutter Monitoring >Display Video Signal
Exposure >Auto Shutter On/Off >Video Signal Monitor
Shooting >Auto Auto Exposure Level Monitor
Exposure >Level Monitoring >Marker Marker
Shooting >Auto Backlight >Setting
Exposure >Mode Monitoring >VF Setting VF Mode
Shooting >Auto Spotlight >Color Mode

Exposure >Mode

Shooting >White >
Preset White

Preset White Select

Monitoring >Gamma
Display Assist >Setting

Gamma Display
Assist

Shooting >Focus >
AF Transition Speed,
Shooting >Focus >
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > Focus Area

Focus Area

Monitoring >Peaking Peaking
>Setting

Monitoring >Zebra Zebra
>Setting

Audio >Audio Output Volume

>Volume
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Menu User

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.

User

Onderdeel Beschrijving

Base Setting Menu-onderdeel Project >Base Setting
Focus Menu-onderdeel Shooting >Focus

S&Q Motion Menu-onderdeel Shooting >S&Q Motion
LUT On/Off Menu-onderdeel Shooting >LUT On/Off
Simul Rec Menu-onderdeel Project >Simul Rec
Proxy Rec Menu-onderdeel Project >Proxy Rec
Interval Rec Menu-onderdeel Project >Interval Rec

Assignable Button

Menu-onderdeel Project >Assignable Button

Assignable Dial

Menu-onderdeel Project >Assignable Dial

Multi Function Dial

Menu-onderdeel Project >Multi Function Dial

All File

Menu-onderdeel Project >All File

Clip Name Format

Menu-onderdeel TC/Media >Clip Name Format

Format Media

Menu-onderdeel TC/Media >Format Media

VF Setting Menu-onderdeel Monitoring >VF Setting
Zebra Menu-onderdeel Monitoring >Zebra
Zoom Menu-onderdeel Technical >Zoom

Menu Settings

Menu-onderdeel Technical >Menu Settings

Edit User Menu

Geeft het menuscherm Edit User weer.

[Opmerking]

U kunt menu-onderdelen toevoegen en verwijderen in het menu User met behulp van het menu Edit User. Er kunnen

maximaal 20 onderdelen worden geconfigureerd.
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Menu Edit User

Het menu Edit User wordt weergegeven als bovenste niveau als Edit User Menu wordt

geselecteerd in het menu User.

Edit User
Onderdeel Instelling subonderdeel Beschrijving
Add Item Voegt een menu-onderdeel aan het

Een onderdeel aan het
menu User toevoegen

menu User toe.

Customize Reset
Reset de onderdelen in
het menu User

Herstelt de menu-onderdelen die
zijn geregistreerd in het menu User
naar de fabrieksinstellingen.

Het tijdens bewerking Delete
geselecteerde menu-

Wist het geregistreerde menu-
onderdeel uit het menu User.

onderdeel Move

Herschikt de geregistreerde menu-
onderdelen binnen het menu User.

Edit Sub ltem

Bewerkt (registreren/wissen) het
geregistreerde menu-subonderdeel
in het menu User.




7

6. Menuweergave en instellingen

Menu Shooting

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Shooting >ISO/Gain/El
Versterkingsinstellingen maken.

Shooting >ISO/Gain/El
Versterkingsinstellingen maken.

Onderdeel Instelling subonderdeel Beschrijving
Mode ISO/dB Selecteert de instellingsmodus voor
versterking.

ISO/Gain<H> Zie voor details over instellingen Stelt de presetwaarde voor <H> gain in.
"Instellingen ISO/Gain en
standaardwaarden” (pagina 108).

ISO/Gain<M> Zie voor details over instellingen Stelt de presetwaarde voor <M> gain in.
"Instellingen ISO/Gain en
standaardwaarden" (pagina 108).

ISO/Gain<L>  Zie voor details over instellingen Stelt de presetwaarde voor <L> gain in.
"Instellingen ISO/Gain en
standaardwaarden" (pagina 108).

Exposure Als Base ISO is ingesteld is op ISO 800: Stelt de <H> belichtingsindexwaarde in.

Index<H> 200El / 4.0E Alleen beschikbaar in de modus Cine El

250El /7 4.3E
320El / 4.7E
400EI / 5.0E
500EI / 5.3E
640El / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250El / 6.7E
1600El / 7.0E
2000El / 7.3E
2500El / 7.7E
3200El 7 8.0E
Als Base ISO is ingesteld is op ISO 12800:
3200El / 4.0E
4000EI /7 4.3E
5000El 7 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000E! / 6.7E
25600El / 7.0E
32000El / 7.3E
40000EI / 7.7E
51200EI / 8.0E

mode.

Onderdeel Instelling subonderdeel Beschrijving
Exposure (Dezelfde instellingen als Exposure Stelt de <M> belichtingsindexwaarde in.
Index<M> Index<H>)
Als Base ISO is ingesteld is op ISO 800:
1000EI / 6.3E
Als Base ISO is ingesteld is op ISO 12800:
16000EI / 6.3E
Exposure (Dezelfde instellingen als Exposure Stelt de <L> belichtingsindexwaarde in.
Index<L> Index<H>)
Als Base ISO is ingesteld is op ISO 800:
800EI / 6.0E
Als Base ISO is ingesteld is op ISO 12800:
12800EI / 6.0E
Shockless On / Off Schakelt de functie naadloze
Gain versterkingsomschakeling in of uit.
Base High / Low Stelt de basisgevoeligheid in voor de
Sensitivity modus Custom.
Base ISO 1SO 12800 /7 1SO 800 Stelt de basis-ISO-gevoeligheid in voor

de modus Cine El.

Shooting >ND Filter
Stelt de presetwaarden in voor het ND-filter.

Onderdeel Instelling subonderdeel Beschrijving

Preset1 1/4/1/8 /1/16 /1/32 /1/64 /1/128 Stelt de preset 1-waarde in voor het
ND-filter.

Preset2 1/4/1/8/1/16 /1/32 /1/64 / 1/128 Stelt de preset 2-waarde in voor het
ND-filter.

Preset3 1/4/1/8/1/16 /1/32/1/64 /1/128 Stelt de preset 3-waarde in voor het

ND-filter.

Shooting >Shutter
Stelt de elektronische sluiter in.

Onderdeel

Instelling subonderdeel

Beschrijving

Mode

Speed / Angle

Selecteert de werkmodus van de
elektronische sluiter.

Wordt gebruikt voor het duidelijk filmen
van snel bewegende objecten. Selecteert
de modus voor instelling van de
sluitertijd in seconden (Speed) of als een
sluiterhoek (Angle).




78 6. Menuweergave en instellingen: Menu Shooting

Shooting >Shutter
Stelt de elektronische sluiter in.

Shooting >Shutter
Stelt de elektronische sluiter in.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving

Shutter On / Off Stelt in of de belichtingstijd bij actieve ECS 23.99 t/m 8000 Stelt de ECS-frequentie in als Mode is
Speed Speed-modus de sluitertijd volgt of is Frequency De beschikbare instellingen variéren ingesteld op ECS.

On/Off ingesteld op volledige belichting. afhankelijk van de systeemfrequentie van

Shutter 64F t/m 1/8000 Stelt de sluitertijd in als Mode is ingesteld de geselecteerde opname-indeling.

Speed De beschikbare instellingen variéren op Speed. De standaardwaarden worden hieronder

afhankelijk van de systeemfrequentie van
de geselecteerde opname-indeling.
59.94P:
64F / 32F /16F / 8F / 7TF / 6F / 5F / 4F /
3F/2F/1/50/1/60 /1/100 /1/120 /
1/125 /7 1/250 /7 1/500 / 1/1000 /
1/2000 7/ 1/4000 / 1/8000
50P:
64F / 32F /16F / 8F / 7F / 6F / 5F / 4F /
3F/2F/1/50/1/60 /1/100 /1/120 /
1/125 /1/250 /1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
29.97P:
64F / 32F /16F / 8F / 7F / 6F / 5F / 4F /
3F/2F/1/30/1/40/1/50/1/60 /
1/100 /1/120 / 1/125 / 1/250 7 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
25P:
64F / 32F /16F / 8F / 7TF / 6F / 5F / 4F /
3F/2F/1/25/1/33/1/50/1/60 /
1/100 /1/120 7/ 1/125 7/ 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P:
64F / 32F /16F / 8F / 7F / 6F / 5F / 4F /
3F/2F/1/24/1/32/1/48 /1/50 /
1/60 /1/96 /1/100 /1/120 / 1/125 /
1/250 /1/500 /7 1/1000 / 1/2000 /
1/4000 / 1/8000

vermeld.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Shooting > Iris

Stelt functie-instellingen voor Bokeh Control in.

Onderdeel Instelling subonderdeel Beschrijving
Bokeh On / Off Schakelt de functie Bokeh Control in en
Control uit.

Shooting >Auto Exposure
Regelt de instellingen voor automatische belichtingsaanpassingen.

Shutter Angle

64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F / 2F /360.0° / 300.0° /

270.0° / 240.0° 7 216.0° / 210.0° /
180.0° /7 172.8° /150.0° / 144.0° /
120.0° 7 90.0° / 86.4° / 72.0° / 45.0° /
30.0°/22.5° /11.25° / 5.6°

Stelt de sluiterhoek in als Mode is
ingesteld op Angle.

ECS On/Off

On / Off

Schakelt de functie Extended Clear Scan
in of uit.

Onderdeel Instelling subonderdeel Beschrijving
Level +3.0/+2.75/+2.5/+2.25/+2.0 / +1.75 / Stelt het helderheidniveau in voor de
+1.5/+1.25/+.0/+0.75/+0.5/+0.25/ automatische gedetecteerde belichting.
+*0/-025/-05/-0.75/-1.0/-125/
-1.5/-175/-20/-225/-25/-275/
-3.0
Mode Backlight / Standard / Spotlight Stelt de werkmodus in van de auto-
belichtingsaanpassing.
Backlight:
Modus Backlight (modus voor minder
donker worden van een onderwerp
als het onderwerp met tegenlicht
wordt gefilmd)
Standard:
Standaardmodus
Spotlight:
Modus Spotlight (modus voor minder
overbelichting als het onderwerp
wordt verlicht door spotlights)
Speed -99 t/m +99 (x0) Stelt de aanpassingssnelheid in van auto-

belichtingsaanpassing.
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Shooting >Auto Exposure
Regelt de instellingen voor automatische belichtingsaanpassingen.

Shooting >White
Regelt de witbalansinstelling.

Onderdeel Instelling subonderdeel

Beschrijving

Preset White  2000K t/m 15000K (3200K)

Stelt de presetwaarde van de witbalans
in.

Onderdeel Instelling subonderdeel Beschrijving
AGC On / Off Schakelt de functie AGC (auto gain
control) in of uit.
AGC Limit Zie voor details over instellingen "AGC Stelt de maximale versterking van de
Limit-instellingen en standaardwaarden" functie AGC in.
(pagina 110).
AGC Point F2.8 /F4 / F5.6 Stelt de F-stopwaarde van het diafragma

in waar AGC-werking begint als de
functie AGC is ingesteld op On.

Auto Shutter

On / Off

Schakelt de automatische sluiterfunctie
in of uit.

Color Temp 2000K t/m 15000K (3200K)

<A>

Stelt de kleurtemperatuur van de
witbalans in, die wordt opgeslagen in
geheugen A.

[Opmerking]

Omdat Color Temp wordt beperkt tot 2000K
en 15000K tijdens R/B Gain-werking, kan de
correcte waarde voor Color Temp mogelijk
niet worden weergegeven voor de R/B Gain-
waarde.

Tint<A> -99 t/m +99 (0)

Stelt de tint van de witbalans in die wordt
opgeslagen in witgeheugen A.

[Opmerking]

Omdat Tint wordt beperkt tot £99 tijdens R/B
Gain-werking, kan de correcte waarde voor Tint
mogelijk niet worden weergegeven voor de
R/B Gain-waarde.

RGain<A>  -99.0 t/m +99.0 (+0.0)

Stelt de witbalans R-versterkingswaarde
in die wordt opgeslagen in geheugen A.

B Gain <A> -99.0 t/m +99.0 (x0.0)

Stelt de witbalans B-versterkingswaarde
in die wordt opgeslagen in geheugen A.

Color Temp 2000K t/m 15000K (3200K)

<B>

Stelt de kleurtemperatuur van de
witbalans in, die wordt opgeslagen in
geheugen B.

[Opmerking]

Omdat Color Temp wordt beperkt tot 2000K
en 15000K tijdens R/B Gain-werking, kan de
correcte waarde voor Color Temp mogelijk
niet worden weergegeven voor de R/B Gain-
waarde.

A.SHT Limit  1/100 /1/150 / 1/200 / 1/250 / 1/2000 Stelt de snelste sluitertijd in voor de
automatische sluiterfunctie.

A.SHT Point  F5.6/F8/F11/ F16 Stelt de F-stopwaarde van het diafragma
in waar de werking van de automatische
sluiterfunctie begint.

Clip High On / Off Schakelt de functie in of uit die de meest

light heldere gebieden negeert voor een
vlakkere respons bij hoge helderheid.

Detect 1/2/3/4/5/6/ Custom Stelt het lichtmetingsbereik voor

Window automatische belichtingsaanpassing in
op basis van de helderheid van het
onderwerp. (Niet beschikbaar als de
belichting handmatig wordt ingesteld)

Detect On / Off Schakelt de indicatie van de lichtmeting

Window in of uit.

Indication

Custom 40 t/m 999 (500) Stelt de breedte van het

Width lichtmetingsbereik in.

Custom 70 t/m 999 (500) Stelt de hoogte van het

Height lichtmetingsbereik in.

Custom H -479 t/m +479 (+0) Stelt de horizontale positie van het

Position lichtmetingsbereik in.

Custom V -464 t/m +464 (+0) Stelt de verticale positie van het

Position lichtmetingsbereik in.

Tint<B> -99 t/m +99 (£0)

Stelt de tint van de witbalans in die wordt
opgeslagen in witgeheugen B.

[Opmerking]

Omdat Tint wordt beperkt tot 99 tijdens R/B
Gain-werking, kan de correcte waarde voor Tint
mogelijk niet worden weergegeven voor de
R/B Gain-waarde.

RGain<B>  -99.0 t/m +99.0 (0.0)

Stelt de witbalans R-versterkingswaarde
in die wordt opgeslagen in geheugen B.

B Gain<B>  -99.0 t/m +99.0 (0.0)

Stelt de witbalans B-versterkingswaarde
in die wordt opgeslagen in geheugen B.
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Shooting >White Setting
Past de witbalansinstelling aan.

Shooting >Offset White
Regelt de offsetinstelling voor witbalans.

Onderdeel Instelling subonderdeel

Beschrijving

Offset Color  -99 t/m +99 (x0) Stelt de offset van de kleurtemperatuur

Temp<B> in, die aan de witbalans moet worden
toegevoegd in geheugen B als Offset
White <B> is ingesteld op On.

Offset -99 t/m +99 (x0) Stelt de offset van de tintwaarde in, die

Tint<B> aan de witbalans moet worden

toegevoegd in geheugen B als Offset
White <B> is ingesteld op On.

Offset White  On / Off
<ATW>

Selecteert of er wel (On) of niet (Off) een
offsetwaarde aan de ATW-witbalans
moet worden toegevoegd.

Onderdeel Instelling subonderdeel Beschrijving
Shockless off/1/2/3 Stelt de reactiesnelheid in van de
White witbalans als wordt overgeschakeld van
witbalansmodus.
Off: schakelt onmiddellijk.
11/m 3: hogere nummers schakelen
langzamer.
ATW Speed 1/72/3/74/5 Stelt de reactiesnelheid van de ATW-
modus in.
1: Snelste reactietijd
White Memory / ATW Selecteert de aanpassingsmodus van de
Switch<B> witbalans die is geselecteerd als de
schakelaar WHT BAL is ingesteld op B.
Filter White On / Off Schakelt de functie die het
Memory geheugengebied voor de witbalans voor

elk ND Filter instelt in of uit.
On: stelt het witbalansgeheugen voor elk
ND-Filter in.

[Tip]

In presetmodus zijn er vier instellingen
(CLEAR/1/2/3). In variabele modus zijn er
twee instellingen (CLEAR/On).

Off: stelt het witbalansgeheugen globaal
voor alle ND-Filters in.

Offset Color =99 t/m +99 (x0)

Stelt de offset van de kleurtemperatuur

Temp<ATW> in, die aan de ATW-witbalans moet
worden toegevoegd als Offset White
<ATW= is ingesteld op On.

Offset -99 t/m +99 (+0) Stelt de offset van de tintwaarde in, die

Tint<ATW> aan de ATW-witbalans moet worden

toegevoegd als Offset White <ATW> is
ingesteld op On.

Shooting >Focus
Regelt de scherpstelling.

Onderdeel Instelling subonderdeel

Beschrijving

Shooting >Offset White
Regelt de offsetinstelling voor witbalans.

Onderdeel Instelling subonderdeel

Beschrijving

Offset White  On / Off

Selecteert of er wel (On) of niet (Off) een

AF Transition 1(Slow)/2/3/4/5/6/7(Fast)
Speed

Stelt de snelheid in van de
scherpstellingsaandrijving als het
onderwerp verandert tijdens
automatische scherpstelling.

AF Subj. Shift 1(Locked On)/ 2/ 3/ 4 / 5(Responsive)
Sens.

Stelt de gevoeligheid in voor wijziging
van onderwerpscherpstelling tijdens
automatische scherpstelling.

<A> offsetwaarde aan de witbalans in
geheugen A moet worden toegevoegd.

Offset Color  -99 t/m +99 (x0) Stelt de offset van de kleurtemperatuur

Temp<A> in, die aan de witbalans moet worden
toegevoegd in geheugen A als Offset
White <A> is ingesteld op On.

Offset -99 t/m +99 (x0) Stelt de offset van de tintwaarde in, die

Tint<A> aan de witbalans moet worden

toegevoegd in geheugen A als Offset
White <A> is ingesteld op On.

Offset White  On / Off

<B>

Selecteert of er wel (On) of niet (Off) een
offsetwaarde aan de witbalans in
geheugen B moet worden toegevoegd.
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Shooting >Focus
Regelt de scherpstelling.

Shooting >S&Q Motion
Regelt de modusinstelling voor Slow & Quick Motion (pagina 50).

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Focus Area Wide / Zone / Flexible Spot Stelt het gebied in voor automatische Setting On / Off Schakelt de Slow & Quick motion-modus
scherpstelling en automatische in of uit.
scherpstelling door knop indrukken (AF) Als dit is ingesteld op On zijn de
(pagina 38). volgende functies uitgeschakeld.
Wide: ® Automatisch diafragma
de zoekt naar een onderwerp in hun ® Automatische scherpstelling
brede hoek van het beeld tijdens het Frame Rate  1fps t/m 60fps / 100fps / 120fps / 150fps /  Stelt de beeldsnelheid in voor het filmen
, scherpstellen. 180fps / 200fps / 240fps met Slow & Quick Motion.
one:
zoekt automatisch naar een I[DOpbmerrI:jst)g] instelli K
H H e beschikbare instellingen kunnen
scherps.t.elllngspunt binnen de variéren afhankelijk van de geselecteerde
gespeaﬂceerde zone. systeemfrequentie, codec en video-indeling.
Flexible Spot: g
stelt scherp op een specifieke plaats Shooting >LUT On/Off
in het beeld. Regelt LUT-instellingen.
Focus Area Flexible Spot Stelt het doelgebied in voor Onderdeel Instelling subonderdeel Beschrijving
(AF-S) scherpstelling door knop indrukken SDI/HDMI  MLUT On / MLUT Off Selecteert of er monitor LUT op de SDI-
(AF-S). en HDMI-uitvoervideo moet worden
Face/Eye Face/Eye Only AF / Face/Eye Priority AF /  Schakelt gezichtsherkenning voor AF in toegepast.
Detection AP Off of uit. VF/Proxy/ MLUT On / MLUT Off Selecteert of er monitor LUT op de
Push AF AF / Single-shot AF(AF-S) Stelt de automatische scherpstelmodus Stream zoeker, proxy, en stream-uitvoervideo
Mode door knop indrukken in tijdens moet worden toegepast.
handmatig scherpstellen. Internal Rec  MLUT On / MLUT Off Selecteert of er monitor LUT op de intern
Touch Tracking AF / Spot Focus Stelt de actie in die wordt uitgevoerd opgenomen video moet worden
Function in wanneer u op het aanraakscherm tikt toegepast.
MF tijdens handmatige scherpstelling. Shoofi Noise S ;
AF Assist On / Off Als dit op On is ingesteld kunt u tijdelijk L e

automatische scherpstelling opheffen en
handmatig scherpstellen.

Regelt de ruisonderdrukkingsinstellingen.

gelﬁr]wstellingen Setting(Custom) en Level(Custom) worden weerspiegeld in de instelling voor Target Display
(pagina 112).
Onderdeel Instelling subonderdeel Beschrijving
Setting On / Off Schakelt de functie ruisonderdrukking in
(Custom) of uit in de modus Custom.
Level Low / Mid / High Stelt de ruisonderdrukking in de modus
(Custom) Custom in.
Setting On / Off Schakelt de functie ruisonderdrukking in
(Cine EI) of uit in de modus Cine El.
Level Low / Mid / High Stelt het ruisonderdrukkingsniveau in de

(Cine EI)

modus Cine El in.




82

6. Menuweergave en instellingen: Menu Shooting

Shooting >Flicker Reduce

Regelt de instellingen voor flikkercorrectie.

Onderdeel Instelling subonderdeel

Beschrijving

Mode Auto / On / Off

Stelt de flikkercorrectiemodus is.

Frequency 50Hz / 60Hz

Stelt de frequentie van de stroombron
van de verlichting in die het flikkeren
veroorzaakt.

Shooting >SteadyShot

Regelt de beeldstabilisatie-instellingen.

Onderdeel Instelling subonderdeel

Beschrijving

Setting Active / Standard / Off

Stelt de functie beeldstabilisatie in.

[Opmerking]
Ingeschakeld als er een compatibel objectief is
bevestigd.
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Menu Project

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen. Project >Rec Format
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB). Regelt de instellingen voor opname-indeling.
Project >Base Setting Onderdeel Instelling subonderdeel Beschrijving
Regelt basisinstellingen. Video Format De beschikbare instellingen kunnen Stelt de beeldgrootte en bitsnelheid in.
Onderdeel Instelling subonderdeel Beschrijving variéren, afhankelijk van de instellingen
a . a voor Frequency en Codec.
iﬂh;)(;)etlng Custom / Cine El Regelt de opnamemodus (pagina 24). Frequency Codec Selectie-opties
Target SDR(BT.709) / HDR(HLG) Stelt de kleurruimte in van de opname/ 29.94 ﬁﬁw(/HDMI) B
Display uitvoer in de modus Custom.
RAW & 4096x2160P
Project >Rec Format XAVC-| I
Regelt de instellingen voor opname-indeling. 3840x2160P
Onderdeel Instelling subonderdeel Beschrijving EAXVX%?IMI) 3840x2160P
Frequency 59.94 /50/29.97 /25 /24 /23.98 Selecteert de systeemfrequentie. XAVC-| 4096x2160P
Imager Scan  FF / S35 Selecteert het imagerformaat. 3840x2160P
Mode _
Codec RAW / RAW & XAVC-1 / RAW(HDMI) / Stelt de clip-opname-/- 1920x1080P
RAW(HDMI) & XAVC-I / XAVC-1 / XAVC-L afspeelmoduscodec in. XAVC-L 3840x2160P
RAW Output De beschikbare instellingen kunnen Stelt de beeldgrootte van de RAW-uitvoer 1920x1080P 50
Format variéren, afhankelijk van de instellingen in. 1920x1080P 35
voor Frequency en Codec. . . [Opmerking] 50 RAW/ _
Frequency Codec Selectie-opties Als Codec is ingesteld op RAW & XAVC-I, RAW(HDMI)
schakelt de instelling voor Video Format
22}94/ RAW % synchroon over met de instellingen voor RAW RAW & 4096x2160P
o, 3840x2160 Output Format. XAVC 3840x2160P
25/ RAW & 4096x2160 RAW(HDMI)  3840x2160P
23.08 XAVC| 3840x2160 & XAVC-I
RAW(HDMI)  4240%2392 XAVC-1 4096x2160P
RAW(HDMI)  4240%2392 3840%2160P
& XAVC 1920x1080P
24 RAW 4096x2160 XAVC-L 3840x2160P
RAW & 4096x2160 1920x1080P 50

XAVC-| 11920x1080P 35
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Project >Rec Format Project >Rec Format
Regelt de instellingen voor opname-indeling. Regelt de instellingen voor opname-indeling.
Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Video Format 29.97 RAW/ - Video Format 23.98 RAW/ -
RAW(HDMI) RAW(HDMI)
RAW & 4096x2160P RAW & 4096x2160P
XAVCH 3840x2160P XAVCH 3840x2160P
RAW(HDMI)  3840x2160P RAW(HDMI)  3840x2160P
& XAVC-I & XAVC-|
XAVC-| 4096x2160P XAVC-| 4096x2160P
3840x2160P 3840x2160P
1920x1080P 1920x1080P
XAVC-L 3840x2160P XAVC-L 3840x2160P
1920x1080P 50 1920x1080P 50
1920x1080P 35 1920x1080P 35
25 RAW/ - 24 RAW/ -
RAW(HDMI) RAW(HDMI)
RAW & 4096x2160P RAW & 4096x2160P
XAVC-| 3840x2160P XAVC-|
RAW(HDMI)  3840x2160P RAW(HDMI)  3840x2160P
& XAVC-| & XAVC-|
XAVC-| 4096x2160P XAVCA 4096x2160P
3840x2160P Project >Cine El Setting
W Regelt de instellingen voor de modus Cine El.
XAVC-L 3840x2160P Onderdeel Instelling subonderdeel Beschrijving
m Color Gamut  S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Stelt het kleurbereik in de modus Cine El

n.

1920x1080P 35
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Project > HDR Setting
Stelt instellingen voor de HDR-modus in.

Project >Interval Rec

Regelt instellingen voor intervalopname (pagina 50).

Onderdeel Instelling subonderdeel

Beschrijving

VF SDR
Preview

On / Off

In HDR-modus schakelt dit de functie in
of uit die het beeld in de zoeker
converteert van HDR naar SDR wanneer
Gamma Display Assist is ingeschakeld.
[Tip]

Wanneer dit is ingesteld op On, wordt SDR
Gain toegepast op het beeld in de zoeker.

SDR Gain 0dB t/m -15dB (-6dB)

In HDR-modus stelt dit de instelling voor
SDR Gain in die wordt toegepast op de
zoeker wanneer VF SDR Preview is
ingesteld op On.

Project >Simul Rec

Regelt de instellingen voor simultane opnamemodus (pagina 52).

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de functie simultane opname in
of uit en stelt de doelmedia voor
opnamen in.

Rec Button Rec Button:[SlotA SlotB] Handle Rec Wijst de opnameknoppen in waarmee de

Set Button:[SlotA SlotB] / Rec Button:[SlotA]
Handle Rec Button:[SlotB] / Rec
Button:[SlotB] Handle Rec Button:[SlotA]

verschillende opnamemedia worden
bediend.

Project >Proxy Rec
Regelt de instellingen voor proxy-opname.

Onderdeel Instelling subonderdeel Beschrijving
Setting On / Off Schakelt intervalopname in of uit. (Als
deze modus op On wordt gezet, worden
alle andere speciale modi uitgeschakeld.)
Interval Time 1/2/3/4/5/6/7/8/9/10/15/ Stelt het interval in tussen opname in de
20/30/40/50(s) modus Interval Rec (als Interval Rec op
1/2/3/4/5/6/7/8/9/10/15/20/ On staat).
30/ 40 / 50 (min)
1/2/3/4/6/12/24(h)
Number of Tframe / 2frames / 3frames / 6frames / Stelt het aantal frames in dat per take
Frames 9frames / 12frames moet worden opgenomen in de modus
De beschikbare instellingen variéren Interval Rec (als Interval Rec op On staat).
afhankelijk van de framefrequentie van de
geselecteerde video-indeling.
59.94P/50P:
2frames / 6frames / 12frames
29.97P/25P/24P/23.98P:
1frame / 3frames / 6frames / 9frames
Pre-Lighting Off/2s/5s/10s Stelt het aantal seconden in dat het

videolicht aangaat, alvorens opname
start in de modus Interval Rec.

[Tip]

Alleen beschikbaar bij gebruik van de HVL-
LBPC (optie).

Project > Picture Cache Rec
Stelt de instellingen in voor de opnamemodus Picture Cache (pagina 51).

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt proxy-opname in of uit.
Audio CH1/CH2 / CH3/CH4 Selecteert het audiokanaal dat naar
Channel proxydata moet opnemen.

Chunk 30s / Tmin / 2min Selecteert het opname-interval voor

segmenten in voor proxybestanden.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de opnamemodus Picture Cache
in of uit.

Cache Size Short / Medium / Long / Max Stelt de tijd in voor het verzamelen van
beelden in het beeld-cachegeheugen
(opnametijd voor beeld-cache).

Cache Rec Geeft de tijd weer voor het verzamelen

Time van beelden in het beeld-

cachegeheugen (opnametijd voor
beeld-cache).
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Project >SDI/HDMI Rec Control
Regelt de bedieningsinstellingen voor SDI/HDMI-opname.

Project >Assignable Button
Stelt functietoewijzing aan toewijsbare knoppen in.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Stelt start/stop-bediening in van een <1>t/m <9>, Off / Base ISO/Sensitivity / AGC / Push Wijst functies aan toewijsbare knoppen
extern apparaat via het SDI/HDMI Focus Hold AGC / ND Filter Position / Auto ND Filter /  toe.
uitgangssignaal. Button Push Auto ND / Auto Iris / Push Auto Iris /  Base ISO/Sensitivity:

Off:
Geen afstandsbediening gebruiken.

SDI/HDMI Remote I/F:
Bediening van stop/start van een
extern aangesloten apparaat, als er
geen medium in de camcorder is
geplaatst. Niet gesynchroniseerd met
frame-nauwkeurigheid aan
camcordermedia.

Parallel Rec:
Bediening van stop/start van een
extern aangesloten apparaat, als er
een medium in de camcorder is
geplaatst. Gesynchroniseerd met
frame-nauwkeurigheid aan
camcordermedia.

[Opmerking]

Als het HDMI uitgangssignaal moet worden
gebruikt voor besturing, stel HDMI TC Out
>Setting (pagina 92) in het menu

TC/Media van het hoofdmenu dan in op On.

Bokeh Control / Auto Shutter / Auto
Exposure Level / Backlight / Spotlight /
Preset White Select / ATW / ATW Hold / AF
Speed/Sens. / Focus Setting / Focus Area /
Focus Area(AF-S) / Face/Eye Detection AF /
Push AF Mode / Push AF/Push MF / Focus
Hold / Focus Magnifier x3/x6 / Focus
Magnifier x3 / Focus Magnifier x6 / S&Q
Motion / SteadyShot / Rec / Picture Cache
Rec / Rec Review / Clip Flag OK / Clip Flag
NG / Clip Flag Keep / Color Bars / Tally
[Front] / DURATION/TC/U-BIT / Display /
Lens Info / Video Signal Monitor / Marker /
VF Adjust / VF Mode / Gamma Display
Assist / Peaking / Zebra / Volume /
Thumbnail / Touch Operation / Handle
Zoom / NFC / Auto Upload (Proxy) / Direct
Menu / User Menu / Menu

Schakelt de basisgevoeligheid van de
beeldsensor om.
AGC:
Schakelt de functie AGC in of uit.
Push AGC:
Schakelt de functie AGC in zolang de
knop wordt ingedrukt.
ND Filter Position:
Schakelt ND-filters om.
Auto ND Filter:
Schakelt de functie auto ND filter in
of uit.
Push Auto ND:
Schakelt de functie auto ND filter in
zolang de knop wordt ingedrukt.
Auto Iris:
Schakelt de diafragmafunctie in of
uit.
Push Auto Iris:
Schakelt de functie autodiafragma in
zolang de knop wordt ingedrukt.
Bokeh Control:
Schakelt de modus Bokeh Control in
en uit.
Auto Shutter:
Schakelt de automatische
sluiterfunctie in of uit.
Auto Exposure Level:
Opent of sluit het menu Auto
Exposure Level.
Backlight:
Schakelt over tussen Backlight en
Standard.
Spotlight:
Schakelt over tussen Spotlight en
Standard.
Preset White Select:
Schakelt de presetmodus van de
witbalanswaarde over.
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Project >Assignable Button

Stelt functietoewijzing aan toewijsbare knoppen in.

Project >Assignable Button

Stelt functietoewijzing aan toewijsbare knoppen in.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving

<1>t/m <9>, ATW: <1>t/m <9>, SteadyShot:

Focus Hold Schakelt de functie ATW in of uit. Focus Hold schakelt over tussen Active, Standard,
Button ATW Hold: Button en Off.

Pauzeert werking van de functie ATW.
AF Speed/Sens.:
Schakelt de AF-snelheidsinstelling en
gevoeligheid van de AF-
onderwerpverplaatsing om.
Focus Setting:
Stelt het scherpstellingsgebied in.
Focus Area:
Stelt het scherpstellingsgebied in
voor AF en push AF.
Focus Area(AF-S):
Stelt het scherpstellingsgebied in
voor scherpstelling per knopdruk
(AF-S).
Face/Eye Detection AF:
Schakelt de AF-instellingen voor
gezichts/oogherkenning om.
Push AF Mode:
Schakelt de modusinstelling voor
scherpstelling per knopdruk om.
Push AF/Push MF:
Activeert in de modus MF
scherpstelling de AF automatische
scherpstelling, zolang de knop wordt
ingedrukt.
Activeert MF in de modus AF
scherpstelling zolang de knop wordt
ingedrukt.
Focus Hold:
In de modus AF scherpstelling wordt
de scherpstelling gefixeerd, zolang
deze knop is ingedrukt.
Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6:
Schakelt de functie
scherpstellingsvergroting in of uit.
S&Q Motion:
Schakelt Slow & Quick Motion in of
uit.
Stelt de opnamebeeldsnelheid in bij
indrukken en vasthouden.

Rec:
start/stopt opname.
Picture Cache Rec:
Schakelt de opnamemodus Picture
Cache in of uit.
Rec Review:
Schakelt de functie Rec Review in of
uit.
Clip Flag OK:
Voert de functie Add OK uit.
Twee keer indrukken om de functie
Delete Clip Flag uit te voeren.
Clip Flag NG:
Voert de functie Add NG uit.
Twee keer indrukken om de functie
Delete Clip Flag uit te voeren.
Clip Flag Keep:
Voert de functie Add Keep uit.
Twee keer indrukken om de functie
Delete Clip Flag uit te voeren.
Color Bars:
Schakelt de kleurbalken in of uit.
Tally [Front]:
Schakelt de functie opnemen/tally
lamp/knipperen in of uit.
DURATION/TC/U-BIT:
Schakelt over tussen Time Code,
Users Bit, en Duration.
Display:
Schakelt de schermindicatoren in of
uit.
Lens Info:
Schakelt de scherptediepte-indicator
om.
Video Signal Monitor:
Schakelt de videosignaalmonitor om
(zoals een golfvormmonitor).
Marker:
Schakelt de markerfunctie in of uit.
VF Adjust:
Geeft de niveaubalken weer voor het
aanpassen van de helderheid van het
zoekerscherm.
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Project >Assignable Button

Stelt functietoewijzing aan toewijsbare knoppen in.

Project >Assignable Dial
Stelt functietoepassingen in voor de toewijsbare regelaar en stelt de draairichting in.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
<1>t/m <9>, VF Mode: Grip/Remote Off / I1ISO/Gain/El / ND Filter / IRIS / Wijst functies toe aan de toewijsbare
Focus Hold Schakelt de zoeker om tussen kleur Dial Auto Exposure Level / Audio Input Level /  regelaar van de greep.
Button en zwart-wit. Multi Function Dial ISO/Gain/El:
Gamma Display Assis't: Past de versterking of El aan.
Schakelt de functie _ ND Filter:
Peazir;:maweergave-a55|st om. Past het ND filter aan.
Schakelt de functie IRIS: o
beeldomtrekversterking in of uit. Past de iris aan.
Zebra: Auto Exposure Level:
Schakelt de functie Zebra-patroon in Past het niveau voor automatische
of uit. belichting aan.
Volume: Audio Input Level:
Regelt het monitoraudioniveau naar Past het audio-opnameniveau aan.
de hoofdtelefoonuitgang en Multi FunFtlon Dial: . .
ingebouwde Iuidspreker. Functioneert als een multifunctionele
Thumbnail: regelaar.
Opent of sluit het Grip Dial Normal / Opposite Stelt de draairichting in voor de
pictogrammenscherm. Direction toewijsbare regelaar van de handgreep.
Touch Operation: Normal: In normale richting draaien.
Schakelt aanraakbediening in of uit. Opposite: In tegenovergestelde richting
Handle Zoom: draaien.
Schakelt de zoombediening via de Handle Dial Off / ISO/Gain/El / ND Filter / IRIS / Auto  Wijst functies toe aan de toewijsbare
draaggreep in of uit. Exposure Level / Audio Input Level / Multi  regelaar van de draaggreep.
NFC: Function Dial ISO/Gain/El:
Voert de functie NFC uit. Past de versterking of El aan.
Auto Upload (Proxy): ND Filter:
Schakelt automatisch uploaden van Past het ND filter aan.
proxy-bestanden in of uit en stelt de IRIS:
segmentmodus in. Past de iris aan.
Direct Menu: Auto Exposure Level:
Opent of sluit het directmenu. Past het niveau voor automatische
User Menu: belichting aan.
Opent of sluit het menu User. Audio Input Level:
Menu: Past het audio-opnameniveau aan.
Opent of sluit het hoofdmenu. Multi Function Dial:
Functioneert als een multifunctionele
regelaar.
Handle Dial Normal / Opposite Stelt de draairichting in voor de
Direction toewijsbare regelaar van de draaggreep.

Normal: In normale richting draaien.
Opposite: In tegenovergestelde richting
draaien.
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Project >Multi Function Dial
Wijst functies toe aan de multifunctionele regelaar.

Project >All File

Regelt instellingen voor ALL-bestanden.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Default Off / IRIS / ISO/Gain/El / Auto Exposure Wijst de standaardfunctie toe aan de Load from Execute / Cancel Laadt instellingen voor ALL-bestanden
Function Level / Audio Input Level multifunctionele regelaar. Media(B) van een geheugenkaart die is geplaatst
IRIS: in een CFexpress Type A/SD-kaartsleuf
Past de iris aan. (B).
ISO/Gain/El: Execute: functie uitvoeren.
Past de versterking of El aan. Load from Execute / Cancel Laadt een gelipload ALL-bestand vanuit

Auto Exposure Level:
Past het niveau voor automatische
belichting aan.

Cloud(Private)

de C3 Portal-clouddienst (privé)
Execute: functie uitvoeren.

Audio | Level: Load from Execute / Cancel Laadt een geulpload ALL-bestand vanuit
udio n;;ut e\;e, : . Cloud(Share) de C3 Portal-clouddienst (gedeeld)
Past het audio-opnameniveau aan. Execute: functie uitvoeren.
Project >User File Save to Execute / Cancel Slaat instellingen voor ALL-bestanden
Regelt instellingen voor bewerkingen van gebruikersbestanden. Media(B) naar een geheugenkaart die is geplaatst
Onderdeel Instelling subonderdeel Beschrijving ig een CFexpress Type A/SD-kaartsleuf
Load from Execute / Cancel Laadt instellingen voor (Ex)écute' functie uitvoeren
Media(B) gebruikersbestanden van een — -
geheugenkaart die is geplaatst in een Save to Execute / Cancel Slaat instellingen voor ALL-bestanden op
CFexpress Type A/SD kaartsleuf (B). Cloud(Private) naar de C3 Portal-clouddienst (privé).
Execute: functie uitvoeren. Execute: functie uitvoeren.
Save to Execute / Cancel Slaat instellingen voor Save to Execute / Cancel Slaat instellingen voor ALL-bestanden-
Media(B) gebruikersbestanden van een Cloud(Share) bestand op naar de C3 Portal-clouddienst
geheugenkaart op die is geplaatst in een (gedeelq). o
CFexpress Type A/SD kaartsleuf (B). Execute: functie uitvoeren.
Execute: functie uitvoeren. File ID Kent een naam toe aan een bestand.
File ID Opent een scherm voor weergegeven/ Load Network On / Off Stelt in of er informatie voor instellingen
bewerken van de bestands-ID van Data voor het menu Network moet worden
gebruikersbestanden. geladen als Load from Media(B), Load
Load On / Off Stelt in of er aangepaste informatie voor from Cloud(Private) Of Load from
Customize het menu User moet worden geladen als Cloud(Share) wordt uitgevoerd.
Data Load from Media(B) wordt uitgevoerd.
Load White On / Off Stelt in of er informatie voor witbalans
Data moet worden geladen als Load from

Media(B) wordt uitgevoerd.
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Menu Paint/Look

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Paint/Look >Base Look
Regelt instellingen voor het basisuiterlijk.

Paint/Look >Scene File
Regelt instellingen voor scene-bestanden.

Onderdeel Instelling subonderdeel Beschrijving

Recall Laadt een scene-bestand dat is
opgeslagen in het interne geheugen en
past de instellingen toe als de huidige

beeldkwaliteitsinstellingen.

Store Slaat de huidige staat van de
beeldkwaliteit op als een scene-bestand

in het interne geheugen.

Onderdeel Instelling subonderdeel Beschrijving

Import from  Execute / Cancel Importeert een basisuiterlijk-bestand van

Media(B) een geheugenkaart die is geplaatst in een
CFexpress Type A/SD-kaartsleuf (B).
Execute: functie uitvoeren.

Import from  Execute / Cancel Importeert een geupload basisuiterlijk-

Cloud(Private)

bestand vanuit de C3 Portal-clouddienst
(privé).
Execute: functie uitvoeren.

Delete Verwijdert een scene-bestand dat is

opgeslagen in het interne geheugen.

Import from
Cloud(Share)

Execute / Cancel

Importeert een gelpload basisuiterlijk-
bestand vanuit de C3 Portal-clouddienst
(gedeeld).

Execute: functie uitvoeren.

Preset Recall Als Shooting Mode is ingesteld op Custom Past preset beeldkwaliteitsinstellingen
en Target Display is ingesteld op (niet overschrijfbaar) toe als de huidige
SDR(BT.709): beeldkwaliteitsinstellingen.

S-Cinetone / Standard / Still / ITU709
Als Shooting Mode is ingesteld op Custom
en Target Display is ingesteld op
HDR(HLG):

HLG Live / HLG Natural

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Stelt het invoerkleurbereik voor het
geselecteerde basisuiterlijk in.

Output BT.709 / HLG Stelt het uitvoerkleurbereik voor het
geselecteerde basisuiterlijk in.

AE Level OEV /1/3EV / 2/3EV /1EV / 4/3EV / Stelt de belichtingsreferentiewaarde voor

Offset 5/3EV / 2EV het geselecteerde basisuiterlijk in.

Paint/Look >Reset Paint Settings
Herstelt de instellingen voor het menu Paint/Look, met uitzondering van het basisuiterlijk.

Paint/Look >Base Look
Regelt instellingen voor het basisuiterlijk.

Onderdeel Instelling subonderdeel Beschrijving

Select Als Shooting Mode is ingesteld op Custom Selecteert een basisuiterlijk.
en Target Display is ingesteld op
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 /
User1 tot User16
Als Shooting Mode is ingesteld op Custom
en Target Display is ingesteld op
HDR(HLG):
HLG Live / HLG Natural / User1 tot
User16
Als Shooting Mode is ingesteld Cine El:
s709 / 709(800) / S-Log3 / User1 tot
User16

Onderdeel Instelling subonderdeel Beschrijving
Reset without Execute / Cancel Herstelt de instellingen voor het menu
Base Look Paint/Look, met uitzondering van het

basisuiterlijk.
Execute: functie uitvoeren.

Paint/Look >Black
Regelt de zwartinstellingen.

Onderdeel Instelling subonderdeel Beschrijving

Master Black -99.0 t/m +99.0 (x0.0) Stelt het masterniveau zwart in.

R Black -99.0 t/m +99.0 (x0.0) Stelt het zwartniveau voor R-signalen in.
B Black -99.0 t/m +99.0 (x0.0) Stelt het zwartniveau voor B-signalen in.

Delete Verwijdert het geselecteerde

basisuiterlijk.

Delete All Verwijdert alle basisuiterlijken.
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Paint/Look >Knee
Regelt kniecorrectie-instellingen.

Paint/Look >Matrix
Regelt matrix correctie-instellingen.

Onderdeel Instelling subonderdeel Beschrijving
Setting Als Target Display is ingesteld op Schakelt de kniecorrectiefunctie in of uit.
SDR(BT.709): [Tip]
On/ Off_ /== o Alleen ingeschakeld als Base Look >Select is
Als Target Display is ingesteld op ingesteld op Standard, ITU709, HLG Live of HLG
HDR(HLG): Natural.
On/ Off / ---
Auto Knee Als Target Display is ingesteld op Schakelt de functie auto knee in of uit.
SDR(BT.709): [Tip]
On/ Oﬁ_ /=== o Alleen ingeschakeld als de instelling voor
Als Target Display is ingesteld op kniecorrectie is ingesteld op On en Base
HDR(HLG): Look >Select is ingesteld op Standard of
On / Off / --- ITU709.
Point 75% t/m 109% (90%) Stelt het kniepunt in.
Slope -99 t/m +99 (x0) Stelt de compressieverhouding in.

Paint/Look >Detail
Regelt instellingen voor detailaanpassingen.

Onderdeel Instelling subonderdeel Beschrijving

User Matrix On / Off Schakelt de functie user matrix-correctie
in of uit.

User Matrix ~ -99 t/m +99 (+0) Past de kleurverzadiging van het totale

Level beeld aan.

User Matrix ~ -99 t/m +99 (+0) Past de kleurtoon (fase) van het totale

Phase beeld aan.

User Matrix -99 t/m +99 (+0) Stelt een door de gebruiker aangepaste

R-G R-G user matrix in.

User Matrix -99 t/m +99 (x0) Stelt een door de gebruiker aangepaste

R-B R-B user matrix in.

User Matrix -99 t/m +99 (x0) Stelt een door de gebruiker aangepaste

G-R G-R user matrix in.

User Matrix -99 t/m +99 (x0) Stelt een door de gebruiker aangepaste

G-B G-B user matrix in.

User Matrix ~ -99 t/m +99 (+0) Stelt een door de gebruiker aangepaste

B-R B-R user matrix in.

User Matrix ~ -99 t/m +99 (x0) Stelt een door de gebruiker aangepaste

B-G B-G user matrix in.

Paint/Look >Multi Matrix
Regelt multi matrix-correctie-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de functie multi matrix-correctie
in of uit.

Reset Execute / Cancel Reset de tint en verzadiging van alle
askleuren naar de standaardwaarden.

Axis B/B+/MG-/MG/MG+/R/R+/YL-/  Seleteert de as.

YL/YL+/G-/G/G+/CY/CY+/B-

Hue -99 t/m +99 (x0) Stelt de tint in van de voor multi matrix-
correctie gebruikte kleur.

Saturation -99 t/m +99 (x0) Stelt de verzadiging in van de voor multi

matrix-correctie gebruikte kleur.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de detailfunctie in of uit.

Level =7 t/m +7 (x0) Stelt het detailniveau in.

Manual On/ Off / --- Schakelt de functie handmatige

Setting detailaanpassing in of uit.

V/H Balance -2t/m +2(0) Stelt de balans in tussen verticaal (V) en
horizontaal (H) detail voor handmatige
detailaanpassing.

B/W Balance Typel/ Type2 / Type3 / Typed / Type5 Stelt de balans in tussen zwart (B) detail
voor gebieden met lage helderheid en
wit (W) detail voor gebieden met hoge
helderheid voor handmatige
detailaanpassingen.

Limit 0t/m7 Stelt het limietniveau in voor het detail
voor handmatige detailaanpassingen.

Crispening 0t/m7 Stelt het niveau in voor aanscherpen voor
handmatige detailaanpassingen.

High Light 0t/m4 Stelt het detailniveau in van heldere

Detail gebieden voor handmatige

detailaanpassingen.




92

6. Menuweergave en instellingen

Menu TC/Media

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

TC/Media >Users Bit
Regelt instellingen met betrekking tot user bits.

TC/Media >Timecode
Regelt tijdcode-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

Stelt de user bits in op een willekeurige
waarde.

Setting

TC/Media >HDMI TC Out
Regelt instellingen met betrekking tot tijdcode-uitvoer bij gebruik van HDMI.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Regelt of er tijJdcode naar apparaten voor
andere doeleinden moet worden

verzonden met HDMI.

Onderdeel Instelling subonderdeel Beschrijving
Mode Preset / Regen / Clock Stelt de uitvoermodus voor de tijdcode
in.

Preset:

Begint met uitvoeren vanaf een
presetwaarde.

Regen:

Begint met uitvoeren van de tijdcode
vanaf het eind van de vorige clip.

Clock:

Gebruikt de interne klok als tijdcode.
Run Rec Run / Free Run Rec Run: De tijdcode loopt alleen tijdens
opname.

Free Run: De tijdcode loopt altijd,
onafhankelijk van de
camcorderwerking.

Setting Stelt de tijdcode in op een willekeurige
waarde.

SET: stelt de waarde in.

Reset Execute / Cancel Reset de tijdcode naar 00:00:00:00.

Execute: functie uitvoeren.

TC Format DF / NDF Stelt de tijdcode-indeling in.

DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Regelt de instellingen voor weergave van de tijdgegevens.

Onderdeel Instelling subonderdeel Beschrijving

Display Select Timecode / Users Bit / Duration Schakelt de weergave van tijdgegevens

om.

TC/Media >Users Bit
Regelt instellingen met betrekking tot user bits.

Onderdeel Instelling subonderdeel Beschrijving

Stelt de modus voor user bits in.

Fix: Gebruikt een willekeurige vaste
waarde in user bits.

Time: gebruikt de huidige uren, minuten
en seconden in gebruikersbits.

Mode Fix / Time
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TC/Media >Clip Name Format
Regelt instellingen met betrekking tot naamgeving en verwijdering van clips.

TC/Media >Update Media
Updatet het beheerbestand op geheugenkaarten.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Title Prefix nnn_ (nnn is tenminste 3 cijfers van het Stelt het titelgedeelte (4 - 46 tekens) voor Media(A) Execute / Cancel Updatet het beheerbestand op de
serienummer) de clipnaamin. geheugenkaart in sleuf A.
Opent een invoerscherm voor Execute: functie uitvoeren.
tekenreeksen. Media(B) Execute / Cancel Updatet het beheerbestand op de

Schermopbouw invoerscherm

tekenreeksen

Tekenselectiegebied (3 regels):
Selecteert de tekens die in het vak
Title Prefix moeten worden
ingevoerd.
1#$%()+.-.;=@[ ]*_~0123456789
abcdefghijkimnopqgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Cursorbedieningsdeel (1 regel):
Space: voegt een spatie in op de
plaats van de cursor.
<«—: Verplaatst de cursor naar links.
—: Verplaatst de cursor naar rechts.
BS: Verwijdert het teken links van de
cursor.

Gedeelte Title Prefix (1 regel):
Gedeelte voor invoeren van de titel.

Zo voert u de titel in

1. Selecteer met de keuzeschakelaar het
teken dat op de plaats van de cursor
moet worden ingevoerd in het
gedeelte Title Prefix van het
tekenselectiegebied (pagina 7),
en druk op de toepassingsknop van
de keuzeschakelaar. (Het
geselecteerde teken wordt ingevoerd
en de cursor beweegt naar rechts.)

2. Herhaal stap 1 om de titel in te
stellen. (Gebruik BS indien nodig.)

3. Selecteer na het invoeren van de titel
Done om het tekeninvoerscherm te
sluiten.

geheugenkaart in sleuf B.
Execute: functie uitvoeren.

TC/Media >Format Media
Initialiseert geheugenkaarten.

Onderdeel Instelling subonderdeel Beschrijving
Media(A) Full Format / Quick Format / Cancel Formatteert de geheugenkaart in sleuf A.
Media(B) Full Format / Quick Format / Cancel Formatteert de geheugenkaart in sleuf B.

Number Set 0001 t/m 9999 Stelt het 4-cijferige achtervoegsel van de
clipnaamin.
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Menu Monitoring

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Monitoring >Display On/Off

Regelt instellingen voor weergave-onderdelen.

Monitoring >Output On/Off Onderdeel Instelling subonderdeel Beschrijving
Regelt de video-uitvoerinstelling. Network On / Off Selecteert de onderdelen die moeten
Onderdeel  Instelling subonderdeel Beschrijving Status worden weergegeven in de zoeker.
File Transf On / Off
SDI On / Off Schakelt de SDI-uitvoer in of uit. Sltaetursans er o
HDMI On / Off Schakelt HDMI-uitvoer in of uit. Rec/Play On / Off
Monitoring >Output Format Status
Regelt de uitvoerindeling. RAW Output On / Off
Onderdeel Instelling subonderdeel Beschrijving (S:;:Hsl
SDI Zie voor details over instellingen Regelt de uitvoerresolutie voor SDI en Tally On / Off
HDMI "Uitvoerindelingen en beperkingen” HDMI.
(pagina 19). Batter'y On / Off
Remain
Monitoring >Output Display Focus Mode On / Off
Regelt de uitvoerinstellingen van de schermweergave.
: — Focus On / Off
Onderdeel Instelling subonderdeel Beschrijving Position
SDI On / Off Stelt in of het menu, de status en de Focus Area On / Off
schermweergave worden opgenomen in Indicator
het SDI-uitgangssignaal. Focus Area On / Off
HDMI On / Off Stelt in of het menu, de status en de Ind.(AF-S)
schermweergave worden opgenomen in Face/Eye On / Off
het HDMI-uitgangssignaal. Detection
Frame
Lens Info On / Off
Imager Scan  On / Off
Mode
Rec Format On / Off
Frame Rate On / Off
Zoom On / Off
Position
UWP RF Level On / Off
SteadyShot On / Off
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Monitoring >Display On/Off
Regelt instellingen voor weergave-onderdelen.

Monitoring >Marker
Regelt instellingen voor markerweergave.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Base Look/ On / Off Setting On / Off Schakelt de weergave van alle markers in
LUT of uit.
SDI/HDMI On / Off Color White / Yellow / Cyan / Green / Magenta / Selecteert de kleur van het
Rec Control Red / Blue markerssignaal.
Gamma On / Off Center 1/2/374/0Off Selecteert de centrale marker.
Display Assist Marker
Proxy Status  On / Off Safety Zone  On / Off Schakelt de veiligheidszonemarker in of
BaseISO/  On/ Off uit.
Sensitivity Safety Area 80% / 90% / 92.5% / 95% Selecteert de grootte van de
Media Status On / Off veiligheidszonemarker (als een
- - - percentage van de totale schermgrootte).
Video Signal  Off / Waveform / Vector / Histogram -
Monitor Aspect Line / Mask / Off Selecteert het type
- Marker beeldindelingsmarkering.
Clip Name On / Off - : :
- Aspect Mask 0t/m15(12) Stelt het niveau van het videosignaal
White On / Off buiten de markering in.
Balance. Aspect Safety On / Off Schakelt de veiligheidsmarkering voor
Scene File On / Off Zone beeldindeling in of uit.
Focus On / Off Aspect Safety 80% / 90% / 92.5% / 95% Selecteert de grootte van de
Indicator Area veiligheidsmarkering voor beeldindeling
Auto On / Off (als een percentage van de totale
Exposure schermgrootte).
Mode Aspect Select 1:1/4:3/13:9/14:9/15:9/16:9/17:9/  Stelt de modus in bij weergave van de
Auto On / Off 1.66:1/1.85:1/ 2.35:1/ 2.39:1 / Custom beeldindelingsmarkering.
Exposure Custom Voer een willekeurig waarde in Stelt de beeldindelingsverhouding in op
Level Aspect Ratio  (01.00:01.00) een willekeurige waarde.
Timecode On / Off [Opmerking]
ND Filter On / Off Deze instelling is actief als Aspect Select is
Iris on / Off : ingesteld op Custom.
- Guide Frame On / Off Schakelt de weergave van het hulpkader
ISO/Gain/El  On / Off - :
in of uit.
Shutter On 7 Off 100% Marker ~ On / Off Schakelt de 100%-marker in of uit.
Level Gauge On/ Off User Box On / Off Schakelt de weergave van de
Audio Level  On / Off indelingsmarkering in of uit.
Meter User Box 3t/m 479 (240) Stelt de breedte in van de
Video Level On / Off Width indelingsmarkering (afstand van het
Warning midden tot de linker en rechter randen).
Clip Number On / Off
Notice On / Off

Message
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Monitoring >Marker
Regelt instellingen voor markerweergave.

Monitoring >Zebra

Regelt de instellingen voor zebra-patroon.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
User Box 3t/m 269 (135) Stelt de hoogte in van de Setting Off / Zebral / Zebra2 Selecteert het type zebra-patroon (Off,
Height indelingsmarkering (afstand van het Zebra 1, Zebra 2).
midden tot de bovenste en onderste ZebralLevel 0% t/m 109% (70%) Stelt het weergaveniveau van Zebra 1in.
randen) - — Zebral 2% t/m 20% (10%) Stelt het diafragmaniveau van Zebra 1in.
User Box H -476 t/m +476 (0) Stelt de horizontale positie van het Aperture
Position midden van de beeldindelingsmarkering Level
n. Zebra2 Level 0% t/m 109% (100%) Stelt het weergaveniveau van Zebra 2 in.
User Box V -266 t/m +266 (0) Stelt de verticale positie van het midden
Position van de beeldindelingsmarkering in.

Monitoring >VF Setting
Regelt de instellingen voor de zoeker.

Onderdeel Instelling subonderdeel

Beschrijving

Brightness 1t/m15(8)

Past de helderheid van het zoekerbeeld
aan.

Color Mode Color / B&W

Selecteert de weergavemodus van de
zoeker in E-E/opname-modus.

Monitoring >Gamma Display Assist

Regelt de instellingen van de gammaweergave-assistent.

Onderdeel Instelling subonderdeel

Beschrijving

Setting On / Off

Schakelt de functie gammaweergave-
assistent in of uit in Custom-modus als
Target Display is ingesteld op HDR(HLG).

Monitoring >Peaking
Regelt de instellingen voor beeldomtrekversterking.

Onderdeel Instelling subonderdeel

Beschrijving

Setting On / Off

Schakelt de functie
beeldomtrekversterking in of uit.

Peaking Level High / Mid / Low

Stelt de kleur van het
beeldomtrekversterkingssignaal in.

Color B&W / Red / Yellow / Blue

Selecteert de kleur van het
beeldomtrekversterkingssignaal.
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6. Menuweergave en instellingen

Menu Audio

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Raadpleeg "Blokschema's

1en

(pagina 134).

Audio >Audio Input
Regelt instellingen voor audio-invoer.

Onderdeel Instelling subonderdeel Beschrijving
Audio >Audio Input CH4 Level Auto / Manual Selecteert automatische ingangsniveau-
Regelt instellingen voor audio-invoer. Control aanpassing of handmatige aanpassing
Onderdeel Instelling subonderdeel Beschrijving voor opname via kanaal 4.
- [Opmerking]
CHI1 Input INPUT1 / Internal MIC / Shoe CH1 Schakelt de Lnganglgibron om voor Als zowel CH3 Input Select als CH4 Input
Select opname op kanaal 1. Select zijn ingesteld op Internal MIC, wordt
CH2 Input INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Schakelt de ingangsbron om voor CH4 op automatisch/handmatig ingesteld, in
Select opname op kanaal 2. combinatie met de instelling voor CH3 Level
CH3 Input Off / INPUT1 / Internal MIC / Shoe CH1 Schakelt de ingangsbron om voor Control. - - -
Select opname op kanaal 3. CH3 Input 0t/m 99 (49) Stelt het ingangsniveau in voor opname
CH4Input  Off / INPUT1 / INPUT2 / Internal MIC / Schakelt de ingangsbron om voor Level van kanaal 3.
Select Shoe CH2 opname op kanaal 4. CH4 Input 0t/m 99 (49) Stelt het ingangsniveau in voor opname
INPUTIMIC ~ -80dB / ~70dB / -60dB / -50dB / -40dB /  Stelt het referentie-opnameniveau in Level van kanaal 4. S
Reference -30dB voor XLR-microfooninvoer van INPUT1. Audio Input  0t/m 99 Stelt het audio-ingangsniveau in.
INPUT2MIC ~ -80dB / ~70dB / -60dB / -50dB / -40dB /  Stelt het referentie-opnameniveau in Level Kan worden gebruikt als mastervolume,
- . . afhankelijk van de instellingen van CH1
Reference -30dB voor XLR-microfooninvoer van INPUT2.
Line | 4dB / 0dB / -3dB / EBUL Stelth f ie-i i in al Level t/m CH4 Level
ine Input ne h telt het referentie-ingangsniveau in als Limiter Mode Off /-6dB /-9dB / -12dB / -15dB / -17dB  Selecteert de limiterkarakteristiek voor
Reference de schakelaar INPUT1/INPUT2 op LINE ; . .
ctaat hoge ingangsignalen als het audio-
- ingangsniveau handmatig wordt
Reference -20dB / -18dB / -16dB / -12dB / EBUL Selecteert het opnameniveau van de ingesteld.
Level - 1kHz referentlétoon. — CH1&2 AGC ~ Mono / Stereo Stelt de modus in voor automatische
C.H1 Wind On / Off Schakelt h‘et Wlndredyctlefl!ter voor Mode niveau-aanpassing voor opname van
Filter opname via kanaal 1in of uit. kanaal 1 en kanaal 2. Bij instelling op
CH2 Wind On / Off Schakelt het windreductiefilter voor Stereo is de AGC tussen de kanalen
Filter opname via kanaal 2 in of uit. gekoppeld.
CH3 Wind On / Off Schakelt het windreductiefilter voor CH3&4 AGC  Mono / Stereo Stelt de modus in voor automatische
Filter opname via kanaal 3 in of uit. Mode niveau-aanpassing voor opname van
CH4 Wind On / Off Schakelt het windreductiefilter voor kanaal 3 en kanaal 4. Bij instelling op
Filter opname via kanaal 4 in of uit. Stereo is de AGC tussen de kanalen
CH3 Level Auto / Manual Selecteert automatische ingangsniveau- gekoppeld.
Control aanpassing of handmatige aanpassing AGC Spec -6dB / -9dB / -12dB / -15dB / -17dB Selecteert de AGC-karakteristiek.
voor opname via kanaal 3. 1kHz Tone on  On / Off Schakelt de 1 kHz referentietoon in of uit
[Opmerking] Color Bars bij het weergeven van kleurbalken.

Als zowel CH3 Input Select als CH4 Input
Select zijn ingesteld op Internal MIC, wordt
CH4 automatisch/handmatig ingesteld, in
combinatie met deze instelling.

[Opmerking]

Als dit is ingesteld op On, wordt de 1 kHz
referentietoon ingesteld voor opname van
kanaal 3 en kanaal 4, zelfs als CH3 Input Select
en CH4 Input Select zijn ingesteld op Off.
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Audio >Audio Input
Regelt instellingen voor audio-invoer.

Audio >Audio Output
Regelt instellingen voor audio-uitvoer.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
CH1 Level Invoer zonder XLR-adapter Stelt de combinatie van audio- Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1/ Selecteert de audiokanaalingang voor de
Audio Input Level / Side / Level+Side  ingangsniveau-aanpassing in op actief CH2 / CH3 / CH4 hoofdtelefoonaansluiting en ingebouwde
Invoer met XLR-adapter (pagina 48) voor opnemen via kanaal 1. luidspreker.
i . .
Audio Input Level / Through [Opmerking] [Opmerking]
"Side" heeft betrekking op de regelaar Als audio voor meerdere kanalen is
AUDIO LEVEL (CH1) aan de zijkant van de ingesteld op gelijktijdige uitvoer, wordt het
camcorder. Als Level+Side is geselecteerd, uitgangsniveau van de audio voor elk kanaal
wordt het audio-opnameniveau bepaald door gereduceerd om clippen te voorkomen.
de combinatie van Audio Input Level en de Volume 0t/m 50 Past het audio-uitgangsniveau naar de
regelaarinstellingen (pagina 134). - . .
= - hoofdtelefoonuitgang en interne
CH2 Level Invoer zonder XLR-adapter Stelt de combinatie van audio- luidspreker aan.
Audio Input Level / Side / Level+Side mgangsmveau—@npassmg in op actief Headphone  Mono / Stereo Selecteert of de hoofdtelefoonuitgang
Invoer met XLR-adapter (pagina 48) voor opnemen via kanaal 2. — .
. Out mono of stereo signaal weergeeft.
Audio Input Level / Through 0 i
[Opmerking] . Alarm Level 0t/m7(4) Past het volume van het alarm aan.
"Side" heeft betrekking op de regelaar — - - - -
AUDIO LEVEL (CH2) aan de zijkant van de HDMI Output CH1/CH2 / CH3/CH4 Stelt de combinatie van audiokanalen in
camcorder. Als Level+Side is geselecteerd, CH op de HDMI-uitvoer.
wordt het audio-opnameniveau bepaald door
de combinatie van Audio Input Level en de
regelaarinstellingen (pagina 134).
CH3 Level Invoer zonder XLR-adapter Stelt de combinatie van audio-
Audio Input Level / CH3 Input Level / ingangsniveau-aanpassing in op actief
Level+CH3 Input Level voor opnemen van kanaal 3.
Invoer met XLR-adapter (pagina 48)
Audio Input Level / Through
CH4 Level Invoer zonder XLR-adapter Stelt de combinatie van audio-

Audio Input Level / CH4 Input Level /
Level+CH4 Input Level

Invoer met XLR-adapter (pagina 48)
Audio Input Level / Through

ingangsniveau-aanpassing in op actief
voor opnemen van kanaal 4.
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6. Menuweergave en instellingen

Menu Thumbnail

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Thumbnail >Transfer Clip (Proxy)
Verzendt proxy-clips.

[Opmerking]

Transfer Clip (Proxy) kan niet worden geconfigureerd als er geen wachtwoord is geconfigureerd met Access

Authentication in het menu Network.

Thumbnail

Onderdeel Instelling subonderdeel Beschrijving

Display Clip Geeft het scherm weer voor
Properties clipeigenschappen.

Thumbnail >Set Clip Flag
Regelt instellingen voor clipvlag.

Onderdeel Instelling subonderdeel Beschrijving

Select Clip Verzendt proxy-clips corresponderend
met de geselecteerde clips.

All Clips Verzendt proxy-clips corresponderend

met alle clips.

[Opmerking]
Er kunnen maximaal 200 clips worden
verzonden.

Onderdeel Instelling subonderdeel Beschrijving

Add OK Voegt een OK-vlag toe.
Add NG Voegt een NG-vlag toe.
Add KEEP Voegt een Keep-vlag toe.
Delete Clip Verwijdert alle vlaggen.
Flag

Thumbnail >Filter Clips
Regelt instellingen voor weer te geven clips.

Thumbnail >Lock/Unlock Clip

Regelt instellingen voor clipbescherming.

Onderdeel Instelling subonderdeel

Beschrijving

Onderdeel Instelling subonderdeel Beschrijving

Select Clip Selecteert en vergrendelt/ontgrendelt
een clip.

Lock All Clips Vergrendelt alle clips.

Unlock All Ontgrendelt alle clips.

Clips

Thumbnail >Delete Clip
Verwijdert clips.

OK Geeft alleen clips weer die een OK-vlag
hebben.

NG Geeft alleen clips weer die een NG-vlag
hebben.

KEEP Geeft alleen clips weer die een Keep-vlag
hebben.

None Geeft alleen clips weer die geen vlag
hebben.

All Geeft alle clips weer, ongeacht of er een

vlagis.

Thumbnail >Customize View
Schakelt het pictogrammenscherm om.

Onderdeel Instelling subonderdeel Beschrijving
Select Clip Verwijdert de geselecteerde clip.
All Clips Verwijdert alle clips.

Onderdeel Instelling subonderdeel

Beschrijving

Thumbnail >Transfer Clip
Verzendt clips.

[Opmerking]

Transfer Clip kan niet worden geconfigureerd als er geen wachtwoord is geconfigureerd met Access

Authentication in het menu Network.

Thumbnail Date Time / Time Code / Duration /
Caption Sequential Number

Schakelt de onder de pictogrammen
weergegeven informatie om.

Onderdeel Instelling subonderdeel Beschrijving
Select Clip Verzendt geselecteerde clips.
All Clips Verzendt alle clips.

[Opmerking]
Er kunnen maximaal 200 clips worden
verzonden.
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6. Menuweergave en instellingen

Menu Technical

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Technical >HOLD Switch Setting
Regelt instellingen voor HOLD-schakelaar.

Technical >Color Bars
Regelt instellingen voor kleurbalk.

Onderdeel Instelling subonderdeel

Beschrijving

Onderdeel Instelling subonderdeel Beschrijving
Setting On / Off Schakelt de kleurbalken in of uit.
Type ARIB 7 100% / 75% / SMPTE Selecteert het type kleurbalk.

Technical >ND Dial

Regelt instellingen met betrekking tot regelaarbediening van ND VARIABLE.

Onderdeel Instelling subonderdeel Beschrijving
CLEAR with On / Off Stelt in of ND statusomschakeling (CLEAR
Dial <=> 0n) moet worden geactiveerd door

bediening van de regelaar ND VARIABLE.

Technical >Tally
Regelt instellingen van opname/tally-lampje.

Onderdeel Instelling subonderdeel

Beschrijving

Handle HOLD Normal / Rec Button Only
Switch

Stelt in of het vergrendelingsdoel van de
HOLD-schakelaar op de draaggreep
alleen de knop Record START/STOP op
de draaggreep is.
Normal:
Alle bedieningsknoppen op de
draaggreep zijn doel van de
vergrendeling.
Alleen de Record START/STOP-knop
op de draaggreep volgt de instelling
"with Rec Button".
Rec Button Only:
Alleen de knop Record START/STOP
op de draaggreep is doel van de
vergrendeling.

Technical >Touch Operation

Regelt instellingen met betrekking tot aanraakbediening.

Front On / Off Schakelt het opname/tally-lampje (voor)
in of uit.
Rear On / Off Schakelt het opname/tally-lampje

(achter) in of uit.

Onderdeel Instelling subonderdeel

Beschrijving

Setting On / Off

Schakelt aanraakbediening in of uit.

Technical >HOLD Switch Setting
Regelt instellingen voor HOLD-schakelaar.

Technical >Rec Review
Regelt instellingen voor opname controleren.

Onderdeel Instelling subonderdeel

Beschrijving

Onderdeel Instelling subonderdeel

Beschrijving

with Rec On / Off Stelt in of de opnameknop START/STOP
Button moet worden vergrendeld.

with Hand On / Off Stelt in of de bediening van de

Grip Remote afstandsbedieningsgreep moet worden

vergrendeld.

Setting 3s/10s/ Clip

Selecteert de afspeeltijd van clips die
zojuist zijn opgenomen voor het
controleren.

Technical >Zoom
Regelt instellingen voor zoom.

Onderdeel Instelling subonderdeel

Beschrijving

Zoom Type Optical Zoom Only / On(Clear Image

Zoom)

Stelt het zoomtype in.
Optical Zoom Only:
Optische zoom wordt aangepast
door bediening van het objectief.
On(Clear Image Zoom):
Elektronische zoom met weinig of
geen aantasting van de
beeldkwaliteit.
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Technical >Handle Zoom
Regelt de zoominstellingen van de draaggreep.

Technical >Menu Page On/Off

Configureert instellingen die te maken hebben met de weergave van het statusscherm.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Setting Off / Low / High / Variable Regelt de snelheid van de Assignable On / Off Schakelt de weergave van het scherm
draaggreepzoom. Button Assignable Button Status uit.
High 1t/m 8(8) Stelt de zoomsnelheid in van de Battery On / Off Schakelt de weergave van het scherm
zoomregelaar van de draaggreep als de Battery Status uit.
snelheid High is geselecteerd. Media On / Off Schakelt de weergave van het scherm
Low 1t/m 8 (3) Stelt de zoomsnelheid in van de Media Status uit.
zoomregelaar van de draaggreep als de Network On / Off Schakelt de weergave van het scherm
snelheid Low is geselecteerd. Network Status uit.
[Opmerking] File Transfer  On / Off Schakelt de weergave van het scherm

Onregelmatig zoomen kan zich voordoen als
de zoomsnelheid laag is ingesteld.

File Transfer Status uit.

Technical >Menu Settings
Regelt instellingen met betrekking tot het menu.

Technical >Fan Control

Regelt instellingen voor de ventilator.

Onderdeel

Instelling subonderdeel

Beschrijving

Onderdeel Instelling subonderdeel Beschrijving
User Menu On / Off Stelt in of alleen het menu User moet
Only worden weergegeven (On) of de

menulijst (Off) als de camcorder het
menu weergeeft.

User Menu On / Off
with Lock

Stelt in of de menuweergave moet
worden vergrendeld, waardoor alleen het
menu User wordt weergegeven.
[Opmerking]

Bij normale menuweergavebediening wordt dit

onderdeel niet weergegeven. Zie voor details
over menuweergavebediening pagina 73.

Setting

Auto / Minimum / Off in Rec

Stelt de besturingsmodus voor de
camcorderventilator in.

[Opmerking]

Zelfs als Off in Rec is geselecteerd, gaat de
ventilator werken als de interne temperatuur
van de camcorder boven een bepaalde grens
komt.

Technical >Lens

Regelt instellingen met betrekking tot lenzen.

Technical >Menu Page On/Off

Configureert instellingen die te maken hebben met de weergave van het statusscherm.

Onderdeel Instelling subonderdeel Beschrijving

Main On / Off Schakelt de weergave van het scherm
Main Status uit.

Camera On / Off Schakelt de weergave van het scherm
Camera Status uit.

Audio On / Off Schakelt de weergave van het scherm
Audio Status uit.

Project On / Off Schakelt de weergave van het

statusscherm Project uit.

Monitoring On / Off

Schakelt de weergave van het scherm
Monitoring Status uit.

Onderdeel Instelling subonderdeel Beschrijving
Zoom Ring Left(W)/Right(T) / Right(W)/Left(T) Stelt de richting in van de
Direction zoomringbediening.
[Opmerking]
Alleen inschakelen bij gebruik van een
objectief met E-bevestiging die overschakeling
van zoomringrichting ondersteunt.
Shading Auto / Off Stelt de automatische
Compensation schaduwcompensatie in.
Chroma Auto / Off Stelt de automatische chromatische
Aberration aberratie in.
Comp.
Distortion Auto / Off Stelt de automatische
Comp. vervormingscompensatie in.
Breathing Auto / Off Stelt de ademcompensatie voor het

Compensation

objectief in.
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Technical >Lens
Regelt instellingen met betrekking tot lenzen.

Technical >Camera Battery Alarm

Regelt instellingen voor accu-alarmmeldingen.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving

Distance Meter / Feet Stelt de weergave-eenheid in voor Battery 3% t/m7% Stelt de resterende accucapaciteit in

Display objectiefinformatie en Empty vanaf waar een melding van lege accu

scherpstellingspositie. wordt weergegeven.

Zoom Focal Length / Number / Bar Stelt de weergave-indeling voor de Technical >Camera DC IN Alarm

Position zoompositie in. Regelt instellingen voor voedingsvoltage.

Display Onderdeel  Instelling subonderdeel Beschrijving

Technical >Video Light Set DC Low 16.0V tot 19.0V (16.5V) Stelt het voltage in waarbij een melding
Stelt de belichtingsbesturingsmodus in voor de verlichting. Alleen beschikbaar bij gebruik van de Voltage1 voor laag ingangsvoltage (DC IN) wordt
HVL-LBPC (optie). weergegeven.

Onderdeel Instelling subonderdeel Beschrijving DC Low 15.5V tot 18.5V Stelt het voltage in waarbij een melding

- - . - - - - - Voltage2 voor onvoldoende ingangsvoltage (DC
Video Light Power Link / Rec Link / Rec Link + Stby Stelt de belichtingsbesturingsmodus in IN) wordt weergegeven.
Set voor de videolamp die is bevestigd aan

de multi-interfaceschoen.
Power Link:
Schakelt de videolamp in of uit als de

camcorder wordt in- of uitgeschakeld.

Rec Link:
Schakelt de videolamp in of uit als de

camcorder start of stopt met opnemen.

Rec Link + Stby:
Schakelt de videolamp in of op
standby als de camcorder start of
stopt met opnemen.

Technical >APR
Voert APR uit.

Onderdeel Instelling subonderdeel

Beschrijving

APR Execute / Cancel

Voert APR (Automatic Pixel Restoration)
uit voor automatische aanpassing van de
beeldsensor.

Execute: functie uitvoeren.

[Opmerking]
Bevestig altijd de objectiefdop voordat APR
wordt uitgevoerd.

Technical >Camera Battery Alarm
Regelt instellingen voor accu-alarmmeldingen.

Onderdeel Instelling subonderdeel

Beschrijving

Low Battery 5% /10% /15% / ... / 45% / 50%

Stelt de resterende accucapaciteit in (in
stappen van 5%) vanaf waar een melding

van laag accuniveau wordt weergegeven.
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Menu Network

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Network >Wireless LAN
Regelt instellingen met betrekking tot draadloze LAN-verbindingen.

Instelling subonderdeel

Beschrijving

Execute / Cancel

Brengt een verbinding tot stand met NFC
(Near Field Communication).
Execute: functie uitvoeren.

Network >Setup for Mobile App Onderdeel
Voert het hulpmiddel voor netwerkinstelling uit. NFC
Onderdeel Instelling subonderdeel Beschrijving
Set Start het hulpmiddel
etup art het hulpmiddel voor MAC Address

netwerkinstelling.

Network >Access Authentication
Regelt instellingen voor toegangsverificatie.

Geeft het MAC-addres weer van de
draadloze LAN-interface van de
camcorder.

Onderdeel Instelling subonderdeel

Beschrijving

Network >AP Mode Settings
Regelt instellingen met betrekking tot verbindingen met toegangspunt.

Instelling subonderdeel

Beschrijving

Auto(5GHz) / Auto / CH1/ CH2 /
CH3/CH4 /CH5/ CH6 / CH7 / CH8 / CH9 /
CH10 /7 CHMNM

Stelt het draadloze LAN-kanaal in.
Auto(5GHz) is alleen beschikbaar op de
ILME-FX6V/VK.

Geeft de SSID en wachtwoord van de
camcorder weer.

Execute / Cancel

Maakt een nieuw wachtwoord aan.
Execute: functie uitvoeren.

Geeft het IP-adres van de camcorder in
toegangspuntmodus weer.

Geeft het subnetmasker-adres van de
camcorder in toegangspuntmodus weer.

User Name Stelt de gebruikersnaam in voor Onderdeel
toegangsverificatie. Channel
Input Stelt het wachtwoord in voor
Password toegangsverificatie.
[Opmerking] Camera SSID
Vanuit beveiligingsstandpunt kunt u het beste & Password
een wachtwoord m_stellen.r?jet een voI(_joende Regenerate
lange tekenreeks die moeilijk te raden is voor
anderen. Bewaar dit op een veilige plaats. Password
Generate Execute / Cancel Genereert automatisch een wachtwoord IP Address
Password voor toegangsverificatie.
Execute: functie uitvoeren. Subnet Mask
Show Geeft informatie weer voor
Settings toegangverificatie.

Geeft het wachtwoord, de vingerafdruk,
het serienummer, het serienummer en de
modelnaam weer als tekst en als QR-
code.

[Opmerking]

Let erop dat andere mensen het wachtwoord

niet kunnen zien en de QR-code niet kunnen
kopiéren.

Network >Wireless LAN

Regelt instellingen met betrekking tot draadloze LAN-verbindingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting Access Point Mode / Station Mode / Off Selecteert de werkmodus van de
draadloze LAN-verbinding.

WPS Execute / Cancel Brengt een verbinding tot stand met WPS

(Wi-Fi Protected Setup).
Execute: functie uitvoeren.
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Network >ST Mode Settings

Regelt instellingen met betrekking tot verbindingen met stationmodus.

Network >ST Mode Settings

Regelt instellingen met betrekking tot verbindingen met stationmodus.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Camera Enable / Disable Stelt in of de camcorder kan worden Scan Detecteert draadloze LAN-netwerken
Remote bediend vanaf een apparaat dat via Networks (toegangspunten) en geeft een lijst weer.
Control draadloos LAN in stationmodus is Kies een bestemming in de lijst om
verbonden. verbinding mee te maken.
Connected Geeft het verbonden draadloze LAN- SSID Geeft de SSID weer voor het
Network netwerk (toegangspunt) weer. toegangspunt waarmee verbinding moet
SSID Geeft de SSID weer voor het worden gemaakt.
toegangspunt waarmee verbinding moet Security Geeft het type beveiliging weer voor het
worden gemaakt. toegangspunt waarmee verbinding moet
Security Geeft het type beveiliging weer voor het worden gemaakt.
toegangspunt waarmee verbinding moet Password Voer het wachtwoord voor het
worden gemaakt. toegangspunt in om verbinding te
Password Geeft het wachtwoord weer voor het maken.
toegangspunt waarmee verbinding moet DHCP Schakelt DHCP in of uit.
worden gemaakt. On / Off
Als Security is ingesteld op WEP of IP Address Voer het IP-adres in van de camcorder als
WPA; e DHCP is ingesteld op Off.
Als Slecunty is ingesteld op None: Subnet Mask Voer het subnetmasker in van de
(leeg) — _ camcorder als DHCP is ingesteld op Off.
DHCP Geeft aan of DHCP is in- of uitgeschakeld. Gateway Voer de standaard gateway in van de
IP Address Geeft het IP-adres weer van de camcorder als DHCP is ingesteld op Off.
camcorder als DHCP is ingesteld op Off. DNS Auto Schakelt automatische DNS-acquisitie in
Subnet Mask Geeft het subnetmasker weer van de On / Off of uit.

camcorder als DHCP is ingesteld op Off.

Gateway Geeft de standaard gateway van de
camcorder aan als DHCP is ingesteld op
Off.

DNS Auto Geeft aan of DNS-acquisitie is in- of

uitgeschakeld.

Primary DNS Server

Geeft de primaire DNS-server van de
camcorder weer als DNS Auto is ingesteld
op Off.

Primary DNS Server

Voer de primaire DNS-server van de
camcorder in als DNS Auto is ingesteld
op Off.

Secondary DNS Server

Voer de secundaire DNS-server van de
camcorder in als DNS Auto is ingesteld
op Off.

Secondary DNS Server

Geeft de secundaire DNS-server van de
camcorder weer als DNS Auto is ingesteld
op Off.
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Network >ST Mode Settings
Regelt instellingen met betrekking tot verbindingen met stationmodus.

Network >Wired LAN

Regelt instellingen met betrekking tot bekabelde LAN-verbindingen.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Manual Registreert instellingen voor handmatige Setting On / Off Schakelt de bekabelde LAN-functie in of
Register verbinding met een toegangspunt. uit.

SSID Voer de SSID in voor het toegangspunt Camera Enable / Disable Stelt in of de camcorder kan worden
waarmee verbinding moet worden Remote bediend vanaf een apparaat dat via
gemaakt. Control draadloos LAN modus is verbonden.

Security Stel het type beveiliging in voor het Detail Configureert de eigenschappen van de

None / WEP / WPA toegangspunt waarmee verbinding moet Settings bekabelde LAN-verbinding.
worden gemaakt. Selecteer WPA als het DHCP Schakelt DHCP in of uit.
type beveiliging voor het On / Off
bestemmingstoegangspunt WPA of IP Address Voer het IP-adres in van de camcorder als

WPA2 is.

Password Voer het wachtwoord voor het
toegangspunt in om verbinding te
maken.

DHCP Schakelt DHCP in of uit.

On / Off
IP Address Voer het IP-adres in van de camcorder als

DHCP is ingesteld op Off.

Subnet Mask

Voer het subnetmasker in van de
camcorder als DHCP is ingesteld op Off.

DHCP is ingesteld op Off.

Subnet Mask

Voer het subnetmasker in van de
camcorder als DHCP is ingesteld op Off.

Gateway Voer de standaard gateway in van de
camcorder als DHCP is ingesteld op Off.
DNS Auto Schakelt automatische DNS-acquisitie in
On / Off of uit.

Primary DNS Server

Voer de primaire DNS-server in als DNS
Auto is ingesteld op Off.

Secondary DNS Server

Voer de secundaire DNS-server in als DNS
Auto is ingesteld op Off.

Gateway Voer de standaard gateway in van de
camcorder als DHCP is ingesteld op Off.
DNS Auto Schakelt automatische DNS-acquisitie in
On / Off of uit.

Network >Modem

Regelt instellingen met betrekking tot USB-tethering.

Primary DNS Server

Voer de primaire DNS-server in als DNS
Auto is ingesteld op Off.

Secondary DNS Server

Voer de secundaire DNS-server in als DNS

Auto is ingesteld op Off.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de smartphoneverbinding in of
uit.

Camera Enable / Disable Stelt de rechten in voor

Remote afstandsbediening via USB-tethering met

Control een smartphone-app, bijvoorbeeld CBM
(Content Browser Mobile) of C3 Portal
App.

Device Name Geeft de apparaatnaam van de
smartphone weer.

IP Address Geeft het IP adres van de smartphone

weer.

Subnet Mask

Geeft het subnetmasker van de
smartphone weer.
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Network >File Transfer

Regelt instellingen met betrekking tot de bestandsoverdracht.

Network >File Transfer

Regelt instellingen met betrekking tot de bestandsoverdracht.

Onderdeel Instelling subonderdeel Beschrijving Onderdeel Instelling subonderdeel Beschrijving
Auto Upload On / Off Hiermee schakelt u het automatisch Server Display Name Stelt de weergavenaam in die in het
uploaden van originele bestanden in en Settings1 configuratiemenu voor
uit. overdrachtsbestemming wordt
weergegeven.
[Opmerking] ' geg
Wanneer Simul Rec >Setting (pagina 85) in Service Geeft het type server weer.
het menu Project is ingesteld op On, worden FTP
de clips die worden opgenomen op het Host Name Stelt de hostnaam van de

medium in sleuf B niet automatisch gelpload.

Auto Upload On / Off / Chunk
(Proxy)

On:
Schakelt automatisch uploaden van
proxybestanden in.

Off:
Schakelt automatisch uploaden van
proxybestanden uit.

Chunk:
Uploadt automatisch een
proxybestand dat is opgenomen in
segmenten.

[Opmerking]

Wanneer Simul Rec >Setting (pagina 85) in
het menu Project is ingesteld op On, worden
de clips die worden opgenomen op het
medium in sleuf B niet automatisch gelpload.
Bovendien is Chunk grijs gemaakt en kan niet
worden geselecteerd.

transmissiebestemmingsserver in.

Port (1t/m 65535 (21))

Stelt het poortnummer in van de
transmissiebestemmingsserver.

User Name Stelt de gebruikersnaam in voor
verificatie van de verbinding met de
transmissiebestemmingsserver.

Password Stelt het verificatiewachtwoord in voor

de verbinding met de
transmissiebestemmingsserver.

Passive Mode
On / Off

Schakelt PASV-modus in of uit.

Destination Directory

Voer de naam in van de
transmissiebestemmingsmap.

Using Secure Protocol
On / Off

Stelt in of veilige FTP-overdracht wel (On)
of niet (Off) moet worden gebruikt (FTPS
Explicit Mode: FTPES).

Root Certificate
Load / Clear / None

Laadt een root certificate voor veilige
FTP-overdracht en wist instellingen.

Root Certificate Status
Loaded / No Certificate

Geeft de laadstatus van het root
certificate voor veilige FTP-overdracht
weer.

Reset
Execute / Cancel

Herstelt de instellingen voor Server
Settings naar de fabrieksinstellingen.
Execute: functie uitvoeren.

Default Selecteert de uploadserver voor

Upload bestanden. De hier geselecteerde server

Server wordt de automatische
uploadbestemming voor origineel
bestanden en proxy-bestanden en de
uploadbestemming voor bestanden van
het pictogrammenscherm.
Geeft de weergavenaam mee die is
geconfigureerd in Server Settings 1t/m 3.

Clear Execute / Cancel Verwijdert voltooide overdrachtstaken uit

Completed de lijst.

Jobs Execute: functie uitvoeren.

Server Identiek aan Server Settings1.
Settings2
Server Identiek aan Server Settings1.
Settings3

Clear All Jobs Execute / Cancel

Verwijdert alle overdrachtstaken uit de
lijst.
Execute: functie uitvoeren.

Network >Network Reset
Herstelt de netwerkinstellingen.

View Job List

Geeft de lijst met overdrachtstaken weer.

Onderdeel Instelling subonderdeel

Beschrijving

Reset Execute / Cancel

Herstelt de netwerkinstellingen.
Execute: functie uitvoeren.
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Menu Maintenance

Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Maintenance >All Reset

Herstelt instellingen naar de standaard fabrieksinstellingen.

Maintenance >Language
Stelt de weergavetaal in.

Onderdeel Instelling subonderdeel

Beschrijving

Onderdeel Instelling subonderdeel

Beschrijving

Select

Stelt de weergavetaal in.
SET: taal instellen.

Reset without Execute / Cancel
Network

Herstelt de menu-instellingen, met
uitzondering van de instellingen van het
menu Network, naar de standaard
fabrieksinstellingen.

Maintenance >Clock Set
Regelt instellingen voor de interne klok.

Maintenance >Hours Meter

Geeft de geaccumuleerde looptijd weer.

Onderdeel Instelling subonderdeel

Beschrijving

Time Zone UTC -12:00 tot UTC +14:00

Stelt het tijdsverschil met UTC in
eenheden van 30 minuten in.

Date Mode YYMMDD / MMDDYY / DDMMYY

Selecteert de weergave-indeling voor
datums.

YYMMDD: jaar, maand, dag
MMDDYY: maand, dag, jaar
DDMMYY: dag, maand, jaar

Onderdeel Instelling subonderdeel Beschrijving

Hours Geeft de geaccumuleerde gebruiksuren

(System) weer (kan niet worden gereset).

Hours(Reset) Geeft de geaccumuleerde gebruiksuren
weer (kan worden gereset).

Reset Execute / Cancel Stelt de weergave Hours(Reset) terug

naar O.
Execute: functie uitvoeren.

12h/24h 12h 7 24h

Selecteert de weergave-indeling voor de
klok.

12h: 12-uursmodus

24h: 24-uursmodus

Maintenance >Version
Geeft versie-informatie weer.

Date

Stelt de huidige datum in.
SET: stelt de waarde in.

Onderdeel Instelling subonderdeel Beschrijving
Version VX.XX Geeft de software-versie van de
Number camcorder weer.

Time

Stelt de huidige tijd in.
SET: stelt de waarde in.

Version Up Execute / Cancel

Updatet de camcorder.”

Execute: functie uitvoeren.
* Deze functie updatet de camcordersoftware.

Maintenance >All Reset

Herstelt instellingen naar de standaard fabrieksinstellingen.

Lens Version  Vxx
Number

Geeft het software-versienummer van
een objectief met E-bevestiging weer.

Onderdeel Instelling subonderdeel

Beschrijving

Reset Execute / Cancel

Herstelt alle instellingen naar de
standaard fabrieksinstellingen.
Execute: functie uitvoeren.

[Opmerking]

Een 3D LUT-bestand dat is geimporteerd met
Base Look >Import from Media(B), Import from
Cloud(Private) of Import from Cloud(Share)
(pagina 90) in het menu Paint/Look kan niet
worden verwijderd. Om alle geimporteerde
3D LUT-bestanden te verwijderen selecteert u
Base Look >Delete All in het menu Paint/Look
(pagina 90).
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Instellingen en standaardwaarden menu Shooting

Instellingen ISO/Gain en standaardwaarden

Het bereik van ISO/Gain-instellingen (pagina 77) en standaardwaarden variéren afhankelijk van de instellingen voor Mode, Target Display, Base Look >Select, en Base Sensitivity. De beschikbare
opties worden grijs gemarkeerd.

Als Mode is ingesteld op ISO

Target Display

SDR(BT.709)

HDR(HLG)

SDR(BT.709) en HDR(HLG) algemeen

Base Look >Select

S-Cinetone / Standard / ITU709 / Still

HLG Live / HLG Natural

User1 t/m User16

Base Sensitivity

Low

High

Low

High

Low

High

1SO 320

ISO/Gain<L> standaard

ISO 400

I1SO 500

ISO 640

ISO/Gain<M> standaard

ISO 800

ISO/Gain<L> standaard

ISO/Gain<L> standaard

1SO 1000

1SO 1250

ISO/Gain<H> standaard

1SO 1600

1SO/Gain<M> standaard

1SO/Gain<M> standaard

1SO 2000

1SO 2500

1SO 3200

I1SO/Gain<H> standaard

ISO/Gain<H> standaard

1SO 4000

I1SO 5000

ISO/Gain<L> standaard

ISO 6400

1SO 8000

1SO 10000

1ISO/Gain<M> standaard

1SO 12800

ISO/Gain<L> standaard

I1SO/Gain<L> standaard

1SO 16000

1SO 20000

1SO/Gain<H> standaard

1SO 25600

ISO/Gain<M> standaard

I1SO/Gain<M> standaard

1SO 32000

I1SO 40000

1SO 51200

ISO/Gain<H> standaard

ISO/Gain<H> standaard

ISO 64000

I1SO 80000

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Als Mode is ingesteld op dB

Instelbereik
-3dB

-2dB

-1dB

0dB ISO/Gain<L> standaard
1dB

2dB

3dB

4dB

5dB

6dB 1SO/Gain<M> standaard
7dB

8dB

9dB

10dB

11dB

12dB 1ISO/Gain<H> standaard
13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28 dB

29 dB
30dB
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AGC Limit-instellingen en standaardwaarden

Het bereik van AGC Limit-instellingen (pagina 79) en standaardwaarden variéren afhankelijk van de instellingen voor Mode, Target Display, Base Look >Select, en Base Sensitivity. De beschikbare

opties worden grijs gemarkeerd.

Als Mode is ingesteld op ISO

Target Display

SDR(BT.709)

HDR(HLG)

HDR(HLG)

SDR(BT.709) en HDR(HLG) algemeen

Base Look >Select

S-Cinetone / Standard / ITU709 / Still

HLG Live

HLG Natural

User1t/m User16

Base Sensitivity

Low High

Low

High

Low

High

Low High

1SO 400

1SO 500

1SO 640

1SO 800

1SO 1000

1SO 1250

1SO 1600

1SO 2000

Standaard

1SO 2500

1SO 3200

1SO 4000

1SO 5000

Standaard

Standaard

Standaard

1SO 6400

I1SO 8000

1SO 10000

1SO 12800

1SO 16000

1SO 20000

1SO 25600

1SO 32000

Standaard

1SO 40000

1SO 51200

1SO 64000

I1SO 80000

Standaard

Standaard

Standaard

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Als Mode is ingesteld op dB

Instelbereik
3dB

6dB

9dB

12dB

15dB Standaard
18dB

21dB

24dB

27dB

30dB
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Beeldkwaliteitsinstellingen opgeslagen voor elke opnamemodus

De huidige status van configuratie-onderdelen met betrekking tot beeldkwaliteit wordt opgeslagen voor elk van de volgende opnamemodi (pagina 24). Als u de opnamemodus wijzigt, worden de

corresponderende instellingen die zijn opgeslagen toegepast voor de doelopnamemodus.

e Custommodus SDR(BT.709)
e Custommodus HDR(HLG)
e Cine El-modus

De configuratie-onderdelen met betrekking tot beeldkwaliteit die worden opgeslagen voor elk van de opnamemodi worden hieronder weergegeven.

Ja: het menu-onderdeel wordt opgeslagen.
Nee: het menu-onderdeel wordt niet opgeslagen.

Configuratie-onderdeel Opnamemodus
Custom modus Cine EI-modus
SDR(BT.709) | HDR(HLG)
Menu Shooting ISO/Gain/El ISO/Gain JaY Nee
Exposure Index Nee Ja
Base Sensitivity Ja Nee
Base ISO Nee Ja
White Preset White Ja Ja
Anders dan bovenstaand Ja
White Setting Ja
Offset White Ja Nee
LUT On/Off Nee Ja
Noise Suppression Setting(Custom) Ja Ja Nee
Level(Custom) Ja Ja Nee
Setting(Cine El) Nee Ja
Level(Cine El) Nee Ja
Menu Paint/Look Base Look Select Ja Ja Ja
Input? Ja
Output? Ja
AE Level Offset? Ja
Black Ja Ja Nee
Knee Auto Knee Ja Nee Nee
Anders dan bovenstaand Ja Ja Nee
Detail Ja Ja Nee
Matrix Ja Ja Nee
Multi Matrix Ja Ja Nee

1) Afzonderlijke ISO-gevoeligheidsinstellingen worden opgeslagen voor zowel Custommodus SDR(BT.709) als HDR(HLG).

2) Instellingen worden opgeslagen voor elke Base Look en zijn niet afhankelijk van de opnamemodus.
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Configuratiegegevens opslaan en laden

Configuratiegegevens

U kunt de instelling van het hoofdmenu
opslaan op een geheugenkaart die is
geplaatst in CFexpress Type A/SD kaartsleuf
(B). U kunt een ALL-bestand ook opslaan
naar een clouddienst. Hiermee kunt snel

een geschikte set menu-instellingen voor de
huidige situatie oproepen.
Configuratiegegevens worden opgeslagen in
de volgende categorieén.

Gebruikersbestanden

Gebruikersbestanden slaan de instellingen en
gegevens van het aanpasbare menu User op.
U kunt 64 bestanden op een geheugenkaart
opslaan.

Door dit bestand in het geheugen van de
camcorder te laden kunt u de configuratie van
het menu User aanpassen.

ALL (all settings)-bestanden

ALL-bestanden slaan de configuratiegegevens
van alle menu's op. U kunt 64 bestanden

op een geheugenkaart opslaan. U kunt

120 bestanden opslaan naar C3 Portal
(clouddienst), onderverdeeld als 60
privébestanden en 60 gedeelde bestanden.
[Opmerking]

Voor nadere gegevens over wat er in een ALL-bestand

is opgeslagen raadpleegt u "Menu-onderdelen die in
bestanden worden opgeslagen” (pagina 126).

Een gebruikersbestand/ALL-
bestand opslaan

Opslaan naar een geheugenkaart

1

Plaats een geheugenkaart in de CFexpress

Type A/SD kaartsleuf (B) (pagina 6).

e Bij CFexpress-kaarten wijst het etiket
naar links.

e \oor SD-kaarten wijst het etiket naar
rechts met de schuin afgeplatte hoek
aan de onderkant.

Selecteer voor een gebruikersbestand
User File >Save to Media(B) (pagina 89)
>Execute in het menu Project van het
hoofdmenu.

Selecteer voor een ALL-bestand All File
>Save to Media(B) (pagina 89) >Execute
in het menu Project van het hoofdmenu.
Er verschijnt een doelscherm voor
bestanden opslaan.

Selecteer een regel met "No File" in het
doelscherm voor bestanden.

Het selecteren van een regel met een
Bestands-ID overschrijft het betreffende
bestand.

De bestands-id die wordt toegewezen bij
het opslaan kan worden gewijzigd met
het menu. Zie voor details over
configuratie "De File ID wijzigen"

(pagina 14).

Selecteer Execute in het
bevestigingsscherm.

Een ALL-bestand opslaan naar een
clouddienst

1 Maak verbinding met het apparaat vanuit
de smartphone-app "C3 Portal App"
(pagina 67).

2 Selecteer All File >Save to Cloud(Private)
of Save to Cloud(Share) (pagina 89)
>Execute in het menu Project van het
hoofdmenu.

Er verschijnt een doelscherm voor
bestanden opslaan.

3 Selecteer een regel met "No File" in het
doelscherm voor bestanden.
Het selecteren van een regel met een
Bestands-ID overschrijft het betreffende
bestand.
De bestands-id die wordt toegewezen bij
het opslaan kan worden gewijzigd met
het menu. Zie voor details over
configuratie "De File ID wijzigen"
(pagina 14).

4 Selecteer Execute in het
bevestigingsscherm.

Een gebruikersbestand/ALL-
bestand laden

Laden vanaf een geheugenkaart

1 Plaats een geheugenkaart waarop een
bestand is opgeslagen in de CFexpress
Type A/SD-kaartsleuf (B) (pagina 6).

e Bij CFexpress-kaarten wijst het etiket
naar links.

e \oor SD-kaarten wijst het etiket naar
rechts met de schuin afgeplatte hoek
aan de onderkant.

2 Selecteer voor een gebruikersbestand
User File >Load from Media(B)
(pagina 89) >Execute in het menu
Project van het hoofdmenu.
Selecteer voor een ALL-bestand All File
>Load from Media(B) (pagina 89)
>Execute in het menu Project van het
hoofdmenu.
Er verschijnt een scherm met een
bestandslijst.

3 Selecteer een te laden bestand.
Er verschijnt een bevestigingsscherm.

4 Selecteer Execute.

[Opmerkingen]

e Het apparaat start automatisch opnieuw na het laden
van de configuratiegegevens.

e Als All File >Load Network Data in het menu Project
van het hoofdmenu is ingesteld op Off, worden alle
instellingen in het ALL-bestand geladen, behalve de
instellingen voor het menu Network.
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Een ALL-bestand laden van een
clouddienst

1

3

4

Maak verbinding met het apparaat vanuit
de smartphone-app "C3 Portal App"
(pagina 67).

Selecteer All File >Load from
Cloud(Private) of Load from Cloud(Share)
(pagina 89) >Execute in het menu
Project van het hoofdmenu.

Er verschijnt een scherm met een
bestandslijst.

Selecteer een te laden bestand.
Er verschijnt een bevestigingsscherm.

Selecteer Execute.

[Opmerkingen]

e Het apparaat start automatisch opnieuw na het laden
van de configuratiegegevens.

e Als All File >Load Network Data in het menu Project
van het hoofdmenu is ingesteld op Off, worden alle
instellingen in het ALL-bestand geladen, behalve de
instellingen voor het menu Network.

De File ID wijzigen

Selecteer voor een gebruikersbestand
User File >File ID (pagina 89) in het
menu Project van het hoofdmenu.
Selecteer voor een ALL-bestand All File
>File ID (pagina 89) in het menu Project
van het hoofdmenu.

Er verschijnt een scherm voor het
bewerken van de File ID.

Selecteer een teken met de
keuzeschakelaar (pagina 7) of de
multifunctionele regelaar (pagina 5)

en druk vervolgens op de
toepassingsknop van de keuzeschakelaar
of multifunctionele regelaar.

Herhaal zo nodig stap 2.

Selecteer Done als u klaar bent met het
invoeren van tekens.
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7. Aansluiting met een extern apparaat

Aansluiting externe monitors en opname-apparaten

Om opgenomen/af te spelen beelden op een
externe monitor af te spelen, selecteert u het
camcorder-uitgangssignaal en gebruikt u de
juiste kabel om de monitor aan te sluiten.

U kunt ook opnameapparaten aansluiten,
zoals een videorecorder en het
uitgangssignaal van de camcorder opnemen.
U kunt op een externe monitor dezelfde
informatie weergeven als zichtbaar is in de
zoeker, zoals statusinformatie en menu's.

Zet Info. Disp. (pagina 15) op het scherm
Monitoring Status of Output Display

(pagina 94) in het menu Monitoring van het
hoofdmenu op On, afhankelijk van het signaal
dat naar de monitor moet worden verzonden.
[Opmerking]

Houd rekening met het volgende als u een externe
monitor of extern opnameapparaat aansluit op het
apparaat. Anders kunnen de interne stroomkringen van
het apparaat beschadigd raken.

- Gebruik een gelijkstroomkabel met een lage GND-

lijnimpedantie om een externe monitor of extern
opnameapparaat aan te sluiten.

- Voordat u een 75 Q-coaxkabel of HDMI-kabel aansluit,

controleert u of er geen potentiaalverschil bestaat
tussen het apparaat en de behuizing van de externe
monitor of opnameapparaat.

- Voordat u een 75 Q-coaxkabel of HDMI-kabel aansluit,

controleert u dat het apparaat en de externe monitor
of opnameapparaat zijn uitgeschakeld. Sluit alle
kabels aan en schakel dan de apparaten in.
Neem contact op met een Sony-
servicevertegenwoordiger voor meer informatie.

SDI OUT-aansluiting (BNC type)

Stel de instelling on/off voor de uitgang en
de uitvoerindeling in het menu Monitoring in
(pagina 94).

Gebruik voor de aansluiting een commercieel
verkrijgbare 75 Q coaxkabel.

Opnemen op de camcorder en het
externe apparaat tegelijkertijd starten

Stel met SDI signaaluitvoer ingeschakeld

de instelling SDI/HDMI Rec Control

(pagina 86) >Setting in het menu Project

van het hoofdmenu op SDI/HDMI Remote

I/F of Parallel Rec om uitvoer van een REC

triggersignaal naar het op de SDI OUT

aangesloten externe apparaat in te schakelen.

Dit synchroniseert opname van het externe

apparaat met de camcorder.

[Opmerkingen]

e Als een aangesloten extern apparaat geen
ondersteuning biedt voor een REC triggersignaal, kan
het apparaat niet worden bediend.

e Als er geen medium is geplaatst wordt alleen het REC
triggersignaal verzonden.

HDMI OUT-aansluiting (Type A
aansluiting)

Stel de instelling On/Off voor de uitgang en
de uitvoerindeling in het menu Monitoring
(pagina 94) of in het hoofdmenu in.

Opnemen op de camcorder en het
externe apparaat tegelijkertijd starten

Stel met HDMI signaaluitvoer ingeschakeld
HDMI TC Out >Setting (pagina 92) in het

menu TC/Media van het hoofdmenu in op

On, en stel SDI/HDMI Rec Control >Setting
(pagina 86) in het menu Project in op
SDI/HDMI Remote I/F of Parallel Rec, om
uitvoer van een REC triggersignaal naar het
op de HDMI OUT aangesloten apparaat in te
schakelen. Dit synchroniseert opname van het
externe apparaat met de camcorder.

[Opmerkingen]

e Als een aangesloten extern apparaat geen
ondersteuning biedt voor een REC triggersignaal, kan
het apparaat niet worden bediend.

e Wanneer dit is ingesteld op SDI/HDMI Remote I/F
wordt alleen het REC-triggersignaal verzonden
wanneer er geen medium is geplaatst.
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7. Aansluiting met een extern apparaat

Tijdcodes synchroniseren

U kunt de tijdcode van het apparaat met
andere apparaten synchroniseren.

De tijdcode met die van andere
apparaten vergrendelen

Stel het apparaat dat de tijdcode verzendt in
op een modus waarin de tijdcodeverzending
actief blijft (zoals Free Run of Clock).

1 Stel Timecode (pagina 92) in het menu
TC/Media van het hoofdmenu als volgt in.
Mode: Preset
Run: Free Run

2 Druk op de toewijsbare knop
(pagina 49) die is toegewezen aan de
functie DURATION/TC/U-BIT om de
tijldcode op het scherm weer te geven.

3 Controleer of de selectieschakelaar TC IN/
OUT (pagina 4) is ingesteld op de
IN-stand, en lever daarna een
referentietijdcode voor synchronisatie van
de systeemfrequentie van de camcorder
naar de TC IN/TC OUT-aansluiting.

De tijdcodegenerator van de camcorder
verkrijgt vergrendeling met de
referentietijdcode en "EXT-LK" verschijnt op
het scherm.

Als er ongeveer tien seconden zijn verstreken
nadat de tijdcode is vergrendeld, wordt de
externe vergrendelingsstaat behouden, zelfs
als de bron van de externe referentietijdcode
wordt losgekoppeld.

[Opmerkingen]

e Bij gebruik met externe vergrendeling ontvangt de
tijdcode onmiddellijk vergrendeling met de externe
tijdcode en de waarde van de externe tijdcode
verschijnt in het gegevensweergavegebied. Start
de opname echter niet onmiddellijk. Wacht een
paar seconden tot de tijdcodegenerator stabiliseert,
alvorens op te nemen.

e Als de frequentie van de referentietijdcode en de
framefrequentie op de camcorder niet hetzelfde zijn,
kan geen vergrendeling worden ontvangen en zal de
camcorder niet goed werken. Als dit zich voordoet,
ontvangt de tijdcode geen succesvolle vergrendeling
met de externe tijdcode.

e De tijdcode mag één frame per uur verspringen ten
opzichte van de referentietijdcode.

Externe vergrendeling vrijgegeven

Verander de instelling Timecode in het menu
TC/Media van het hoofdmenu.

Externe synchronisatie wordt ook vrijgegeven
als de systeemfrequentie wordt gewijzigd

en als opname wordt gestart in een speciale
opnamemodus (Slow & Quick Motion of
Interval Rec).

De tijdcode van een ander
apparaat synchroniseren met de
tijdcode van de camcorder

Stel het apparaat dat de tijdcode verzendt in
op een modus waarin de tijdcodeverzending
actief blijft (zoals Free Run of Clock).

1 Stel de tijdcode van de camcorder in met
Timecode (pagina 92) in het menu TC/
Media van het hoofdmenu.

2 Controleer of de selectieschakel TC IN/
OUT (pagina 4) is ingesteld op de
OUT-stand, en sluit de TC IN/TC OUT-
aansluiting aan op de tijdcode-ingang van
het apparaat dat u wilt synchroniseren.
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7. Aansluiting met een extern apparaat

Clips beheren/bewerken met behulp van een computer

Aansluiten met behulp van een
USB-kabel

Een kaartlezer gebruiken (optie)

Sluit een CFexpress-kaartlezer of een SD-
kaartlezer aan op een computer met een
USB-kabel en plaats een geheugenkaart in

de sleuf van de kaartlezer. De geheugenkaart
wordt herkend als een extern station van de
computer. Op computers die dit ondersteunen
kunnen clips op hoge snelheid worden
geimporteerd in de massaopslagmodus van
de camcorder.

Massaopslagmodus gebruiken

[Opmerking]

Massa-opslag modus kan niet worden gebruikt

als Modem >Setting in het menu Network van het
hoofdmenu is ingesteld op On, of als Wired LAN >Setting
in het menu Network is ingesteld op On. Zet deze beide
op Off.

Sluit de camcorder aan met een USB-kabel en
plaats een geheugenkaart in kaartsleuf A of
B. De geheugenkaart wordt door de computer
herkend als een extern station.

1 Sluit de USB-C-aansluiting (pagina 7)
of USB/multi-aansluiting (pagina 7)
aan op de computer met een USB-kabel.

2 Zet de POWER-knop van de camcorder in
de ON-stand.
Er verschijnt een melding op het
zoekerscherm waarin wordt gevraagd of
er een USB-verbinding tot stand moet
worden gebracht.

[Opmerking]

De USB-bevestigingsmelding wordt

niet weergegeven als er een andere
bevestigingsmelding of voortgangsmelding wordt
weergegeven, bijvoorbeeld bij het formatteren of
herstellen van een geheugenkaart.

De bevestigingsmelding wordt weergegeven als
het formatteren of herstellen is beéindigd. De
USB-bevestigingsmelding wordt ook weergegeven
als het scherm voor clipeigenschappen wordt
weergegeven. De melding wordt weergegeven als
de bewerking eindigt of als u teruggaat naar het
pictogrammenscherm.

Draai aan de multifunctionele regelaar om
Execute te selecteren.

4 Controleer onder Windows of de kaart is

toegevoegd als een verwisselbare schijf in
het venster "Deze Computer".

Controleer op Mac of er een folder met de
naam “NO NAME" of “Untitled”
(bewerkbaar) is toegevoegd op het
bureaublad.

[Opmerkingen]

Voer de volgende handelingen niet uit als de
toegangsindicator rood brandt.

- De stroom uitschakelen of het netsnoer losmaken
- De geheugenkaart verwijderen

- De USB-kabel losmaken

De werking is niet gegarandeerd op alle computers.

Een non-lineair
bewerkingssysteem gebruiken

In en non-lineair bewerkingssysteem is
bewerkingssoftware (optie) vereist die de
door de camcorder opgenomen indelingen
ondersteunt.

Gebruik speciale toepassingssoftware om de
clips die u wilt bewerken eerst op te slaan op
de harde schijf van de computer.
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8. Appendix

Voorzorgsmaatregelen voor gebruik

Over condensatie

Als het apparaat rechtstreeks van een koude
in een warme omgeving wordt gebracht of

als de omgevingstemperatuur plots stijgt, kan
er zich vocht vormen op de buitenzijde en/

of in het toestel. Dit wordt condensvorming
genoemd. Schakel in geval van
condensvorming het toestel uit en gebruik het
niet opnieuw tot de condens verdwenen is. Als
u het toestel toch gebruikt terwijl er condens
aanwezig is, kan het toestel beschadigd raken.

Op LCD-panelen

Het Icd-paneel van dit apparaat is met behulp
van een hoogwaardige precisietechnologie
vervaardigd, waardoor een werkende
pixelratio ontstaat van minimaal 99,99%.
Hieruit volgt dat een zeer klein gedeelte van
de pixels vast staat; altijd uit (zwart), altijd aan
(rood, groen of blauw) of knippert. Bovendien
kunnen gedurende een lange gebruiksperiode
als gevolg van de fysieke eigenschappen

van de lcd dergelijke vaste pixels spontaan
verschijnen. Bovenstaande punten zijn geen
defecten. Merk op dat dergelijke problemen
geen invloed hebben op opgenomen
gegevens.

Camera CMOS beeldsensor-
verschijnselen

[Opmerking]

De volgende verschijnselen die kunnen voorkomen in
afbeeldingen zijn specifiek voor beeldsensoren. Dit wijst
niet op een storing.

Witte vlekjes

Hoewel de beeldsensors worden
geproduceerd met hoogwaardige
precisietechnologieén, kunnen er in zeldzame
gevallen kleine witte vlekjes worden
gegenereerd op het scherm, veroorzaakt door
kosmische straling, etc.

Dit is inherent aan het principe van
beeldsensoren en is geen defect.

De witte vlekjes kunnen vooral te zien zijn in
de volgende gevallen:

e Bij werken in een hoge omgevingstemperatuur

e Als u de versterking heeft verhoogd
(sensitivity)

Flikkering

Bij het filmen onder belichting van

fluorescerend licht, natriumlampen,

kwiklampen of LEDs, kan het scherm flikkeren
of kunnen kleuren variéren.

Op verbruiksartikelen

e De ventilator en batterij zijn
verbruiksartikelen die af en toe vervangen
moeten worden.

Wanneer u het apparaat bij
kamertemperatuur gebruikt, moeten

deze onderdelen ongeveer elke 5 jaar
vervangen worden. Merk op dat deze
termijn een algemene richtlijn is en geen
garanties biedt aangaande de levensduur
van deze onderdelen. Neem contact op
met een onderhoudsdienst van Sony of uw
leverancier voor meer informatie over het
vervangen van onderdelen.

e De verwachte levensduur van de
AC-adapter en de elektrolytische
condensator is ongeveer 5 jaar bij normale
werkingstemperaturen en normaal gebruik
(8 uur per dag, 25 dagen per maand). Als
het gebruik de normale gebruiksfrequentie
overschrijdt, kan de levensduur
dienovereenkomstig verkorten.

e De accuaansluiting van dit apparaat (de
aansluiting voor accusets en netadapters) is
een verbruiksartikel.

Het apparaat krijgt mogelijk geen stroom
als de pennen van de accu-aansluiting
zijn vervormd door schokken of trillingen,
of als ze gecorrodeerd zijn als gevolg van
langdurig gebruik in de buitenlucht.
Periodieke inspecties worden geadviseerd
om het apparaat goed werkend te houden
en de bruikbare levensduur te verlengen.
Neem contact op met een Sony service- of
verkoopvertegenwoordiging voor meer
informatie over inspecties.

Over de ingebouwde oplaadbare batterij

De camcorder heeft een ingebouwde
oplaadbare batterij voor het opslaan van
datum, tijd en andere instellingen, zelfs

als de camcorder wordt uitgeschakeld. De
ingebouwde oplaadbare batterij wordt
opgeladen na 24 uur als het apparaat

is aangesloten op een stopcontact met

de netadapter, of als er een volledig
opgeladen accuset is bevestigd, ongeacht

of de camcorder is in- of uitgeschakeld. De
oplaadbare batterij wordt volledig ontladen
in ongeveer 2 maanden als de netadapter
niet is aangesloten of als de camcorder
wordt gebruikt zonder bevestigde accuset.
Gebruik uw camcorder na het opladen van de
batterij. Als de oplaadbare batterij echter niet
worden opgeladen, wordt de werking van de
camcorder niet beinvloed zolang u de datum
niet hoeft op te nemen.

Gebruiks- en opslaglocaties

Opslaan op een vlakke geventileerde plaats.
Vermijd gebruik of opslag op de volgende
plaatsen.

e |n uitzonderlijke hitte of kou
(bedrijfstemperatuurbereik: 0 °C tot 40 °C)
Bedenk dat in de zomer in warme klimaten
de temperatuur in een auto met gesloten
ramen makkelijk boven de 50 °C kan komen.

e |n vochtige of stofrijke omgevingen. Locaties
waar het apparaat blootstaat aan regen

e Plaatsen met sterke trillingen

e Bij sterke magnetische velden

e Dichtbij radio- of tv-ontvangers die sterke
elektromagnetische velden produceren.

e | angere periodes in direct zonlicht of
dichtbij verwarming

Opmerking over laserstralen

Laserstralen kunnen de CMOS beeldsensor
beschadigen. Als u een scene filmt waarin

een laserstraal voorkomt, pas dan op dat de
laserstraal niet op de lens van het apparaat
wordt gericht. Vooral ultrasterke laserstralen
van medische apparatuur of andere apparaten

kunnen schade veroorzaken, als gevolg van
reflecterend en verstrooid licht.

Elektromagnetische interferentie van
draagbare communicatieapparatuur
voorkomen

Gebruik van draagbare telefoons en andere
communicatieapparaten in de buurt van

deze camera kan resulteren in storingen en
interferentie met audio- en videosignalen.
Geadviseerd wordt om de draagbare
communicatieapparatuur in de buurt van deze
camera uit te schakelen.

Veiligheidsmaatregelen

e SONY IS NIET AANSPRAKELIJK VOOR
WELKE SCHADE DAN OOK DIE
VOORTKOMT UIT HET NIET NEMEN VAN
VOLDOENDE BEVEILIGINGSMAATREGELEN
OP TRANSMISSIEAPPARATEN,
ONVERMIJDBARE GEGEVENSLEKKEN
DOOR TRANSMISSIESPECIFICATIES OF
BEVEILIGINGSPROBLEMEN VAN WELKE
AARD DAN OOK.

e Afhankelijk van de gebruiksomgeving
kunnen onbevoegden via het netwerk
toegang krijgen tot het apparaat. Wanneer u
het apparaat verbinding laat maken met het
netwerk, zorg er dan voor dat het netwerk
goed is beveiligd.

e De inhoud van communicatie kan zonder
dat u dat weet worden onderschept
door onbevoegden in de buurt van
het signaal. Wanneer u draadloze LAN-
communicatie gebruikt, pas dan correcte
beveiligingsmaatregelen toe om de inhoud
van uw communicatie te beschermen.

e Wanneer u dit product aansluit op een
netwerk, maak dan verbinding via een
systeem dat beveiliging biedt, zoals een
router of firewall. Als u verbinding maakt
zonder dergelijke bescherming kunnen
beveiligingsproblemen ontstaan.
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8. Appendix

Uitvoerindelingen en beperkingen

Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld, 1920x1080P (Level A)).

[Opmerkingen]

e De resolutie van de uitvoerindeling wordt beperkt door de instellingen Rec Format >Frequency, Video Format en
Codec in het menu Project van het hoofdmenu (pagina 83).
e De resolutie van de uitvoerindeling wordt bovendien beperkt door de combinatie met de S&Q-beeldsnelheid.
Naast de tabel met uitvoerindelingen vanaf de aansluitingen SDI OUT/HDMI OUT wijzigt de HDMI-uitvoer naar Full
HD of lager wanneer aan al de volgende voorwaarden is voldaan.
- S&Q Motion >Setting in het menu Shooting is op On ingesteld
- S&Q Motion >Frame Rate in het menu Shooting is hoger dan 60fps
- Rec Format >Codec in het menu Project is ingesteld op RAW of RAW & XAVC-I, of Output On/Off >SDI in het

menu Monitoring staat op On

e Als aan bovenstaande voorwaarden is voldaan, worden de selectieopties HDMI-uitvoer 4096x2160P en 3840x2160P

voor Output Format >SDI/HDMI (pagina 94) in het menu Monitoring grijs weergegeven en kunnen niet worden

geselecteerd.

e Het beeld wordt niet uitgevoerd als een hogere resolutie dan die van het afspeelbeeld is geconfigureerd.

Uitvoerindelingen SDI OUT/HDMI OUT-aansluitingen

Instelling voor
systeemfrequentie

Codec-instelling
(Rec Format

Instelling van RAW-/
opname-indeling

Uitvoerindeling (Output Format in
het menu Monitoring)

Instelling voor Codec-instelling
systeemfrequentie (Rec Format
(Rec Format > >Codec in het

Frequency in het  menu Project)
menu Project)

Instelling van RAW-/
opname-indeling
(Rec Format > RAW
Output Format/Video
Format in het menu
Project)

Uitvoerindeling (Output Format in
het menu Monitoring)

SDI HDMI

50/59.94Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P
RAW & XAVC-| 3840x2160P
1920x1080P
1920x1080i
3840%2160(RAW) (3840%2160 RAW) 3840x2160P
1920x1080P
1920x1080i
RAW(HDMI) 4240x2392(RAW) 1920x1080P (4240%2392 HDMI
RAW(HDMI) & (Level A) RAW)
XAVC-I 1920x1080P
(Level B)

1920x1080i

(Rec Format > >Codec in het (Rec Format > RAW SDI HDMI
Frequency in het  menu Project) Output Format/Video
menu Project) Format in het menu
Project)
XAVC-I 4096x2160(Video) 4096x2160P" 4096x2160P
XAVC-L 4096x2160P 1920x1080P
4096x2160P 1920x1080i
3840x2160P 3840x2160P
3840x2160P 1920x1080P
3840x2160P 1920%1080i
1920x1080P 1920x1080P
(Level A)
1920x1080P 1920%1080i
(Level A)
1920x1080P 1920x1080P
(Level B)
1920x1080P 1920%1080i
(Level B)
1920x1080i 1920x1080i
3840x2160(Video) 3840x2160P 3840x2160P
3840x2160P 1920x1080P
3840x2160P 1920x1080i
1920x1080P 1920x1080P
(Level A)
1920x1080P 1920%1080i
(Level A)
1920x1080P 1920x1080P
(Level B)
1920x1080P 1920%1080i
(Level B)
1920x1080i 1920%1080i
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Instelling voor

systeemfrequentie

Codec-instelling
(Rec Format

Instelling van RAW-/
opname-indeling

Uitvoerindeling (Output Format in

het menu Monitoring)

Instelling voor

systeemfrequentie

Codec-instelling
(Rec Format
>Codec in het

Instelling van RAW-/
opname-indeling

Uitvoerindeling (Output Format in
het menu Monitoring)

(Rec Format > >Codec in het (Rec Format > RAW SDI HDMI (Rec Format > (Rec Format > RAW SDI HDMI
Frequency in het  menu Project) Output Format/Video Frequency in het  menu Project) Output Format/Video
menu Project) Format in het menu menu Project) Format in het menu
Project) Project)
50/59.94Hz XAVC-I 1920x1080(Video) 1920x1080P 1920x1080P 23.98Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P
XAVC-L (Level A) RAW & XAVC-I 3840x2160P
1920x1080P 1920x1080i 1920x1080P
(Level A) 3840x2160(RAW) (3840x2160 RAW) 3840x2160P
1920x1080P 1920x1080P 1920x1080P
Level B
(Level B) _ RAW(HDMI) 4240x2392(RAW) 1920x1080P (4240x2392 HDMI
1920x1080P 1920x1080i RAW(HDMI) & RAW)
(Level B) XAVC-|
192010801 1920x1080i XAVC-| 4096x2160(Video)  4096x2160P" 4096x2160P
(Uitvoer 720x480P"9 XAVC-L 4096x2160P 1920x1080P
onderbroken) _ 720x576p"> 3840x2160P 3840x2160P
25/29.97Hz RAW 4096x2160(RAW) (4096x2160 RAW) 4096x2160P 3840x2160P 1920x1080P
RAW & XAVC _3840x2160P 1920x1080P 1920x1080P
1920<1080P 3840x2160(Video)  3840x2160P 3840x2160P
1920x1080i 3840x2160P 1920x1080P
3840x2160(RAW) (3840x2160 RAW) 3840x2160P 1920x1080P 1920x1080P
1920<1080P 1920x1080(Video) 1920x1080P 1920x1080P
1920x1080i 24Hz RAW 4096x2160(RAW) (40962160 RAW) 4096x2160P
RAW(HDMI) 4240%x2392(RAW) 1920x1080P (4240x2392 HDMI RAW & XAVC-1 1920x1080P
RAW(HDMI) & RAW
X AVC(—I ) 1920x1080PsF ) XAVC-| 4096x2160(Video)  4096x2160P" 4096x2160P
XAVC-| 4096x2160(Video)  4096x2160P"  4096x2160P 1920x1080P 1920x1080P
XAVC-L 4096x2160P 1920x1080P 1) De schermweergave kan niet worden opgenomen.
3840x2160P 3840x2160P 2) Wanneer de systeemfrequentie 59.94 is
3) Wanneer de systeemfrequentie 50 is
3840x2160P 1920x1080P
1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
3840x2160(Video) 3840%2160P 3840x2160P
3840x2160P 1920x1080P
1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
1920x1080(Video) 1920x1080P 1920x1080P
1920x1080PsF 1920x1080i
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Problemen oplossen

Stroomvoorziening

Symptoom

Oorzaak

Oplossing

Symptoom

Oorzaak

Oplossing

De camcorder schakelt niet
in.

Eris geen accuset bevestigd
en er wordt geen stroom
geleverd via de DC IN-
aansluiting.

Bevestig een accuset (pagina 17) of
sluit aan op netstroom met een
netadapter (pagina 18).

Het opgenomen geluid heeft

een hoog ruisniveau.

Het audioniveau is te laag.

Pas de audio-opnameniveaus aan met
de regelaars AUDIO LEVEL (CH1/CH2)
(pagina 47).

Als er een externe microfoon is
geselecteerd, pas dan ook de instelling
van INPUT MIC Reference aan bij Audio
Input in het menu Audio (pagina 97).

De accuset is volledig
uitgeput.

Vervang de accuset door een volledig
opgeladen set (pagina 17).

De stroomvoorziening stopt
tijdens gebruik.

De accuset raakt uitgeput.

Vervang de accuset door een volledig
opgeladen set (pagina 17).

De accuset raakt snel

De omgevingstemperatuur is

Dit komt door de accu-eigenschappen

Clips kunnen niet worden
afgespeeld.

De clip wordt momenteel
bewerkt.

Clips kunnen niet worden afgespeeld
als u de bestandsnamen of mappen
heeft gewijzigd, of als de clip in gebruik
is op een computer. Dit is geen defect.

De clip wordt opgenomen
op een ander apparaat.

Clips die zijn opgenomen op andere
apparaten kunnen mogelijk niet worden
afgespeeld of weergegeven op de
correcte grootte. Dit is geen defect.

Externe apparaten

Symptoom

Oplossing

uitgeput. erg laag. en is geen defect.
De accuset is onjuist Laad de accuset opnieuw op
opgeladen. (pagina 17).
Als de accuset snel leeg is, zelfs na
volledig opladen, is de accuset mogelijk
aan het eind van zijn levensduur.
Vervang door een nieuwe.
Opnemen/afspelen
Symptoom Oorzaak Oplossing

Bij het indrukken van de
knop START/STOP wordt
opname niet gestart.

De geheugenkaart is vol.

Vervang de geheugenkaart door een
kaart met voldoende vrije opslagruimte.

De geheugenkaart moet
worden hersteld.

Herstel de geheugenkaart
(pagina 33).

De computer herkent de
camcorder niet.

Koppel de USB-kabel van de computer los en steek deze er daarna

weer stevig in.

Koppel de USB-kabel los van de computer, start de computer
opnieuw en doorloop daarna de stappen nogmaals in de juiste

volgorde.

Verbind de computer met de camcorder door een USB-kabel in de
USB-C-aansluiting of de USB/multi-aansluiting te plaatsen.

Audio-opname is niet
mogelijk.

De AUDIO LEVEL (CH1/
CH2)-regelaars zijn op het
minimumniveau ingesteld.

Pas de audio-opnameniveaus aan met
de regelaars AUDIO LEVEL (CH1/CH2)
(pagina 47).

Het opgenomen geluid klinkt Het audioniveau is te hoog.

vervormd.

Pas de audio-opnameniveaus aan met
de regelaars AUDIO LEVEL (CH1/CH2)
(pagina 47).

Clips kunnen niet in de computer

worden geladen.

Koppel de USB-kabel van de computer los, herstart de camcorder

en maak opnieuw verbinding.

Om clips in de computer te kunnen importeren moet er
toepassingssoftware op de computer zijn geinstalleerd

(pagina 117).
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Draadloze LAN-verbinding

[Opmerking]

Obstakels en elektromagnetische interferentie tussen de camcorder en het draadloze LAN-toegangspunt of het
eindapparaat of de omgeving (zoals muurmaterialen) kunnen het communicatiebereik verkorten of verbindingen in
het geheel blokkeren. Als u deze problemen ervaart, controleer dan de verbindings-/communicatiestatus nadat u de
camcorder naar een nieuwe locatie heeft verplaatst of de camcorder en het toegangspunt/terminalapparaat dichter
bij elkaar heeft gebracht.

Symptoom Oplossing

Een terminal kan geen toegang
krijgen tot de camcorder.

® Controleer de draadloze LAN-verbinding (een IP-adres, etc.).

® De communicatie-instellingen tussen het toegangspunt en de
client kunnen mogelijk ongeldig zijn. Raadpleeg voor details de
gebruiksaanwijzing van het toegangspunt.

U kunt niet op de camcorder Controleer de gebruikersnaam en het wachtwoord dat u heeft

inloggen. ingesteld.

Internetverbinding

Symptoom Oplossing

Het uploaden van een bestand De gebruikersnaam en het wachtwoord van de server zijn mogelijk
mislukt. niet correct.

Voer de correcte gebruikersnaam en wachtwoord in.

Het uploaden van bestanden is
niet beschikbaar.

De signaalverbinding is mogelijk slecht.
Ga naar een andere locatie en probeer het opnieuw.

Bij gebruik van het ND-filter

Symptoom Oplossing

Het ND-filter beweegt niet. U kunt het filter op de volgende manier naar de Clear-stand

verplaatsen.

1 Zet de schakelaar POWER van de camcorder op Off.

2 Verwijder de ronde dop aan de onderkant.

3 Steek een schroevendraaier in de opening en draai deze naar links.
e Het ND-filter wordt verplaatst naar de Clear-stand door het draaien naar links. Blijf draaien
tot de Clear-stand is bereikt.
e Gebruik een schroevendraaier met een diameter van 2,4 mm of minder. De
schroevendraaier moet ongeveer 3,0 cm in de opening kunnen verzinken.

|

©00

C:)£ZD 0!

000000000000

:

Schroefgat
(met dop verwijderd)

4 Zet de schakelaar ND PRESET/VARIABLE (pagina 5) in de stand PRESET, en zet de
omhoog/omlaag-knoppen voor ND FILTER POSITION (pagina 5) op de stand CLEAR.

[Opmerkingen]

e Gebruik de bovenstaande procedure niet tijJdens normaal gebruik. Gebruik deze procedure alleen als het ND-filter
niet wil bewegen. Het ND-filter kan beschadigd raken als deze procedure wordt gebruikt tijJdens normaal gebruik.

e Neem na het gebruiken van bovenstaande procedure contact op met een Sony service center om de camcorder te
laten repareren.

e Als er na het uitvoeren van de bovenstaande procedure nog steeds een foutmelding verschijnt, kan er nog wel
worden gefilmd.
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Fout-/waarschuwingsmeldingen

Als op de camcorder een waarschuwing of bedieningssituatie optreedt die moet worden

bevestigd, wordt een bericht weergegeven in de zoeker, begint het opname/tally-controlelampje

te knipperen en klinkt er een waarschuwingsgeluid.

Zoekermelding

Waarschu-

wingsgeluid tally-lampje

Opname/

Oorzaak en oplossing

Het waarschuwingsgeluid wordt weergegeven via de hoofdtelefoon die is aangesloten op de m:i'a Temperature  Periodiek Knippert ilzehtoeorgperatuurvan de CFexpress geheugenkaart
hoofdtelefoonaansluiting. Vervang de kaart of laat deze afkoelen, alvorens
opnieuw te gebruiken.
Voltage Low Periodiek Knippert Het ingangsvoltage (DC IN) is laag (level 1).
Foutmeldingen Controleer de stroombron.,
Insufficient Voltage Continu Snel Het ingangsvoltage (DC IN) is laag (level 2).
knipperen  Opname is uitgeschakeld.
De camcorder stopt met werken als de volgende schermen worden weergegeven. Sluit een andere stroombron aan.
Zoekermelding Waarschu-  Opname/ Oorzaak en oplossing Media Near Full Periodiek Knippert De resterende capaciteit van de geheugenkaart
wingsgeluid tally-lampje wordt lager. -
E + foutcode Continu Snel Geeft een abnormale situatie in de camcorder Zo snel mogelijk vervangen.
knipperen aan. Opname stopt, zelfs als @REC wordt Media Full Continu Snel Clips konden niet worden opgenomen of
weergegeven in de zoeker. knipperen  gekopieerd omdat de resterende capaciteit op de
Schakel de camcorder uit en controleer op geheugenkaart onvoldoende is.
problemen met aangesloten apparaten, kabels of Onmiddellijk vervangen.
media. Als de fout aanhoudt als de camcorder Clips Near Full Periodiek  Knippert Het aantal aanvullende clips dat kan worden
weer opnieuw wordt ingeschakeld, neem dan opgenomen op de geheugenkaart wordt minder.
contact op met uw Sony Zo snel mogelijk vervangen.
serwcevertegenwoqrd|g_er. Clips Full Continu Snel Het maximale aantal clips dat kan worden
(Als de camcorder niet uitschaket als de knop knipperen  opgenomen op de geheugenkaart is bereikt
POWER op OFF wordt gezet, verwijder dan de PP P9 P 9 9 Lo
Opnemen of kopiéren van meer clips is niet
accu of koppel de netadapter los.) mogelijk. Onmiddellijk vervangen
Afhankelijk van de status van de camcorder wordt EALILS J gen.
er mogelijk geen weergave van de fout of Last Clip Recording Periodiek Knippert De clip die momenteel wordt opgenomen is de
waarschuwingsgeluid weergegeven. laatste clip die kan worden opgenomen, omdat
het maximale aantal clips is bereikt.
Prepareer een nieuwe geheugenkaart.
Media(A)" Life Near Periodiek Knippert De levensduur van de geheugenkaart is bijna
. . End verstreken. Zo snel mogelijk vervangen.
Waarschuwingsmeldingen
darschu gsme d g€ Media(A)" Life End Continu Snel De levensduur van de geheugenkaart is
knipperen  verstreken. Onmiddellijk vervangen.
Volg de instructies als het volgende scherm wordt weergegeven. Media(A)" Near Full Periodiek Knippert Bij gebruik van de functie Simul Rec
Zoekermelding Waarschu- Opname/  Oorzaak en oplossing Media(A)" Full Continu Snel Bij gebruik van de functie Simul Rec
wingsgeluid tally-lampje knipperen
Battery Near End Periodiek Knippert De resterende capaciteit van de accuset wordt ';A(Tld'a(A)” Clips Near  Periodiek Knippert Bij gebruik van de functie Simul Rec
minder. u
Zo snel mogelijk opladen. Media(A)" Clips Full Continu Snel Bij gebruik van de functie Simul Rec
Battery End Continu Snel De accuset is leeg. Opname is uitgeschakeld. knipperen
knipperen  Stop gebruik en vervang de accuset. Media(A)" Last Clip Periodiek Knippert Bij gebruik van de functie Simul Rec
Temperature High Periodiek Knippert De interne temperatuur is hoog. Rec

Schakel de camcorder uit en laat deze afkoelen
voordat u hem opnieuw gebruikt.

Transfer Jobs Near
Full

Het aantal FTP-bestandsoverdrachtstaken dat kan
worden vastgelegd begint krap te worden.
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Zoekermelding Waarschu-  Opname/ Oorzaak en oplossing

wingsgeluid tally-lampje

Het aantal FTP-bestandsoverdrachtstaken dat kan
worden vastgelegd heeft de bovenste grens
bereikt. Wilt u nog een taak vastleggen, verwijder
dan eerst ongewenste taken.?

Transfer Jobs Full - -

1) “(B)" wordt weergegeven voor de kaart in kaartsleuf B.
2) U kunt taken selecteren en verwijderen met File Transfer >View Job List (pagina 106) in het menu Network van
het hoofdmenu. U kunt ook taken verwijderen uit de CBM-takenlijst.

Waarschuwings- en systeemmeldingen

De volgende waarschuwings- en systeemmeldingen kunnen op het scherm verschijnen.
Volg de vermelde aanwijzingen om het probleem op te lossen.

Melding op het scherm

Oorzaak en oplossing

Battery Error
Please Change Battery

Er is een fout gedetecteerd in de accuset.
Vervangen door een normale accuset.

Backup Battery End
Please Change

De resterende capaciteit van de back-upaccu is onvoldoende.
Laad de back-upaccu op.

Unknown Media (A)?
Please Change

Er is een geheugenkaart geplaatst die is gepartitioneerd of
een geheugenkaart die meer clips bevat dan door de
camcorder wordt ondersteund.

De kaart kan niet worden gebruikt in de camcorder en moet
worden vervangen.

Cannot Use Media (A)"
Unsupported File System

Er is een niet-geformatteerde kaart geplaatst of een kaart die
een ander bestandsysteem ondersteunt.

De kaart kan niet worden gebruikt door de camcorder en
moet worden vervangen of worden geformatteerd met de
camcorder.

Media Error
Media (A) " Needs to be Restored

Er heeft zich een fout voorgedaan op de geheugenkaart en de
kaart moet worden hersteld.
Herstel de geheugenkaart.

Media Error
Cannot Record to Media (A) "

De geheugenkaart is mogelijk beschadigd en kan niet langer
worden gebruikt voor opname.

Afspelen is mogelijk, dus maak een kopie. Vervangen van de
geheugenkaart wordt geadviseerd.

Media Error
Cannot Use Media (A) Y

De geheugenkaart is mogelijk beschadigd en kan niet langer
worden gebruikt voor opname of afspelen.

De kaart kan niet worden gebruikt in de camcorder en moet
worden vervangen.

Media (A) " Error
Recording Halted
Playback Halted

Opnemen en afspelen is gestopt omdat zich een fout heeft
voorgedaan bij gebruik van de geheugenkaart.
Als het probleem aanhoudt, vervang dan de geheugenkaart.

Media Reached Rewriting Limit
Change Media (A) "

De levensduur van de geheugenkaart is verstreken.

Maak een backup en vervang de geheugenkaart onmiddellijk.
Als u de kaart blijft gebruiken kan er mogelijk niet meer
worden opgenomen of afgespeeld.

Raadpleeg voor details de gebruiksaanwijzing van de
geheugenkaart.

The specified address is invalid.

Het opgegeven adres is ongeldig.
Controleer of de instelling correct is.

Cannot Use Specified Port Number

Het aangegeven poortnummer is ongeldig.
Controleer of de instelling correct is.
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Melding op het scherm

Oorzaak en oplossing

Fan Stopped

De ingebouwde ventilator is gestopt.
Vermijd gebruik op hoge temperaturen, koppel de stroom los
en neem contact op met uw Sony servicevertegenwoordiger.

Lens I/F Error(xx:xx)

Er is een objectieffout gedetecteerd bij de I/F-communicatie
van het objectief bij bevestiging van een objectief met
E-bevestiging.

Controleer de status van de verbinding met het objectief met
E-bevestiging.

Als het probleem aanhoudt, neem dan contact op met uw
Sony servicevertegenwoordiger en vermeld de foutcode (vijf
tekens tussen haakjes).

This Multi Term. acc is not supported
by the device and cannot be used.
Please verify the compatibility.

Er is een incompatibel accessoire gedetecteerd.

Het enige Multi Terminal-accessoire dat door het apparaat
wordt ondersteund is de meegeleverde
afstandsbedieningsgreep.

Failed

Deze fout verschijnt mogelijk als een adres niet kan worden
bereikt met DHCP op On.
Controleer de DHCP serverinstellingen.

Addition of auto upload job failed.

Het maximale aantal overdrachten is bereikt.

Wis niet gewenste overdrachten. De instelling voor
automatische uploadbestemming voor origineel bestanden of
voor proxybestanden is mogelijk ook incorrect. Controleer of
de instelling correct is.

<SSID>Not found.

Netwerk (toegangspunten) met de gespecificeerde <SSID>
kon niet worden gevonden.
Controleer of de instelling correct is.

<SSID>Authentication Failed

Verificatie van de verbinding op het netwerk (toegangspunt)
met de gespecificeerde <SSID> is mislukt.

Controleer of het wachtwoord en andere instellingen correct
zijn.

An IP address conflict has occurred.
Please check the network settings.

Er is een conflict tussen netwerkadressen van draadloos LAN,
bekabeld LAN of USB-tethering.

Wijzig het adres handmatig of wijzig de instellingen voor de
netwerkrouter.

The IP address of the Wireless LAN
Access Point Mode has been
changed due to an IP address
conflict.

Het IP-adres van het draadloze LAN-toegangspunt is
gewijzigd als gevolg van een conflict in de netwerkadressen
van de draadloze LAN-toegangspuntmodus, het draadloze
LAN of de USB-tethering.

Controleer de instelling van het IP-adres.

1) "(B)" wordt weergegeven voor de kaart in kaartsleuf B.
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Menu-onderdelen die in bestanden worden opgeslagen

Onderdelen die in het hoofdmenu zijn geconfigureerd

Ja: het menu-onderdeel wordt opgeslagen.
Nee: het menu-onderdeel wordt niet opgeslagen.
-: Niet opgeslagen (tijdelijke instelling)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/El Mode Ja Nee
ISO/Gain<H> Ja Nee

ISO/Gain<M> Ja Nee

ISO/Gain<L> Ja Nee

Exposure Index<H> Ja Nee

Exposure Index<M> Ja Nee

Exposure Index<L> Ja Nee

Shockless Gain Ja Nee

Base Sensitivity Ja Nee

Base ISO Ja Nee

ND Filter Preset1 Ja Nee
Preset2 Ja Nee

Preset3 Ja Nee

Shutter Mode Ja Nee
Shutter Speed On/Off Ja Nee

Shutter Speed Ja Nee

Shutter Angle Ja Nee

ECS On/Off Ja Nee

ECS Frequency Ja Nee

Iris Bokeh Control Nee Nee

LEVEL 2 LEVEL 3 All File Scene File
Auto Exposure Level Ja Nee
Mode Ja Nee
Speed Ja Nee
AGC Ja Nee
AGC Limit Ja Nee
AGC Point Ja Nee
Auto Shutter Ja Nee
A.SHT Limit Ja Nee
A.SHT Point Ja Nee
Clip High light Ja Nee
Detect Window Ja Nee
Detect Window Indication Ja Nee
Custom Width Ja Nee
Custom Height Ja Nee
Custom H Position Ja Nee
Custom V Position Ja Nee
White Preset White Ja Nee
Color Temp <A> Ja Nee
Tint<A> Ja Nee
R Gain <A> Ja Nee
B Gain <A> Ja Nee
Color Temp <B> Ja Nee
Tint<B> Ja Nee
R Gain <B> Ja Nee
B Gain <B> Ja Nee
White Setting Shockless White Ja Nee
ATW Speed Ja Nee
White Switch<B> Ja Nee
Filter White Memory Ja Nee
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Ja Nee Project Base Setting Shooting Mode Ja -
Offset Color Temp<A> Ja Nee Target Display Ja -

Offset Tint<A> Ja Nee Rec Format Frequency Ja Nee

Offset White <B> Ja Nee Imager Scan Mode Ja Nee

Offset Color Temp<B> Ja Nee Codec Ja Nee

Offset Tint<B> Ja Nee RAW Output Format Ja Nee

Offset White<ATW> Ja Nee Video Format Ja Nee
Offset Color Temp<ATW> Ja Nee Cine El Setting Color Gamut Ja -

Offset Tint<ATW> Ja Nee HDR Setting VF SDR Preview Ja Nee

Focus AF Transition Speed Ja Nee SDR Gain Ja Nee

AF Subj. Shift Sens. Ja Nee Simul Rec Setting Ja Nee

Focus Area Ja Nee Rec Button Set Ja Nee

Focus Area (AF-S) Ja Nee Proxy Rec Setting Ja Nee

Face/Eye Detection AF Ja Nee Audio Channel Ja Nee

Push AF Mode Ja Nee Chunk Ja Nee

Touch Function in MF Ja Nee Interval Rec Setting Nee Nee

AF Assist Ja Nee Interval Time Ja Nee

S&Q Motion Setting Ja Nee Number of Frames Ja Nee

Frame Rate Ja Nee Pre-Lighting Ja Nee

LUT On/Off SDI/HDMI Ja Nee Picture Cache Rec Setting Ja Nee

VF/Proxy/Stream Ja Nee Cache Size Ja Nee
Internal Rec Ja Nee Cache Rec Time - -

Noise Suppression Setting(Custom) Ja Nee SDI/HDMI Rec Control Setting Ja Nee

Level(Custom) Ja Nee Assignable Button <1> Ja Nee

Setting(Cine El) Ja - <2> Ja Nee

Level(Cine El) Ja - <3> Ja Nee

Flicker Reduce Mode Ja Nee <4> Ja Nee

Frequency Ja Nee <5> Ja Nee

SteadyShot Setting Ja Nee <6> Ja Nee

<7> Ja Nee

<8> Ja Nee

<9> Ja Nee

Focus Hold Button Ja Nee

Assignable Dial Grip/Remote Dial Ja Nee

Grip Dial Direction Ja Nee

Handle Dial Ja Nee

Handle Dial Direction Ja Nee

Multi Function Dial Default Function Ja Nee
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LEVEL1 LEVEL 2 LEVEL 3 All File  Scene File LEVEL1 LEVEL 2 LEVEL 3 All File  Scene File
Project User File Load from Media(B) - - Paint/Look Detail Setting Ja Ja
Save to Media(B) - - Level Ja Ja
File ID Nee Nee Manual Setting Ja Ja
Load Customize Data Ja Nee V/H Balance Ja Ja
Load White Data Ja Nee B/W Balance Ja Ja
All File Load from Media(B) - - Limit Ja Ja
Load from Cloud(Private) - - Crispening Ja Ja
Load from Cloud(Share) - - High Light Detail Ja Ja
Save to Media(B) - - Matrix User Matrix Ja Ja
Save to Cloud(Private) - - User Matrix Level Ja Ja
Save to Cloud(Share) - - User Matrix Phase Ja Ja
File ID Ja Nee User Matrix R-G Ja Ja
Load Network Data Nee Nee User Matrix R-B Ja Ja
Paint/Look Scene File Recall - - User Matrix G-R Ja Ja
Store - - User Matrix G-B Ja Ja
Delete - - User Matrix B-R Ja Ja
Preset Recall - - User Matrix B-G Ja Ja
Base Look Select Ja Ja Multi Matrix Setting Ja Ja
Delete - - Reset - -
Delete All - - Axis Nee Ja
Import from Media(B) - - Hue Ja Ja
Import from Cloud(Private) - - Saturation Ja Ja
Import from Cloud(Share) - - TC/Media Timecode Mode Ja Nee
Input Ja Ja Run Ja Nee
Output Ja Ja Setting Nee Nee
AE Level Offset Ja Ja Reset - -
Reset Paint Settings Reset without Base Look - - TC Format Ja Nee
Black Master Black Ja Ja TC Display Display Select Ja Nee
R Black Ja Ja Users Bit Mode Ja Nee
B Black Ja Ja Setting Nee Nee
Knee Setting Ja Ja HDMI TC Out Setting Ja Nee
Auto Knee Ja Ja Clip Name Format Title Prefix Ja Nee
Point Ja Ja Number Set Nee Nee
Slope Ja Ja Update Media Media(A) - -
Media(B) - -

Format Media

(
Media(A)
Media(B)
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Monitoring Output On/Off SDI Ja Nee Monitoring Display On/Off ND Filter Ja Nee
HDMI Ja Nee Iris Ja Nee
Output Format SDI Ja Nee ISO/Gain/El Ja Nee
HDMI Ja Nee Shutter Ja Nee
Output Display SDI Ja Nee Level Gauge Ja Nee
HDMI Ja Nee Audio Level Meter Ja Nee
Display On/Off Network Status Ja Nee Video Level Warning Ja Nee
File Transfer Status Ja Nee Clip Number Ja Nee
Rec/Play Status Ja Nee Notice Message Ja Nee
RAW Output Control Status Ja Nee Marker Setting Ja Nee
Tally Ja Nee Color Ja Nee
Battery Remain Ja Nee Center Marker Ja Nee
Focus Mode Ja Nee Safety Zone Ja Nee
Focus Position Ja Nee Safety Area Ja Nee
Focus Area Indicator Ja Nee Aspect Marker Ja Nee
Focus Area Ind.(AF-S) Ja Nee Aspect Mask Ja Nee
Face/Eye Detection Frame Ja Nee Aspect Safety Zone Ja Nee
Lens Info Ja Nee Aspect Safety Area Ja Nee
Imager Scan Mode Ja Nee Aspect Select Ja Nee
Rec Format Ja Nee Custom Aspect Ratio Ja Nee
Frame Rate Ja Nee Guide Frame Ja Nee
Zoom Position Ja Nee 100% Marker Ja Nee
UWP RF Level Ja Nee User Box Ja Nee
SteadyShot Ja Nee User Box Width Ja Nee
Base Look/LUT Ja Nee User Box Height Ja Nee
SDI/HDMI Rec Control Ja Nee User Box H Position Ja Nee
Gamma Display Assist Ja Nee User Box V Position Ja Nee
Proxy Status Ja Nee VF Setting Brightness Ja Nee
Base I1SO/Sensitivity Ja Nee Color Mode Ja Nee
Media Status Ja Nee Gamma Display Assist  Setting Ja Nee
Video Signal Monitor Ja Nee Peaking Setting Ja Nee
Clip Name Ja Nee Peaking Level Ja Nee
White Balance Ja Nee Color Ja Nee
Scene File Ja Nee Zebra Setting Ja Nee
Focus Indicator Ja Nee Zebral Level Ja Nee
Auto Exposure Mode Ja Nee Zebral Aperture Level Ja Nee
Auto Exposure Level Ja Nee Zebra2 Level Ja Nee
Timecode Ja Nee
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Audio Audio Input CH1 Input Select Ja Nee Thumbnail Display Clip Properties - -
CH2 Input Select Ja Nee Set Clip Flag Add OK - -
CH3 Input Select Ja Nee Add NG - -
CH4 Input Select Ja Nee Add KEEP - -
INPUT1 MIC Reference Ja Nee Delete Clip Flag - -
INPUT2 MIC Reference Ja Nee Lock/Unlock Clip Select Clip - -
Line Input Reference Ja Nee Lock All Clips - -
Reference Level Ja Nee Unlock All Clips - -
CH1 Wind Filter Ja Nee Delete Clip Select Clip - -
CH2 Wind Filter Ja Nee All Clips - -
CH3 Wind Filter Ja Nee Transfer Clip Select Clip - -
CH4 Wind Filter Ja Nee All Clips - -
CH3 Level Control Ja Nee Transfer Clip (Proxy) Select Clip - -
CH4 Level Control Ja Nee All Clips - -
CH3 Input Level Ja Nee Filter Clips oK - -
CH4 Input Level Ja Nee NG - -
Audio Input Level Ja Nee KEEP - -
Limiter Mode Ja Nee None - -
CH1&2 AGC Mode Ja Nee All - -
CH3&4 AGC Mode Ja Nee Customize View Thumbnail Caption Ja -
AGC Spec Ja Nee
1kHz Tone on Color Bars Ja Nee
CH1 Level Ja Nee
CH2 Level Ja Nee
CHS3 Level Ja Nee
CH4 Level Ja Nee
Audio Output Monitor CH Ja Nee
Volume Nee Nee
Headphone Out Ja Nee
Alarm Level Ja Nee
HDMI Output CH Ja Nee




131 8. Appendix: Menu-onderdelen die in bestanden worden opgeslagen

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting Nee Nee Technical Lens Zoom Ring Direction Ja Nee
Type Ja Nee Shading Compensation Ja Nee
ND Dial CLEAR with Dial Ja Nee Chroma Aberration Comp. Ja Nee
Tally Front Ja Nee Distortion Comp. Ja Nee
Rear Ja Nee Breathing Compensation Ja Nee
HOLD Switch Setting with Rec Button Ja Nee Distance Display Ja Nee
with Hand Grip Remote Ja Nee Zoom Position Display Ja Nee
Handle HOLD Switch Ja Nee Video Light Set Video Light Set Ja Nee

Touch Operation Setting Ja Nee APR APR - -
Rec Review Setting Ja Nee Camera Battery Alarm Low Battery Ja Nee
Zoom Zoom Type Ja Nee Battery Empty Ja Nee
Handle Zoom Setting Ja Nee Camera DCIN Alarm DC Low Voltagel Ja Nee
High Ja Nee DC Low Voltage2 Ja Nee

Low Ja Nee Network Setup for Mobile App Setup - -
Menu Settings User Menu Only Ja Nee Access Authentication User Name Nee Nee
User Menu with Lock Nee Nee Input Password Nee Nee

Menu Page On/Off Main Ja Nee Generate Password - -

Camera Ja Nee Show Settings - -
Audio Ja Nee Wireless LAN Setting Ja Nee

Project Ja Nee WPS - -

Monitoring Ja Nee NFC - -

Assignable Button Ja Nee MAC Address - -
Battery Ja Nee AP Mode Settings Channel Ja Nee

Media Ja Nee Camera SSID & Password - -

Network Ja Nee Regenerate Password - -

File Transfer Ja Nee IP Address - -

Fan Control Setting Ja Nee Subnet Mask - -
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Network ST Mode Settings Camera Remote Control Ja Nee Network Wired LAN Setting Ja Nee
Connected Network Camera Remote Control Ja Nee
SSID - - Detail Settings
Security - - DHCP Ja Nee
Password - - IP Address Ja Nee
DHCP - - Subnet Mask Ja Nee
IP Address - - Gateway Ja Nee
Subnet Mask - - DNS Auto Ja Nee
Gateway - - Primary DNS Server Ja Nee
DNS Auto - - Secondary DNS Server Ja Nee
Primary DNS Server - - Modem Setting Ja Nee
Secondary DNS Server - - Camera Remote Control Ja Nee
Scan Networks Device Name - -
SSID - - IP Address - -
Security - - Subnet Mask - -
Password Nee Nee File Transfer Auto Upload Ja Nee
DHCP Ja Nee Auto Upload (Proxy) Ja Nee
IP Address Ja Nee Default Upload Server Ja Nee
Subnet Mask Ja Nee Clear Completed Jobs - -
Gateway Ja Nee Clear All Jobs - -
DNS Auto Ja Nee View Job List - -
Primary DNS Server Ja Nee Server Settings1/Server Settings2/Server Settings3
Secondary DNS Server Ja Nee Display Name Ja Nee
Manual Register Service Ja Nee
SSID Ja Nee Host Name Ja Nee
Security Ja Nee Port Ja Nee
Password Nee Nee User Name Nee Nee
DHCP Ja Nee Password Nee Nee
IP Address Ja Nee Passive Mode Ja Nee
Subnet Mask Ja Nee Destination Directory Ja Nee
Gateway Ja Nee Using Secure Protocol Ja Nee
DNS Auto Ja Nee Root Certificate - -
Primary DNS Server Ja Nee Root Certificate Status - -
Secondary DNS Server Ja Nee Reset - -
Network Reset Reset - -
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LEVELT LEVEL 2 LEVELS Allfile  Sceneflle Menu-onderdelen door toewijshare knoppen geconfigureerd
Maintenance Language Select Ja Nee
Clock Set Time Zone Ja Nee
Ja: het menu-onderdeel wordt opgeslagen.
Date Mode Ja Nee Nee: het menu-onderdeel wordt niet opgeslagen.
12h/24h Ja Nee -: Niet opgeslagen (tijdelijke instelling)
Date Nee Nee Assignable button selection All File Scene File
Time Nee Nee ND Filter Position Ja Nee
All Reset Reset - - Auto Iris Ja Nee
Reset without Network - - ATW Ja Nee
Hours Meter Hours(System) - - Focus Setting Ja Nee
Hours(Reset) - - Display Ja _
Reset - - VF Adjust Ja -
Version Version Number - -
Version Up - -

Lens Version Number

Menu-onderdelen door de toewijsbare regelaar geconfigureerd

Ja: het menu-onderdeel wordt opgeslagen.
Nee: het menu-onderdeel wordt niet opgeslagen.
-: Niet opgeslagen (tijdelijke instelling)

Selectie toewijsbare regelaar All File Scene File
IRIS Ja Nee
ND Filter Ja Nee

Audio Input Level Ja Nee
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Blokschema's

Zie voor meer informatie “De audio voor opname instellen” (pagina 47) en “Menu User” (pagina 75).

Audio Input (CH1&CH2)

Hieronder wordt het blokschema weergegeven met bevestigde draaggreep.
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Internal MIC

Shoe CH1
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* Op Manual instellen als audio wordt ontvangen via XLR-adapter.
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Audio Input (CH3&CH4)

Hieronder wordt het blokschema weergegeven met bevestigde draaggreep.
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INPUT1
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Internal MIC

Shoe CH1
Shoe CH2

* Op Manual instellen als audio wordt ontvangen via XLR-adapter.
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Audio Output

CH1

CH2
CH3
CH4

[HDMI Output CH]
CH1/CH2, CH3/CH4

N e e e e e

/

- ———

CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

V4 N\

g SDI OUT

' J

- 4 \
HDMI OUT

"\ J

[Alarm Level] [VOLUME]
0~7 0~ 50

\ 4

Internal Speaker

Headphone




E-mount objectiefsoftware updaten

U kunt de software van een objectief met
E-bevestiging met de camcorder updaten.
Raadpleeg de website voor het objectief om
te zien welke objectieven kunnen worden
gelipdatet en voor de bijbehorende software.

De versie controleren

1 Bevestig een objectief met E-bevestiging
aan de camcorder (pagina 22).

2 Selecteer Version in het menu
Maintenance van het hoofdmenu om Lens
Version Number (pagina 107) weer te
geven.

Aan de zijkant wordt de softwareversie
van het objectief met E-bevestiging
weergegeven.

Software updaten

Zet de camcorder in de modus Massaopslag
(pagina 117).

Update de software volgens dezelfde
procedure als bij de objectiefsoftware.



138

8. Appendix

Licenties

MPEG-4 AVC Patent Portfolio-
licentie

DIT PRODUCT IS GELICENSEERD ONDER

DE AVC PATENT PORTFOLIO-LICENTIE

VOOR PERSOONLIJK GEBRUIK VOOR EEN

CONSUMENT OF ANDER GEBRUIK WAARBIJ

GEEN VERGOEDING VOOR

(i) VIDEO ENCODEREN OVEREENKOMSTIG DE
AVC-STANDAARD ("AVC-VIDEO") EN/OF

(i) DECODEREN VAN AVC-VIDEO DIE IS
GECODEERD DOOR EEN CONSUMENT DIE
BEZIG IS MET PERSOONLIKE ACTIVITEITEN
EN/OF IS ONTVANGEN VAN EEN
VIDEOLEVERANCIER DIE IS GELICENSEERD
VOOR HET LEVEREN VAN AVC-VIDEO.

VOOR ANDER GEBRUIK IS GEEN LICENTIE
INGESLOTEN EN WORDT DEZE NIET VERLEEND.
AANVULLENDE INFORMATIE IS VERKRIJGBAAR
BlJ MPEG LA, L.L.C. ZIE
HTTP://WWW.MPEGLA.COM

Software verkrijgen onder de
GPL/LGPL-licentie

Dit product gebruikt software waarop de GPL/
LGPL-licentie van toepassing is. Hierin wordt
vermeld dat u het recht heeft tot toegang,
modificeren en herdistribueren van de
broncode voor deze softwareprogramma'’s
onder de voorwaarden van de GPL/LGPL.

De broncode is beschikbaar op internet.
Gebruik de volgende URL en volg de
downloadinstructies.
https://0ss.sony.net/Products/Linux/

Wij vragen u vriendelijk geen contact met ons
op te nemen betreffende de inhoud van de
broncode.

Licenties (in het Engels) zijn opgenomen in het
interne geheugen van het product.

Breng een massaopslagverbinding tot stand
tussen het product en een computer om
licenties te lezen in de mappen "PMHOME" -
"LICENSE".

Als u een Mac gebruikt, kan het zijn dat de
map "PMHOME" - "LICENSE" niet toegankelijk
is.

Wilt u de bestanden bekijken, gebruik dan een
andere computer (geen Mac) of ga naar het
volgende webadres:
https://0ss.sony.net/License/ILME-FX6/

LICENTIEOVEREENKOMST
EINDGEBRUIKERS

IMPORTANT:

BEFORE USING THE SOFTWARE CONTAINED IN THE
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS
END USER LICENSE AGREEMENT ("EULA") CAREFULLY. BY
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony
Corporation ("SONY"). This EULA governs your rights
and obligations regarding the software of SONY and/or
its third party licensors (including SONY's affiliates) and
their respective affiliates (collectively, the “THIRD-PARTY
SUPPLIERS") contained in the wireless adapter, together
with any updates/ upgrades provided by SONY, any
printed, on-line or other electronic documentation for
such software, and any data files created by operation of
such software (collectively, the “SOFTWARE").
Notwithstanding the foregoing, any software in

the SOFTWARE having a separate end user license

agreement (including, but not limited to, GNU General
Public license and Lesser/Library General Public License)
shall be covered by such applicable separate end user
license agreement in lieu of the terms of this EULA to
the extent required by such separate end user license
agreement (“EXCLUDED SOFTWARE").

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The SOFTWARE is
protected by copyright and other intellectual property
laws and international treaties.

COPYRIGHT

All right and title in and to the SOFTWARE (including,
but not limited to, any images, photographs, animation,
video, audio, music, text and “applets” incorporated into
the SOFTWARE) is owned by SONY or one or more of the
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE

SONY grants you a limited license to use the SOFTWARE
solely in connection with the wireless adapter and only
for your individual use. SONY and the THIRD-PARTY
SUPPLIERS expressly reserve all rights, title and interest
(including, but not limited to, all intellectual property
rights) in and to the SOFTWARE that this EULA does not
specifically grant to you.

REQUIREMENTS AND LIMITATIONS

You may not copy, publish, adapt, redistribute, attempt
to derive source code, modify, reverse engineer,
decompile, or disassemble any of the SOFTWARE,
whether in whole or in part, or create any derivative
works from or of the SOFTWARE unless such derivative
works are intentionally facilitated by the SOFTWARE.
You may not modify or tamper with any digital rights
management functionality of the SOFTWARE. You
may not bypass, modify, defeat or circumvent any of
the functions or protections of the SOFTWARE or any
mechanisms operatively linked to the SOFTWARE. You
may not separate any individual component of the
SOFTWARE for use on more than one wireless adapter
unless expressly authorized to do so by SONY. You
may not remove, alter, cover or deface any trademarks
or notices on the SOFTWARE. You may not share,
distribute, rent, lease, sublicense, assign, transfer or
sell the SOFTWARE. The software, network services

or other products other than SOFTWARE upon which

the SOFTWARE'S performance depends might be
interrupted or discontinued at the discretion of the
suppliers (software suppliers, service suppliers, or
SONY). SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other products
will continue to be available, or will operate without
interruption or modification.

EXCLUDED SOFTWARE AND OPEN SOURCE
COMPONENTS

Notwithstanding the foregoing limited license grant,
you acknowledge that the SOFTWARE may include
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE
may be covered by open source software licenses
("Open Source Components”), which means any
software licenses approved as open source licenses by
the Open Source Initiative or any substantially similar
licenses, including but not limited to any license that,
as a condition of distribution of the software licensed
under such license, requires that the distributor make
the software available in source code format. If and to
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list
of applicable OPEN SOURCE COMPONENTS included in
the SOFTWARE from time to time, and the applicable
terms and conditions governing its use. Such terms
and conditions may be changed by the applicable
third party at any time without liability to you. To the
extent required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will apply in lieu
of the terms of this EULA. To the extent the terms of the
licenses applicable to EXCLUDED SOFTWARE prohibit
any of the restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will not apply
to such EXCLUDED SOFTWARE. To the extent the terms
of the licenses applicable to Open Source Components
require SONY to make an offer to provide source code
in connection with the SOFTWARE, such offer is hereby
made.


https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/
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USE OF SOFTWARE WITH COPYRIGHTED
MATERIALS

The SOFTWARE may be capable of being used by you

to view, store, process and/or use content created by
you and/or third parties. Such content may be protected
by copyright, other intellectual property laws, and/

or agreements. You agree to use the SOFTWARE only

in compliance with all such laws and agreements that
apply to such content. You acknowledge and agree

that SONY may take appropriate measures to protect
the copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are not
limited to, counting the frequency of your backup and
restoration through certain SOFTWARE features, refusal
to accept your request to enable restoration of data, and
termination of this EULA in the event of your illegitimate
use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE
DESIGNED TO BE USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT SERVICES
("CONTENT SERVICE"). USE OF THE SERVICE AND THAT
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL

BE LIMITED. You acknowledge and agree that certain
content and services available through the SOFTWARE
may be provided by third parties over which SONY has
no control. USE OF THE CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY
SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet connection
for which you are solely responsible. Further, you are
solely responsible for payment of any third party fees
associated with your Internet connection, including

but not limited to Internet service provider or airtime
charges. Operation of the SOFTWARE may be limited

or restricted depending on the capabilities, bandwidth
or technical limitations of your Internet connection

and service. The provision, quality and security of such
Internet connectivity are the sole responsibility of the
third party providing such service.

EXPORT AND OTHER REGULATIONS

You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country
in which you reside, and not to transfer, or authorize

the transfer, of the SOFTWARE to a prohibited country

or otherwise in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not designed,
manufactured or intended for use or resale as on-

line control equipment in hazardous environments
requiring fail-safe performance, such as in the
operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life
support machines, or weapons systems, in which the
failure of the SOFTWARE could lead to death, personal
injury, or severe physical or environmental damage
("HIGH RISK ACTIVITIES"). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates
specifically disclaim any express or implied warranty,
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE
is at your sole risk and that you are responsible for use
of the SOFTWARE. The SOFTWARE is provided “AS IS,”
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY, NONINFRINGEMENT AND
FITNESS FOR A PARTICULAR PURPOSE. SONY

DOES NOT WARRANT OR MAKE ANY CONDITIONS

OR REPRESENTATIONS (A) THAT THE FUNCTIONS
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B)
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL

NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER

THAN THE SOFTWARE) UPON WHICH THE SOFTWARE'S
PERFORMANCE DEPENDS WILL CONTINUE TO BE
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE

GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE
OF SONY SHALL CREATE A WARRANTY, DUTY OR
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF
THIS WARRANTY. SHOULD THE SOFTWARE PROVE
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT
APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") SHALL NOT BE LIABLE FOR ANY INCIDENTAL
OR CONSEQUENTIAL DAMAGES FOR BREACH OF

ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE,
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE,
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE,
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA, DATA
SECURITY

You acknowledge and agree that SONY and its
affiliates, partners and agents may read, collect,
transfer, process and store certain information

collected from the SOFTWARE, including but not

limited to information about (i) the SOFTWARE and

(ii) the software applications, contents and peripheral
devices that interact with your wireless adapter and the
SOFTWARE (“Information”). Information includes, but

is not limited to: (1) unique identifiers relating to your
wireless adapter and its components; (2) performance
of the wireless adapter, the SOFTWARE and their
components; (3) configurations of your wireless adapter,
the SOFTWARE and the software applications, contents
and peripheral devices that interact with the wireless
adapter and the SOFTWARE; (4) use and frequency of
use of the functions of (x) the SOFTWARE, and (y) the
software applications, contents and peripheral devices
that interact with the SOFTWARE; and (5) location data,
as indicated below. SONY and its affiliates, partners
and agents may use and disclose Information subject
to applicable laws in order to improve its products and
services or to provide products or services to you. Such
uses include, but are not limited to: (a) administering
the functionalities of the SOFTWARE; (b) to improve,
service, update or upgrade the SOFTWARE; (c)
improving, developing and enhancing the current and
future products and services of SONY and other parties;
(d) to provide you with information about the products
and services offered by SONY and other parties; (e)
complying with applicable laws or regulations; and (f)
to the extent offered, providing you with location-based
services of SONY and other parties, as indicated below.
In addition, SONY retains the right to use Information
to protect itself and third parties from illegal, criminal or
harmful conduct.

Certain services available through the SOFTWARE may
rely upon location information, including, but not limited
to, the geographic location of the wireless adapter. You
acknowledge that for the purpose of providing such
services, SONY, the THIRDPARTY SUPPLIERS or their
partners may collect, archive, process and use such
location data, and that such services are governed by
the privacy policies of SONY or such third party. By
reviewed the privacy policies applicable to such services
and consent to such activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally identify
the owner or user of the SOFTWARE without your
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knowledge or consent. Any use of Information will be

in accordance with the privacy policies of SONY or such
third party.

Please contact applicable contact address of each area or
country for SONY's current privacy policy. Please contact
applicable third parties for privacy policies relating

to personally identifiable and other information you
provide when you use or access third party software or
services.

Information may be processed, stored or transferred

to SONY, its affiliates or agents which are located in
countries outside of your country of residence. Data
protection and information privacy laws in certain
countries may not offer the same level of protection

as your country of residence and you may have fewer
legal rights in relation to Information processed and
stored in, or transferred to, such countries. SONY will
use reasonable efforts to take appropriate technical and
organizational steps to prevent unauthorized access to
or disclosure of Information, but does not warrant it will
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY SUPPLIERS
may automatically update or otherwise modify the
SOFTWARE, including, but not limited to, for purposes
of enhancement of security functions, error correction
and improvement of functions, at such time as you
interact with SONY's or third parties’ servers, or
otherwise. Such updates or modifications may delete
or change the nature of features or other aspects of the
SOFTWARE, including, but not limited to, functions you
may rely upon. You acknowledge and agree that such
activities may occur at SONY’s sole discretion and that
SONY may condition continued use of the SOFTWARE
upon your complete installation or acceptance of such
update or modifications. Any updates/modifications
shall be deemed to be, and shall constitute part of, the
SOFTWARE for purposes of this EULA. By acceptance of
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY's privacy policy, each as amended
and modified from time to time, together constitute the
entire agreement between you and SONY with respect
to the SOFTWARE. The failure of SONY to exercise or

enforce any right or provision of this EULA shall not
constitute a waiver of such right or provision. If any part
of this EULA is held invalid, illegal, or unenforceable,
that provision shall be enforced to the maximum extent
permissible so as to maintain the intent of this EULA,
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION

The United Nations Convention on Contracts for the
International Sale of Goods shall not apply to this EULA.
This EULA shall be governed by the laws of Japan,
without regards to conflict of laws provisions. Any
dispute arising out of this EULA shall be subject to the
exclusive venue of the Tokyo District Court in Japan, and
the parties hereby consent to the venue and jurisdiction
of such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this EULA to the
contrary, you acknowledge and agree that any violation
of or noncompliance with this EULA by you will cause
irreparable harm to SONY, for which monetary damages
would be inadequate, and you consent to SONY
obtaining any injunctive or equitable relief that SONY
deems necessary or appropriate in such circumstances.
SONY may also take any legal and technical remedies
to prevent violation of and/or to enforce this EULA,
including, but not limited to, immediate termination of
your use of the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to violate

this EULA. These remedies are in addition to any other
remedies SONY may have at law, in equity or under
contract.

TERMINATION

Without prejudice to any of its other rights, SONY may
terminate this EULA if you fail to comply with any of its
terms. In case of such termination, you must: (i) cease
all use, and destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section below
entitled “Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND ANY OF THE
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED

BY YOU, BY PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF
NOTICE. If you do not agree to the amendment, you
should promptly contact SONY for instructions. Your
continued use of the SOFTWARE after the effective date
of any such notice shall be deemed your agreement to
be bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express intended
thirdparty beneficiary of, and shall have the right to
enforce, each provision of this EULA with respect to the
SOFTWARE of such party.

Should you have any questions concerning this EULA,
you may contact SONY by writing to SONY at applicable
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licenties open source software

Dit product gebruikt open source software op
basis van de contracten opgemaakt tussen
Sony en de auteursrechthebbenden van de
software.

Sony is verplicht u te informeren over de
inhoud van deze licenties om aan de eisen van
de auteursrechthebbenden van de software te
voldoen.

Licenties (in het Engels) zijn opgenomen in het
interne geheugen van het product.

Breng een massaopslagverbinding tot stand
tussen het product en een computer om
licenties te lezen in de mappen "PMHOME" -
"LICENSE".

Als u een Mac gebruikt, kan het zijn dat de
map "PMHOME" - "LICENSE" niet toegankelijk
is.

Wilt u de bestanden bekijken, gebruik dan een
andere computer (geen Mac) of ga naar het
volgende webadres:
https://0ss.sony.net/License/ILME-FX6/


https://oss.sony.net/License/ILME-FX6/
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Algemeen

Massa

Ca. 890 g (alleen hoofdbody)

Ca. 2,59 kg (inclusief SEL24105G objectief,
objectiefkap, accu (BP-U35),
zoeker, draaggreep, handgreep)

Afmetingen

Zie pagina 144.
Netvoedingsvereisten

19,5V DC (18,0 V tot 20,5 V)
Stroomverbruik

Ca. 18,0 W (body, objectief, XAVC-1 QFHD
59.94P opname, zoeker aan,
zonder aangesloten externe
apparatuur)

Ca. 36,0 W (body, objectief, XAVC-I QFHD
59.94P opname (S&Q 120 fps),
zoeker aan, HDMI, SDI, extern
apparaat verbonden)

Bedrijfstemperatuur
0°Ctot40°C
Opslagtemperatuur
-20 °C tot +60 °C
Doorlopende bedrijfstijd

Ca. 105 minuten (bij gebruik van BP-U35)
(body, objectief, XAVC-1 QFHD
59.94P opname, zoeker aan,
zonder aangesloten externe
apparatuur)

Opname-indeling (video)
XAVC Intra

XAVC-1 4K/QFHD modus:
VBR, 600 Mbps (max) bitrate,
MPEG-4 AVC/H.264

XAVC-1 HD modus:
CBG, 223 Mbps (max) bitrate,
MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD modus:
VBR, 150 Mbps (max) bitrate,
MPEG-4 H.264/AVC
XAVC-L HD 50 modus:
VBR, 50 Mbps (max) bitrate,
MPEG-4 H.264/AVC
XAVC-L HD 35 modus:
VBR, 35 Mbps (max) bitrate,
MPEG-4 H.264/AVC
Opname-indeling (audio)
LPCM 24-bit, 48 kHz, 4-kanaals
Beeldsnelheid opname
XAVC Intra
XAVC-1 4K modus:
4096x2160/59.94P, 50P, 29.97P,
25P, 24P, 23.98P
XAVC-1 QFHD modus:
3840x2160/59.94P, 50P, 29.97P,
25P, 23.98P
XAVC-1 HD modus:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
XAVC Long
XAVC-L QFHD modus:
3840x2160/59.94P, 50P, 29.97P,
25P, 23.98P
XAVC-L HD 50 modus:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
XAVC-L HD 35 modus:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
Opname/afspelen tijd
XAVC Intra
XAVC-1 QFHD modus:
59.94P
Ca. 30 minuten
(bij gebruik van CEA-G160T)
XAVC-1 HD modus:
59.94P

Ca. 78 minuten
(bij gebruik van CEA-G160T)
XAVC Long
XAVC-L QFHD modus:
59.94p
Ca. 115 minuten
(bij gebruik van CEA-G160T)
XAVC-L HD 50 modus:
59.94p
Ca. 155 minuten
(bij gebruik van CEA-G80T)
XAVC-L HD 35 modus:
59.94p
Ca. 210 minuten
(bij gebruik van CEA-G80T)
[Opmerking]
De opname/afspeeltijd kan variéren afhankelijk van
gebruikscondities en geheugeneigenschappen.
De opname- en afspeeltijden gelden voor een
aaneengesloten opname als enkelvoudige clip. De

werkelijke tijden kunnen korter zijn, afhankelijk van het
aantal opgenomen clips.

Camerasectie

Beeldapparaat (type)

CMOS beeldsensor met enkelvoudige chip en
equivalent van volledig 35 mm-
beeld

Aantal pixels

12,9M (totaal)

10,2M (effectief)
Automatische scherpstelling

Detectiemodus: fasedetectie/
contrastdetectie

Interne ND-filters

CLEAR: OFF

1: 1/4ND

2:1/16ND

3:1/64ND

Lineair variabel ND-filter: 1/4ND t/m 1/128ND
ISO-gevoeligheid

ISO 800712800 (modus Cine El, D55 lichtbron)
Objectiefbevestiging

E-bevestiging
Breedtegraad

15+ diafragma'’s
Sluitertijd

64F t/m 1/8000 sec. (23.98P)
Sluiterhoek

5,6° t/m 360°, 2 t/m 64 frames
Slow & Quick Motion

XAVC QFHD: 1 fps t/m 120 fps

XAVC HD: 1 fps t/m 240 fps

XAVC 4K: 1 fps t/m 60 fps

XAVC HD (S35): 1 fps t/m 120 fps
Witbalans

2000 K t/m 15000 K
Versterking

-3 dB t/m +30 dB (stappen van 1dB)
Basisuiterlijk

S-Cinetone, Standard, Still, ITU709, s709,

709(800%), S-Log3, HLG Live, HLG
Natural

Audiosectie

Samplingfrequency
48 kHz
Kwantisering
24-bit
Frequentiebereik
XLR-ingang MIC-modus: 20 Hz tot 20 kHz
(3 dB of minder)
XLR-ingang LINE-modus: 20 Hz tot 20 kHz
(3 dB of minder)
Dynamiekbereik
XLR-ingang MIC-modus: 80 dB (normaal)
XLR-ingang LINE-modus: 90 dB (normaal)
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Vervorming
XLR-ingang MIC-modus: 0,08% of lager
(-40 dBu ingangsniveau)
XLR-ingang LINE-modus: 0,08% of lager
(+14 dBu ingangsniveau)
Interne luidspreker
Mono
Interne microfoon
Mono
Interne microfoon draaggreep
Omnidirectionele stereo elektretmicrofoon
[Opmerking]

De interne microfoon in de draaggreep wordt alleen
actief als de draaggreep is bevestigd.

Ingangs/uitgangssectie

Ingangen
INPUT 1/2:
XLR type, 3-pins, vrouwelijk
LINE / MIC / MIC+48V omschakelbaar
MIC: referentie -30 dBu t/m -80 dBu
TCIN:
BNC type

Uitgangen
SDI OUT:
BNC type, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B),
HD-SDI
Hoofdtelefoons (stereo mini-jack):
-16 dBu (referentieniveau uitgang, maximum
monitorvolume, 16 Q belasting)
HDMI:
Type A, 19-pins
TC OUT:
BNC type

Overig
DCIN:
EIAJ compatibel, 18 Vt/m 20,5V DC
Multi-interfaceschoen:
Toepassingsgericht (21-pins)
REMOTE:
2,5 mm, 3-polig sub-mini-aansluiting
Aansluiting afstandsbedieningsgreep:

3,5 mm 4-polige stereo mini-jack
(meegeleverde aansluiting voor
afstandsbedieningsgreep)

USB-C:

USB3.2Gen1

USB/muilti:

Compatibel met USB 2.0-standaard, micro B

type voor massa-opslag (1)
VF:
Toepassingsgericht (40-pins)

Displaysectie

Zoeker (LCD)
Schermgrootte
8,8 cm (3,5 inch) diagonaal
Beeldverhouding
16:9
Aantal pixels
1280 (H) x 720 (V)

Sectie mediasleuven

CFexpress Type A/SD kaartsleuf (2)

Draadloos LAN

Ondersteunde normen

IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

IEEE 802.11 b/g/n (ILME-FX6T/TK)
Frequentieband

2,4 GHz

5 GHz (alleen ILME-FX6V/VK)
Ondersteunde beveiligingsprotocollen

WEP/WPA-PSK/WPA2-PSK
Verbindingsmethode

Wi-Fi Protected Setup™ (WPS)/handmatig
Toegangsmethode

Infrastructuurmodus

Acculader (BC-CU1)

Massa

Ca.60g
Afmetingen

Ca. 57 x 26 x 101 mm

(breedte/hoogte/diepte)

Input

19,5V DC, 26 W
Output

16,4V DC 1,4 A
Bedrijfstemperatuur

0°Ctot 40 °C
Opslagtemperatuur

-20 °Ctot +60 °C

Meegeleverde accessoires

Netadapter (1)

Netsnoer (1)

Acculader (1)

Accuset (1)

Draaggreep (1)

LCD-monitor (1)

USB-C-kabel (1)
Afstandsbedieningsgreep (1)

LCD-kap (1)

Koude schoen (1)

(Koude schoen (1), schoenveer (1), schroeven (4))
Kap objectiefbevestiging (1)
Beschermkap draaggreepaansluiting (1)
Voordat u het apparaat gebruikt (1)
Garantieboekje (1)

Ontwerp en specificaties kunnen zonder
voorafgaande kennisgeving worden gewijzigd.
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Opmerkingen

e Maak altijd een proefopname en
controleer of deze correct is opgenomen.
SONY KAN NIET AANSPRAKELIJK WORDEN
GESTELD VOOR SCHADE AAN HET
APPARAAT EN LEVERT GEEN COMPENSATIE
OF VERGOEDING ALS GEVOLG VAN
DEFECTEN AAN HET APPARAAT OF DE
OPNAMEMEDIA, OF ANDERE MEDIA OF
OPSLAGSYSTEMEN VOOR HET OPNEMEN
VAN WILLEKEURIG MATERIAAL.

e Controleer altijd of het apparaat correct
werkt voordat u dit gaat gebruiken.

SONY KAN OM GEEN ENKELE REDEN ALS
GEVOLG VAN SCHADE AAN HET APPARAAT
AANSPRAKELIJK WORDEN GESTELD EN
COMPENSEERT OF VERGOEDT NIET HET
VERLIES VAN HUIDIGE OF TOEKOMSTIGE
INKOMSTEN DOOR DEFECTEN AAN HET
APPARAAT (TIJDENS DE GARANTIEPERIODE
OF NA VERLOOP VAN DE GARANTIE).

e SONY KAN NIET AANSPRAKELIJK WORDEN
GESTELD VOOR WELKE AANSPRAKEN
DAN OOK DOOR GEBRUIKERS VAN HET
APPARAAT OF DOOR DERDEN.

e SONY IS NIET AANSPRAKELIJK VOOR
VERLIES, REPARATIE OF REPRODUCTIE VAN
GEGEVENS DIE ZIJN OPGENOMEN OP HET
INTERNE OPSLAGSYSTEEM, OPSLAGMEDIA
OF WELKE MEDIA OF OPSLAGSYSTEMEN
DAN OOK.

e SONY IS NIET AANSPRAKELIJK VOOR HET
BEEINDIGEN OF NIET DOORGAAN VAN
ENIGE DIENST MET BETREKKING TOT DIT
APPARAAT DIE HET GEVOLG IS VAN WELKE
OMSTANDIGHEID DAN OOK.
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Externe afmetingen
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Alle andere bedrijfsnamen en productnamen
zijn gedeponeerde handelsmerken of
handelsmerken van de betreffende eigenaren.

Handelsmerken

e O(is een handelsmerk van Sony Onderdelen die handelsmerk zijn, worden
Corporation. niet gekenmerkt door ™ of ®-symbolen in dit
e XAVC en zijn gedeponeerde document.

handelsmerken van Sony Corporation.

e De begrippen HDMI, HDMI High-Definition
Multimedia Interface en het HDMI-logo
zijn handelsmerken of geregistreerde
handelsmerken van HDMI Licensing
Administrator, Inc. in de Verenigde Staten en
andere landen.

e Microsoft en Windows zijn handelsmerken
of gedeponeerde handelsmerken van de
Microsoft Corporation in de Verenigde
Staten en/of andere landen.

e Mac en macOS zijn gedeponeerde
handelsmerken van Apple Inc.in de V.S. en
andere landen.

e "Catalyst Browse," "Content Browser
Mobile," en het "Content Browser Mobile"-
logo zijn handelsmerken of gedeponeerde
handelsmerken van Sony Corporation.

e iOS is een gedeponeerd handelsmerk of
handelsmerk van Cisco Systems, Inc. en/of
gelieerde bedrijven in de Verenigde Staten
en bepaalde andere landen.

e Android, Google Play zijn handelsmerken
van Google Inc.

e \Wi-Fi, het Wi-Fi logo en Wi-Fi PROTECTED
SETUP zijn handelsmerken of gedeponeerde
handelsmerken van de Wi-Fi Alliance.

e Het N-teken is een handelsmerk of
gedeponeerd handelsmerk van NFC Forum,
Inc.in de Verenigde Staten en in andere
landen.

e Het SDXC-logo is een handelsmerk van SD-
3C, LLC.

e CFexpress en het CFexpress Type A-logo

zijn handelsmerken van de CompactFlash
Association. Exmorl] Pe CI}
e

e QR Code is een handelsmerk van Denso Xpress

HDmI == /A
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